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IMPORTANT- READ CAREFULLY BEFORE OPENING SOFTWARE PACKET(S) AND/OR USING THE 
SOFTWARE. By opening the sealed packet(s) containing the software and/or using the software, 

you indicate your acceptance of the following Software license Agreement. 

- SOFTWARE LICENSE AGREEMENT (Single User Products) -
This software license agreement, including the Warranty and Special Provisions set forth in the appendix or separate booklet included in this package, is 
a legal agreement between you (either an individual or an entity) and the manufacturer ("PC Manufacturer") of the computer system purchased with this 
software product. By opening the sealed software packet(s) and/or using the software, you are agreeing to be bound by the terms of this agreement. If 
you do not agree to the terms of this agreement, promptly return the unopened software packet(s) and the accompanying items (including any Microsoft 
hardware, written materials, and binders or other containers) to the place you obtained them for a full refund. 
1. GRANT OF LICENSE. This License Agreement permits you to use one copy of the Microsoft software program(s) included in this package (the 
"SOFTWARE") on a single computer. The SOFTWARE is in "use" on a computer when it is loaded into temporary memory (i.e., RAM) or installed into 
permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that computer. However, installation on a network server for the sole purpose 
of internal distribution shall not constitute "use" for which a separate license is required, provided you have a separate license for each computer to which 
the SOFTWARE is distributed. 
2. ADDITIONAL GRANT OF LICENSE (LANGUAGE SOFTWARE\. If the SOFTWARE includes a Microsoft language program, then you have a royalty-free 
right to reproduce and distribute executable files created using the SOFTWARE. If the language program is a BASIC or COBOL compiler product, then PC 
Manufacturer grants to you a royalty-free right to reproduce and distribute the runtime modules of the SOFTWARE provided that you: (a) distribute the 
runtime modules only in conjunction with and as a part of your software product; (b) do not use PC Manufacturer's or its suppliers' names, logos, or 
trademarks to market your software product; (c) include a valid copyright notice on your product label and as part of the sign-on message for your 
software product; and (d) agree to indemnify, hold harmless, and defend PC Manufacturer and its suppliers from and against any claims or lawsuits, 
including attorneys' fees, that arise or result from the use or distribution of your software product. The "runtime modules" are those files in the 
SOFTWARE that are identified in the accompanying user documentation as required during execution of your software program. The runtime modules are 
limited to runtime files, install files, and ISAM and REBUILD files. 
3. COPYRIGHT. The SOFTWARE (including any images, "applets", photographs, animations, video, audio, music and text incorporated into the SOFT
WARE) is owned by Microsoft C:orporation or its suppliers and is protected by United States copyright laws and international treaty provisions and all 
other applicable national laws. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book or musical recording) except 
that if the SOFTWARE is not copy protected you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer 
the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy the user documentation 
accompanying the SOFTWARE. 
4. SOFTWARE MEDIA. You may receive the SOFTWARE in disk media or on a CD-ROM or installed on the hard disk drive or ROM of your computer, or 
in multiple forms of media. Regardless of the number or type(s) of media you receive, you may use only the media appropriate for your single computer. 
You may not use the other media on another computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as 
provided below) of all SOFTWARE and user documentation. 
5. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and any accompanying Microsoft hardware, 
user documentation on a permanent basis provided you retain no copies and the recipient agrees to the terms of this Agreement. If the SOFTWARE is an 
update or has been updated, any transfer must include the most recent update and all prior versions. You may not reverse engineer, decompile, or 
disassemble the SOFTWARE, unless otherwise provided in the Warranty and Special Provisions for your country. 
6. US. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c)(1 )(ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-
19, as applicable. Manufacturer is Microsoft Corporation/One Microsoft Way/Redmond, WA 98052-6399. 
Please see the Warranty and Special Provisions for information conceming governing law. 
Product support for the SOFTWARE is not provided by Microsoft Corporation or its subsidiaries. For product support, please refer to PC Manufacturer's 
support number provided in the documentation for the SOFTWARE or for your computer. Should you have any questions concerning this Agreement, or 
if you desire to contact PC Manufacturer for any other reason, please refer to the address provided in the documentation for your computer. 

APPENDIX - WARRANTY AND SPECIAL PROVISIONS FOR UNITED STATES OF AMERICA AND ANY OTHER COUNTRY 
- LIMITED WARRANTY -

LIMITED WARRANTY. PC Manufacturer warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying written 
materials for a period of ninety (90) days from the date of receipt, and (b) any Microsoft hardware accompanying the SOFTWARE will be free from defects 
in materials and workmanship under normal use and service for a period of one (1) year from the date of receipt. Any implied warranties on the 
SOFTWARE and Microsoft hardware are limited to ninety (90) days and one (1) year, respectively. Some statesf]urisdictions do not allow limitations on 
duration of an implied warranty, so the above limitation may not apply to you. 
CUSTOMER REMEDIES. PC Manufacturer's and its suppliers' entire liability and your exclusive remedy shall be, at PC Manufacturer's option, either 
(a) return of the price paid, or (b) repair or replacement of the SOFTWARE or hardware that does not meet this Limited Warranty and which is returned 
to PC Manufacturer with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, 
or misapplication. Any replacement SOFTWARE or hardware will be warranted for the remainder of the original warranty period or thirty (30) days, 
whichever is longer. 
NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, PC Manufacturer and its suppliers disclaim all other warranties, either 
express or implied, including, but not limited to implied warranties of merchantability and fitness for a particular purpose, with regard to the SOFTWARE, 
the accompanying written materials, and any accompanying hardware. This limited warranty gives you specific legal rights. You may have others which 
vary from state/jurisdiction to state/jurisdiction. 
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by applicable law, in no event shall PC Manufacturer or its suppliers 
be liable for any damages whatsoever (including without limitation, direct or indirect damages for personal injury, loss of business profits, business 
interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use this product, even if PC Manufacturer 
has been advised of the possibility of such damages. In any case, PC Manufacturer's and its suppliers' entire liability under any provision of this 
agreement shall be limited to the amount actually paid by you for the SOFTWARE and/or Microsoft hardware. Because some states/jurisdictions do not 
allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you. 

- SPECIAL PROVISIONS -
If you acquired the SOFTWARE in the United States this Software License Agreement and Warranty are governed by the laws of the State of Washington, 
U.S.A. If you acquired the SOFTWARE outside the United States, local law may apply. 
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Welcome 

Welcome to the Microsoft ® Windows ™ operating system, software that makes 
your computer easier and more fun to use. Windows is easy to learn because 
its graphical interface is consistent from one application to the next. When 
you've learned to use one application, such as Write, you've learned the 
essentials for using any other application with Windows. You can run your 
existing MS-DOS-based applications beside Windows applications and share 
information between them. And now, Windows is easier and faster to set up 
on your system. 

If you are new to Windows, you may want to go to Chapter 3 after setting up 
Windows. Chapter 3, "A Guided Tour of Microsoft Windows," offers a visual 
introduction to Windows so that you can become familiar with the graphical 
interface before you start to use it. 

If you prefer to preview Windows on the screen, you can use the Microsoft 
Windows Tutorial during the Setup program. To use the Windows Tutorial, 
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you must have a mouse and a V GA (or better) monitor. If Windows is already set 
up on your computer, you can start the Tutorial from within Windows. Choose 
the Windows Tutorial command from the Help menu in Program Manager. For 
more information, see "Running the Microsoft Windows Tutorial" at the end 
of Chapter 3, "A Guided Tour of Microsoft Windows." 

About Your Windows User's Guide 
This book is only one part of the Windows version 3.1 documentation set. Also 
included are an online Tutorial and an extensive online Help system. In addition, 
several online documents (formatted for use with Write, an application included 
with Windows) are copied to your hard disk when you set up Windows. 

The first part of the Windows User's Guide is a setup guide and introduction to 
Microsoft Windows version 3.1. The rest of the book, in conjunction with online 
Help, provides a comprehensive guide to using Windows. Procedures for the 
tasks you perform most often are provided in this book. Procedures for other 
tasks are provided in Help. For more information about using Help, see Chapter 6, 
"Online Help." 
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This book is arranged as follows: 

Part 1, "Getting Started" -Chapters in this part introduce you to Windows 
and guide you through setting up Windows. 

• "Welcome" 

An overview of this book and other documentation, and a list of system 
requirements. 

• Chapter 1, "Setting Up Windows" 

Instructions for setting up Windows, tips for previous Windows users on 
upgrading to Windows version 3.1, instructions for setting up Windows 
from a network, and options for starting Windows (for advanced users). 

• Chapter 2, "New in This Version" 

A summary of the new and enhanced features in Windows version 3.1. 

• Chapter 3, "A Guided Tour of Microsoft Windows" 

A look at Windows, introducing the basic concepts, some essential Windows 
techniques, and the main applications included with Windows. 

Part 2, "Windows Fundamentals" -Chapters in this part describe the basic 
structure of Windows and the skills you need to work with Windows. 

• Chapter 4, "Windows Basics" 

An explanation of the basic elements of Windows and instruction in the skills 
you need to work with Windows. 

• Chapter 5, "Application Basics" 

Techniques for using your applications with Windows, including how to easily 
switch from one application to another. 

• Chapter 6, "Online Help" 

Instructions on how to use online Help to find information about tasks and 
features. 

• Chapter 7, "File Manager" 

Procedures for using File Manager to organize and manage the files and 
directories on your disks. 

• Chapter 8, "Print Manager" 

Procedures for printing files and setting up your printer for use with Windows. 
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• Chapter 9, "Accessories" 

Descriptions of the accessory applications included with Windows. There are 
three full-featured accessory applications: Write, a word processor; Paintbrush, 
a color painting and drawing application; and Terminal, a communications 
application. 

There are also two new multimedia applications, Media Player and Sound 
Recorder, in addition to several applications that add convenient capabilities 
to Windows, including Calculator, Calendar, Cardfile, Character Map, Clock, 
Notepad, and Recorder. 

Part 3, "Getting the Most Out of Windows" -One chapter in this part describes 
how to run MS-DOS--based applications with Windows. The other chapters 
provide information for advanced users. 

• Chapter 10, "Object Linking and Embedding" 

Instructions for transferring and sharing information between applications. 

• Chapter 11, "MS-DOS Applications" 

Procedures for running MS-DOS-based applications (applications not 
designed for Windows). 

• Chapter 12, "Customizing Windows" 

Procedures for changing screen colors, desktop settings, and other system 
settings, such as those affecting fonts and sounds. 

• Chapter 13, "Configuring Hardware" 

Instructions for installing and changing device drivers for system hardware, 
such as your mouse, display adapter, and multimedia devices. 

• Chapter 14, "Managing Memory and Performance" 

Methods for improving system speed while keeping adequate memory for 
app lications. 

Appendixes-The appendixes provide reference material on the following topics: 

• Appendix A, "Keyboard Shortcuts" 

Keyboard shortcuts for performing various Windows tasks. 

• Appendix B, "Windows and Networks" 

Instructions for using Windows with a network. 

• Appendix C, "Troubleshooting" 

Questions you might have when setting up and using Windows, and possible 
solutions. 
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What You Need to Run Windows 
The minimum software and hardware requirements your computer system needs 
to run Windows successfully are shown in the following list. 

Windows requires: 

• Microsoft MS-DOS ® version 3.1 or later. (To check your version, type ver 
at the command prompt.) 

• For 386 enhanced mode, a personal computer with a 386 processor 
(or higher) and 640 kilobytes (K) of conventional memory plus 1024K 
of extended memory, 8 megabytes (MB) of free disk space (10 MB is 
recommended), and at least one floppy disk drive. 

For standard mode, a personal computer with a 286 processor (or higher) 
and 640K of conventional memory plus 256K of extended memory, 6 MB of 
free disk space (9 MB is recommended), and at least one floppy disk drive. 

Note Minimum disk-space requirements are based on your having no optional 
components, network, or printers. Recommended requirements are based on 
your having all components installed, including a network and printer. 

• A display adapter that is supported by Windows. 

• A printer that is supported by Windows, if you want to print with Windows. 

• A Hayes, Multi-Tech, Trail Blazer, or compatible modem, if you want to use 
Terminal, the Windows communications application. 

• A mouse that is supported by Windows. Though it is not required, a mouse 
is highly recommended so that you can take full advantage of the easy-to-use 
Windows graphical interface. 

Note To get the best performance from Windows, you should configure memory 
above 640K as extended memory. Memory is discussed in Chapter 14, "Managing 
Memory and Performance." 

Windows runs in one of two operating modes, standard or 386 enhanced, 
depending on your hardware configuration. For information about starting 
Windows in a specific mode, see Chapter 1, "Setting Up Windows." 
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About Your Windows Documentation 
The Windows version 3.1 documentation set consists of the Microsoft Windows 
User's Guide, an online Tutorial, an extensive online Help system, and several 
online documents (formatted for use with Write) that are copied to your hard disk 
when you set up Windows. 

The following list outlines the various pieces of the Windows documentation: 

• The Microsoft Windows User's Guide (this book) includes a guide to 
setting up Windows on your system and a brief introduction to Windows. In 
conjunction with online Help, this book also provides a comprehensive guide 
to using Windows. It includes explanations and procedures for first-time users, 
in addition to topics for advanced users. 

• The Microsoft Windows Tutorial provides online instructions for using a 
mouse and for performing some basic tasks in Windows. 

• Online Help provides a quick reference to procedures and commands you 
need when using Windows. Context-sensitive Help is now available in the 
main Windows-based applications. To obtain specific information about how 
to complete a dialog box, just press Fl or choose the Help button while using 
the dialog box. 

• Several online documents are copied to your hard disk when you set up 
Windows. You can read (and print) the files by using Write. These files 
include: 

• SETUP. TXT - Information about software and hardware configurations 
that require special handling in order for you to successfully set up and 
start Windows. (You can view this file by using any text editor.) 

• README.WRI-Information updated after the User's Guide was printed. 

• PRINTERS.WRI-Information about configuring particular printers and 
fonts. 

• NETWORKS.WRI-Information about operating Windows with specific 
networks. 

• SYSINI.WRI-Procedures for modifying settings in the SYSTEM.INI file 
(for advanced users only). 

• WININLWRI-Procedures for modifying settings in the WIN.INI file 
(for advanced users only). 
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Conventions 
To help you locate and interpret information easily, Microsoft Windows 
User's Guide uses consistent visual cues and a few standard text formats. 

Visual Cues 
You will find the following typographic conventions throughout this guide. 

This 

bold 

italic 

ALL CAPITALS 

Represents 

Characters that you must type exactly as they appear. For 
example, if you are directed to type dir \windows, you should 
type all the bold characters exactly as they are printed. 

Placeholders for information you must provide. For example, 
if you are directed to type filename, you should type the actual 
name for a file instead of the word shown in italic type. 

Italic type also signals a new term. An explanation generally 
follows the italicized term. 

Directory names, filenames, and acronyms. 

A section that is specific to running Windows in 386 enhanced 
mode. 

Keyboard Formats 
Key combinations and key sequences appear in the following formats. 

Format 

KEYltKEY2 

KEYl,KEY2 

Meaning 

A plus sign (+) between key names means to press and hold down 
the first key while you press the second key. For example, "press 
ALT tESC" means to press and hold down the ALT key and press 
the ESC key, and then release both keys. 

A comma (,) between key names means to press and release the 
keys one after the other. For example, "press ALT, F" means to 
press and release the ALT key, and then press and release the 
Fkey. 
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CHAPTER 1 

Setting Up Windows 

Setup Designed with Users in Mind 
Setting up the Microsoft Windows version 3.1 operating system on your computer 
is simple. You can choose between two methods: Express Setup and Custom 
Setup. 

Express Setup 
Express Setup is the method recommended for most users. 

When you use Express Setup, the Setup program identifies your hardware and 
software, configures Windows to run with your system, and updates necessary 
files. All you do is type your name, answer a few simple questions (such as what 
type of printer you have), and insert disks when requested. 

If you have applications already on your system, Express Setup sets them up so 
that you can easily use them with Windows. Setup may be unable to set up some 
less common applications. You can set these up later from within Windows. Also, 
if you want to make changes to your system after Windows has been set up, you 
can do so by running Windows Setup from within Windows. 

Note If your system does not have enough disk space to set up all of Windows, 
Express Setup proposes a partial setup, which excludes some or all of the optional 
Windows components (for example, screen savers and additional accessory 
applications). 

To set up Windows by using Express Setup, you need to know two things: 

• What type of printer you have, if any 

• Which port your printer is connected to 
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Note Most computers are equipped with one or more parallel ports, such as 
LPTl, and one or more serial ports, such as COMl. You can use these ports to 
connect your computer to external devices, such as a printer. 

A physical port is a socket located on the front or back of your computer, into 
which you plug a mouse, printer, or other hardware. A virtual port is an 
internal connection, such as a connection to a network printer. Your computer 
may have one or both types of ports. See your hardware documentation for 
information about the ports on your computer. 

Express Setup sets up Windows in the C:\WINDOWS directory. If you are 
updating from Windows version 3.0, Express Setup prompts you for a directory 
name, giving your previous Windows directory as the default choice. 

Custom Setup 
Custom Setup is for experienced computer users who want to alter the standard 
Windows configuration. For example, to control how your CONFIG.SYS and 
AUTOEXEC.BAT files are modified, you should use Custom Setup rather than 
Express Setup. 

If you have limited space on your hard disk, you can use Custom Setup to choose 
which optional Windows components or files you want to set up. 

During Custom Setup, you are prompted to verify and provide information about 
the following: 

• The directory where you want to store Windows files. 

• The type (brand and processor) of computer you are using (for example, 
COMPAQ 386). 

• Your display (monitor) type. 

• Your mouse, if you are using one. 

• Your keyboard and keyboard layout. 

• The language you will work in. 

• Any network driver you are using. 

• The printer and printer port you use, if any. 

• Applications on your hard disk that you want to run with Windows. 
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• Changes that may need to be made to your AUTOEXEC.BAT and 
CONFIG.SYS files. 

• Which optional Windows components to install (including the Microsoft 
Windows Tutorial). 

• Your virtual-memory settings (if Windows will be running in 386 enhanced 
mode). 

Running Setup 
Setup detects minimum system requirements (listed in "Welcome") and warns 
you if your system does not meet the requirements. Also, Setup notifies you if it 
detects system features that are incompatible with Setup or Windows. 

Caution Before running Setup, turn off any automatic message service, such as a 
network pop-up or a printing notification, that prints directly to your screen. 
These are incompatible with Setup. 

~ To set up Windows 

1. Insert the Windows version 3.1 disk 1 in a floppy disk drive, and close the 
drive door. 

2. At the command prompt, type the drive letter of the drive you're using, 
followed by a colon (:), and then press ENTER. 

3. Type setup, and then press ENTER. 

4. Follow the instructions on the screen. 

You can choose Express Setup or Custom Setup. It is recommended that you 
use Express Setup; however, you can use Custom Setup if you are an 
experienced user. Both methods are described earlier in this chapter. 

Windows Tutorial 
You can choose to go through the brief, online Microsoft Windows Tutorial as 
part of the Setup program. The first Tutorial lesson guides you through basic 
mouse techniques and gives you a chance to practice them before you start 
working with Windows. The second lesson introduces you to basic Windows 
techniques. 

If you choose not to take the Tutorial from within the Setup program, you can run 
it later from within Windows by choosing the Windows Tutorial command from 
the Help menu in Program Manager. For complete instructions, see "Running the 
Microsoft Windows Tutorial" at the end of Chapter 3, "A Guided Tour of 
Microsoft Windows." 
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Upgrading from Windows Version 3.0 
Although you can keep your existing Windows version 3.0 in a separate directory, 
it is strongly recommended that you upgrade your copy of Windows version 3.0. 
You can then take full advantage of the many new features and enhancements in 
Windows version 3.1. Before upgrading, make backup copies of any data files and 
applications you have added to your system. 

If you have Windows version 3.0, upgrading to Windows version 3.1 preserves 
existing Windows settings, such as groups you might have created or desktop 
settings you've chosen. Also, applications, fonts, and certain drivers are 
preserved. Only the Windows system files, upgraded device drivers, and 
accessories are replaced with the new versions. 

Upgrading does the following: 

• Maintains existing Program Manager groups 

If you have created new groups in Program Manager or added program-item 
icons to existing groups, Setup preserves them. 

• Preserves existing system-information settings 

Settings for your computer, display adapter (monitor), mouse, keyboard and 
keyboard layout, language, network, and the associated drivers are preserved. 

• Updates existing device drivers that were supplied with Windows 
version 3.0 

If you have a Windows version 3.0 driver installed for which there is an 
available updated version, Setup installs the updated driver. 

• Maintains all installed drivers that were not supplied with Windows 

If you have a device driver installed that was supplied by another 
manufacturer, Setup leaves the driver unchanged. In some cases, Windows 
version 3.1 has a new driver that you can use in place of your existing driver. 
For example, if you have a Super VGA (video graphics adapter), you may 
want to update to the Windows version 3.1 Super VGA driver by using 
Custom Setup or by running Setup from within Windows later. 

• Preserves settings relating to the upper memory area 

The order in which drivers are loaded is critical in optimiZing the use of the 
upper memory area. Setup preserves the loadhigh= line and its placement in 
your AUTOEXEC.BAT file. Setup also preserves the devicehigh= line in your 
CONFIG.SYS file. 
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Note Although you are strongly advised against it, you can keep your existing 
Windows version 3.0 and add version 3.1 in a separate directory. When Setup 
asks whether you want to upgrade, specify a new directory for Windows 
version 3.1. Version 3.1 will not incorporate the custom settings you specified for 
version 3.0, such as new groups, colors, and desktop settings. After setting up 
Windows version 3.1, remove Windows version 3.0 from your PATH setting in 
your AUTO EXEC. BAT file. Some parts of Windows version 3.0 cause serious 
problems if Windows version 3.1 is running. 

More Information About Upgrading 
If you are upgrading, please note the following information: 

• If you are using an English version of Windows version 3.1 to upgrade a non
English version of Windows version 3.0, Setup will upgrade all the necessary 
Windows device drivers, using the English driver names. 

However, some of your installed device drivers that were not originally 
supplied with Windows may not be upgraded. After setup, you may need to 
obtain new third-party drivers (such as those supplied by hardware 
manufacturers) and update them by running Setup from within Windows or 
from the MS-DOS prompt. For more information, see Chapter 13, 
"Configuring Hardware." 

• Microsoft also provides the Windows Driver Library (WDL), which contains 
device drivers made available after Windows version 3.1 was released. Device 
drivers are added to the WDL as they become available. If you have a modem, 
you can download WDL device drivers from network services, including 
CompuServe, GEnie, Microsoft Online, various user-group bulletin-board 
services (BBSs on the Association of PC User Groups, or APCUG, network), 
and the electronic downloading service maintained by Microsoft (phone 
206-936-6735). If you do not have a modem, you may purchase disks by 
calling Microsoft Customer Support Services at 1-800-426-9400. 
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Network Setup 
The Setup program has options that enable you to put Windows files on a network 
server or set up Windows for an individual network user to run. This section 
describes both procedures. 

Setting Up Windows from a Network 
If a network system administrator has put the Microsoft Windows files on a 
network server, you can set up Windows on your system from the network. Check 
with your system administrator for any special instructions before setting up 
Windows from a network. 

Note For information about copying Windows files to a network server, see the 
next section, "Placing Windows Files on a Network Server." 

You can set up Windows from a network in three ways: 

• All Windows files are copied to your computer. 

In this situation, you create your own copy of Windows on your computer. All 
Windows files are copied to your hard disk. 

To set up Windows, you connect to the network server and type setup (do not 
use the /n network option). Follow the instructions on the screen. It is 
recommended that you use Express Setup instead of Custom Setup. Both 
methods are described earlier in this chapter. 

• Personal Windows files are copied to your computer; shared Windows 
files are located on the server. 

You can set up your system to access a shared copy of Windows. In this case, 
most Windows files are located on a network server and are shared by you and 
others. During Setup, a few Windows files are copied to your personal 
Windows directory on your hard disk. By maintaining your own copies of 
these files, you can customize Windows according to your preferences. 

To set up Windows this way, use the setup /n option, described in the 
procedure following this list. 

• No Windows files are copied to your computer. 

If your computer is a diskless workstation (that is, it does not have a hard 
disk), no files can be copied to your computer. When running Windows, you 
use shared Windows files located in a network Windows directory. During 
Setup, a few Windows files are copied to your personal Windows directory on 
the server hard disk and modified for your use. 
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To set up Windows this way, use setup In, described in the following 
procedure. When Setup asks you where it should put your Windows files, 
specify the name of your personal Windows directory, located on the server 
hard disk. If you are not sure which network directory you should use as your 
personal Windows directory, ask your network system administrator. 

~ To set up a personal copy of Windows from a shared network directory 

1. Connect to the network. 

2. Change to the directory where Windows is located on the network (for 
example, W:\WINSHARE). 

3. At the MS-DOS prompt, type setup /n 

4. Follow the instructions on the screen. 

It is recommended that you use Express Setup instead of Custom Setup. Both 
methods are described earlier in this chapter. 

Setup will ask where it should put your Windows files. Type the path of your 
personal Windows directory-for example, c:\windows (or u:\winuser, for a 
diskless workstation). 

Note If you have a set of Windows disks, do not attempt to set up a network copy 
of Windows from the disks (by typing setup In). You can run setup /n only if you 
are setting up Windows from a network server. 

If you are using an English version of Windows version 3.1 to upgrade a non
English version of Windows version 3.0, you need to use Custom Setup. In the 
System Information screen, choose the English names of drivers you previously 
installed in your non-English version of Windows. 

In addition, some of your installed device drivers that were not originally supplied 
with Windows might not be upgraded. After setup, you may need to obtain new 
third-party drivers (such as those supplied by hardware manufacturers) and update 
them by running Setup from within Windows. 

Placing Windows Files on a Network Server 
Windows has an administrative setup option you can use to place Windows files 
on a network server. The administrative option does not set up a usable copy of 
Windows that you can run, but transfers the files from the Windows Setup disks 
to a network drive. The files are expanded, renamed, and marked as read-only 
when they are copied to the network drive. After the Windows files are copied to 
a directory on the network, users may connect to this directory and run the Setup 
program to set up Windows for their own workstations. 
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~ To place Windows files on a network server 

1. Insert the Windows version 3.1 disk 1 in a drive. 

2. At the MS-DOS prompt, type the drive letter of the drive. 

3. Type setup /a 

4. Follow the instructions on your screen. 

Setup prompts you to specify the network drive and directory to which you 
want the Windows files copied. You're also prompted to specify group 
registration information (group name and company name), which is stored 
and used when individual workstations are set up. 

Windows requires the following disk space for network files: 

• Shared network directory-16 MB 

• Personal network directory-300K 

Setup Summary 
The Windows Setup program: 

• Determines what hardware you are using. 

• Expands files from the Windows disk set and copies them to your hard disk. 

• Configures the SYSTEM.INI and WIN.INI files, which are used to customize 
your copy of Windows. 

• Searches your hard disk for applications to set up for use with Windows and 
creates program-item icons for these applications. You can then start an 
application simply by choosing its icon. 

• Creates program information files (PIFs) and program-item icons for any 
known MS-DOS-based applications you currently have on your system. PIFs 
supply Windows with essential information about how to run the applications 
with Windows. 

• Modifies your AUTOEXEC.BAT and CONFIG.SYS files as described in the 
following section. (Express Setup does this automatically. During Custom 
Setup, you can choose whether or not to have Setup modify these files.) 

• Restarts your system (if you want), so that all changes that were made to your 
system during Setup take effect immediately. 
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Note If you quit Setup before Windows has been completely set up (by pressing 
F3, for example), Windows will not be properly set up on your system. You will 
need to run Setup again before you can use Windows. 

Changes to the AUTOEXEC.BAT and CONFIG.SYS Files 
Setup makes the following changes to your AUTOEXEC.BAT file: 

• Adds to your PATH setting the directory where you are setting up Windows. 

• Adds the SMARTDRV.EXE command line, if appropriate for your system 
configuration. 

• Creates a TEMP directory in the Windows directory and sets the TEMP 
variable to it (if you have not already set the variable). 

Setup makes the following changes to your CONFIG.SYS file: 

• Adds the HIMEM.SYS line. For example: 

device=c:\windows\himem.sys 

• Adds the SMARTDRV.EXE Idouble _buffer line, if needed. For example: 

device=c:\windows\smartdrv.exe /double_buffer 

• Updates RAMDRIVE.SYS, if it is in use. 

• Updates EMM386.EXE, if appropriate. 

• Updates your Microsoft or Hewlett-Packard mouse driver. 

• Deletes any commands that load incompatible device drivers. 

• Adds or updates your EGASYS device driver if you are using an enhanced 
graphics adapter (EGA) or a Mouse Systems mouse. 

• Adds the appropriate parameter to the 386MAX line, if it is present. 

Note If you have problems setting up Windows, see Appendix C, 
"Troubleshooting." 
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Starting Windows 
At the end of the Setup program, you can choose whether to restart Windows or 
return to the command (MS-DOS) prompt. You can start Windows from the 
MS-DOS prompt at any time. 

~ To start Windows 

• At the command prompt, type win and then press ENTER. 

Note To have Windows start whenever you turn on your computer, add the win 
command to the end of your AUTO EXEC. BAT file. For more information about 
the AUTOEXEC.BAT file, see your MS-DOS documentation. 

When you start Windows, you can specify which mode (386 enhanced or 
standard) you want Windows to run in. Windows modes are described in the next 
section. 

You can also specify the name of an application or an MS-DOS command that 
you want to run when Windows is started. 

Windows Modes 
Windows can run in two modes: 386 enhanced mode and standard mode. When 
you type win, Windows starts in the most appropriate mode for your system. You 
can find out which mode Windows is running in by choosing the About command 
from the Help menu in Program Manager. 

Windows uses the following criteria when determining which mode to use: 

• Windows runs in 386 enhanced mode if you have a 386 computer ( or higher) 
with at least 640K of conventional memory plus 1024K of extended memory. 

• Windows runs in standard mode if you have a 286 computer (or higher) with 
at least 640K of conventional memory plus 256K of extended memory. 
Windows also runs in standard mode on 386 computers that have less than 
2 MB of free memory. 

Starting Windows in a Specific Mode 
At times you might want to run Windows in a specific mode, even if it is not the 
most efficient one for your system. For example, if your system is a 386 computer 
with between 2 and 3 MB of memory and you do not want to run MS-DOS-based 
applications in Windows, you may decide to run Windows version 3.1 in standard 
mode to speed up performance. For more information about improving 
performance, see Chapter 14, "Managing Memory and Performance." 
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To ensure that Windows runs in a particular mode, specify one of the following 
options after the win command. For example, type win /s to start Windows in 
standard mode. 

You can specify one of the following options. 

Use To 

/s Run Windows in standard mode. 

You might want to use this option if you have a 386 computer with 640K of 
conventional memory plus l024K to 2096K of extended memory and do not 
use MS-DOS-based applications with Windows. On such systems, Windows 
runs faster in standard mode than in 386 enhanced mode. 

You might also want to use this option if you are having hardware 
compatibility problems when Windows is running in 386 enhanced mode. 

/3 Run Windows in 386 enhanced mode. 

You might want to use this option if you want to run Windows in 386 
enhanced mode even though your 386 (or higher) computer has less than the 2 
MB of memory that 386 enhanced mode normally requires. This option works 
only with 386 systems with at least 1 MB of memory (640K conventional, 
384K extended). If your system has less than 2 MB of memory, Windows 
probably runs slower in 386 enhanced mode than in standard mode. However, 
you may be able to run more Windows-based applications at once in 386 
enhanced mode. 

Specifying a mode is optional. If you do not specify a mode, Windows starts in 
the mode most appropriate for your system. 

Specifying an Application or an MS·DOS Command 
When you start Windows, you can also run an application or MS-DOS command. 
For example, the following commands start Windows and then Microsoft Excel: 

win c:\excel\excel.exe 

If you specify an application or MS-DOS command, it must come after an option 
that specifies a mode. For example, the following commands start Windows in 
standard mode and then run the application MYEDITOR.EXE: 

win /s myeditor.exe 

Some Samples for Starting Windows 
The following samples show how to specify modes, applications, and MS-DOS 
commands when starting Windows. 
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Sample One: Starting Windows and an Application 
The following commands start Windows and then run the application 
TEXTEDIT.COM, which is in the EDITORS directory on drive D: 

win d:\editors\textedit.com 

Sample Two: Starting Windows and Opening a Document 
The following commands start Windows in standard mode and then open the 
document AGENDA.TXT in Notepad: 

win /s agenda. txt 

Notepad starts because Windows associates all files that have the .TXT filename 
extension with Notepad. You can change such file associations in File Manager 
by choosing the Associate command from the File menu. For information, see 
Chapter 7, "File Manager." 

Sample Three: Starting Windows and an Application, and 
Opening a Document 
The following commands start Windows, run Microsoft Word, and then open the 
Word document LETTER.DOC: 

win c:\word\word.exe letter.doc 
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New in This Version 

This chapter highlights some of the new and enhanced features and many of the 
performance improvements in Windows version 3.1. 

TrueType Fonts 
One of the most dramatic features in Windows version 3.1 is the addition of 
TrueType fonts. TrueType provides you with a full set of fonts, with enough 
variety to meet virtually all your printing needs. 

15 

TrueType fonts are scalable, so you can choose the exact font size you need for 
your documents. For example, you can use a font at 12 points for the main text of 
a report and at 16 points for topic heads. If you use a dot-matrix or laser printer, 
the page you print will appear exactly as you see it on the screen, without your 
having to obtain special screen, cartridge, or soft fonts. 

Windows version 3.1 supplies several families of TrueType fonts, including Arial, 
Courier New, Symbol, and Times New Roman. You can easily add other 
TrueType fonts from a font manufacturer to enhance your Windows-based 
applications. 

For more information about using TrueType fonts, see Chapter 12, "Customizing 
Windows." 

Object Linking and Embedding 
Object linking and embedding is now available in Paintbrush, Write, Cardfile, and 
Sound Recorder (included with Windows version 3.1) and in applications such as 
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Microsoft Excel, Ami Professional, and WordPerfect. Object linking and 
embedding enables you to transfer and share information in a powerful new way. 

• Object embedding 

With object embedding, you can create a drawing, sound file, or other object 
by using an application such as Paintbrush or Sound Recorder and then insert 
(embed) it in another document. You can edit the embedded information from 
within your document. 

For example, suppose you are working on a report in which you have 
embedded a drawing. To make changes to the drawing, you choose it, 
and Paintbrush opens. You can then make changes to the drawing, save it, 
and return to your report. You don't have to remember where the drawing is: 
Windows finds it for you. 

• Object linking 

With object linking, you can use the same information (the object) in several 
documents. An object can be any kind of information, including text, a 
drawing, or a sound file. You create the object and then connect (link) it to as 
many documents as you want. 

When you edit the information in any of the documents, your changes are 
reflected in all the other documents that contain the same linked information. 
You save time and effort because you don't have to perform a cut-and-paste 
operation for each document every time you change the information. You save 
disk space because only one copy of the information exists-the documents 
contain only the links. 

For more information about object linking and embedding, see Chapter 10, 
"Object Linking and Embedding." 

A New File Manager 
File Manager has a new look: a split window with a directory list on the left and 
the contents of the "open" directory on the right. You can browse through the file 
system easily without having to open separate windows. 

File Manager has several other enhancements, including: 

• The ability to display the contents of more than one drive or directory at once. 
This makes it easy to copy and move files and subdirectories from one 
directory or drive to another. 

• More clearly labeled windows, disk drives, and network connections, making 
it easier to use File Manager. 
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• A variety of fonts that you can use to display information in the File Manager 
window. This enables you to control how much file information is displayed in 
the File Manager window at a time. 

• Enhanced network support that makes it easy to connect to and disconnect 
from network drives. (The specific commands that appear on menus depend on 
the network you are using.) 

• A Quick Format option so that you can format a floppy disk and then copy 
files to it without having to start MS-DOS Prompt or quit Windows. 

• A status bar that displays information about disk-space usage and availability. 

For more information about using File Manager, see Chapter 7, "File Manager." 

Drag and Drop 
The new "drag and drop" feature makes it easy to print, copy, or move a file in 
File Manager. You simply drag a file icon from one location to another by using 
the mouse. For example, you can print a file by dragging its file icon from File 
Manager and dropping it onto the minimized Print Manager window. 

If you want to create a new program item to use to start an application, you can 
drag the application's file icon from File Manager and drop it onto a group icon or 
window in Program Manager. 

For more information about dragging and dropping files, see Chapter 7, "File 
Manager." 

A New Print Manager 
Installing printers and connecting to network printers are now easier and smoother 
- you can perform these tasks by using either Print Manager or Control Panel. 

In addition, several of the Windows printer drivers have been improved, making it 
quicker and easier to print files. For example, support has been added for printing 
at a baud rate of 19200 on a Hewlett-Packard LaserJet Series II or III printer. If 
you are using this type of printer, you can take full advantage of this feature and 
increase printing speed dramatically. For more information, see your HP LaserJet 
documentation. 

Print Manager now is faster and more efficient, returning control to your 
applications sooner. This enables you to quickly return to working on your 
documents while other documents or files are being printed. And remember-you 
can print most files just by dragging their file icons from File Manager onto the 
minimized Print Manager window. 

For more information about printing, see Chapter 8, "Print Manager." 
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Online Tutorial 
Windows version 3.1 offers an online Tutorial in which you can practice working 
with a mouse and performing basic Windows tasks. To run the Microsoft 
Windows Tutorial, you need a mouse and a VGA (or better) monitor. 

You can run the Tutorial when you run Windows Setup or at any time afterward. 
To run the Tutorial after you have set up Windows, choose the Windows Tutorial 
command from the Help menu in Program Manager. 

New Multimedia Features 
Windows version 3.1 has several new multimedia features, including sound, 
graphics, animation, and video capabilities. Many popular sound devices are 
supported, such as sound cards and devices with Musical Instrument Digital 
Interface (MIDI) capabilities. 

The following are among the new multimedia features: 

• Media Player 

You can use Media Player to control the playing of media files on hardware 
such as sound cards, CD-ROM drives, and videodisc players. Media Player 
can play animation, sound, and MIDI sequencer files. For more information 
about using Media Player, see Chapter 9, "Accessories," and Media Player 
online Help. 

• Sound Recorder 

You can use Sound Recorder to play, record, and edit sound files that have the 
WAVE format. You can assign the sounds that you record to system or 
application events, or use the sounds in applications that support object linking 
and embedding. 

The Sound Recorder window displays the sound wave as if it were being 
shown on an oscilloscope. For more information about using Sound Recorder, 
see Chapter 9, "Accessories," and Sound Recorder online Help. 

• Enhancements to Control Panel 

Control Panel has a new Drivers option, so you can set up drivers for almost 
any device you want to use. Although most devices include the appropriate 
driver, Windows also supplies sound drivers for common sound devices. 

Also, you can now assign unique sounds to different system and application 
events by using the enhanced Sound option. For example, you can select a 
sound to play every time you start or quit Windows, when an application 
displays a message, or in place of your computer's warning beep. 
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Control Panel has a new MIDI Mapper option, which you can use with sound 
devices that have MIDI capabilities, such as a synthesizer. MIDI Mapper is 
available only if you have a driver installed that supports a MIDI device. 

For more information about the new sound support in Control Panel, see 
Chapter 12, "Customizing Windows." 

Additional Features and Enhancements 
There are additional features and enhancements in Windows version 3.1: 

• Setup enhancements 

Setup has been greatly simplified. If you choose Express Setup, Windows is 
set up for you. You just type your name and answer a few simple questions, 
such as what type of printer you have. 

If you are an advanced user and need more control over how Windows is set 
up-for example, if you want to set any special printer options or choose not 
to set up some Windows components-you can use Custom Setup. Chapter 1, 
"Setting Up Windows," provides detailed instructions on how to set up 
Windows on your computer, using both methods. 

• Improved support for MS-DOS-based applications 

Windows now includes program information files (PIFs) for even more 
MS-DOS-based applications. PIFs are set up when you create program items 
for your MS-DOS-based applications in Program Manager, making it easier to 
run these applications from within Windows. 

Note An MS-DOS-based application is designed to run with MS-DOS but not 
specifically with Windows. 

When you run Windows in 386 enhanced mode, improved virtual-memory 
functions make it smoother to run several MS-DOS-based applications in the 
background and to switch between them. 

Full mouse support has been added to MS-DOS-based applications running in 
a window. You can now use your mouse to move around in and select items in 
these applications. 

Different font sizes are available for your MS-DOS-based applications, so you 
can pick the font size that best suits your needs. 

Also included is a collection of icons (in the MORICONS.DLL file) that 
represent many of the most popular MS-DOS-based applications. You can 
now use these icons when adding MS-DOS-based applications to Program 
Manager. 

For more information about running MS-DOS-based applications in 
Windows, see Chapter 11, "MS-DOS Applications." 
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I Network enhancements 

When you restart Windows, your system is reconnected to all the printers and 
network drives you were previously connected to. 

I Character Map 

Character Map is a new accessory application that you can use to insert special 
characters not found on your keyboard into your application. These characters 
include accented characters and characters in the Symbol fonts. For more 
information about using Character Map, see Chapter 9, "Accessories," and 
Character Map online Help. 

I Object Packager 

Windows Object Packager is a new accessory application you can use when 
linking and embedding information. For more information about Object 
Packager, see Chapter 10, "Object Linking and Embedding." 

I Online Help enhancements 

In addition to a complete, indexed Help system for all of Windows, you can 
now get context -sensitive Help for the task you are performing. Context
sensitive Help is available in all dialog boxes in the following Windows 
applications: Windows Setup, Program Manager, File Manager, Print 
Manager, PIF Editor, and Control Panel. Now, you can get Help on a dialog 
box by simply choosing the Help button or pressing F1. For more information 
about using Help, see Chapter 6, "Online Help." 

I Improved startup configuration 

When Windows starts, it runs (or loads) any applications whose program-item 
icons you placed in the new StartUp group in Program Manager. 

In Program Manager and File Manager, you can preserve the contents and 
positions of windows and icons, and any menu settings you change, from one 
Windows session to the next. For more information about using the StartUp 
group, see Chapter 5, "Application Basics." 

I More ways to customize your desktop 

Windows version 3.1 now has more desktop color schemes to choose from, 
including three designed for use with liquid crystal display (LCD) monitors. 

Also included are screen savers, which display moving graphics or text on 
your screen while you are not actively working with Windows. Screen savers 
reduce the wear on your screen and can be password-protected so that your 
work remains private. For more information about the new desktop features, 
see Chapter 12, "Customizing Windows." 
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• Serial-port enhancements 

Windows now includes additional communications settings for your serial 
ports. You can use serial ports that were not previously recognized by 
Windows and set separate interrupts for ports 1 and 3, in addition to ports 2 
and 4, so that you can use these ports simultaneously. For more information 
about this feature, see Chapter 13, "Configuring Hardware." 

• Standardized dialog boxes 

Many of the common dialog boxes, such as those that appear when you choose 
the Open, Save As, Browse, or Print Setup command, now look the same 
throughout Windows. 

• New collection of application icons 

Program Manager now offers a collection of icons that you can choose from to 
represent your applications. Whether you are adding an application to a group 
or changing application information, you can choose the most suitable icon. 
Also included is a file (MORICONS.DLL) that contains icons used to 
represent MS-DOS-based applications. 

Performance Improvements 
Windows version 3.1 includes many significant improvements to overall 
performance. For example: 

• Program Manager now requires less system memory, so you can create more 
groups without using up memory. 

• File Manager is much faster: Your screen updates faster when you move and 
copy files and when you search through drives and directories. 

• Running an MS-DOS-based application in a window is now much faster in 
386 enhanced mode. Also, switching between Windows and an MS
DOS-based application is smoother and faster. 

• Printing is faster and more efficient: Your documents print faster, and control 
is returned to your applications sooner. 

• Disk-caching is improved with SMARTDrive. Opening, saving, and managing 
files when using MS-DOS-based applications is now smoother and faster. 





CHAPTER 3 

A Guided Tour of Microsoft 
Windows 

I ntrod uction 
This chapter introduces you to the Microsoft Windows operating system version 
3.1-what it is, what it looks like, and how it works. You may want to tryout 
some of the Windows features as you read this chapter. 

This tour is designed for mouse users. If you don't have a mouse, the tour can 
still provide a good overview of Windows. To learn about specific keyboard 
procedures, see Chapter 4, "Windows Basics," Chapter 5, "Application Basics," 
and Appendix A, "Keyboard Shortcuts." 
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If you are new to using a mouse, you can use the online Microsoft Windows 
Tutorial either during the Setup program or later from within Windows. The first 
Tutorial lesson introduces you to basic mouse procedures. For more information, 
see "Running the Microsoft Windows Tutorial" at the end of this chapter. 

If Windows is not yet set up on your system, read Chapter 1, "Setting Up 
Windows," before continuing. 

Starting Windows 
After Windows is set up on your computer, it is easy to start: 

• At the command prompt (for example, C», type win and then press ENTER. 

Windows Basics 
As you work with Windows, there are a few basic terms you need to become 
familiar with. 

You do your work in rectangular areas of the screen called windows. These 
windows appear on a background called the desktop. The applications you work 
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with (such as your word-processing or spreadsheet applications) are represented 
in Windows by small graphical symbols called icons. 

You often carry out an action in Windows by choosing an item: For example, 
choosing an icon can start an application. You choose an icon by double-clicking 
it with the mouse. 

Program-item icons represent applications you can run. 

~ ~ 
Windows PIF Editor Read Me 

Setup 

Program Manager 

Games S tartU p 

The screen background 
is known as the desktop. 

Each of these areas 
is a window. 

When you start Windows, the first thing you see is Program Manager, which 
continues to run as long as you are using Windows. Initially, the Program 
Manager window displays the contents of the Main group. A group is a collection 
of applications you can run. The names and icons for the applications in the group 
are displayed in the group window. 



The Main group 
window shows the 
main applications 

included with 
Windows. 
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Program Manager also displays icons for other groups of applications: 
Accessories, Games, and StartUp. 

Note Your Program Manager window may contain another group icon called 
Applications. During Windows Setup, applications already installed on your 
computer can be set up for you to use with Windows. The Applications group 
window contains icons for those applications. 

You can perform many important tasks by using Program Manager. For example, 
you can: 

• Start applications. 

• Organize your applications into groups for easy access. 

• Quit Windows. 

The following illustration points out some of the Windows features displayed 
when you first start Windows. 

~ I 
Windows PIF Editor Read Me 

Setup 

Accessories Games StartUp Appications 

Group icons represent other 
groups of applications. 

The title bar identifies the 
application (or group) in the window. 

The mouse pointer is used to select 
and move objects on the screen. 
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Starting an Application 
From Program Manager, you can easily start an application by using the mouse to 
double-click (or "choose") its icon, called a program-item icon. You may need to 
open another group window to find the icon representing the application you want 
to use. For example, you need to open the Accessories group to start Notepad. 

S' 

Windows 
Setup 

@ I 
PIF Editor Read Me 

[[i] [[i] ffi] [[i] 
Accessories Games S tartU p Applications 

You can open a group window by 
double-clicking the group icon. 

The Accessories group window displays icons for additional applications you 
can run. 

§ [W iii • I Cardlile Calendar Calculator Clock Object 
Packager 

It A 
Character Map Media Player Sound 

Recorder 



§ 
Cardfile 

rillI 

Chapter 3 A Guided Tour of Microsoft Windows 27 

When you double-click ("choose") the icon, in this case Notepad, the application 
appears in an application window, ready for you to use. 

The Notepad window is now the active window. The active window is generally 
the window in the foreground. To make another window active, you click 
anywhere in the window. 

.. (I I ~~;:; 

You can start an application by 
double-clicking its program-item icon. 

Calendar Calculator Clock Object 
Packager 

IS If 
Character Map Media Player Sound 

Recorder 
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Using a Menu 
Each application window, and other windows as well, has menu names located on 
a menu bar (beneath the title bar). A menu contains a list of commands, which are 
actions you can carry out in Windows. To choose a menu name or command, you 
click it once. 

Clicking a menu name displays 
the menu commands. 

I 
_______ J 

Clicking a command 
carries out an action. 

Contents for Notepad Help 

Notepad is a text editor that you can use to edit smalilm1.fU.Gil, 
such as your CONFIG.SYS or AUTOEXEC.BATfile. 

To learn howto use Help, press F1. 

How To ... 

In this case, the command 
opens a Help window. 
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Reducing an Application Window to an Icon 
As you work with Windows, you may want to temporarily put aside an 
application but keep it running and easily available to use later. You can avoid 
clutter on your screen if you reduce the application window to an icon by clicking 
its Minimize button; the icon stays on the Windows desktop until you need to use 
the application again. 

You can reduce an application window 
to an icon by clicking the Minimize button. 

The application is running, but it takes up less space as an application icon. 

ell [ill) III I 
Cardfile Calendar Calculator Object 

Packager 

~ 

Application icon 
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Quitting an Application 
When you finish using an application, you may want to quit it to free memory for 
other tasks. Using a mouse, you can quit an application as easily as starting it. The 
quickest way to quit is to double-click the application's Control-menu box. (You 
can also press ALT+F4. Or you can click the Control-menu box once to display the 
Control menu, and then click the Close command.) 

You can quit an application by 
double-clicking its Control-menu box. 

If you have any unsaved work, Windows prompts you to save it before the 
application window closes. 

More Ways to Use Program Manager 
You can also use Program Manager to: 

• Create and delete groups. 

• Add applications to a group and delete applications from a group. 

• Add applications to the StartUp group so that they start when Windows starts. 

For information about these and other Program Manager tasks, see Chapter 5, 
"Application Basics." 
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File Manager 

This is a 
directory icon. 

The status bar 
shows information 
about disk space 

and availability. 

File Manager provides a graphical representation of files and directories to help 
you organize them and simplify file maintenance. You can start File Manager by 
double-clicking its icon in the Main group window. 

You can perform many tasks by using File Manager. For example, you can: 

• View the contents of your directories. 

• Move, copy, and delete files and directories. 

• Change to other disk drives, including network drives. 

Files and Directories 
A file is an electronic document or an application or program that has been named 
and is stored on your computer. A file could be a memo you have written or the 
word-processing application you used to create the memo. Files have unique 
names, such as LEITER. TXT and APPLICTN.EXE, and they can be organized 
into directories. 
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A directory is a collection of files and/or other directories (sometimes called 
subdirectories). Two directories that are likely to be on your computer are 
WINDOWS and SYSTEM. 

C:\ I Dnve 

LI REPORTS] }Directories L1r--W-IN-o-ow-s---'I 

SYSTEM I Subdirecto~ 

1----- calc.exe 

1----calc. hlp Files 

L-___ cardfile.exe 

The WINDOWS directory contains the SYSTEM subdirectory, in addition to 
many of the Windows files. The SYSTEM directory contains additional files. 

A directory window appears in the main File Manager window. It graphically 
displays the relationship of the directories and files stored on a disk drive. 

The left side of the window displays the directory tree, and the right side displays 
the contents of the current directory. 



The directory tree 
displays directories on 

the drive you are using. 
The selected directory 

(WINDOWS) is "open." 
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The files and subdirectories in the 
open directory are displayed. 

Viewing Directory Contents 
By using File Manager, you can easily scan the contents of a directory. Just 
open the directory by clicking (selecting) its name or icon on the left side of the 
window. 

In the following illustration, the REPORTS directory is open, with its contents 
displayed at the right. 

Llcharts 
Llrecords 
Lltables ~ notes. txt 
D accounts.bak D sales.dat 
D accounts. dat LZl showart. bat 
~apr.wri 
~feb.wri 
~ian.wri 
D letters. log 
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Scrolling to View Information 
When a file has more text or graphics than can fit inside a window, you can use 
scroll bars to bring the rest of the information into view. 

These scrolling techniques will be useful in much of your work with Windows. 

Clicking these arrows displays information 
above or below what is currently visible. 

~~"':;"""'...,..,.......ff- Placement 

Clicking these arrows displays information to 
the right or left of what is currently visible. 

Moving and Copying Files 

of the scroll 
box shows 
your position 
in the list. 

With the "drag and drop" feature available in File Manager, you can use your 
mouse to move or copy files quickly. 

For example, to copy a file from your hard disk to a disk in drive A, first position 
the mouse pointer on the file icon. Then press and hold down the left mouse 
button and move (drag) the file icon to the drive icon labeled "a." Finally, 
release the mouse button, dropping the file icon onto the drive icon. 

You can move a file to a different drive by pressing and holding down the SHIff 

or ALr key while you drag the file icon to the drive icon. 
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When you move or copy files in File Manager, your mouse pointer appears as in 
the following illustration. 

You can copy a file to another drive by dragging its icon to the drive icon. 

You can also move and copy files from one directory to another by dragging file 
icons. 

• You can move a file to another directory on the same drive by dragging the 
file icon to the destination directory icon or window. 

• You can copy a file to another directory on the same drive by pressing and 
holding down the CTRL key while you drag the file icon to the destination 
directory icon or window. 

For more information about moving and copying files, see Chapter 7, 
"File Manager." 

Changing Disk Drives 
In File Manager, all of your disk drives are readily available, even any network 
drives you are connected to. 

Each File Manager directory window displays icons for all drives on your 
system-floppy disk drives, hard disk drives, and network drives-in the space 
beneath the window title. The icon of the current drive is outlined. The files and 
directories on the current drive are those displayed in the directory window. 
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The drive you are currently using is outlined. 

You can change to another drive by clicking its drive icon. 

logo.bmp 
~mar.wri 
iamkreport.exe 

t.ltables ~ notes. txt 
D accounts.bak D sales.dat 
D accounts. dat [j] showart. bat 

When you click another drive icon, the directory window changes to display the 
contents of that drive. Double-click the drive icon to open an additional directory 
window rather than replace the contents of the current directory window. 

More Ways to Use File Manager 
You can also use File Manager to: 

• Connect to network drives. 

• Format and maintain disks. 

• Print documents. 

• Start applications. 

• Rename and delete files. 

• Change the kind and amount of information displayed about each file. 

• Create directories and subdirectories. 

For information about these and other File Manager tasks, see Chapter 7, 
"File Manager," and Help for File Manager. 

Control Panel 
You can use Control Panel to adjust settings on your system, such as changing the 
look of your desktop and configuring hardware. 

You can start Control Panel by double-clicking its icon in the Main group 
window. 
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You can perform many tasks by using Control Panel. For example, you can: 

• Change screen colors and desktop settings. 

• Set options for your printer. 

• Add, configure, and remove device drivers. 

By using the dialog box that appears when you choose a Control Panel icon, you 
can make changes, such as adding and removing fonts. 

91 " D ate/T ime Network 

liample 

aBbCcXxYyZz 123 

T his is a scalable True Type font which can be 
displayed on the screen and printed on your printer. 

Size of Font on Disk: 66 KB 

Note Your fonts may be different from those shown here. 
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Using Dialog Boxes 
Sometimes Windows requires additional information from you in order to 
complete a task. You provide this information in a dialog box. Depending on the 
task you are performing, you might need to select certain options, type some text, 
or specify settings. 

Clicking this arrow displays 
a list of options to select from. 

f.ile: Ipa,t.l'.bmp III 

Clicking this command button 
displays another dialog box. 

@ hentel 0 lile -----+It- Clicking this check box 
Sizing Glid '-C-U-ISO-I O-li-nk-R-at-e _-----J turns the option on or off. 

lilanulalit.l': 

!!.oldel Width: 

Slow Fast 

IRltll:III"11I 

You can select only one of 
these option buttons at a time. 

More Ways to Use Control Panel 
You can also use Control Panel to: 

• Change options for your mouse or other pointing device, such as the double-
click rate. 

• Change settings for network connections. 

• Specify international settings for applications that use them. 

• Assign unique sounds to system events. For example, you can have Windows 
play musical notes each time it starts, if you have a sound card. 

• Add, configure, or remove sound and Musical Instrument Digital Interface 
(MIDI) device drivers, if you have a sound card or MIDI device. 

• Set printer options. 
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For information about these and other Control Panel tasks, see Chapter 12, 
"Customizing Windows," Chapter 13, "Configuring Hardware," and Help for 
Control Panel. 

Print Manager 
Print Manager controls printing for Windows-based applications and helps you 
keep track of documents sent to your printer. The Print Manager window displays 
the status of your printer(s) and the documents that are printing or waiting to be 
printed. 

You can view the Print Manager window by double-clicking its icon in the Main 
group window. 

You can use Print Manager to: 

• Check the print status of a document. 

• Pause and restart a printer or the printing of a document. 

• Cancel the printing of a document. 

• Set up a printer. 

In Windows, you often need to select (highlight) an item before you carry out an 
action on it. For example, in Print Manager you click a print job to select it; then 
you can pause, restart, or cancel printing by clicking the appropriate button. 

r---...... You use the Pause and Resume buttons 

QMS-PS 810 on 

1 Calendar -SCHEDULE.CAL 

to temporarily stop and restart printing. 

You can cancel a print job by selecting 
it and then choosing the Delete button. 

This area displays the current 
status for the selected printer. 

4% of 458K 1 :43 PM 10/19/1991 

13K 1 :12 PM 10/19/1991 
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Checking Printer Status 

This line shows the 
queue status for a 

printer that is directly 
connected to your 

computer. 

This line shows the 
queue status for a 

printer that you are 
connected to 

through a network. 

By using Print Manager, you can monitor the status of your printer and the 
documents being printed. This can be particularly useful when you are printing 
more than one document or printing on a network printer that is located where 
you can't see it. 

QMS-PS 810 on 

1 Calendar -SCHEDULE .CAL 

4% of 458K 1 :43 PM 10/19/1991 

13K 1 :12 PM 10/19/1991 

These lines display the status of files 
that are printing or waiting to be printed. 

More Ways to Use Print Manager 
You can also use Print Manager to: 

• Set up a printer. 

• Change the order of documents waiting to be printed. 

• Specify how print messages are displayed. 

• Connect to and disconnect from network printers. 

• Use separator pages between documents. 

• Specify your default printer. 

For information about these and other Print Manager tasks, see Chapter 8, "Print 
Manager," and Help for Print Manager. 

Switching Between Applications 
Using Windows to run more than one application at a time can make your job 
much easier. But when several windows are open, it may become difficult to find 
applications beneath overlapping windows. 



Task List 
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An easy way to keep track of your applications is to use the Windows fast 
application-switching feature. You can switch quickly to another application by 
pressing and holding down the ALT key and then pressing the TAB key repeatedly. 
As you continue to press TAB, the title of each application currently running in 
Windows appears in the center of your screen. 

When you see the application you want to use, release ALT + TAB. The application 
window appears in the foreground. 

Another method of managing your applications is to use Task List. 

Using Task List, you can: 

• Display a list of all the applications you are currently running. 

• Switch quickly to any running application. 

• Rearrange windows and icons on your desktop. 

• Quit an application. 

You can display Task List by double-clicking anywhere on the desktop. Another 
method is to press CTRL+ESC. (If a menu is displayed, you need to press ESC first.) 
Or you can choose the Switch To command from any application's Control menu. 

You can switch to an application 
by double-clicking its name. 

The list shows your rliiftlm •• iiiiiiiiii.1 
running applications. 



42 Microsoft Windows User's Guide 

The Task List buttons can be used to perform several functions: 

Switches you to the selected application. 

Quits the selected application. 

Closes Task List. Or you can close it by pressing ESC. 

Layers windows on your screen so that you can see the title of each 
window. 

Resizes windows and arranges them side by side. 

Rearranges application icons along the bottom of your desktop. 

For more information about switching between applications, see Chapter 5, 
"Application Basics." 

Online Help 
Windows provides online Help to assist you in working with Windows. Following 
are some of the ways you can obtain Help: 

• Press the Fl key to view a list of Help topics for the application you are 
working with. 

• When you are using a dialog box that has a Help button, click the Help button 
(or press Fl) to display information about working with the dialog box. 

• Choose the Help menu in any application to display a list of Help commands. 

The buttons near the top of the Help window can help you find the information 
you need. 
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Contents for Control Panel Help 
Windows Control Panel provides you with a graphical way of 
configuring hardware and customizing Windows. 

To learn howto use Help, press F1. 

Change Keyboard Options 
Change Network Settings 
Change Pointing-Device Options 
Change Serial-Port Settings 
Change Swap-File Settings 
Change the Look of Windows 
Change the System Date and Time 
Conned to a Remote Printer 
Control Sound 
Customize Windows for International Use 
Install and Configure Printers 
Install and Remove Device Drivers 

Displays a list of Help topics for an application. 

Displays a dialog box where you specify a topic to search for. 

Displays the previously viewed topic. 

Displays a chronological list of all Help topics viewed during your 
current Windows session. 

Displays a list of Windows terms and their definitions. 

If you need to learn how to use Help, press Fl while the Help window is open. 
Or choose How To Use Help from your application's Help menu. For more 
information about using Help, see Chapter 6, "Online Help." 
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Quitting Windows 
Before turning off your computer, it is recommended that you quit Windows. You 
can quit Windows by double-clicking the Control-menu box in Program Manager. 

A @ I 
Windows PIF Editor Read Me 

Setup 

Accessories Games S tartU p Applications 

The Next Step 
This chapter has provided a brief introduction to Windows. The rest of this book, 
along with online Help, provides details on the features presented in this chapter. 
Also, you may want to use the Windows Tutorial that is available on your system. 
Instructions for running the Tutorial follow. 

Running the Microsoft Windows Tutorial 
The Windows Tutorial is an interactive, online application that teaches you the 
basics of using a mouse and Windows. To use the Tutorial, you need a mouse and 
a VGA (or better) monitor. 
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~ To run the Tutorial from within Windows 

Mouse 

1. Switch to the Program Manager window by clicking it or by using Task List. 

2. Click the Help menu, and then click the Windows Tutorial command . 

.lifT 

'Windows PIF Editor Read Me 
Setup 

[ill] [ill] 
Accessories Games S tartU p Applications 

Keyboard 

1. Switch to the Program Manager window: Press and hold down ALT, and then 
press TAB repeatedly until "Program Manager" appears in the small window in 
the middle of your screen. Then release both keys. The Program Manager 
window appears. 

2. Press ALT and then H to display the Help menu. 

3. Press W. Or press the DOWN ARROW key to select the Windows Tutorial 
command, and then press ENTER. 





PAR T 2 

Windows Fundamentals 
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CHAPTER 4 

Windows Basics 

If you are new to Windows, this chapter may be the most important one to read. It 
explains the basic skills you need to work with Windows. You may want to return 
to this chapter often as a reference. 

Another way to become familiar with Windows is to read Chapter 3, "A Guided 
Tour of Microsoft Windows." The tour introduces you to all the parts of Windows 
and gives you a brief overview of the main applications included with Windows. 

Basic Elements of Windows 
Windows provides everything you need to manage your applications and files 
easily and efficiently. The following illustration shows the graphical environment 
of Windows. 

~ I 
Windows PIF Editor Read Me 

Setup 

Accessories Games S tartU p Applications 
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When working in Windows, your main work area is the desktop. You can move 
items around on the desktop, add new ones to it, and remove those you do not 
need. 

The first time you start Windows, the Program Manager window appears on your 
screen. You can use Program Manager to organize your applications and start 
them. 

After you start an application, it runs in an application window on the desktop. 
You can reduce any open application window to an application icon. An 
application icon is a small picture representing an application. By reducing 
application windows to icons, you can free space on your desktop without quitting 
the applications. For more information about icons, see "Types of Icons" later in 
this chapter. 

The following illustration shows applications running in windows and 
applications running as icons on the desktop. 

~---------r Applications running in windows 

TO DO THIS WEEK 

- Do charts for Thursday 
status lIIeeting. 

- Schedule lIIeeting wi th Jan 
re next 1II0nth' s selllinar. 

- Finish writing report by 
Friday. 

- Clean out elllail lIIailbox. 
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For more information about how to start, run, switch between, and quit 
applications, see Chapter 5, "Application Basics." 

Parts of a Window 
Most windows have certain elements in common, such as a title bar and a menu 
bar. Not all windows, however, have every element. 

Insertion point 

I 

Window corner Mouse pointer 

Minimize button 

Maximize button 

Menu bar 

Window border 

Vertical 
scroll bar 

Scroll arrows 

You'llieam more about how to use window elements throughout this chapter. 

• The Control-menu box is in the upper-left corner of each window. Click the 
Control-menu box to open the Control menu. The Control menu is most useful 
if you use your keyboard (rather than a mouse) to move, size, and close a 
window. 

• The title bar shows the name of the application, document, group, directory, or 
file. If more than one window is open, the title bar for the active window (the 
one in which you are working) has a color or intensity different from other title 
bars. 
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• The menu bar contains the available menus from which you can choose 
commands. 

• The scroll bars enable you to move through a document or a list when the 
entire document or list does not fit in the window or the allotted space. Click 
the scroll arrows with the mouse to move through the document or list one 
line at a time. 

• Clicking the Maximize button with the mouse enlarges the active window so 
that it fills the entire desktop; clicking the Minimize button reduces the 
window to an icon. You can also use the Maximize and Minimize commands 
on the Control menu. 

• The Restore button replaces the Maximize button after you enlarge a window. 
Clicking the Restore button returns the window to its previous size. You can 
also use the Restore command on the Control menu. 

• The window border is the outside edge of a window. You can change the 
window size by lengthening or shortening the border on each side of a 
window. 

• Moving the window corner shortens or lengthens two adjoining sides of a 
window border at the same time. 

• The insertion point shows where you are in a document. It marks the place 
where text and graphics appear when you begin typing or drawing. (The shape 
of the insertion point may vary among applications.) 

• The mouse pointer appears if you have a mouse installed. When you move the 
mouse, the position of the pointer changes on the screen. (The shape of the 
mouse pointer may vary among applications and even among documents 
within the same application.) 
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Types of Windows 
As you work with applications, two kinds of windows appear on your desktop: 
application windows and windows inside the application window. 

An application window contains a running application. The following is an 
example of an application window. 

An application -( 
window has a title .Eile .Edit .search Jjelp 

bar and menu bar. 

Another window, sometimes called a document window, may appear inside an 
application window. This type of window may contain documents, data files, 
groups (in Program Manager), or directories (in File Manager). In certain 
applications, more than one of these windows can be open at a time. For example, 
with File Manager (one of the main applications included with Windows), you 
can view several directories at a time. Each directory appears inside its own 
window. 
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As the following illustration shows, document windows share the application
window menu bar but not the title bar. When a document window is open, 
commands that you choose from the application's menus affect the document 
window and the information contained in it. 

~---------TDocument windows do not 
have their own menu bars. 

" III It ~ I ., 
Cardfle Calculator Clock Windows PIF Editor ReadMe 

Setup 

Games StartUp Applications 

If you use a mouse, you move and size application windows and document 
windows in the same way. If you use the keyboard, however, you use different 
keystrokes to manipulate each type of window. For more information, see 
"Working with a Window" later in this chapter. 

Types of Icons 
Icons are small pictures that represent various types of applications and files. 



Group icons 

§ [ID 
Cardfile Calendar 

II 
Calculator 

StartUp 
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Program-item icons appear only in Program Manager 
groups and can be moved from one group to another. 

11 I '.:«~ 

Clock Object 
Packager 

\ Application icons ap~ear at the 
lower edge of the Windows desktop. 

The following table describes the three types of icons found on the desktop. 

Icon type 

Program-item icon 

Application icon 

Group or document icon 

Description 

Represents an application you can start from Windows. 

Most program-item icons look unique. However, icons 
for many MS-DOS-based applications are identical. A 
group might contain several MS-DOS-based 
applications. The icon label is the only way to 
distinguish which application the icon represents. 

Represents a program-item icon (an application) that was 
started and then reduced to an icon. 

Generally appears along the lower edge of the 
application window and represents a group or document 
window that was reduced to an icon. This icon can be 
moved anywhere within the application window. 
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Minimized document 
windows have identical 

icons distinguished only 
by their labels. 

Basic Mouse Techniques 
The following table describes some of the terms referred to throughout this guide. 
Other terms are explained as they are introduced in the text. 

Term 

Click 

Double-click 

Drag 

Point 

Meaning 

To quickly press and release the mouse button. 

To click the mouse button twice in rapid succession. 

To press and hold down the mouse button while you move the 
mouse. 

To move the mouse until the mouse pointer on the screen points to 
the item of choice. 

Note The mouse has more than one button. In Windows, use the left mouse 
button, which is the default. You can change the default by using Control Panel. 
For more information, see Help for Control Panel. 

Basic Keyboard Techniques 
Using a mouse is usually easier and faster than using the keyboard. Therefore, in 
most cases the procedures in this guide show you mouse techniques for 
completing tasks. If you prefer using the keyboard, see Appendix A, "Keyboard 
Shortcuts." 
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Choosing and Selecting 
In Windows, the terms choose and select have different meanings. Selecting an 
item usually means marking it with the selection cursor, which can appear as a 
highlight, a dotted rectangle, or both. Selecting alone does not start an action. 

You choose an item to carry out an action. For example, choosing an icon might 
start an application, open a window, or carry out a command. You choose an item 
from a menu and choose a command button in a dialog box. (Menus and dialog 
boxes are discussed later in this chapter.) 

You select an item by clicking it once with the mouse or by using the TAB key or 
the arrow keys to move the cursor to the item. You choose an item by double
clicking it or by pressing a key (such as ENTER) after the item is selected. 

You can use a combination of mouse and keyboard techniques. For example, you 
can click an item to select it and then press ENTER to choose it. When a procedure 
in this guide directs you to choose an item, generally you can use either a mouse 
or the keyboard, whichever method you prefer. 

Selecting Items 
While using Windows, you often need to select an item or multiple items from a 
list; for example, when using a dialog box. 

~ To select a single item by using a mouse 

1. If necessary, click the scroll arrows until the item you want appears. 

2. Click the item. 

~ To select a single item by using the keyboard 

1. If necessary, use the arrow keys until the item you want appears. 

2. Press ENTER. 

Sometimes you may want to select multiple items that mayor may not be in 
sequential order. In these cases, you can select or cancel items. 

~ To select or cancel multiple sequential items by using a mouse 

• To select items, click the first item you want to select, and then drag the cursor 
to the last item you want. To cancel the selection, click any item in the list. 

Or click the first item you want to select, press and hold down SHIFT, and then 
click the last item you want. Both items and all items in between are selected. 
To cancel the selection, release SHIFT, and then click any item. 
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~ To select or cancel mUltiple sequential items by using the keyboard 

1. To select items, use the arrow keys to highlight the first item you want. 

2. Press and hold down SHIff, and press the arrow key to continue to select 
items. To cancel the selection, press the appropriate arrow key. 

~ To select or cancel multiple nonsequential items 

• To select, press and hold down CTRL, and then click each item you want. To 
cancel, press and hold down CTRL, and then click the item to cancel the 
selection. 

For more information about using the keyboard to select items, see "Selecting 
Items" in Appendix A, "Keyboard Shortcuts." 

Using a Menu 
Commands are listed on menus. Most applications have their own menus, which 
are listed on the menu bar along the top of the application window. 

Note Some applications, such as Clock, can hide their menu bar. To display a 
hidden menu, double-click anywhere in the application window. 

The following are typical Windows menus. 

Enter 
F7 
F8 
Del 
AlttEnter 

Choosing Commands from Menus 
To open a menu, you select it. When a menu is open, you can choose an item 
from it. Menu items are most often commands. However, they can also be 
characteristics (such as bold or centered) that you assign to graphics or text, a list 
of open windows or files, or the names of other menus (cascading menus) that list 
additional commands. 
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~ To open a menu and choose an item 

1. Move the mouse pointer so that it points to the name of the menu on the menu 
bar, and then click the left mouse button. 

2. Click the menu item you want. Or drag the selection cursor down the menu 
until the menu item is highlighted, and then release the mouse button. 

Tip To move directly to a command on a menu, type the letter that is 
underlined in the item name. 

The following menu conventions are used in Windows. 

Menu convention Meaning 

Dimmed (or not visible) command You cannot use the command with your 
application at the current time. (For 
example, you may need to select another 
item before you can use this command.) 

An ellipsis ( ... ) following a command A dialog box appears when you choose 
the command. The dialog box contains 
options you need to select before the 
command can be carried out. 

A check mark (~) to the left of a command The command is in effect. When you 
remove the check mark (by choosing the 
command again), the command is no 
longer in effect. 

A key combination to the right of a command The key combination is a shortcut for 
choosing the command. You can press 
the keys listed to choose the command 
without first opening the menu. 

A triangle (~ ) to the right of a command When you choose this command, a 
cascading menu appears. 

~ To close a menu without choosing an item 

• Click the menu name, or click anywhere outside the menu. 

Using the Control Menu 
Application windows and their icons, document windows and their icons, and 
some dialog boxes have a Control menu. 

You open the Control menu for windows and dialog boxes by selecting the 
Control-menu box in the upper-left corner of the window or dialog box. You open 
the Control menu for an icon by selecting the icon. 
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The commands on the Control menu and the way you open this menu vary. The 
following section describes how to use the Control menu in different 
environments. 

Opening the Control Menu in a Windows Application 
How you open the Control menu depends on whether you are working with an 
application window, a document window, a dialog box, or an icon. 

Note In an application window that contains document windows, there may be 
more than one Control-menu box. The Control-menu box to the left of the 
application title bar controls the application. The others control the document 
windows inside the application window. 

~ To open the Control menu 

• Click the Control-menu box in the upper-left corner of the dialog box, 
application window, or document window. Or, if the application or document 
window has been reduced to an icon, click the icon. 

Do not double-click; if you do, you close the window or application or restore 
the icon to a window. 

You can also use the keyboard to open the Control menu. Use one of the 
following key combinations after the window or icon is selected. 

To open the Control menu 

In an application window 

In a document window 

In a dialog box 

Press 

ALT+SPACEBAR 

ALT+HYPHEN (-) 

ALT+SPACEBAR 

Tip When you are using the keyboard, you must first cycle through the windows 
and icons to select the one whose Control menu you want to open. Press ALT +ESC 

(to cycle through application windows and icons) or CTRL+TAB (to cycle through 
document windows and icons). 

Opening the Control Menu in an MS-DOS Application 
An MS-DOS-based application is designed to run with Microsoft MS-DOS 
rather than with Windows. You can use most MS-DOS-based applications with 
Windows. 

Windows can run in one of two modes: standard or 386 enhanced. An 
MS-DOS-based application running in standard mode does not have an 
application window; it occupies the entire screen. Before you can open its 
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Control menu, you must switch back to Windows so that the application is 
reduced to an icon. 

To find out which mode Windows is running in, choose the About command on 
the Help menu in Program Manager. 

~ To open the Control menu for an MS·DOS-based application running in a 
full screen 

1. Press ALT+ESC to switch from the application to Windows. 

The application is reduced to an icon at the bottom of the screen. 

2. Click the icon. Or press ALT +ESC to select the icon you want, and then press 
ALT+SPACEBAR to open the Control menu. 

~ To open the Control menu for an MS· DOS-based application running in a 
window in 386 enhanced mode 

• Click the Control-menu box in the upper-left corner of the application 
window. Or, if the application window has been reduced to an icon, click the 
icon. 

Do not double-click; if you do, you close the window or restore the icon to a 
window. 

Control-Menu Commands 
The following table describes the commands on the Control menu. Some 
applications do not have all these commands. 

Use 

Restore 

Move 

Size 

Minimize 

Maximize 

Close 

Switch To 

Next 

Edit 

To 

Restore the window to its former size after you have enlarged 
(maximized) it or reduced (minimized) it to an icon. 

Move the window to another position by using the keyboard. 

Change the size of the window by using the keyboard. 

Reduce the window to an icon. 

Enlarge the window to its maximum size. 

Close the window or dialog box. (From an application window, 
you can use this command to quit the application.) 

Open Task List, which enables you to switch between running 
applications and to rearrange windows and icons on your desktop. 

Switch between open document windows and icons (available for 
document windows only). 

Display a cascading menu with additional commands (available 
for MS-DOS-based applications running in 386 enhanced mode 
only). 
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Use 

Settings 

Fonts 

Always On Top 

To 

Display a dialog box that requests information about multitasking 
options (available for MS-DOS-based applications running in 
386 enhanced mode only). 

Display a dialog box that you can use to specify font information 
(available for MS-DOS-based applications running in 386 
enhanced mode only). 

Ensure that a particular window is not covered by any other 
window. 

Choosing the Edit command opens a menu with four additional commands, as 
follows. 

Use 

Mark 

Copy 

Paste 

Scroll 

Working with a Window 

To 

Select text and move it onto the Clipboard by using the keyboard. 

Copy the selected text onto the Clipboard. 

Copy text from the Clipboard to the active window. 

View information not currently visible in the window. 

When you work with applications and documents, you often have a number of 
windows open. This section explains how to move and resize windows, scroll 
through their contents, and arrange them on the desktop. 

Moving a Window 
You can move any window to a different location on your desktop. 

~ To move a window 

1. Drag the title bar of the window to the new location. 

As you move the mouse pointer, an outline of the window moves with it. 

2. Release the mouse button. 

Tip To cancel the move, press ESC before you release the mouse button. 
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Changing the Size of a Window 
You can change the size and shape of a window so you can view the contents of 
two or more windows simultaneously. 

Note Some application windows cannot be resized. 

~ To change the size of a window 

1. Select the window you want to resize. 

2. Point to a border or corner of the window. 

The pointer changes to a two-headed arrow. 

3. Drag the corner or border until the window is the size you want. 

If you drag a corner, the two sides that form the corner are sized at the same 
time. 

4. Release the mouse button. 

Tip To cancel the resizing, press ESC before you release the mouse button. 

Reducing a Window to an Icon 
You may want to reduce an application window to an icon if you want the 
application available for later use. When reduced to icons, Windows-based 
applications continue to run but their windows do not take up space on the 
desktop. You may also be able to reduce a document window to an icon. These 
icons appear in the application window, not at the bottom of the desktop. 

After a window is reduced to an icon, you can select and move the icon in the 
same way you select and move a window. 
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~ To reduce a window to an icon 

1. Select the window you want to reduce. 

2. Click the Minimize button in the upper-right corner of the window. 

Minimize 
button 

Tip When a document window is maximized, the Minimize and Maximize 
buttons are replaced by the Restore button. If you want to minimize the document 
window, you can either choose Minimize from the window's Control menu, or 
you can first use the Restore button to restore the window and then click the 
Minimize button. 

Enlarging a Window 
In most cases, you can enlarge an application window to fill a larger portion of the 
desktop or even the entire desktop. A document window can be enlarged to fill 
the application window. 

~ To enlarge a window to its maximum size 

• Click the Maximize button in the upper-right corner of the window. 

The Maximize button is replaced by the Restore button. 

Maximize 
button 

Tip You can also maximize a window by double-clicking its title bar. To restore 
an application window to its previous size, double-click the title bar again. To 
restore a document window, click the Restore button in the upper-right corner of 
the window. 
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A maximized document window shares the application window's title bar. The 
Minimize and Maximize buttons affect the application window, not any windows 
inside it. Only the Restore button affects the document window alone. 

Tip When two or more windows are open inside an application window and you 
enlarge one of them, all the others are covered up by the enlarged window. If you 
want the other windows displayed, choose the Restore button to return the 
enlarged window to its previous size, or choose Minimize from the document 
window's Control menu to reduce the window to an icon. 

Restoring an Icon or Window 
You can restore an icon or window to its original size. 

~ To restore an icon to a window 

• Double-click the icon. 

~ To restore an enlarged window to its previous size 

• Click the Restore button in the upper-right corner of the window. 

Moving an Icon 

Restore 
button 

You can move an application icon anywhere on your desktop except into another 
application window. (An application icon may appear to be in another application 
window, but if you close the window, the icon remains on the desktop.) You can 
move a document icon to a different location in its application window but not 
outside the application window. 

~ To move an icon 

1. Drag the icon to a new location. The mouse pointer changes to an outline of 
the icon, which moves as you move the mouse. 

2. Release the mouse button. 

Tip To cancel the move, press ESC before you release the mouse button. 
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Using Scroll Bars 
Some windows and dialog boxes have scroll bars you can use to view information 
that does not fit inside the window. When you can view all the contents of a 
window or dialog box without scrolling, scroll bars may be absent or dimmed to 
indicate they cannot be used. 

Scroll arrow 
Scroll box 

Paintbrush Terminal Notepad 

eJ [ill) II • ~ t. I Scroll bar 
Cardfile Calendar Calculator Clock Object 

Packager 

~ To scroll through information displayed in a window or dialog box 

• Drag the scroll box to scroll through all the information in a list or document. 

You can also use the following techniques to scroll. 

To scroll 

One line up or down 

One screen 

Continuously 

To any position 

Do this 

Click the up or down scroll arrow. 

Click the scroll bar above or below the scroll box on 
vertical scroll bars to scroll vertically. Click to the left 
or right of the scroll box on the horizontal scroll bar to 
scroll horizontally. 

Point to one of the scroll arrows, and press and hold 
down the mouse button until the information comes into 
view. 

Drag the scroll box in the scroll bar to the position you 
want. The section of the document or list that moves into 
view depends on where you position the scroll box. For 
example, if you position the scroll box halfway down the 
vertical scroll bar, the text halfway through the document 
or list appears. 

For information about using the keyboard to scroll, see Appendix A, "Keyboard 
Shortcuts." 
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Closing a Window 
One way to quit an application is to close the application window. Similarly, you 
can close a document by closing the document window. If you made changes to 
your document since you last saved it, a message prompts you to save the 
document before closing the window. 

~ To close a window, use one of the following methods 

• From the File menu, choose Exit. 

• From the Control menu, choose Close. 

• Double-click the Control-menu box. 

• Press ALT+F4. 

Using a Dialog Box 
A dialog box appears when you need to supply additional information to complete 
a task. 

An ellipsis ( ... ) after a menu command indicates that a dialog box will appear 
when you choose that command. For example, if you choose the Open command 
on the File menu in Notepad, the Open dialog box appears. In this dialog box, you 
specify the name of the file you want to open. 

mtgnotes.lxt 
review. txt 
statrepuxt 

-
c:\memos 

lC7 c:\ 
~memos 

List Files of !vpe: D rixes: 

L-ITe_xt_F_ile--,s I_s. T_XT-'-I_ ....... I_" . I Iii! c: chris II 

Most dialog boxes contain options you can select. Mer you specify options, you 
can choose a command button to carry out the command. Some dialog boxes may 
display information, warnings, or messages indicating why a requested task 
cannot be accomplished. 

If a dialog box has a title bar, you can move the dialog box to another location on 
your desktop. Moving a dialog box is just like moving a window-you drag the 
title bar or use the Move command on the Control menu. For more information, 
see "Moving a Window" earlier in this chapter. 
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Moving Within a Dialog Box 
Often you need to move within a dialog box to select one or more options. The 
currently selected option is marked by the selection cursor, which appears as a 
dotted rectangle, a highlight, or both. 

~ To move within a dialog box 

• Click the option or area you want to move to. Or press TAB to move clockwise 
or SHIFT + TAB to move counterclockwise through the options or areas. 

Tip If the option, box, or button has an underlined letter in its name, you can 
choose that item by pressing and holding down ALT while typing the underlined 
letter. 

Types of Options 
Several types of dialog box options are described in the following sections. 

Command Buttons 
You choose a command button to initiate an action, such as carrying out or 
canceling a command. The OK, Cancel, and Help buttons are common command 
buttons. They are often located along the bottom or on the right side of the dialog 
box. 

The selection cursor indicates 
the currently selected option. 

This button carries 
out the command. 

Memory: 

Orientation---"'" 

~ 
@ f.ortrait c· 111 .l"l. _opres: L!....--.J 
o landscape 

Carlridges (max: 2)-------, 

HP: ProColiection 
HP: WordPerfect 
HP: Global Text 
HP: Great Start 

~!!!t This button closes 
~ the dialog box 

without carrying 
out the command. 

A button containing an 
ellipsis ( ... ) opens 
another dialog box. 
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Some dialog boxes contain a command button marked with greater-than signs 
(»). This button expands the active dialog box. 

Unavailable buttons appear dimmed. The currently selected button has a border 
that is darker than that of other buttons. You can choose the selected button 
simply by pressing ENTER. 

~ To choose a command button 

• Click the command button. Or press TAB until the button you want is selected, 
and then press ENTER. 

Text Boxes 
You type information into a text box. When you move to an empty text box, an 
insertion point (a flashing vertical bar) appears. The text you type starts at the 
insertion point. 

Start Erom: L-Ic:_\w_in_do_w_s _______ ---1 

IZl S~arch All Subdirectories 

If the box you move to contains text, and the text is highlighted, any text you 
type will replace it. You can also delete the existing text by pressing DEL or 
BACKSPACE. For information about editing text, see "Working with Text" in 
Chapter 5, "Application Basics." 

~ To select text in a text box 

• Drag the pointer across the text, or double-click a word to select one word at a 
time. Or press and hold down ALT while pressing an arrow key. 

For more information about selection methods, see "Selecting Text" in Chapter 5, 
"Application Basics." 
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List boxes present 
available choices. 

List Boxes 
A list box displays a list of choices. If there are more choices than can fit in the 
box, scroll bars are provided so you can move quickly through the list. For 
information about scrolling, see "Using Scroll Bars" earlier in this chapter. 

Installed frinters: ---------, 
!.I •• 

QMS-PS 810 on lPT2: 

~ !,tse Print Manager 

.list 01 Printers: 

Generic I Text Only 
Agla 9000 Series PS 
Agla Compugraphic 400PS 
Agla Compugraphic Genies 
Apple LaserWriter 
Apple laserWriter II NT 
A Ie laserWriter II NTX 

Usually, you can select only one item in a list box. In some cases, you can select 
more than one item, as in the Disconnect Drive dialog box in File Manager. 

For more information about selecting items in a list box, see "Selecting Items" 
earlier in this chapter. 

Drop-Down List Boxes 
A drop-down list box appears initially as a rectangular box containing the current 
selection. When you select the down arrow in the square box at the right, a list of 
available choices appears. If there are more items than can fit in the box, scroll 
bars are provided. 



M.easurement: 

Lisl ~eparalor: D 

Chapter 4 Windows Basics 71 

A drop-down list box opens 
to show available choices. 

Q.ale Formal-------',...Cyrrency Formal 

5114192 

[lime Formal 
1:2,(:23 AM 

$1.22 1:lIJt[¥J 
($1.22) : , ..• ~,~ 

~ To open a drop-down list box and select an item by using a mouse 

1. Click the arrow at the right of the box to open the box. 

2. Click the up or down scroll arrow. Or drag the scroll box until the item you 
want to select is displayed. 

3. Click the item. 

~ To select an item from a drop-down list by using the keyboard 

Option buttons 
present mutually 

exclusive options. 

• Press the UP ARROW or DOWN ARROW key to move through the available 
options until you reach the one you want. 

Option Buttons 
Option buttons represent a group of mutually exclusive options. You can select 
only one option at a time. If you already have one option selected, your current 
selection replaces it. The selected option button contains a black dot. Names of 
unavailable options appear dimmed. 

This option is selected. 
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~ To seleci an option button 

Check boxes present 
nonexclusive options. 

• Click the option button, or press the SPACEBAR. 

Tip If the option name has an underlined letter, you can select the option button 
by pressing and holding down ALT while typing the underlined letter. 

Check Boxes 
A check box presents nonexclusive options; you can select as many check-box 
options as needed. When a check box is selected, it contains an X. Names of 
unavailable options appear dimmed. 

These options are selected. 

~ To select or clear a check box 

• Click the check box, or press the SPACEBAR. 

Tip If the option name has an underlined letter, you can select or clear the check 
box by pressing and holding down ALT while typing the underlined letter. 

Closing a Dialog Box 
When you choose a command button, the dialog box closes and the command is 
carried out. You can also close the dialog box to cancel a command. 

~ To close a dialog box without carrying out a command 

• Choose the Cancel button, double-click the Control-menu box, or press ESC. 

Note You can also choose the Close command on the Control menu (or press 
ALT+F4) to close a dialog box. If a dialog box does not have a Control menu, 
choose the appropriate button. 



73 

CHAPTER 5 

Application Basics 

A major advantage of using Windows is that you can run two or more 
applications at the same time. For example, you can have a spreadsheet 
calculating complex formulas while you are using a word-processing application 
to prepare an annual report. At the same time, your computer can be receiving the 
latest information about industry sales trends that you can use in the introduction 
of your report. 

Types of Applications 
Various types of applications run with Windows. Some are specifically designed 
to run with Windows. Others are designed to run with Microsoft MS-DOS rather 
than Windows. The following table lists the types of applications you can run. 

Type of application 

Windows-based 

Older Windows-based 

MS-DOS-based 

Description 

Windows-based applications require Windows version 
3.0 or later in order to run. These programs are 
generally highly graphical and designed to share your 
computer's memory among applications as efficiently 
as possible. 

Some Windows-based applications were designed for 
previous versions of Windows and do not work 
correctly with Windows version 3.0 and later. If you 
have an older Windows-based application, it is best to 
obtain an updated version of it. 

MS-DOS-based applications are designed to run with 
the MS-DOS operating system but not specifically 
with Windows. They do not take advantage of the 
Windows graphical interface, they may not have 
menus or dialog boxes, and they may not make use of 
the mouse. However, you can still use most of these 
applications with Windows. For more information, see 
Chapter 11, "MS-DOS Applications." 



74 Microsoft Windows User's Guide 

Type of application 

Memory-resident program 

Description 

Memory-resident programs are MS-DOS-based 
applications; however, they run differently than other 
applications. When started from MS-DOS, a memory
resident program is loaded into memory and is 
available even when another application is running. A 
common type of memory-resident program is a pop-up 
program, which is loaded into memory but is not 
visible until you type a certain key combination. 
Memory-resident programs are sometimes referred to 
as terminate-and-stay-resident programs, or TSRs. For 
more information, see Chapter 11, "MS-DOS 
Applications." 

Organizing Your Applications into Groups 
Windows has several predefined groups of applications, described in the 
following table. You can control how the groups are arranged on your desktop, 
and you can define and add new groups. 

Group 

Main 

Applications 

Accessories 

Games 

StartUp 

Creating and Deleting a Group 

Contains 

Windows system applications: File Manager, Control 
Panel, Print Manager, Clipboard Viewer, MS-DOS 
Prompt, Windows Setup, and PIF Editor. This group 
also contains an item named Read Me that includes 
information you should have before you start working 
with Windows. 

Applications found on your hard disk during Setup. If, 
during Setup, you chose the Custom Setup option and 
chose not to have Windows set up applications from 
your hard disk, your Program Manager window will 
not contain an Applications group. 

Windows-based applications for word processing, 
drawing, and communications. 

Games included with Windows. You can use these 
games to practice basic Windows skills. 

Applications that start when you start Windows. You 
can add any application to this group. The group is 
empty until you add applications to it. 

You can add any number of groups to Program Manager to organize your 
applications and documents. If you no longer need a group, you can delete it. You 
do not have to delete the contents of the group before you delete it. 
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~ To create a new group 

1. From the File menu in Program Manager, choose New. 

2. Select the Program Group option button, and then choose the OK button. 

3. In the Program Group Properties dialog box, type a description for the group 
you want to create, and then choose the OK button. 

The Group File box contains information about the contents of the group. You 
can leave this box blank, because Program Manager automatically ~ssigns a 
name to this file. 

Mter creating a group, you can add program items (icons that represent 
applications) to it. 

~ To delete a group 

1. Select the group icon for the group you want to delete. 

2. From the File menu, choose Delete. Or press DEL. 

Creating a Program Item 
When you create a program item for an application, you specify the program 
item's properties, such as a description (label) for the item, a working directory 
where any files the application creates are stored, and the icon that represents the 
application. You can change these properties at any time. For information about 
changing properties, see Help for Program Manager. 

A group can contain a maximum of 40 program items. 

You can create a program item by using any of the following methods: 

• Choose the New command from the File menu in Program Manager to create a 
program item for an application or document. 

• Drag files from File Manager to a Program Manager group. 

• Run Windows Setup to create program items for one or more applications. 

The following sections describe these methods in detail. 



76 Microsoft Windows User's Guide 

Using the New Command to Create a Program Item 
You can create a program item for an application or document. When you choose 
a program item for a document, the application opens, displaying the document. 

~ To create a program item for an application 

1. Open the group that you want to add an item to, and then choose New from the 
File menu in Program Manager. 

2. Select the Program Item option button, and then choose the OK button. 

Tip You can quickly open the Program Item Properties dialog box by pressing 
and holding down ALT while double-clicking in a blank area of the group 
window . 

.!!.escription: 

.!;.ommand line: 

~orking Directory: 

ihortcut Key: L-INo_n_e _____ ----l 

D Run Minimized 

3. In the Program Item Properties dialog box, type a description for the 
application. The description becomes the label that appears under the icon in 
the group window. If you leave this box blank, Program Manager labels the 
icon for you. 

4. In the Command Line box, type the name of the program file, including the 
path (if there is one) and extension. 

For example, to add Microsoft Excel, located in a directory named C:\EXCEL, 
type c: \excel\exceI.exe. 

If you don't know the name of the program file, choose the Browse button in 
the Program Item Properties dialog box to display a list of files and directories. 
Select the appropriate filename from the list, and then choose the OK button. 
(You can use the directory listing to change to a different directory.) 
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c:\windows 

fj. r=~-c-:-:\------'_=~ I~liliilliliml 

t :~s~::s l)itiUllp:(ml 
pifedit.eHe 
printman.eHe 
progman.exe 
recorder.exe 

list Files of Ivpe: D riyes: 

IL-Pr-=og=-ra_ms ___ -I4II ... ··· ' IIi:EiI c: chris I!I 

5. In the Working Directory box, type the name of the directory where the 
program files for this application are located and where new files will be 
stored. 

6. To reserve a shortcut key for use with the application, type the key 
combination in the Shortcut Key box. You use a shortcut key to switch to the 
application when it is running or to start an application when the Program 
Manager window is active. 

Valid shortcut-key sequences are: 

• CTRL+ALT +character 

• CTRL+SHIFT +character 

• SHIFT +ALT +character 

• CTRL+SHIFT +AL T +character 

Character can be any letter, number, or special character. When you type only 
a character in the Shortcut Key box, Program Manager adds CTRL+ALT in front 
of it. To specify a different control-key sequence, you must type the sequence. 

Note You can reserve shortcut keys for an MS-DOS-based application by 
using Program Manager or PIF Editor. Shortcut-key settings made in Program 
Manager override settings made in PIF Editor. 

7. If you want this application to be reduced to an icon when it starts, select the 
Run Minimized check box. 

8. Choose the Change Icon button to see the default icon for this program item. 
Scroll through the list, select the icon you want to use, and then choose 
the OK button. 

9. Choose the OK button in the Program Item Properties dialog box. The new 
program item appears in the group. 
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~ To create a program item for a document 

1. Follow the first four steps in the procedure describing how to create a program 
item for an application, in the preceding section. 

2. After the program filename in the Command Line box, press the SPACEBAR, 

and type the filename of the document. Include the path required to locate the 
document. 

For example, to specify a spreadsheet named 93BUDGETXLS, located in the 
C:\ADMIN\FY93 directory, as the document to be opened when you start 
Microsoft Excel, you would type the following: 

c:\excel\excel.exe c:\admin\fy93\93budget.xls 

Note If the document is in the same directory as the application, you do not 
have to repeat the path when you type the filename of the document. If you 
have specified a working directory that is different from the application 
directory, you must specify a path with the document filename. 

3. Complete the other areas in the dialog box, and then choose the OK button. 

Dragging Files from File Manager to Create a Program Item 
You can also use File Manager to create program items by moving applications 
and associated documents from File Manager directories to Program Manager 
group windows. You can do this even if a group window is minimized. The 
following procedure requires a mouse. 

~ To create a program item by using File Manager 

1. Locate the Program Manager group where you want to create a new program 
item. The destination group can be either a window or an icon. 

2. Open File Manager and select the program or document file that you want to 
add as a program item. (You can also select multiple items and add them to a 
group at the same time.) 

3. If necessary, reposition the File Manager window so that you can see both File 
Manager and the Program Manager group icon or window where you want to 
place the new program item. 

Tip If no other application windows are open except for File Manager and 
Program Manager, you can press CTRL+ESC to open Task List, and then choose 
the Tile button to arrange the File Manager and Program Manager windows. 

4. Drag the file icon from File Manager to Program Manager, and drop it in the 
group window or onto the group icon. 

As you drag the file icon, the mouse pointer turns into a replica of a file icon. 
If you select multiple items, you can drag them all at the same time. 
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Running Setup to Create Program Items 
By using the Windows Setup icon, you can create a program item for one or more 
applications already on your hard disk. Instead of adding each application to a 
group separately, you can have Windows Setup search your computer's drive(s) 
and set up multiple applications at the same time. Windows Setup creates an 
Applications group, and each application found appears as an icon in that group. 

Caution Before running a setup program for any other Microsoft application that 
is not yet on your hard disk, you must quit Windows Setup. Otherwise, the 
application's setup program may fail. 

Note If Setup finds an MS-DOS-based application on your hard disk, it uses a 
program information file (PIF) to set up the application. Setup will set up only 
those MS-DOS-based applications that have a PIF. If Setup detects a naming 
conflict or multiple PIFs for one application, it displays a dialog box prompting 
you to specify the name of the application or PIF you want to use. For more 
information, see Chapter 11, "MS-DOS Applications." 

~ To have Setup search for and set up applications 

1. In the Main group, choose the Windows Setup icon. 

2. From the Options menu, choose Set Up Applications. 

3. Select the Search For Applications option button, and then choose the 
OK button. Setup displays a dialog box where you specify that Setup search 
for applications on one or more specific drives, and/or the current path. 

4. Click the search options you want, and then choose the Search Now button. 
When the search is completed, Setup displays a list of the applications found . 

Applications found on hard disk(s): 

Learning Windows 1.0 
Microsoft Help 3.5 

Quick Troubleshooter 
IWINCHT 

Microsoft Word 
C:\WINWORD\WINWORD.EXE 

.£et up for use with Windows: 

I 

In the Applications Found On Hard Disk(s) box, Setup lists the names of all 
the applications it found. (If you cancel the search, Setup lists the names of 
applications found before you canceled.) 
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5. Click each application you want. (You can cancel the selection by clicking it 
again.) 

6. Mter you select all the applications you want, choose the Add button to move 
them to the Set Up For Use With Windows box. To add all the listed 
applications, choose the Add All button. 

To delete an application after you add it, select the application name, and then 
choose the Remove button. 

7. Mter you have selected the applications you want to set up, choose the 
OK button. 

Changing a Program-Item Icon 
If you don't like the icon assigned to a program item, you can choose one of the 
many icons provided with Program Manager. 

~ To change the program-item icon 

1. Select the program-item icon that you want to change. 

2. Choose Properties from the File menu, and then choose Change Icon in the 
Program Item Properties dialog box. 

3. In the File Name box, type the path for either the PROGMAN.EXE file or the 
MORICONS.DLL file (in your Windows directory). 

You can now select from these icons by scrolling through the Current 
Icon box. 

4. Mter you select the new icon, choose the OK button. 

5. Choose the OK button in the Program Item Properties dialog box. The icon 
you selected appears. 

Starti ng an Application 
With Windows, you can start an application in a number of ways: 

• Choose a program-item icon from a group in Program Manager. 

• Choose a program file or a program information file (PIF) from a directory 
window in File Manager. (For information about starting an application from 
its PIF, see Help for PIF Editor.) 

• Choose the Run command from the File menu in Program Manager or File 
Manager. 

• Use MS-DOS Prompt to start MS-DOS-based applications. 



Chapter 5 Application Basics 81 

Note In the following procedures, remember that when using a mouse, you click 
to choose menu commands and command buttons, and you double-click to choose 
icons. 

Starting an Application from Program Manager 
The easiest way to start an application in a group is to choose the program-item 
icon for the application from the group window. If a document is associated with 
this program-item icon, the application opens, displaying the document. 

~ To start an application from a group 

1. If necessary, double-click the group icon to open the group window that 
contains the application you want to run. 

2. Double-click the icon for the application. 

Tip You can choose the Minimize On Use command from the Options menu in 
Program Manager to reduce Program Manager to an icon whenever you start an 
application. 

Starting an Application When You Start Windows 
When you install Windows by using the Setup program, Windows creates a 
StartUp group. Each application in this group starts when you start Windows. 

For example, if you want File Manager to start whenever you start Windows, 
copy the File Manager icon from the Main group to the StartUp group. (For more 
information, see Chapter 4, "Windows Basics.") 

You can also have Windows automatically reduce an application to an icon in the 
StartUp group. To do this, select the Run Minimized check box when you create 
the program item, or choose the Properties command on the File menu. 

Returning to Program Manager from an Application 
When you are working with an application or document and you want to start a 
different application, you can do so by returning to Program Manager. 

~ To return to Program Manager 

• Click the Program Manager window. Or double-click anywhere on the 
Windows desktop or press CTRL+ESC to display Task List, and then choose 
Program Manager from the list of running applications. 
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Tip Press and hold down ALT, and then press TAB repeatedly. As you continue to 
press TAB, the title of each running application is displayed. When "Program 
Manager" appears in the center of your screen, release ALT. The Program 
Manager window appears in the foreground. 

Starting an Application by Using File Manager 
You can start an application from File Manager by choosing the application 
program file from a directory window. A program file has a .COM, .EXE, .PIF, or 
.BAT filename extension. If you start an application that can run in a window, the 
window appears in front of the File Manager window. If the application is a full
screen application, such as MS-DOS Prompt, it replaces the Windows desktop on 
your screen. 

~ To start an application by using File Manager 

1. In the Main group, double-click the File Manager icon. 

2. Click the drive icon for the drive you want. 

3. Click the directory icon for the directory you want. 

4. Double-click the name of the application's program file. 

Tip You can choose the Minimize On Use command from the Options menu in 
File Manager to reduce File Manager to an icon whenever you start an 
application. 

Starting an Application by Using the Run Command 
You can use the Run command to start an application that you run only 
occasionally or have not yet added to a group. You can also specify that a 
particular document open when you start the application. 

~ To start an application by using the Run command 

1. From the File menu in Program Manager or File Manager, choose Run. 
The Run dialog box appears . 

CUI/enl Direclory: C:\W'INDOW'S 

I;.ommand line: 

o Run Minimized 

... -1-
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2. In the Command Line box, type the path and the name of the program file, 
including the extension, if there is one. (In File Manager, you do not need to 
type the path if the program file is in the current directory. In Program 
Manager, you can choose the Browse button to display a list of program files 
to select from.) 

For example, if you want to start Aldus PageMaker and it is in the directory 
C:\PAGEMKR, you would type the following in the Command Line box: 

c: \pagemkr\pm.exe 

In most cases, you can open a document at the same time you start an 
application by typing a space and the document filename (including the path 
where the document is located) after the program filename. 

For example, to open a document named NEWSLTR.PM3 in the AUGUST 
subdirectory of C:\P AGEMKR, you would type the following: 

c: \pagemkr\pm.exe c: \pagemkr\august\newsltr.pm3 

3. If you want the application to be reduced to an icon as soon as it starts, select 
the Run Minimized check box. 

4. Choose the OK button or press ENTER. 

Starting an Application by Using the MS-DOS Command Prompt 
Generally, you can set up your MS-DOS-based applications to run from Program 
Manager. (For more information, see Chapter 11, "MS-DOS Applications.") For 
MS-DOS-based applications that aren't set up, such as memory-resident 
programs, you can start them by using MS-DOS commands. 

MS-DOS Prompt appears as a program item in the Main group in Program 
Manager. You can use it to gain access to the MS-DOS command prompt without 
leaving Windows. 

• To start an application by using MS·DOS Prompt 

1. In Program Manager, choose the Main group icon. 

2. In the Main group, choose the MS-DOS Prompt icon. 

3. When the command prompt appears, type the necessary MS-DOS commands 
to start your MS-DOS-based application. 

1386' • To run MS·DOS Prompt in a window (in 386 enhanced mode only) 

• After MS-DOS Prompt is running (follow steps 1 and 2 from the previous 
procedure), press ALT+ENTER. MS-DOS Prompt appears in a window so you 
can use the commands on the Control menu. 

• To return to a full screen, press ALT+ENTER again. 
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Tip If you want MS-DOS Prompt to always start in a window, you can change 
the DOSPRMPT.PIF file located in the Windows directory. Using PIF Editor, 
open the file and select the Windowed option under Display Usage. Then save the 
file. Running MS-DOS Prompt in a window uses more memory. 

~ To quit MS·DOS Prompt 

1. At the command prompt, type the following: 

exit 

2. Press ENTER. 

You can also leave MS-DOS running and switch to Windows to work with 
applications. For more information, see "Switching Between Applications and 
Documents" later in this chapter. 

Caution Some MS-DOS commands do not work properly when Windows is 
running. For example, when you use the chkdsk command with the If option, 
chkdsk tries to modify part of the operating system that cannot be modified while 
Windows is running. You should also avoid using the undelete command; the 
chcp (change codepage) command; and disk-compaction or optimization 
programs, such as the Norton SD.EXE program, when Windows is running. If you 
need to run such programs or such commands, quit Windows first. 

Running Two or More Applications 
With Windows, you can start an application and then keep it running while you 
start one or more additional applications. 

When applications run at the same time, they share computer resources. The way 
they share resources depends on the type of computer you have, the type and 
amount of available memory, whether the applications are Windows-based or 
MS-DOS-based, and which mode Windows is running in. 

Note When Windows is running in 386 enhanced mode rather than in standard 
mode, more applications can run simultaneously. To find out which mode 
Windows is running in, choose the About command from the Help menu in 
Program Manager. 
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Switching Between Applications and Documents 
When you have more than one application window open at once, the window you 
are currently working with is the active window. The active window always 
appears in the foreground, so it might overlap or completely obscure other 
windows. To work with another application, you must select its window to make 
it active. 

~ To switch to an application, use one of the following methods 

• If the application is visible, click anywhere in the application window. If the 
application is running as an icon, double-click the icon. 

• To return to the application you last used, press ALT+TAB. 

• To switch quickly to another application, press and hold down ALT, and then 
press TAB repeatedly. As you continue to press TAB, the title of each running 
application appears. 

When the title of the application you want appears, release ALT. The 
application then appears in the foreground. 

• Press ALT+ESC repeatedly to cycle through open application windows and 
application icons until you reach the application you want. 

• Display Task List, and use it to switch to the application you want. For more 
information, see the following section, "Using Task List to Switch Between 
Applications." 

Tip If you use an application frequently, you may want to create a shortcut key to 
use when switching to it. You can define a shortcut key in the Program Item 
Properties dialog box in Program Manager. For more information, see "Using the 
New Command to Create a Program Item" earlier in this chapter. 

USing Task List to Switch Between Applications 
Task List is a window that displays a list of all the applications you are currently 
running. You can use Task List to switch to another application. 
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~ To switch to an application by using Task List 

1. Double-click anywhere on the desktop (that is, not inside an open window) to 
display Task List, or choose Switch To from the Control menu in Program 
Manager, or press CTRL+ESC. 

Control Panel 
Sound Recorder - (Untitled) 
Notepad - README. TXT 
Calculator 
Object Packager - Package 

2. In Task List, double-click the name of the application to switch to. Or select 
the name of the application you want, and then choose the Switch To button. 

~ To close Task List 

• Press ESC, or choose the Cancel button. 

For more information about displaying and using Task List, see "Arranging 
Application Windows and Icons" later in this chapter. 

Switching Between Documents 
With some applications, you can open more than one document at a time, each in 
its own window. If you have more than one document window open, you can 
easily switch between them. 

For example, you can switch between directory windows in File Manager. 

~ To switch to another document window in an application 

• Click anywhere in the document window you want to switch to. Or open the 
application's Window menu, and then choose the document you want. 

Tip You can also press CTRL+P6 or CTRL+TAB repeatedly until the document 
window you want is selected. (This is a shortcut for using the Next command on 
the Control menu.) 
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Arranging Application Windows and Icons 
You can use the Cascade and Tile buttons in Task List to rearrange application 
windows so that all running applications are visible on your desktop. The Cascade 
command causes the windows to overlap so that each title bar is visible. The Tile 
command arranges the open windows in smaller sizes to fit next to each other on 
the desktop. 

~ To arrange application windows on your desktop 

1. Double-click anywhere on the desktop to open Task List. Or press CTRL+ESC. 

2. Choose the Cascade or Tile button. 

If you have a number of applications running as icons and they are scattered 
across your desktop, follow the next procedure to rearrange them evenly. 

~ To rearrange application icons 

1. Double-click anywhere on the desktop to open Task List. Or press CTRL+ESC. 

2. Choose the Arrange Icons button. The icons are arranged along the lower edge 
of the desktop. 

Dragging Files to Perform Tasks 
When using File Manager, Program Manager, Print Manager, and certain other 
Windows-based applications, you can perform some essential tasks by dragging 
File Manager files from one place to another with the mouse. This is known as 
dragging and dropping. 

For example, you can print a file on your default printer by dragging a File 
Manager file onto the Print Manager icon (the minimized Print Manager window) 
and then releasing the mouse button. Or you can set up an application to run with 
Windows by dragging a File Manager file onto a group window or icon in 
Program Manager. 

Note Dragging File Manager files can only be done by using a mouse. There is 
no keyboard equivalent. 

~ To drag and drop a file 

1. In the Main group, double-click the File Manager icon to start File Manager. 

2. Select the drive and directory containing the file you want to drag. 

3. Make sure the application that you want to drag the file to is running either as 
a window or an icon. 
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4. Arrange the windows on your screen so that both the File Manager file you 
want to drag and the application window or icon you want to move the file 
onto are visible. 

5. Select the file you want. 

6. Press and hold down the left mouse button, drag the file onto the application 
window or icon, and then release the mouse button. 

You can perform the following tasks by dragging File Manager files. 

To 

Create a Program Manager group item 

Open a file in an application 

Move or copy a file to a different drive 

Move or copy a file to a File Manager 
directory 

Print a file on your default printer with the 
default settings 

Drag the file onto 

A Program Manager group window or 
icon. 

The application's icon or title bar. 

A File Manager drive icon. 

A File Manager directory window or 
directory icon. 

The minimized Print Manager window 
(Print Manager running as an icon). 

Note The ability to print and open files by dragging and dropping icons depends 
on the application. Some applications may not support this feature. Check your 
application's documentation to find out whether dragging and dropping are 
supported. 

Receiving a Message from an Inactive Application 
When an inactive application issues a status or error message, the application title 
bar or icon flashes, and you may hear a beep. 

~ To receive a status or error message 

• Select the application window or icon. The message appears. 

Quitting an Application 
There are various ways to quit an application. If you are working on a document 
and you haven't saved your changes, you are prompted to save them. 

~ To quit a Windows-based application, use one of the following methods 

• From the application's File menu, choose Exit. 

• From the Control menu, choose Close. 
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• Press ALT +F4. 

• Double-click the Control-menu box. 

~ To quit an MS-DOS-based application 

• Choose the application's exit or quit command. If you are using MS-DOS 
Prompt, type exit at the command prompt. The application closes, and you 
return to Windows. 

When you quit an MS-DOS-based application that is running in a full screen, 
you usually return to the Windows desktop just as you left it. If you return to an 
MS-DOS prompt, type exit. 

Opening and Saving Documents 
This section explains some basic tasks, such as opening, editing, and saving files, 
that are common to many Windows-based applications. 

Note The procedures in this section apply to the applications supplied with 
Windows. Other applications may work differently. 

Opening Files 
Choosing the Open command from an application's File menu opens a dialog box 
that is often the same regardless of which application you are using. This dialog 
box is designed to save you time because you can select the drive, directory, file, 
and file type from the ones displayed in the list boxes. 

~ To open a file 

1. From the application's File menu, choose Open. The Open dialog box appears. 

I home. txt 

mtgnotes.txt 
review. txt 
statrepUxt 

c:\memos 

1'27 c:\ 
~memos 

list Files of llpe: Dr~es: 

II-T e_xt_F_ile-,s ('--z. T_x-.:.Tl_-,II_I IIiiiiilI c: chris II 
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Saving Files 

2. If the file you want to open is on a different drive, select the drive you want 
from the Drives list. 

3. In the Directories box, choose the directory you want to open. (Double-click 
the directory.) 

Windows displays the names of all files in that directory that are the type 
selected in the List Files Of Type box. To display a different type of file, 
select the type you want from the List Files Of Type box. 

4. Type the filename, and then choose the OK button. Or double-click the 
filename in the File Name box. 

In many applications, the File menu contains two commands for saving files: Save 
and Save As. You use the Save command to save changes to an existing file. You 
use the Save As command to name and save a new file or to save an existing file 
under a new name. For example, you may want to make changes to a file, yet also 
keep the original file without the changes. By using the Save As command, you 
can save a copy of the original file with a different name. 

~ To save an existing file 

• From the application's File menu, choose Save. 

~ To save a new file or an existing file under a new name 

1. From the application's File menu, choose Save As. 

2. If you want to save the file on a different drive, select the drive you want from 
the Drives list. 

3. In the Directories box, choose the directory in which you want to save the file. 

4. In the File Name box, type a name for the file. 

If you don't specify a filename extension, the application may add one. For 
example, Notepad adds the extension .TXT to a filename. 

The default extension is shown in the Save File As Type box. To use a 
different extension, select an extension from the Save File As Type list, or 
type an extension. 

5. Choose the OK button. 
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Working with Text 
With many applications, you type text from time to time. The procedures for 
typing text, correcting errors, and editing text are the same for most Windows
based applications. 

Typing Text 
When you start typing text, an insertion point marks the place where the text 
appears. 

~ To type text in a new document 

• Begin typing the text. Press ENTER to move the insertion point to the next line. 
Press the SPACEBAR to move the insertion point one space to the right. 

~ To type text in an existing document 

• Move the mouse pointer to where you want text to appear, click once, and then 
start typing. Or use the arrow keys to move the insertion point to where you 
want text to appear. 

Note To create a blank line and move the insertion point along that line, use 
ENTER and the SPACEBAR. For example, to type a report title 10 lines from the top 
of a new page and 20 spaces from the left margin, press ENTER 10 times, and then 
press the SPACEBAR 20 times before you type the title. 

Moving Within Text 
You can easily move the insertion point wherever you want within text. 

To move to the Press 

Next line DOWN ARROW 

Previous line UPARROW 

End of the line END 

Beginning of the line HOME 

Next screen PAGE DOWN 

Previous screen PAGE UP 

Next word CTRL+RIGHT ARROW 

Previous word CTRL+LEFf ARROW 

End of the document CTRL+END 

Beginning of the document CTRL+HOME 
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Correcting Typing Mistakes 
If you make a mistake while typing, you can correct it by using one of the 
methods in the following table. Or, if you need to change more than a few 
characters, you can select the text and edit it. 

To Do this 

Delete the character (or selected text) to the Press BACKSPACE. 
left of the insertion point 

Delete the character (or selected text) to the Press DEL. 
right of the insertion point 

Insert characters at the insertion point Type the characters. 

Selecting Text 
You can make changes to blocks of text by selecting (highlighting) the text you 
want to change, and then choosing one of the commands from the application's 
Edit menu. 

~ To select text 

1. Point to the first character you want to select. 

2. Press and hold down the mouse button, and then drag the insertion point to the 
last character you want to select. 

3. Release the mouse button. 

Tip With some applications, you can select a single word by double-clicking it. 
Or you can select all the text in your file by choosing Select All from the Edit 
menu. 

~ To cancel the selection 

• Click anywhere in the document. 

The following table shows ways to select text by using the keyboard. Not all 
applications offer all options. In most cases, you can select an area of text by 
pressing and holding down SHIFT while you use standard keystrokes. For 
information about valid key combinations, see your application's documentation. 



To extend the selection to the 

Next word 

Previous word 

Next line 

Previous line 

End of the line 

Beginning of the line 

Next screen 

Previous screen 

End of the document 

Beginning of the document 

Editing Selected Text 

Chapter 5 Application Basics 93 

Press 

CfRL+SHIFf +RIGHT ARROW 

CfRL+SHIFf +LEFf ARROW 

SHIff +DOWN ARROW 

SHIff +UP ARROW 

SHIFf+END 

SHIFf+HOME 

SHIff +PAGE DOWN 

SHIFf+PAGE UP 

CfRL+SHIFf +END 

CfRL+SHIFf +HOME 

The following table describes ways you can edit selected text. 

To 

Delete the selected text and place it 
onto the Clipboard 

Make a copy of the selected text and 
place it onto the Clipboard 

Replace the text with new text 

Delete the text (not place it onto the 
Clipboard) 

Cancel the previous editing 
operation 

Paste text from the Clipboard into 
the active window 

Do this 

From the Edit menu, choose Cut. 

From the Edit menu, choose Copy. 

Type the new text. 

Press DEL or BACKSPACE. 

From the Edit menu, choose Undo. 

Place the insertion point where you want the text to 
appear, and then choose Paste from the Edit menu. 

Transferring Information Between Applications by 
Using the Clipboard 

Information you cut or copy onto the Clipboard remains there until you clear it or 
cut or copy another piece of information onto it, or until you quit Windows. 
Because the information remains on the Clipboard, you can paste the information 
into a document as often as you like. 
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Cutting or Copying Information onto the Clipboard 
The method you use to transfer information onto the Clipboard depends on 
whether you are using a Windows-based or MS-DOS-based application and 
whether it is running in a window or a full screen. For more information about 
cutting or copying information onto the Clipboard from an MS-DOS-based 
application, see Chapter 11, "MS-DOS Applications." 

If you are using a Windows-based application, you can cut or copy selected 
information onto the Clipboard. You can also copy an image of the entire desktop 
or a single window. 

~ To cut or copy information onto the Clipboard 

1. Select the information you want to cut or copy. (For information about 
selecting text in Windows, see "Selecting Text" earlier in this chapter.) 

You can cut or copy text, graphics, or a combination of text and graphics. 

2. From the application's Edit menu, choose Cut or Copy. 

Use the Cut command to remove information from a file and place it onto the 
Clipboard. 

Use the Copy command to place a copy of the information onto the Clipboard, 
leaving the information in its original location as well. 

Copying the Desktop 
Whether Windows is running in 386 enhanced mode or in standard mode, you can 
copy the contents of the desktop onto the Clipboard. When Windows is running in 
standard mode, however, graphics from an MS-DOS-based application are not 
copied onto the Clipboard. 

~ To copy an image of the desktop onto the Clipboard 

• Press PRINT SCREEN. 

Note If pressing PRINT SCREEN does not copy the screen onto the Clipboard, you 
may not have an enhanced keyboard. Try pressing ALT +PRINT SCREEN or 
SHIFT +PRINT SCREEN to copy the screen. 
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Copying the Contents of the Active Window 
To use the following procedure, Windows must be running in 386 enhanced 
mode. 

~ To copy the contents of the active window onto the Clipboard 

• Press ALT+PRINT SCREEN. If you are copying from a Windows-based 
application, a bitmap of the window is placed onto the Clipboard. If you are 
copying from an MS-DOS-based application, the information is placed onto 
the Clipboard as text. The application you want to transfer the information to 
must be able to read bitmap (.BMP) files. See the documentation supplied with 
your application to determine this. 

~ To copy from an MS-DOS-based application running in a window 

Mouse 

1. Drag the mouse pointer across the information you want to copy. 

2. Click the Control-menu box, and the choose Edit from the Control menu. 
The Edit drop-down menu appears. 

3. Choose Copy to transfer the selected information onto the Clipboard. 

Keyboard 

1. Press ALT+SPACEBAR to open the Control menu for the application, and then 
choose Edit from the Control menu. The Edit cascading menu appears. 

2. Choose Mark. A rectangular cursor appears at the upper-left corner of the 
window. 

3. Move the cursor to the first character you want to select. 

4. Press SHIFT and an arrow key to mark the information you want to copy. 

5. From the Control menu, choose Edit. The Edit menu appears 

6. Choose Copy to transfer the selected information onto the Clipboard. 



96 Microsoft Windows User's Guide 

Viewing the Contents of the Clipboard 
When you copy or cut information, it is placed on the Clipboard. You can view 
the contents of the Clipboard by starting Clipboard Viewer. 

~ To view the contents of the Clipboard 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon. 

Note Sometimes Windows changes the line length of the information you copy or 
cut so that all of it can be seen in the Clipboard window. When you paste the 
information from the Clipboard into the destination application, however, the 
information is intact. 

The Clipboard accepts a number of text and graphics formats. When you transfer 
information from one application to another, the original application places the 
information onto the Clipboard in all the formats the Clipboard recognizes. The 
application you paste the information into then selects the format that is most 
compatible. To view a list of all the available formats on the Clipboard and to 
view the information in a different format, use the Display menu in Clipboard 
Viewer. 

Pasting Information from the Clipboard 
You can paste information from the Clipboard into an application at any time. 
Make sure the application you want to paste the information into accepts the 
bitmap format if you copied the desktop or a window onto the Clipboard. 
Information you cut or copy onto the Clipboard remains there until you cut or 
copy something else, clear it, or quit Windows. The method you use to paste 
information depends on whether you are pasting into a Windows-based or 
MS-DOS-based application. For information about MS-DOS-based applications, 
see Chapter 11, "MS-DOS Applications." 

~ To paste information into a Windows-based application 

1. Make sure the information you want to paste is on the Clipboard. (For 
information about viewing the Clipboard contents, see the preceding section, 
"Viewing the Contents of the Clipboard.") 

2. Start the application. 

3. Place the insertion point where you want to paste the information. 

4. From the application's Edit menu, choose Paste. 
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Saving the Contents of the Clipboard 
You can save the contents of the Clipboard in a file. You can later retrieve the file 
and paste its contents into an application. You can view the file you save by using 
Clipboard Viewer. 

~ To save the contents of the Clipboard to a file 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon, and then choose Save 
As from the File menu. The Save As dialog box appears. 

3. Type a filename for the contents of the Clipboard. The default extension for a 
Clipboard file is .CLP. 

You can also type a path if you want to store the Clipboard file in a different 
directory. 

4. Choose the OK button. 

You can open a Clipboard file and then paste it into any application. Only files 
with a .CLP extension can be opened in Clipboard Viewer. 

~ To retrieve a Clipboard file 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon, and then choose Open 
from the File menu. The Open dialog box appears. 

3. Select the .CLP file you want to retrieve, and then choose the OK button. 

Note If the Clipboard already contains information, you are prompted to clear it. 
If you choose the OK button, the current contents of the Clipboard are replaced by 
the contents of the file you specified. 

If you need more memory to run an application, you can clear the Clipboard. 
Since the Clipboard stores information in multiple formats, clearing it might free 
some memory. 

~ To clear the Clipboard 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon, and then choose Delete 
from the Edit menu or press DEL. 

3. Choose the OK button. 
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CHAPTER 6 

Online Help 

Online Help in Windows is a convenient, quick way to look up information about 
a task you are performing or a feature or dialog box you would like to know more 
about. 

Help is available whenever you see a Help command button in a dialog box or 
Help as an item on a menu bar. 

Eilc .Edit ~icw Icxt Qptions !:!clp 
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The applications and accessories (except Clock) you received with Windows 
include Help, as described in this section. Other Windows-based applications 
and MS-DOS-based applications might also have Help. For information, see the 
documentation for your application. 

Starting Help 
Because Help may be displayed differently, depending on which application you 
are using and what kind of information you need, you can request Help in several 
ways. Not all methods can be used with every application. 
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~ To request Help, use one of the following methods 

• From the Help menu, choose a Help command. 

• Press Fl. Then choose a topic from the Help Contents for the application you 
are using, or search for a topic by using the Search button. 

• Choose the Help button available in many dialog boxes. This method gives 
you quick access to specific information about the dialog box. 

• Use the keyboard to select an item on a menu, and then press Fl to see a 
description of the item (available in certain applications). 

• Select a dialog box option or command, and then press Fl or choose the 
Help button to move directly to an explanation of the option (available in 
PIF Editor, an application included with Windows). 

Tip You can keep Help readily available by resizing the Help window and 
moving it next to the running application. For information about moving and 
sizing windows, see "Working with a Window" in Chapter 4, "Windows Basics." 

Using the Help Menu 
When you choose Help from the menu bar, a list of Help menu commands 
appears. 

~ To get Help by using the Help menu 

1. Choose the Help menu from the menu bar. 

2. Choose the menu command you want to use. 

You can find the following standard commands on most Help menus in Windows. 
If this is the first time you've used Help, you may want to choose How To Use 
Help to get started. 



Menu item 

Contents 

Search For Help On 

How To Use Help 

Always On Top 

About application 
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Description 

An alphabetic list of all Help topics available for the active 
application. 

A dialog box for locating information about a specific topic. 

Information about how to use Help. 

When selected, ensures that no other open window on the 
desktop overlaps the Help window. (This command appears 
only on the Help menu in a Help window.) 

Information about the active application, such as copyright, 
version, and application name. Generally, this also includes a 
user name and company name, the mode Windows is running 
in, and the amount of memory available on your computer. 

Note The Help menu in Program Manager also contains a command named 
Windows Tutorial. Choose this command to start an online Tutorial that teaches 
basic mouse and Windows techniques. To use the Windows Tutorial, you need a 
mouse and a VGA (or better) monitor. For information about how to use the 
Tutorial, see "Running the Microsoft Windows Tutorial" in Chapter 3, "A Guided 
Tour of Microsoft Windows." 

Finding Information in Help 
You can find information in Help by using Help Contents or Search For Help On, 
two commands on the Help menu. 

Finding Information by Using Help Contents 
If you are using an application that has Help on the menu bar, you can view all the 
available Help topics. Each application has a unique Help file, so the Help topics 
displayed are for the application you are currently using. 

~ To display Help Contents and choose a topic 

1. From the Help menu, choose Contents or press FI. 

2. Scroll to the topic you want information about. 

3. Click the topic. Or press TAB until you reach the topic you want, and then 
press ENTER. 
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Finding Information by Using Search 
The Search feature is an efficient way to find the information you need. When you 
have a topic that you want help with, you can use Search to find the information. 

~ To search for a Help topic 

1. From the Help menu in your application, choose Search For Help On. Or press 
FI to open Help, and then choose the Search button. 

The Search dialog box appears. 

2. Select the word or phrase you want to search for. Or type a word in the text 
box. You do not have to type an entire word; Help matches the characters you 
type as closely as possible with the available keywords. 

3. Double-click the word or phrase, or choose the Show Topics button. A list of 
topics is displayed at the bottom of the dialog box. 

4. Double-click the topic. Or select the topic you want to view, and then choose 
the Go To button. 

Information about the topic you selected appears on your screen. 

Getting Help for a Dialog Box 
Many dialog boxes contain a Help button. 

~ To request Help on a dialog box 

1. While using the dialog box, choose the Help button or press FI. 

A new window opens that contains a description of the dialog box. If the 
dialog box contains only a few areas, procedural information for the entire 
dialog box is included. More complex dialog boxes have a list of areas to 
select from. 

2. Select the area you want information about. 

A pop-up window displaying procedural information appears. (If the window 
has no Control menu, you can close it by pressing any key or clicking 
anywhere on your screen.) 

Tip It may be helpful to resize and arrange the Help window so that it does not 
overlap the dialog box. In some cases, the smaller the Help window is, the smaller 
the pop-up window is. If you cannot read all the information in a pop-up window, 
enlarge the Help window. For more information, see "Working with a Window" 
in Chapter 4, "Windows Basics." 
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Additional Methods 
When you finish reading about a topic, you have several choices. If a list of 
related topics follows the information, you can choose from the list. Or you can 
choose one of the buttons along the top of the Help window. 

Use this button To 

View the Help Contents for your application. 

Locate information about a topic (keyword or phrase) you select 
from a list or that you type in the Search For box. 

Retrace your path through the Help topics you've already viewed. 

View a complete, sequential list of every Help topic you have 
viewed during the current Windows session. 

View an alphabetic listing of terms used in Help. 

The following buttons may appear in Help for some applications. 

Use this button To 

View the previous topic in a series of related topics. When you 
reach the first topic in the series, the button appears dimmed. 

View the next topic in a series of related topics. When you reach 
the last topic in the series, the button appears dimmed. 

View an alphabetic list of all Help topics. 

Displaying Glossary Definitions 
In Help, glossary terms have a dotted underline. If you choose a glossary term, a 
definition of that term appears. 

~ To display a glossary definition 

• Choose the term. 

A definition appears. 
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~ To remove the definition from your screen 

• Click anywhere on your screen. Or press ESC. 

You can also view the entire list of available glossary terms. This list is organized 
alphabetically. 

~ To view the list of glossary terms 

1. From the Help window, choose the Glossary button. 

2. Scroll through the list until you find the term you want to learn about. 

3. Choose the term. 

Quitting Help 
You can quit Help at any time. 

~ To quit Help 

• From the File menu, choose Exit. 
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CHAPTER 7 

File Manager 

File Manager is an application included with Windows that can help you organize 
files and directories on your disk drives. 

This chapter describes how you can use File Manager to perform some common 
tasks, including managing drives, directories, and files and connecting to network 
directories. For a more complete list, see Help for File Manager. 

The File Manager Window 
When you start File Manager from the Main group, the window shown on the 
following page appears. 
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Drive bar 

Status bar 

LJcharts 
LJrecords 
LJ tables lliJ notes. tKt 
D accounts.bak D sales.dat 
D accounts.dat E'lilshowart.bat 
~apr.wri 
~feb.wri 
lliJian.wri 
D letters. log 

• The directory window is divided by the split bar. The left side of the window 
displays the structure of the current drive, or the directory tree. The right side 
of the window displays a list of files in the selected directory. 

The following table describes the various icons used in the directory window. 

Icon Description 

Displays the contents of the directory one level up in the directory tree. 

Represents a directory. 

Represents an application file. These files start applications or run 
programs. 

Represents a document file associated with an application. When you 
open this file, the application associated with it starts. 

Represents a system or hidden file. These files have system or hidden 
attributes. 

Represents other document files. 
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• You can use the drive icons on the drive bar to choose what drive is displayed 
in a directory window. You can choose to hide the drive bar. 

• The status bar displays information about the current drive and directory and 
other information that helps explain the task you are performing with File 
Manager. You can choose to hide the status bar. 

• The menu bar contains menus listing File Manager commands. 

Viewing Information in a Directory Window 
File Manager provides many ways to display files. Often, if you are looking for a 
particular file or group of files, it helps to change the way the files are listed or to 
display only the files that fit particular criteria. Also, when you are preparing to 
copy or move a file, it may be useful to display both the file and the directory that 
you will move or copy the file to. 

Opening a New Directory Window 
You can open more than one directory window to display more than one drive or 
directory at a time. Among other things, opening more than one directory window 
enables you to move and copy files by dragging them from one directory window 
to another. For more information about moving and copying files, see "Moving 
and Copying Files and Directories" later in this chapter. 

~ To open a new directory window 

• From the Window menu, choose New Window. 

If you want to open a new window displaying the contents of a different drive, 
you can double-click the drive icon. 

The new window initially has the same display characteristics as the original 
window, but you can change its characteristics independently of other windows. 

Changing the Information Displayed for Each File 
You can change the way files are displayed in the directory window. For example, 
if you want to know when each file was created, you can display all the details 
about each file (including the date) and then sort the files by creation date. Or, if 
you want to see as many files as will fit in the window, you can display only the 
name of each file. The following table describes how you can use the many 
display options. 
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Use the following commands on the View menu to determine what information is 
displayed for each file. 

Use this command 

Name 

All File Details 

Partial Details 

Sort By Name 

Sort By Type 

Sort By Size 

Sort By Date 

By File Type 

To 

Display only the names of files. 

Display the names, sizes, dates and times of creation, and 
attributes of files. 

Display specific information about each file. 

Display files in alphabetic order, based on the filename. 

Display files in alphabetic order, based on the filename 
extension. 

Display files in order of size, from largest to smallest. 

Display files in chronological order. 

Specify which types of files are displayed in a directory 
window. 

To save the new settings when you quit File Manager, choose the Save Settings 
On Exit command from the Options menu. A check mark next to the command 
means it is in effect. 

Note These commands affect only the list of files in the active directory window. 
If the directory window is displaying only the directory tree, the commands do not 
affect the window. 

Updating a Directory Window 
In most cases, File Manager updates open directory windows automatically. 
Sometimes, however, File Manager cannot do this, especially if you are using 
network drives or if you change floppy disks. 

~ To update a directory window 

• Click the icon for the current drive, or choose Refresh from the Window menu. 
You can also press F5. 
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More Ways to View Information in a Directory Window 
For information about the following additional tasks, see "Changing the Look of 
File Manager" in Help for File Manager: 

• Arranging windows and icons 

• Changing views in a directory window 

Looking at Drives, Directories, and Files 
In order to perform tasks with File Manager, you must be able to locate the file or 
directory you want to work with. This section describes how to locate and select 
files and directories. 

Selecting Files and Directories 
You can select one or more files or directories in the list of files when you want to 
copy, move, or delete files or perform other related tasks. You use the same 
methods for selecting files and directories as you do for selecting items in a list 
box. For more information about selecting items in a list box, see Chapter 4, 
"Windows Basics." 

~ To select a file or directory 

• Click the icon. Or press TAB to move to the list of files, and then use the arrow 
keys. 

~ To select consecutive items 

• Click the first item, press and hold down SHIFf, and then click the last item in 
the group. Or select the first item by using the arrow keys, press and hold 
down SHIFf, and then use the arrow keys to extend the selection to the last 
item in the group. 

~ To select or cancel selection of nonconsecutive items 

• Press and hold down CTRL, and click each item. Or press SHIFf +P8, use the 
arrow keys to move to each item, press the SPACEBAR to select it or to cancel 
selection, and then press SHIFf +P8 again. 
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~ To select files with similar filenames 

1. From the File menu, choose Select Files. 

2. In the Files box, specify the type of files you want to select. For example, type 
*.txt to select all files that have a .TXT extension. 

3. Choose the Select button. 

You can repeat steps 2 and 3 to select more groups of files, if you want. 

You can choose the Deselect button at any time to remove from a selection the 
file type currently specified in the Files box. 

Tip You can select all files in a directory by pressing CTRL+SLASH (n. You can 
cancel all selections by clicking any item (without pressing CTRL), or by pressing 
CTRL+BACKSLASH (\). 

Changing Drives and Directories 
The files you want to work with may be on a different drive or in a different 
directory. File Manager enables you to easily view and work with them. 

~ To change the current drive 

• In the drive bar, click the drive icon for the drive you want, or double-click it 
to create a new directory window displaying information for the new drive. 
You can also press and hold down CTRL while typing the letter of the drive 
you want to select. The last method works even if the drive bar is not 
displayed. 

Note When you change drives, File Manager searches the drive to display its 
contents. You can press ESC at any time to stop the search. If you stop the search, 
only a partial directory tree may be displayed, as indicated in the status bar. 

~ To change to another directory 

• Select the directory in the directory tree (or select the directory in the list of 
files) by using the mouse or the arrow keys. 

In the list of files, you can move up one level in the directory structure by 
clicking the Up icon. 
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Viewing Different Directory Levels 
In the directory tree, you can view the subdirectories in a directory by expanding 
the directory . You can also choose not to view subdirectories by collapsing the 
directory. 

When you expand a directory, the names of its subdirectories are displayed in the 
directory tree, as shown in the following example. 

~notes.txt 
Dsales.dat 

exe 

t:ltables tilshowart.bat 
D accounts. bak 
D accounts. dat 
~apr.wri 
~feb.wri 
~ian.wri 
D letters. log 
~mar.wri 

You can expand an entire branch (all levels of subdirectories in a directory), a 
single level of the branch, or all branches on the drive. 

You can collapse a directory so that subdirectories are not shown in the directory 
tree. All directories except the root directory are collapsed the first time you start 
File Manager. 

~ To expand one level of a directory 

• In the directory tree, double-click the icon of the directory you want to expand. 
Or select it by using the arrow keys, and then press ENTER. 

You can also use the following commands on the Tree menu to expand 
directories. 

Use 

Expand One Level 

Expand Branch 

Expand All 

To 

Display the immediate subdirectories of the selected directory. 
Or you can press the PLUS (+) key. 

Display all the subdirectory levels below the selected directory. 
Or you can press the ASTERISK (*) key. 

Display all the directories and subdirectories on the drive. Or 
you can press CTRL+ASTERISK (*) on the numeric keypad. 
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~ To collapse a directory 

• In the directory tree, double-click the icon of the directory you want to 
collapse. Or select the icon by using the arrow keys, and then press ENTER. 

You can also use the Collapse Branch command on the Tree menu. 

Using Network Directories 
If you are using a network, you can use File Manager to connect to a network 
directory if you know its location (and password, if there is one). With some 
networks, you can browse through all the network directories to find the one you 
want to connect to. You can also disconnect from network directories that you are 
no longer using. If you are not using a network, the network commands are not 
available. 

You should always start the network before you start Windows. If you made 
network connections before you started Windows, the network drive icons for 
these connections appear on the File Manager drive bar. Windows saves any new 
network connections you make and, if you do not disconnect from them, sets up 
the same network connections the next time you start Windows. 

With some networks, you can change settings so that your connections are not 
reestablished each time you start Windows. To change network settings, choose 
the Network icon in Control Panel. For more information, see Help for Control 
Panel. 

Connecting to and Disconnecting from Network Directories 
When you connect to a network directory, File Manager assigns the directory the 
next available drive letter (or you can assign a letter of your choice). This creates 
a network drive, which appears as a drive icon on the File Manager drive bar. 
Mter you are connected to a network directory, you can use the resulting network 
drive as you would any other drive. 

Note Depending on your network, you may have different commands and dialog 
boxes available to connect to and disconnect from network directories. The 
following procedures are based on your having the Network Connections 
command available. If you have different network commands, such as Connect 
Network Drive and Disconnect Network Drive, substitute those commands for 
Network Connections in the following procedures. If the dialog box for 
connecting to a network directory is different from the one shown in this 
procedure, choose the Help button in the dialog box for more information. 
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~ To connect to a network directory 

1. From the Disk menu, choose Network Connections. 

2. In the Network Connections dialog box, specify the network path, drive 
letter, and password, if any, for the connection. For help with the Network 
Connections dialog box, choose the Help button or press Fi while using the 
dialog box. 

3. Choose the Connect button. 

You can assign a different drive letter to the network 
directory by opening the Drive list and selecting the letter 
you want. Or you can type the drive letter in the Drive box. 

You specify the location of the network 
directory by typing its path in this box. 

If the network directory requires 
a password, type it in this box. 

You choose the Previous 
button to connect to a 
network directory you 
have used before. 

With some networks, you 
can use the Browse button 
to find the directory you 
want. 

4. Repeat steps 1 through 3 for each connection you want to make. When you are 
finished, choose the Close button. 

Note The Browse button may appear dimmed if your network does not support 
browsing. 
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~ To disconnect from a network directory 

1. In the Network Connections dialog box, select the directory you want to 
disconnect from in the Current Drive Connections box. 

2. Choose the Disconnect button, and then choose the Close button. 

Note If Windows is running in 386 enhanced mode, you may not be able to 
disconnect from network drives that were active before you started Windows. 

Working with Files and Directories 
You can use File Manager to move, copy, create, delete, rename, and search for 
files or directories. You can also print files from File Manager. 

Moving and Copying Files and Directories 
You can move and copy files and directories from one location (called the source) 
to another (called the destination) either by the drag-and-drop method or by using 
the Copy or Move command. The destination can be a directory window, 
directory icon, or drive icon. 

~ To move or copy a file or directory 

• To move a file or directory to a destination on a different drive, press and hold 
down SHIFT while you drag the item. To move a file or directory to a 
destination on the same drive, drag the item. 

• To copy to a different drive, drag the item to the appropriate drive icon. To 
copy to the same drive, press and hold down CTRL while you drag the item. 

• You can also select the file or directory and then choose Move or Copy from 
the File menu. Then complete the appropriate dialog box. 

Creating Directories 
You can create a directory by using the Create Directory command. 

~ To create a directory 

• From the File menu, choose Create Directory. Then type the new directory's 
path in the Name box. 

Tip To quickly create a subdirectory of an existing directory, select the existing 
directory before you choose the Create Directory command. Then type only the 
new directory's name instead of its path in the Name box. 



Chapter 7 File Manager 115 

Deleting Files and Directories 
You can delete a file or an entire directory, including all the files and 
subdirectories contained in it. 

~ To delete a tile or directory 

• Select the file or directory you want to delete (you can extend the selection to 
include more than one file or directory). Then choose Delete from the File 
menu, or press DEL. 

Renaming Files and Directories 
You can change the names of files, but you must be careful when working with 
system or hidden files. A system file contains information required for running the 
Microsoft MS-DOS operating system. A hidden file is a file not intended to be 
viewed in a directory listing. For example, your Windows swap file is a hidden 
file. If you change the name of a system file, your Windows directory, or any 
initialization (.INI) file used by Windows, your system may not run correctly. 

~ To rename a file or directory 

1. Select the file(s) or directory you want to rename, and then choose Rename 
from the File menu. 

2. The From box contains the name(s) you selected. In the To box, type a 
filename to rename a single file, or use wildcards (* or ?) to rename a group of 
files. For example, type * .bak to affect all files that have the .BAK extension. 
For more information about wildcards, see your MS-DOS documentation. 

Searching for Files and Directories 
If you know a particular file is on your disk, but you don't remember where, you 
can use the Search command to find it. 

~ To search for a file or directory 

1. Select the directory that you want to start the search from, and then choose 
Search from the File menu. 

2. Type a filename, or use wildcards (* or ?) in the Search For box to search for 
a group of files or directories that have related filenames or extensions. The 
Search Results window displays a list of all the files that meet the criteria. 

You can work with the files that appear in the Search Results window in the same 
way you work with files in the directory window. 

To cancel the search, press ESC. To close the Search Results window, choose 
Close from the Control menu. 
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Printing Files 

If you modify information on the drive on which the search was performed, and 
the Search Results window is active (or is made active), a dialog box appears, 
asking whether you want to update the Search Results window. If you choose 
the Yes button, the search is repeated. 

You can print files by dragging the file icons onto the Print Manager application 
icon or window. Some applications do not support printing through File Manager. 
If this is the case, or if a file is not associated with an application, you must open 
the appropriate application and then print the file from there. 

~ To print a file by using File Manager 

• Make sure Print Manager is activated, and then drag the document-file icon 
onto the Print Manager application icon or window. 

Or, in the directory window, select the file you want to print, and then choose 
Print from the File menu. 

For information about activating Print Manager, see Help for Print Manager. 

Note Printing by using File Manager prints the file on the default printer. 

Working with Floppy Disks 
You can use commands on the Disk menu to format floppy disks and copy the 
contents of one disk to another. 

~ To format a floppy disk 

1. Insert a disk in a drive. 

2. From the Disk menu, choose Format Disk. 

3. In the Disk In list, select the letter for the drive you want to format. The other 
parameters are adjusted to match that drive. 

4. Complete the other areas of the dialog box, and then choose the OK button. 

In the Format Disk dialog box, you can use the following options. 

Use 

Label 

Make System Disk 

Quick Format 

To 

Specify the disk label. 

Make the disk a startup disk. 

Format the disk quickly (the disk is not scanned for bad 
sectors). This works only for disks that have been 
previously formatted. 
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For more information about formatting a disk, choose the Help button or press Fl 

while using the Format Disk dialog box. 

Caution Be sure you format the correct disk. Unless you are running MS-DOS 
version 5.0 or later, or you have a disk-recovery program, you cannot recover 
information on a disk that is accidentally formatted. 

~ To copy a floppy disk to another floppy disk 

• Insert the source disk in the drive you want to copy from. If you have two 
floppy disk drives of the same size, insert the destination disk in the drive you 
want to copy to. Then choose Copy Disk from the Disk menu. 

Both disks must have the same storage capacity, but you do not need two drives 
of the same storage capacity. If you have only one floppy disk drive of the right 
capacity, Windows prompts you to switch source and destination disks as needed. 

For information about the following additional tasks, see "Managing Floppy 
Disks" in Help for File Manager: 

• Labeling a disk 

• Making a system disk 

More Ways to Use File Manager 
There are many other features that you can use to customize File Manager to fit 
your needs and to perform various tasks. For example, you can start applications 
from File Manager (for more information, see Chapter 5, "Application Basics"). 

For information about the following tasks, see Help for File Manager: 

• Associating files with applications 

• Changing the look of File Manager 

• Managing floppy disks 

• Moving around in File Manager 

• Starting applications 

• Turning off confirmation messages 

• Working with files and directories 





CHAPTER 8 

Print Manager 

Print Manager is an application included with Windows that you can use to 
manage documents sent to a printer. You can also use Print Manager to install 
and configure printers and to connect to network printers. 
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If you print from a Windows-based application, the application creates a print file 
and sends it to Print Manager. Print Manager works in the background, sending 
your documents to the printer while you continue working. You can check the 
status of the document at any time and change its status until it starts printing. 

This chapter describes some of the common tasks you can perform by using Print 
Manager. For a more complete list, see Help for Print Manager. 

Before You Print 
You must do the following before you can print: 

1. Make sure the appropriate printer driver is installed. This is a program that 
enables your printer to communicate with Windows. For each type of printer 
you plan to use, whether it is your own or a printer on the network, you must 
install the appropriate printer driver. 

Generally, you specify a printer when you set up Windows, and the Setup 
program installs the printer driver for that printer. However, if you skipped this 
step during Setup, or if you want to use an additional or different printer, you 
need to perform this step again. For information about how to set up a printer, 
see "Setting Up a Printer" later in this chapter. 

2. If you plan to use a printer on the network, you must connect to that printer. 
For information about how to connect to a network printer, see "Connecting to 
a Network Printer" later in this chapter. 
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Managing Documents 
Most Windows-based applications include a Print command on the File menu 
that you can use to print documents. You can also print a document from File 
Manager by dragging the file's icon onto the Print Manager application icon or 
window. For information about this procedure, see Chapter 7, "File Manager." 

When you print a document from a Windows-based application on your own 
printer (a printer physically connected by a printer cable to your computer), Print 
Manager starts and appears on the desktop as an icon, if it is not already running. 
The icon does not appear when you print on a network printer (a central printer 
that anyone who is using a network can use). 

MS-DOS-based applications that run in Windows print the same way they would 
from MS-DOS. They do not use Windows printer drivers and do not route print 
files through Print Manager, but they can still print on network printers. 

Looking at the Print Queue 

Information for 
your printer 

Information for a 
network printer 

Information for 
documents 

As you send documents to Print Manager, a print queue forms. Print queues list 
information about the printers that are installed on your system and about the 
documents that are printing or waiting to print. You can view this information by 
enlarging the Print Manager icon to a window or by choosing Print Manager from 
the Main group. 

13K 1 :12 PM 10/19/1991 
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The print queue displays the following printer information: 

• The name ofthe printer. 

• The port your printer is connected to and, if it is a network printer, the 
network path. 

• The current status of the printer (such as active or idle). 

Beneath the printer information, the print queue displays the following document 
information: 

• The title of the document (some network software may not support this 
feature). 

• The document's position in the queue, or a printer icon if the document is 
printing. 

• The size of the document in kilobytes (if the Print File Size command has a 
check mark next to it). 

• The time and date you sent the document to Print Manager (if the TimelDate 
Sent command has a check mark next to it). If you are connected to a network 
printer, the network time and date are shown, which may differ from your 
computer's time and date. 

• If a document is currently printing, the amount (as a percentage) of the 
document printed so far. 

If you are printing on a network printer from a Windows-based application, Print 
Manager only reports the status of your documents in the network queue. For 
information about viewing every document in a network queue, see "Viewing 
Network Print Queues" in Help for Print Manager. 

Pausing and Resuming Printing 
You can pause your printer or your individual documents on a network printer. 
Pausing your printer stops every document in its queue from printing. Pausing 
a single document stops only that document from printing-other documents in 
the queue will print. After a document has actually started to print, you cannot 
pause it. 
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Use these buttons to 
pause, resume, and 

cancel printing. 

Most networks allow you to pause only the documents you send to a network 
printer. However, your ability to pause the entire network queue depends on the 
features your network supports. 

• To pause printing 
1. In the Print Manager window, select the document or the name of the printer 

you want to pause. 

2. Choose the Pause button. Or press ALT+P. 

• To resume printing 
1. In the Print Manager window, select the document or the name of the printer 

you want to resume printing. 

2. Choose the Resume button. Or press ALT+R. 

Canceling the Printing of a Document 
You can cancel the printing of your document on your own printer or on a 
network printer by deleting it from the print queue. Whether you can cancel the 
printing of other documents on a network printer depends on the capabilities of 
the network. 

• To cancel the printing of a document 

1. In the Print Manager window, select the document you want to cancel. 

2. Choose the Delete button. Or press ALT +D. A dialog box appears, prompting 
you to confirm the deletion. 

• To cancel the printing of all documents on your printer 

• From the File menu, choose Exit to quit Print Manager. A dialog box appears, 
prompting you to confirm the deletion. 

Note If you quit Print Manager while a document is printing in graphics mode, 
you might need to turn your printer off and on or use the reset option on your 
printer. 



Chapter 8 Print Manager 123 

Choosing the Default Printer 
Many Windows-based applications use the default printer when you choose the 
Print command. 

~ To choose a default printer 

1. From the Options menu, choose Printer Setup. 

2. In the Installed Printers list, select the printer you want. 

3. Choose the Set As Default Printer button, and then choose the Close button. 

Tip You can also double-click the printer in the Installed Printers list. 

Note Some Windows-based applications may have a Print Setup command that 
you can use to print to any installed printer. In most cases, selecting a different 
printer does not make it the default printer for all Windows-based applications. 
However, with some applications, the setting for the default printer does change. 
For more information, see the documentation that comes with your application. 

Printing to a File 
If you are planning to merge two files or to print a document at a later time or 
different location, you may want to print a document to a file rather than directly 
to a printer. 

Some applications have an area in their Print dialog box in which you can specify 
printing to a file. If your application does not support this feature, you can print 
your document to a file by specifying FILE as the port in Print Manager. For more 
information, see "Setting Up a Printer" later in this chapter. 

Printing Through MS-DOS 
When you print in Windows, documents are sent directly to the port your printer 
is connected to, bypassing MS-DOS printing interrupts. This speeds up printing 
and is the recommended method to use. 

However, in the following situations you may want to print by using MS-DOS 
interrupts: 

• You are using additional printer software that relies on MS-DOS interrupts 
(such as software that accompanies switch boxes). 

• You are trying to print on a network not supported by Windows. 

• You are trying to print to a serial printer and are using a terminate-and-stay
resident (TSR) program that takes direct control of the COM port. 
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Printing through MS-DOS may slow down printing, but it ensures that in these 
cases your files print correctly. 

~ To print through MS·DOS 

1. From the Options menu, choose Printer Setup. 

2. In the Printers dialog box, choose the Connect button. 

3. In the Connect dialog box, clear the Fast Printing Direct To Port check box, 
and then choose the OK button to return to the Printers dialog box. 

4. Choose the Close button. 

Connecting to a Network Printer 
If you are using a network and want to print to a network printer, you can use 
Print Manager to connect to the printer. 

When you connect to a network printer, you specify the location of the printer, a 
password, if one is required, and a port name, such as LPT2 or LPT3. Before 
connecting to a network printer, make sure that you have installed the printer 
driver for the network printer and that the printer is assigned to the port that you 
want to use for the network connection. For more information about installing a 
printer driver, see "Setting Up a Printer" later in this chapter. 

Note Depending on your network, you may use different commands and dialog 
boxes to connect to and disconnect from network printers. The following 
procedures are based on your having the Network Connections command and 
dialog box available. If your network provides different commands, such as 
Connect Network Printer and Disconnect Network Printer, substitute those 
commands for Network Connections in the following procedures. If the dialog 
box for connecting to or disconnecting from a network printer is different from 
the one shown in this procedure, choose the Help button in the dialog box for 
more information. 
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~ To connect to a network printer 

1. From the Options menu, choose Network Connections. 

2. In the Network Connections dialog box, specify the network path, port, and 
password, if any, for the connection. For help with the Network Connections 
dialog box, choose the Help button or press Fl while using the dialog box. 

3. Choose the Connect button. 

You specify the location of the network 
printer by typing its path in this box. 

You can assign a different port to the 
network printer by opening the Port 
list and selecting the port you want. 
Or you can type the port in the box. 

If the network printer requires 
a password, type it in this box. 

You choose the Previous 
button to connect to a 
network printer you have 
used before. 

With some networks, you 
can use the Browse 
button to find the printer 
you want. 

4. Repeat steps 1 through 3 for each connection you want to make. When you are 
finished, choose the Close button. 

Note The Browse button may appear dimmed if your network does not support 
browsing. 

~ To disconnect from a network printer 

1. In the Network Connections dialog box, select the printer you want to 
disconnect from in the Current Printer Connections box. 

2. Choose the Disconnect button, and then choose the Close button. 
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Setting Up a Printer 
If you did not set up a printer when you set up Windows, the Print Manager 
window is empty and you cannot print. You can set up printers by using Control 
Panel or Print Manager. 

It is recommended that you read the PRINTERS.WRI online document, which 
contains information about specific printers, before you set up a printer. 

Note The Printers option in Control Panel provides the same method for setting 
up a printer as the Print Manager method described in the following sections. 

~ To set up a printer 

1. From the Options menu, choose Printer Setup. 

2. Choose the Add button to display the List Of Printers box if it is not already 
displayed. 

3. In the List Of Printers box, do the following. 

Double-click If 

The model name of your printer 

The PostScript version of your printer 

The printer that your printer emulates 

The printer that your PostScript cartridge 
emulates 

PostScript Printer 

Install Unlisted or Updated Printer 

GenericlText Only 

Your printer is listed and does not 
emulate another printer. 

Your printer uses a PostScript 
cartridge that does not emulate another 
printer. 

Your printer is not listed but emulates 
a listed printer. 

Your printer uses a PostScript 
cartridge that emulates a listed printer. 

Your printer is not listed, does not 
emulate a listed printer, but is 
PostScript -compatible. 

You have a disk from your printer 
manufacturer that contains a Windows 
printer driver for your printer. 

Your printer is not listed and is a 
daisy-wheel printer or a text-only 
printer. 

Depending on the choice you make, you may be required to insert one of the 
installation disks contained in the Windows package, a disk provided by your 
printer manufacturer, or, if you are not a United States customer, the additional 
Non-USA Printer Drivers disk that comes with your Windows package. 
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Note If you choose the name of a printer that your printer emulates, your 
printer must be set to operate in the appropriate emulation mode. Make sure 
that you set the proper DIP-switch settings or menu settings on your printer. 
For more information, see your printer documentation. 

4. If you want to change the port that is assigned to your printer, select the printer 
in the Installed Printers list, and then choose the Connect button. In the dialog 
box that appears, select the port that you want to assign to your printer. 

Following is a description of the types of ports available. 

Port Description 

LPT A parallel port. 

COM A serial port. 

EPT Used for the IBM Personal Pageprinter. This port requires that a special 
card be installed in your computer. 

FILE Prints to a file instead of to a printer. If the application you are working 
with supports this feature, you can print to a file even if you don't select 
this option. 

If you select a COM port, you might want to make sure that the 
communications settings for the port match those required by your 
printer. You can choose the Settings button to determine this. For help 
with the Settings dialog box, choose the Help button or press Fi while using 
the dialog box. 

If the printer is a network printer, choose the Network button to connect 
to it. For more information about connecting to network printers, see 
"Connecting to a Network Printer" earlier in this chapter. 

Choose the OK button to close the Connect dialog box. 

5. If you want to make this printer the default printer, double-click the printer in 
the Installed Printers list. Or select the printer, and then choose the Set As 
Default Printer button. 

6. Choose the Close button. 

If none of the printers listed in the Printers dialog box is appropriate for your 
printer, you have two choices: 

• Contact your printer manufacturer for a printer driver that works with 
Windows. 

• Request information about additional drivers included on the Windows Driver 
Library (WDL) disk. Microsoft adds drivers as they become available. For 
more information, see "The Windows Driver Library" in Chapter 13, 
"Configuring Hardware." 
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If you are using MS-DOS-based applications in 386 enhanced mode, you can use 
the 386 Enhanced option in Control Panel to control what happens when several 
applications compete for access to a printer port. For more information, see Help 
for Control Panel. 

There are more procedures to help you set up printers. For information about the 
following additional tasks, see "Setting Up a Printer" in Help for Print Manager: 

• Selecting timeout options 

• Selecting printer settings 

Removing an Installed Printer 
If you are no longer using a printer, you can remove it from the Installed Printers 
list in the Printers dialog box. 

~ To remove an installed printer 

1. From the Options menu, choose Printer Setup. 

2. From the Installed Printers list, select the printer you want to remove. 

3. Choose the Remove button. A dialog box appears, prompting you to confirm 
the removal. 

4. Choose the Close button. 

Removing a printer from the Installed Printers list does not remove the printer 
driver from your hard disk. This is because another printer may use the same 
driver. Similarly, removing the printer does not remove any associated fonts 
from memory. For information about removing fonts, see Chapter 12, 
"Customizing Windows." 

More Ways to Use Print Manager 
There are many other features that you can use to customize Print Manager to fit 
your needs and to perform various tasks. For information about the following 
tasks, see Help for Print Manager: 

• Changing the print order 

• Deactivating Print Manager 

• Displaying Print Manager messages 

• Giving Print Manager priority 

• Printing on a network 
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CHAPTER 9 

Accessories 

Calculator 

Windows includes accessories that you can use to perform many everyday tasks. 
The following list briefly describes how to use the accessories: 

• Use Media Player and Sound Recorder to play or record sound files and work 
with other multimedia devices. 

• Use Calculator, Calendar, Cardfile, and Clock to manage personal information. 

• Use Write, Notepad, Paintbrush, and Character Map for publishing or writing 
tasks. 

• Use Terminal to communicate with another computer through a modem. 

• Use Recorder to record keystrokes or mouse actions to play back later. 

This chapter introduces the accessories (in alphabetic order). Procedures for 
performing tasks are provided in online Help. To view Help, choose the Contents 
command from the Help menu. 

To start an accessory, choose an icon in the Accessories group. For information 
about starting accessories, see Chapter 4, "Windows Basics." 

Calculator includes both a standard and scientific calculator. You can use the 
standard calculator to do simple calculations and then store them in memory. You 
use the scientific calculator to do advanced scientific and statistical calculations. 
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Use these buttons 
to edit the numbers 

in the display. 

Use these 
buttons to use 

memory features. 

When you start Calculator for the first time, the standard calculator appears. 

Th' 's where Calculator 
ays numbers . displ I .1 
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These are the basic 
mathematical operators. 

For information about the following tasks, see Help for Calculator: 

• Performing calculations 

• Using Calculator memory 

• Using Calculator with the Clipboard 

• Using the scientific calculator 

• Working with different number systems 

• Using advanced functions (operators, number-base functions, advanced 
statistical functions) 



Calendar 
lilll 

Appointment area 

Cardfile 

Chapter 9 Accessories 131 

Calendar combines a month-at-a-glance calendar and a daily appointment book. 

Status line 
7:00 AM 
8:00 
9:00 
10:00 
11:00 
12:00 PM 
1:00 
2:00 
3:00 
4:00 
5:00 
6:00 
7:00 
8:00 

-----------I!!H-llf- Insertion point 

Scratch pad 

For information about the following tasks, see Help for Calendar: 

• Entering appointments 

• Moving to appointments 

• Printing appointments 

• Setting and removing appointments 

Cardfile is similar to a set of index cards. You can use it to keep track of names, 
addresses, phone numbers, directions, or anything else you want quick access to. 
U you have a modem, you can dial a telephone number that is typed on a Cardfile 
card. 
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Use the index line 
to label each card. 

You can also copy, link, or embed information into Cardfile. For example, on a 
card that shows a client's name, address, and telephone number, you could add a 
picture (a bitmap image) of the client. Or you could add an icon that, when 
chosen, opens and displays the picture. For more information about linking and 
embedding objects, see Chapter 10, "Object Linking and Embedding." 

'---------fl---- Use the scroll 
,---------------, arrows to move 

Text appears at the insertion 
point when you type. 

forward or backward 
through the cards. 

For information about the following tasks, see Help for Cardfile: 

• Filling in and adding cards 

• Viewing cards as a list 

• Moving through your cards 

• Editing text on cards 

• Embedding or linking an object 

• Restoring or deleting a card 

• Duplicating a card 

• Printing a Cardfile file 

• Using automatic dialing 
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Character Map 
~.'." .. '.i 

~ 
Character Map displays all the characters, including extended and special 
characters, that you can use with the selected font in your Windows-based 
application. Character Map also displays the keystrokes you can use to create a 
selected character within your application. 

You can use Character Map only with Windows-based applications. If you are 
running an MS-DOS-based application, check its documentation to find out how 
to insert special characters. 

Available fonts 
are listed here. 

Choose the Copy button 
to copy these characters 

onto the Clipboard. 

These are the 
available characters 
in the selected font. 

Clock 

Eont: 

111#3%&~()*+,-

~ABXflE~rHI~KAMNOII8P};TYc,QB'!'ZI 

This box shows what keys to press 
to create the selected character. 

For information about the following tasks, see Help for Character Map: 

I Selecting a font 

I Inserting a character into a document 

I Using keystrokes to create selected characters 

Clock helps you keep track of time. You can display an analog or digital clock. 
You might find it useful to add Clock to your StartUp group, so that Clock is 
running every time you start Windows. 
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Media Player 
Using Media Player, you can play multimedia files and control hardware devices. 
For example, you can use Media Player to play sound files through a sound card. 
If you have an audio compact-disc player or videodisc player connected to your 
computer, you can use Media Player to start and stop them. 

Media Player can play digitized sounds created by Sound Recorder or Musical 
Instrument Digital Interface (MIDI) devices. 

Before Media Player can playa file, you must have the sound hardware and its 
driver installed and configured. For information about installing hardware drivers, 
choose the Drivers icon from Control Panel, and then choose the Help button. 

To playa multimedia file (sound or animation) or device (such as a videodisc 
player), you must first choose the type of device you want to use. For information 
about setting up your device, see Chapter 13, "Configuring Hardware." If the 
device requires a file to play, you must also open the file. Some devices, such as 
audio compact-disc players, do not require a file. 

Use the scroll bar to start 
playing at another part of the file. 

Eject 

For information about the following tasks, see Help for Media Player: 

• Specifying a media device 

• Playing a media file 

• Changing and positioning the scale 



Notepad 

Paintbrush 

The Toolbox contains 
the tools you use to 

create or change 
a drawing. 
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Notepad is a text editor. You can use Notepad to create notes, write short memos, 
and create and edit batch files. Notepad creates files by using the ASCII format 
and has none of the features used for formatting a document. 

For information about the following tasks, see Help for Notepad: 

• Setting word wrap 

• Searching for text in Notepad 

• Managing Notepad files 

• Printing a Notepad document 

Using Paintbrush, you can create simple or elaborate, black-and-white or color 
drawings. After you've created a drawing, you can print it or use it in another 
document. For information about using Paintbrush drawings in other documents, 
see Chapter 10, "Object Linking and Embedding." 

The Linesize box contains 
the available drawing widths. 

The drawing area is where 
you create or change a drawing. 

The Palette contains colors and 
patterns you can use in a drawing. 
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You use the tools in the Paintbrush Toolbox to create and change drawings. The 
following list provides a brief description of each tool's function. 

Scissors - X [~ -Pick 

Airbrush - r i 

abc -Text too! 

Color Eraser

Paint Roller-

-Eraser 

-Brush 

Curve - cR / -Line 

Box - 0 II - Filled Box 

Rounded Box- 0 • -Filled Rounded Box 

Circle/Ellipse - 0 • -Filled Circle/Ellipse 

Polygon - '\. \. -Filled Polygon 

This tool 

Scissors 

Pick tool 

Airbrush 

Text tool 

Color Eraser 

Eraser 

Paint Roller 

Brush 

Curve 

Line 

Box 

Filled Box 

Rounded Box 

Filled Rounded Box 

Circle/Ellipse 

Filled Circle/Ellipse 

Polygon 

Filled Polygon 

Does this 

Defines an area to cut, copy, or change. 

Defines a rectangular area to cut, copy, or change. 

Creates a circular spray of dots. 

Adds text to your drawing. 

Changes colors in all or part of a drawing. 

Changes foreground colors to the selected background color. 

Fills any closed shape or area with color. 

Draws freehand shapes and lines. 

Draws curved lines. 

Draws straight lines. 

Draws hollow squares and rectangles. 

Draws squares and rectangles filled with color. 

Draws hollow round-cornered squares and rectangles. 

Draws round-cornered squares and rectangles filled with 
color. 

Draws hollow circles and ellipses. 

Draws circles and ellipses filled with color. 

Draws polygons from connected straight lines. 

Draws polygons filled with color. 

Unlike the other accessories, Paintbrush makes use of both mouse buttons. Help 
for Paintbrush specifies when to use the right mouse button. If no button is 



Recorder 
tiiJiJ 
~ 
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specified, use the left mouse button. For information about performing tasks with 
Paintbrush, see Help for Paintbrush. 

Using Recorder, you can record a sequence of keystrokes and mouse actions
called a macro-to play back at a later time. You can use macros to automatically 
type a special phrase or code that you use frequently or to automate the steps of a 
task you routinely perform. For example, you could record the steps you go 
through to switch to the Main group in Program Manager, choose the MS-DOS 
Prompt icon, change to the MS-DOS directory, and start a text editor. When you 
run this macro, it performs these steps for you. 

For information about the following tasks, see Help for Recorder: 

• Recording a simple macro 

• Playing back a macro 

• Setting permanent preferences 

• Creating macros to use as demos 

Sound Recorder 

A You can use Sound Recorder to play, record, and edit digitized sound files. 
To play sound files, you must have a sound card and its driver installed and 
configured. To record sound files, you must also have a microphone installed. 
For information about hardware drivers, see Chapter 13, "Configuring Hardware." 

The Wave box displays the sound 
as if it were being shown on an oscilloscope. 

Use the scroll bar to move 
to any point in a sound file. 

Record 
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Terminal 

Write 

~ 

Text appears at 
the insertion point 

when you type. 

The page-status area 

For information about the following tasks, see Help for Sound Recorder: 

• Creating and editing a sound file 

• Playing a sound file 

• Linking and embedding sound files 

Using Terminal, you can connect your computer to other computers and 
exchange information through a modem. For example, you can connect to online 
information services, such as Dow Jones NewslRetrieval, and to online bulletin 
boards, such as CompuServe. 

To run Terminal, you must have a Hayes or Hayes-compatible modem installed 
on your computer. For information about performing tasks with Terminal, see 
Help for Terminal. 

Write is a word-processing application that you can use to create and print 
documents for business and personal use. When you create Write documents, 
you can type, edit, and format text in the Write window; insert graphics; save the 
text and graphics as a file; and print your documents. 

Write also supports object linking and embedding (OLE). For more information, 
see Chapter 10, "Object Linking and Embedding." 

The end mark indicates the end of the document. 

indicates which page _ •••••• " ••••••••••••• of text is displayed. 

The mouse pointer indicates where the insertion point 
will move to if you click a location in the document. 

For information about performing tasks with Write, see Help for Write. 
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CHAPTER 10 

Object Linking and Embedding 

In Windows, you can use a feature called object linking and embedding (OLE) 
to transfer and share information between Windows-based applications and 
accessories. When you use OLE, you can view and use different forms of 
information in a single document. For example, rather than switching between 
applications, you can view and even work on a Microsoft Excel spreadsheet or 
a Paintbrush bitmap right from a Microsoft Word for Windows document. 

Paintbrush, Sound Recorder, Write, Cardfile, and Object Packager all support 
OLE and are included with Windows. Many other Windows-based applications 
support OLE. Check the documentation supplied with your applications to 
determine whether they support OLE and how to use their OLE features. 

141 

This chapter provides an introduction to OLE. Some procedures are provided as 
examples, using the Paintbrush and Write applications. For more comprehensive 
information about using the OLE features of Paintbrush and Write, see Help for 
each of these applications. 
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What Is Object Linking and Embedding? 
To understand object linking and embedding, you need to be familiar with the 
following terms and concepts: 

• An object is a piece of information such as a chart, a spreadsheet, a drawing, 
or text that can be linked or embedded. 

• A source document is the document in which the object originates. For 
example, if you use Microsoft Excel to create a spreadsheet and then use 
that spreadsheet or part of it in another document, the original spreadsheet 
is the source document. 

• A destination document is the document into which you place an object. For 
example, if you use part of a Microsoft Excel spreadsheet (as in the previous 
example) in a Word document, the Word document is the destination 
document. 

• An embedded object is an object in a destination document that is a copy of 
information that was created in another application. By choosing an embedded 
object-for example, by double-clicking it-you start the application that 
was used to create it, without switching away from the document you're 
working in. 

For example, suppose you are creating a memo by using Write and you want 
to use a drawing of your company logo at the top of the memo. The drawing 
has been created by using Paintbrush, so you can embed the drawing in your 
Write document. Mter it is embedded, making changes to it is easy-you 
choose the embedded object, and Paintbrush starts, displaying the object. 

Mter it is embedded, an object is no longer connected to the source document. 
Changes you make to the object do not affect the source document. 

• When you create a linked object, you establish a link between the 
destination and source documents. Although the linked object is displayed 
in the destination document and you can print the object, the data that makes 
up the object resides only in the source document. When you make changes 
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to a linked object, you are actually changing the information in the source 
document. When you make changes in the source document, the changes 
appear in the destination document (updating the linked object). 

Note You can control whether a linked object is updated manually or 
automatically. For more information, see "Maintaining Links" later in this 
chapter. 

By choosing a linked object-for example, by double-clicking it-you start 
the application that was used to create it, without switching away from the 
document you're working in. 

For example, suppose you are writing a chapter of a book by using Word for 
Windows. Someone else is creating the artwork for your chapter by using 
Paintbrush. You can create a link between the Paintbrush artwork and your 
Word document so that any changes to the artwork are automatically reflected 
in your document. 

The procedures you use for embedding and linking objects are generally similar to 
the procedures you use for copying and pasting information. The end result 
depends on the application that was used to create the information you are using. 
If the application supports OLE, then following the procedures in this chapter will 
result in an embedded or linked object. If the application does not support OLE, 
then following these procedures will result in static copies of the information. 

Embedding an Object 
The way you embed an object depends on the type of object it is and whether the 
object has already been created. 

Note Different applications may use different menu commands for object linking 
and embedding. For information about embedding an object by using a specific 
application, see the documentation supplied with the application. 
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You can embed an object by starting from either the source or destination 
document. The following illustration shows an example of both methods of 
embedding. 

Use the Insert Object command to 
embed the Paintbrush object into 
the Write document. 

The Write file, SAMPLE.WRI, 
is the destination document. 

After you choose the Update 
command in Paintbrush, the 
embedded object appears. 

Use the Update command --Jl~ •• " •• _ 
to embed the object. 

This is a 
Paintbrush 

object. ---!tI:""C:--H------;-
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The following procedure describes one way of embedding a Paintbrush object in a 
Write document. 

~ To embed a Paintbrush object, starting from Write 

1. Open the Write document in which you want to embed the object. 

2. Place the insertion point where you want the object to appear. 

3. From the Edit menu, choose Insert Object. A dialog box appears, listing all 
the applications on your computer that support OLE. 

Note Some applications have a Paste From command on the Edit menu that 
you can use to open the document containing the drawing you want to embed 
as an object. 

4. Select Paintbrush Picture, and then choose the OK button. 

5. In the Paintbrush window, create a drawing. Or open the document that 
contains the drawing you want to embed. 

6. From the File menu in Paintbrush, choose Update. This embeds the 
Paintbrush object into the Write document. 

7. From the File menu in Paintbrush, choose Exit & Return To (name of 
document). Paintbrush closes and you return to the Write document. 

Editing an Embedded Object 
You can edit an embedded object from within its destination document. The 
following procedure describes how to edit a Paintbrush object that has been 
embedded in a Write document. 

~ To edit an embedded Paintbrush object from within a Write document 

1. In the Write document, choose the embedded object. Paintbrush opens, 
with the object displayed. 

2. Edit the object as needed. 

3. From the File menu in Paintbrush, choose Update. 

The embedded object is updated in the Write document. 

4. From the File menu in Paintbrush, choose Exit & Return To (name of 
document). Paintbrush closes and you return to the Write document. 
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Linking an Object 
The way you link an object depends on the type of object it is. 

Note Different applications may use different command names for object linking 
and embedding. For more information about linking an object by using a specific 
application, see the documentation supplied with the application. 

From a single source document, you can create links to more than one destination 
document. Any changes you make to a linked object in a destination document 
appear in the source document and in every destination document that contains a 
link to that object. 

Note You can control whether a linked object is updated manually or 
automatically. For more information, see "Maintaining Links" later in this 
chapter. 

You can link objects only from saved documents. For example, if you open 
Paintbrush and create a drawing, you must save it as a file before you can link the 
drawing to another document. 
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The following illustration shows how to link a Paintbrush object to a Write 
document. 

Copy the saved object onto the 
Clipboard by using the Copy 
command in the source document. 

This is the source document. 

This is the destination document, 
which now contains the linked object. 

After an object has been 
copied onto the Clipboard, 
you link it to your destination 
document by choosing 
the Paste Link command. 
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The following procedure describes how to link a Paintbrush object to a Write 
document. 

~ To link a Paintbrush object to a Write document 

1. In Paintbrush, open the document that contains the drawing you want to link. 
Or create a drawing. 

2. If you've created a drawing or made any changes to an existing drawing, save 
the drawing. 

3. Use the Pick tool to select the drawing. 

4. From the Edit menu, choose Copy. A copy of the drawing is placed onto the 
Clipboard. 

5. Start Write and open the document to which you want to link the drawing. 

6. Place the insertion point where you want the object to appear. 

7. From the Edit menu in Write, choose Paste Link. 

Some applications have a Paste Special command that, when chosen, displays 
a list of formats. You can choose which format you want the information 
displayed in. 

The linked object appears in your Write document. 

Editing a Linked Object 
Any changes you make to a linked object in a destination document appear in the 
source document and in every destination document that contains a link to that 
object. 

The following procedure describes how to edit a Paintbrush object that is linked 
to a Write document. 

~ To edit a linked Paintbrush object from within a Write document 

1. In the Write document, choose the linked object. Paintbrush opens, with the 
source document displayed. 

2. Edit the object as needed. The linked object in the Write document is updated 
as you make your changes. 

3. In Paintbrush, choose Save from the File menu. 

4. From the File menu, choose Exit. Paintbrush closes and you return to the Write 
document. 
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Maintaining Links 
After you create a linked object in a destination document, you can do the 
following: 

• Control whether the linked object is updated manually or automatically. 

• Create multiple links to the same object. 

• Cancel or delete a link. 

• Restore a broken link. 

• Change the format of an object. 

The following sections generally describe these tasks. For more information about 
performing these tasks by using a specific application, see the documentation 
supplied with the application. 

Controlling How Linked Objects Are Updated 
You can update a linked object either automatically or manually. A linked object 
in a destination document that is updated automatically is updated whenever the 
object in the source document changes. By default, linked objects are updated 
automatically. If you specify that a linked object is to be updated manually, the 
object in the destination document does not change when the object in the source 
document changes, but only when you choose to update it. 

Some applications have a Links command that, when chosen, displays a dialog 
box containing a list of existing links; you can then specify how a linked object is 
updated. Sound and animation objects are always updated automatically when 
you save changes to the source document. 

Creating Multiple Links 
There are two ways to create multiple links to an object. You can create each link 
by using the procedure described earlier in this chapter, or you can copy an 
existing linked object from a destination document. The result is the same
multiple destination documents will contain links to the object in the source 
document. You can edit the object from any document that contains a link to the 
source document, or you can change the source document without opening a 
destination document. Either way, the changes are reflected in every document 
that contains a link to the source document. 

To copy a linked object, select the object in one destination document, and then 
copy it onto the Clipboard. Then paste the object from the Clipboard into the 
document in which you want it to appear. 
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Canceling or Deleting a Link 
Many applications have a Links command that opens a dialog box from which 
you can cancel or delete existing links. 

You can cancel a link so that an object in a destination document no longer retains 
a link to the object in the source document but exists as a static copy. After you 
cancel a link, changes made in the source document no longer appear in the 
destination document, and you can no longer make changes to the source 
document from the destination document. The object still exists in both the 
source and other destination documents. 

To edit an object in a destination document after you cancel a link, you must 
cut and paste it into the application that was used to create it, make your changes, 
and then copy and paste the object back into the destination document. 

Deleting a link is different from canceling a link because both the link and the 
object itself are removed from the destination document. To delete a link, select 
the linked object in the destination document, and then cut it from the document. 

Restoring a Broken Link 
If you change the name of a source document that contains linked objects, the 
links between the destination document and those objects break because they 
refer to a filename that no longer exists. From the destination document, you must 
change the name of the document that the object is linked to so that the link will 
work properly again. 

Some applications have a Links command that, when chosen, displays a dialog 
box containing a list of existing links; you can then specify the name of the source 
document that the selected object is linked to. 

Note If for any other reason a link no longer works, try choosing the object again 
to open the source document. If the link still does not work, you may need to 
delete the linked object from the destination document and try linking it again. 

Changing the Format of an Object 
Because information is stored on the Clipboard in a variety of formats, you can 
transfer and share information between applications that use different formats. 
For example, on the Clipboard you can store a Paintbrush picture, unformatted 
text, or a document in Word for Windows format. 
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When you use the Copy command to place information onto the Clipboard, the 
source application sends the information in more than one format. When you 
paste the information from the Clipboard, the destination application selects a 
format that it can use. 

You can change the format that the destination application selects from the 
Clipboard by using the Paste Special command. For example, you might select a 
particular format if you know that people using the destination document have 
an application that can read only one format. When you choose the Paste Special 
command, a dialog box appears, listing other available formats for the 
information currently on the Clipboard, with the default format for the Paste 
command selected. You can select a different format and then choose the Paste 
button to paste or embed the object, or the Paste Link button to link it. (With some 
formats, choosing the Paste button may paste the object rather than embed it.) 

Choosing the Paste button from the Paste Special dialog box without selecting a 
different format is the same as choosing the Paste command directly from the Edit 
menu. 

Note Not all applications provide the Paste Special command. Write and 
Cardfile, both applications that support object linking and embedding, provide 
this command as described. Check your application's documentation to see how 
the Paste Special command is used. 

Using Object Packager 
There is another way to embed or link objects. Instead of embedding or linking 
the object in the form in which it was created, you can use Object Packager, an 
application in the Accessories group, to embed an icon that represents the object. 
This icon is called a package. A package can contain either an embedded object 
or a link to a document, but a package itself is always embedded. 

A package has the same properties as any embedded object. When you choose a 
package, the object it contains is displayed (as in the case of text or a Paintbrush 
object) or played (as in the case of a sound object). 

For example, suppose you are writing a report that refers to survey results on your 
topic. You want the survey results to be available to those who are interested, but 
easy to skip over for those who are not. Placing the results as a package in the 
context of your report makes the information easily accessible but not actually 
part of the text. To view the survey results, you simply open the package by 
choosing it. 
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Object Packager is also useful if you've embedded or linked a range of 
spreadsheet cells into a text document. You can package the cells so that 
they appear as an icon instead of as a range of cells within your text. 

You can use Object Packager to: 

• Package information into an object so that you can embed it in a destination 
document. 

• Package an MS-DOS command line into an object so that it can be embedded 
and run from within a destination document. 

• Customize the icon and label of the packaged object. 

For more information about Object Packager, see Help for Object Packager. 



CHAPTER 11 

MS-DOS Applications 

MS-DOS-based applications are designed to run with MS-DOS but not 
specifically with Windows. Most MS-DOS-based applications can run with 
Windows nonetheless. These applications are also sometimes referred to as 
non-Windows applications. 
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To run an MS-DOS-based application in the most efficient way, you may need to 
supply Windows with more information about the application. You do this by 
using a program information file (PIF). A PIF contains information about an 
MS-DOS-based application, such as how much memory it needs and how it uses 
various system components. 

Windows provides PIFs for many common MS-DOS-based applications, in 
addition to a default PIF with settings that work for most applications. If 
Windows does not provide a PIF and the settings in the default file do not 
work with your application, you need to create a PIF. You do this by using PIF 
Editor, an application in the Main group. 

This chapter explains what you need to know about setting up and running 
MS-DOS-based applications, describes how to use PIFs, and introduces PIF 
Editor. For more information about PIF Editor and all its options, see Help for PIF 
Editor. 

Setting Up an MS-DOS Application 
You set up an MS-DOS-based application to run with Windows just as you would 
other applications, by using Program Manager, File Manager, or Windows Setup. 
Regardless of which method you use, Windows sets up a PIF for the application. 
This section describes using the Setup program. For information about using 
Program Manager or File Manager to set up an application, see "Creating a 
Program Item" in Chapter 5, "Application Basics." 
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When you run the Setup program to install Windows, you can choose to have 
Setup search your hard disk for applications you have installed and create a PIF 
and an icon for each application. Setup gets the information it needs for each 
PIF by using information provided by Windows. 

When you set up an MS-DOS-based application after Windows is set up, the 
Windows Setup program searches your hard disk for a PIF to use with the 
application. If it finds one, it sets up the application and the PIF to work together. 
If Setup doesn't find a PIF and there is no information available to create one, 
Windows uses the default PIF, named _DEFAULT.PIF, when you start the 
application. 

~ To set up an MS·DOS-based application after Windows is set up 

1. In the Main group, choose the Windows Setup icon. 

2. From the Options menu, choose Set Up Applications. 

3. Select one of the two option buttons, depending on whether you want the 
Setup program to search your hard disk for applications or whether you want 
to specify an application. Then choose the OK button. 

4. If you selected Search For Applications, a dialog box appears, prompting you 
to select the MS-DOS path or individual drives that Setup should search. 
Select Path to search the directories specified by the path command in your 
AUTOEXEC.BAT file. Select a drive letter to search the entire contents of a 
hard disk. After making your selection, choose the Search Now button. 

At the completion of the search, Setup displays a dialog box listing the 
applications found. From the list of applications, select those you want to set 
up, and then select the Add button, or select Add All to set up all applications 
listed. Then choose the OK button. 

S. If you selected to specify an application, a dialog box appears. Type the 
application's path (the drive letter and directory where the program file is 
located) and filename, or choose the Browse button to select from a list of 
applications. Then choose the OK button in the Setup Applications dialog box. 

For each application you select, Setup adds a program-item icon to the 
Applications group. If there is no Applications group, Setup creates one. 

6. If Setup detects a naming conflict or multiple PIFs for one application, it 
displays a dialog box prompting you to specify the name of the application 
or PIF you want to use. 

If Setup doesn't find a PIF, it searches for the information it needs to create 
one. If it finds the information, a dialog box appears, asking whether you want 
Windows to use the information. When you choose the Yes button, a PIF is 
created. 
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Using Program Information Files 
After you set up your application, you can start using it with Windows. If 
the application doesn't perform properly, you probably need to modify the 
application's PIF. The following procedure describes how to do this. (You can 
also use this procedure to create a PIF.) 

Make sure you are modifying the PIF that Windows is using with your 
application. Sometimes you can determine this by using the Properties 
command on the File menu in Program Manager. The PIF is specified in 
the Command Line box in the Program Item Properties dialog box. 

Caution Changing PIF settings can affect how, and even whether, the 
application runs. 

~ To modify a PIF 

1. In the Main group, choose the PIF Editor icon. Depending on which mode 
Windows is running in, PIF Editor displays an untitled PIF that contains either 
standard-mode or enhanced-mode settings. (To create a PIF, you can change 
these options and then name the new file by using the Save As command on 
the File menu.) 

2. From the File menu, choose Open. In the File Name box, type the name of the 
PIF you want to open, or select a PIF from the list. Then choose the OK 
button. 

3. Change any options that are appropriate for your application. To receive Help 
for a selected option, press Fi while using PIF Editor. 

4. From the File menu, choose Save. Use the same base filename as the 
application. For example, if the application filename (program file) is 
WP .EXE, use WP .PIF as the name of the PIF. 

5. From the File menu, choose Exit. 

Using a Manufacturer-Supplied PIF 
Some software manufacturers provide a PIF for an application so that you can run 
the application with Windows. To determine whether a PIF has been supplied, 
contact the software manufacturer or search the application disks for a file that 
uses the same base filename as the application and has a .PIF extension. If you 
have PIFs from both Windows and the software manufacturer, use the PIF 
supplied by the manufacturer. 
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To use a PIF supplied with an application, copy the file to the directory where the 
application's files are located or the directory where you set up Windows. Then 
create a program item in Program Manager so that you can run the application 
from its PIF. For more information, see "Creating a Program Item" in Chapter 5, 
"Application Basics." 

Using the Default PIF 
The _DEFAULT.PIF file is located in your Windows directory. This PIF contains 
settings that work with most MS-DOS-based applications. Windows uses the 
_DEFAULT.PIF file when there is no other PIF available for your application. 

Because Windows might use the default PIF with more than one application, do 
not modify it; however, you can use the default PIF as a starting point for creating 
a PIF. Use the procedure for modifying a PIF described earlier in this chapter to 
open the _DEFAULT.PIF file and modify it. Then save it by using the Save As 
command and specifying a new filename. Your default PIF remains unchanged. 

Using Multiple PIFs for an Application 
You can create more than one PIF for an application if you run an application 
under different circumstances. For example, you can specify in a PIF how much 
expanded (EMS) memory an application has access to. By using two PIFs, you 
could give an application access to a large amount of EMS memory when you are 
using large data files but limit its use of memory when you are working with 
smaller files. 

To start the application, you choose the program-item icon for the PIF that 
contains the settings you want. 

~ To set up two PIFs for an application 

1. Create two PIFs. For more information, see the procedure for modifying a PIF 
earlier in this chapter. 

2. For each PIF, indicate the appropriate settings. In the example just cited, for 
one PIF you would set the EMS Memory: KB Limit setting to -1, which 
allocates as much expanded memory to the application as it requests. For 
the other PIF, you would set the EMS Memory: KB Limit setting to 1024K. 
(These options are available only in 386 enhanced mode.) 

3. Save each PIF with a unique filename. 

4. Create program-item icons for both PIFs in Program Manager, giving each 
a unique label. For more information, see "Creating a Program Item" in 
Chapter 5, "Application Basics." 
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Note Because you want to start the application from its PIF in this case, 
be sure to specify the PIF filename, not the program file, in the Command 
Line box. 

You then can choose either program-item icon to start the application. 

Starting an MS-DOS Application 
You start an MS-DOS-based application from Program Manager by choosing the 
application's program-item icon, or from File Manager by choosing its program 
file, a document associated with a program file, or the application's program 
information file (PIF). For detailed information about ways to start an application, 
see Chapter 5, "Application Basics." 

When you start an application from Program Manager or File Manager, Windows 
searches for a PIF with the same base filename. It searches directories in the 
following order: the directory where the application's files are located, the current 
working directory, the Windows directory, the SYSTEM subdirectory of the 
Windows directory, and then the directories specified by the path command in 
the AUTOEXEC.BAT file. 

You can also run MS-DOS-based applications, such as memory-resident 
programs (TSRs), by using MS-DOS Prompt. However, when you start an 
MS-DOS-based application from the command prompt, the DOSPRMPT.PIF file 
is used instead of the application's PIF. If your application requires unique PIF 
settings and has its own PIF, start the application from Program Manager or File 
Manager. 

Working with MS-DOS Applications in 386 Enhanced 
Mode 

This section describes features that you use only when you are running 
MS-DOS-based applications in 386 enhanced mode. To determine which mode 
Windows is running in, choose the About command from the Help menu in 
Program Manager. The mode is displayed near the bottom of the dialog box. 

Running an MS-DOS Application in a Window 
You can run most MS-DOS-based applications in a window when Windows is 
running in 386 enhanced mode. You cannot run an MS-DOS-based application 
in a window if Windows is running in standard mode. When the application is 
running in a window, you can move and size the window, and you can share 
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information with other applications by using the Clipboard. For more information 
about using the Clipboard with MS-DOS-based applications, see "Copying 
and Pasting Information by Using the Clipboard" later in this chapter. 

~ To switch an MS-DOS-based application between a window and a full screen 

• While working with the MS-DOS-based application, press ALT+ENTER. 

If the application was running in a full screen, it now appears in a window. If 
the application was running in a window, it now appears in a full screen. 

Tip You can specify that you want an application to run in a window every 
time you start it. To do this, select the Windowed option button in the 
application's PIF. 

Changing Settings for a Running Application 
You can make temporary changes to the wayan MS-DOS-based application runs. 
Your changes stay in effect until you quit the application. 

~ To change settings for a running application 

1. If your MS-DOS-based application is running in a full screen, press CTRL+ESC 

to reduce it to an icon, or press ALT +ENTER to run it in a window. 

2. From the Control menu, choose Settings. A dialog box appears, displaying the 
settings you can modify. 

Tip To both run the application in a window and open the Control menu in 
one step, press ALT+SPACEBAR. (If your application uses ALT+SPACEBAR 

for another function, you cannot open the Control menu by pressing 
ALT+SPACEBAR.) 

3. Change the appropriate setting(s), and then choose the OK button. The options 
(Display, Tasking, Priority, and Terminate) are described in the following 
sections. 

For information about using the Control menu, see Chapter 4, "Windows Basics." 



Chapter 11 MS· DOS Applications 159 

Display Options 
Use the Display options to specify whether an application appears in a window or 
in a full screen. 

Use 

Window 

Full Screen 

To 

Run the application in a window. 

Run the application in a full screen. 

Tasking Options 
Use the Tasking options to control how an application shares system resources 
with other applications. You can select one or both of the following check boxes. 

Use 

Exclusive 

Background 

To 

Suspend other applications while the application is the active one. 
(If the application is running in a window, Windows-based 
applications continue to run, but other MS-DOS-based 
applications are suspended.) 

Run the application in the background while you work with other 
applications. (This application is suspended when an application 
that has the Exclusive option set is the active application.) 

You can also set these options in the application's PIF by using PIF Editor. For 
more information about these and other PIF Editor options, see Help for PIF 
Editor. 

Priority Options 
Use the Priority options to specify how much processor time the application 
should receive, relative to other applications. Giving the application a high 
priority makes it run faster than applications with lower priorities; conversely, 
giving it a lower priority slows it down. 

Use 

Foreground 

Background 

To 

Control how fast the application runs, relative to other applications, 
when it is the active application. You can type a value from a to 
10000; the default foreground priority is 100. 

Control how fast the application runs, relative to other applications, 
when it is not the active application. For this option to take effect, 
you must also select the Background check box under Tasking 
Options. You can type a value from a to 10000; the default 
Background priority is 50. 

You can also set these options in the application's PIF by using PIF Editor. For 
more information about these and other PIF Editor options, see Help for PIF 
Editor. 
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Terminate Option 
Use the Terminate button to quit an MS-DOS-based application when you 
cannot use the usual methods from within the application-for example, when 
the application does not respond to the commands you type. 

Caution Use the Terminate button only as a last resort, because it can result 
in lost data. If you cannot open the Control menu in your MS-DOS-based 
application, you can press CTRL+ALT +DEL to quit the application. Windows 
displays a message confirming the action. Press ENfER to quit the application. 

Changing the Size of the Font 
When you are running an MS-DOS-based application in a window, you can 
change the size of the font displayed in the window by using the Fonts command 
on the Control menu. 

~ To change the size of the font 

1. If your MS-DOS-based application is running in a full screen, press CTRL+ESC 
to reduce it to an icon, or press ALT+ENTER to run it in a window. 

2. From the Control menu, choose Fonts. 

3. Select a font size. The Selected Font box displays the font size. 

4. If you want to use this font size whenever you run this MS-DOS-based 
application in a window, select the Save Settings On Exit check box. 

5. Choose the OK button. 

Copying and Pasting Information by Using the Clipboard 
The methods you use to copy and paste information between MS-DOS-based 
applications are different from those you use with Windows-based applications. 
With MS-DOS-based applications, you use commands on the Control menu. 

~ To copy selected information from an MS-DOS-based application 

1. If the MS-DOS-based application you want to copy from is running in a full 
screen, press ALT+ENTER to run it in a window. 

2. From the Control menu, choose Edit. 

3. From the Edit cascading menu, choose Mark. 

4. Select the information you want to copy. 

5. Click using the right mouse button, or press ENTER, to copy the selected 
information onto the Clipboard. You can also choose the Copy command from 
the Edit menu. 
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The method you use to paste information into an MS-DOS-based application 
depends on whether the application is running in a window or in a full screen. 

~ To paste information into an MS·DOS application running in a window 

1. Make sure the information you want to paste is on the Clipboard. To view the 
contents of the Clipboard, choose the Clipboard Viewer icon in the Me in 
group. 

2. Switch to the destination application. 

3. Place the insertion point where you want the information from the Clipboard 
to appear. 

4. Open the application's Control menu. 

5. From the Control menu, choose Edit. 

6. From the Edit cascading menu, choose Paste. 

The following procedure can be used in either standard or 386 enhanced mode. 

~ To paste information into an MS·DOS application running in a full screen 

1. Make sure the information you want to paste is on the Clipboard. To view the 
contents of the Clipboard, choose the Clipboard Viewer icon in the Main 
group. 

2. Switch to the destination application. 

3. Place the insertion point where you want the information from the Clipboard 
to appear. 

4. Press ALT+SPACEBAR to open the application's Control menu. 

Note If Windows is running in standard mode, or if your application uses 
ALT+SPACEBAR for another function, you cannot open the Control menu by 
pressing ALT+SPACEBAR. Press CTRL+ESC. The application will then appear as 
an icon near the bottom of the Windows desktop. (Task List will also appear.) 
Click the icon to open the application's Control menu. 

5. From the Control menu, choose Edit. 

6. From the Edit cascading menu, choose Paste. 

Giving an Application Exclusive Use of Resources 
You can specify that an application has exclusive use of system resources when 
it is the active application. For example, you might want to do this to ensure that 
an application runs as quickly as possible, without being slowed down by 
applications running in the background. Also, some applications use hardware 
in such a way that they cannot run at the same time as other applications. 
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There are two ways to give an application exclusive use of resources: 

• Use PIP Editor to open the application's PIP, and then select the Exclusive 
check box. When you use this setting, no other applications can run when 
that application is active. This setting takes effect every time you start the 
application. 

• If the application is running in a window or as an icon, use the Settings 
command on the application's Control menu. Select the Exclusive check box 
(under Tasking Options). The application gets exclusive use of resources only 
until you quit the application. The next time you start the application, the 
setting is not in effect. 

Running an Application in the Background 
You can run an application in the background (calculating numbers or reading a 
large file, for example) while another application is in the foreground. 

There are two ways to run an application in the background: 

• Use PIP Editor to open the application's PIP, and then select the Background 
check box. This setting takes effect every time you run the application. 

• If the application is running in a window or as an icon, use the Settings 
command on the application's Control menu. Select the Background check 
box (under Tasking Options). The application runs in the background only 
until you quit the application. 

Note If an MS-DOS-based application is running in the foreground and the 
Exclusive check box is selected in its PIP, other applications cannot run in the 
background (even if the Background check box is selected in their PIPs). 

Using Memory-Resident Programs 
If you want a memory-resident program (TSR) to be available to all Windows
based and MS-DOS-based applications, start it before you run Windows. The 
program is then available to all applications you run with Windows; however, the 
memory it uses is not available to other applications. In general, most memory
resident programs are started from your CONPIG.syS or AUTOEXEC.BAT file. 
(These files are located in the root directory of your startup drive.) The files 
indicate to MS-DOS which commands and programs to run when you start your 
computer. 

If only one application requires a memory-resident program, you might not want 
to start the program from the CONPIG.SYS or AUTOEXEC.BAT file. Instead, 
you can create an MS-DOS batch program that starts the memory-resident 
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program and then the application. You can run that batch program from Windows. 
For more information about using batch programs with Windows, see your 
MS-DOS documentation. 

Running Pop-up Programs 
A pop-up program is a memory-resident program that is loaded into memory but 
isn't visible until you press a certain key combination. You should start pop-up 
programs, such as Borland SideKick, only after starting Windows. By doing so, 
you can switch to and from that program as you would any MS-DOS-based 
application (rather than by using its "pop-up" shortcut key), and the pop-up 
program can share memory with Windows and other applications. 

~ To use a pop-up program with Windows 

1. If necessary, create a PIF for the pop-up program. 

2. Start the pop-up program as you would any application-for example, by 
setting it up as a program item in Program Manager and then double-clicking 
its icon. When you start the pop-up program, Windows displays a message 
confirming that the program is loaded. 

For information about setting up and starting applications, see Chapter 5, 
"Application Basics." 

3. Press the appropriate key combination to make the program appear on your 
screen. 

A few pop-up programs require a key combination that is usually reserved for 
Windows (for example, ALT+ESC). In this case, you can edit the PIF for the 
pop-up program, selecting the appropriate key-combination check box in the 
Reserve Shortcut Keys area in the Advanced Options window. When you 
press the key combination, the pop-up program appears instead of the usual 
Windows function being performed. 

Note You can switch to and from a pop-up program by using Task List (press 
CTRL+ESC) rather than by pressing the key combination that usually displays the 
program. 
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CHAPTER 12 

Customizing Windows 

After setting up Windows, you may want to change some of your system settings. 
For example, you may want to use a different color scheme or add some fonts. 
This chapter describes the following tasks that you can perform to customize 
Windows: 

• Changing your desktop colors, pattern, or wallpaper 

• Using a screen saver 

• Adding and removing fonts 

• Changing your network settings 

• Using sounds and setting MIDI options 

• Changing your code page 

For information about other customization tasks, see "More Ways to Customize 
Windows" at the end of this chapter. 

Customizing Desktop Colors 
By using the Colors option in Control Panel, you can customize the colors used 
for your desktop, the area of the screen in which windows, icons, and dialog 
boxes appear. You can change the color of an individual screen element or 
several elements at once. You can also create your own colors. 

Choosing a Color Scheme 
Windows provides several predefined color schemes. A color scheme is a 
collection of complementary colors. Some color schemes include only solid 
colors; others also include nonsolid colors. 
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A solid color is directly supported by your display adapter. Video graphics 
adapters (VGAs) support 16 solid colors, and 256-color adapters support 20 
solid colors. Both types of adapters support hundreds of non solid colors. 
A nonsolid color is produced by a pattern of colored dots. 

~ To choose a color scheme 

• In the Control Panel window, choose the Color icon. In the Color dialog box, 
select the color scheme you want to use, and then choose the OK button. 

For help with the Color dialog box, choose the Help button or press Pl while 
using the dialog box. 

This box displays the current color 
scheme. Clicking the down arrow opens 
a list of color schemes to select from. 

Choosing this button deletes 
the current color scheme. 

The sample screen shows 
the current color selections. 

When choosing a color scheme, note the following: 

• Using a color scheme that has only solid colors (such as Windows Default) 
may increase the speed at which Windows redraws your screen. 

• If you are using a plasma display adapter, you might want to use the Plasma 
Power Saver color scheme, which uses darker colors that require less power. 

• If you are using a liquid crystal display adapter (LCD), colors may appear in 
reverse video. In this case, you might want to use one of the color schemes 
whose names start with LCD. 

• Control Panel uses the solid color closest to the selected nonsolid color for 
several screen elements. This will be reflected in the sample screen. 
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Note Some LCD monitors have switches you can use to set the screen display so 
that it does not appear in reverse video. For other computers with LCD monitors, 
you need to press a key to change the screen display. In this case, you may need 
to quit Windows before you can change the display. 

If you use only a few color schemes, you can shorten the list of selections by 
removing schemes. The only color scheme you cannot remove is Windows 
Default. 

Changing the Color of Screen Elements 
You can change the color of one or more screen elements (parts of a window) and 
then save the changes you make. 

~ To change the color of a screen element 

Clicking an element 
in the sample screen 
selects it so that you 
can change its color. 

• In the Color dialog box, choose the Color Palette button. The dialog box 
expands as shown. Select the colors you want for particular screen elements, 
and then choose the OK button. 

Choosing this button saves the current color selections to 
the current color scheme or to a new scheme that you specify. 

This box displays the selected screen 
element name. Clicking the down arrow 

opens a list of elements you can select from. 

110 0 •• 11 
.OB ••• 
• 0 •••••• 

•••••••• •••••••• ••••• W.O 

Selecting a color in the Basic Colors palette 
changes the color of the selected screen element. 
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Creating Your Own Colors 
You can create up to 16 additional colors at a time and use them in your color 
schemes. 

~ To create your own color 

Dragging the cursor 
in the color refiner 

box creates a color. 

• In the expanded Color dialog box, choose the Define Custom Colors button. In 
the Custom Color Selector dialog box, create colors, and then choose the Add 
Color button to add them to the Custom Colors palette. Then choose the Close 
button. 

For help with the Custom Color Selector dialog box, choose the Help button or 
press PI while using the dialog box. 

Dragging the cursor in this 
bar adjusts the color brightness. 

II 

.0~HJIl0 ••• 
• 0 110 ••• 

Double-clicking this .0 ••••• 
square or pressing •••••••• 
ALTtOselectsthe •••••••• 
~~~ ••••• m.o 

is closest to the HMe: @III Red: ~ 
new color. ----,,-m:==_ ~ r;:;;-liI Colors: 

~"'-----' s.al:~li,een:~ 00000000 
ColodSQlid lum: ~ DJue: @DIl 00000000 

1::-.. m~.'".'."'''.''I .. tW:a., .!~,'¢! 

Typing values or clicking the arrows 
in these boxes can also create a color. 

Choosing this button adds the new color to 
the selected box in the Custom Colors palette. 

Changing Desktop Settings 
By using the Desktop option in Control Panel, you can change the screen 
background and customize the way that windows and icons appear on your 
screen. When you choose the Desktop icon, the Desktop dialog box appears. 



Select this check 
box to enable fast 
switching among 

applications. 

Use this area to 
select a wallpaper 

(bitmap) for the 
desktop. 
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Use this area to select or 
create a pattern for the desktop. 

Saver-------------, 

Ngme:,(None) iii 
Q.elay: ~ Minutes 

Wallpaper 

file:' '(N-on-e-) -'I [II 
Icons-----, 

fuiacing: '75 fJI Pixels 

[g] ~rap Title @ tenter 0 Die 

Sizing Grid 

.!!ranularity: 

J!.order Width: 

Cursor Blink Rate 

Slow Fast 

Use this area to set an invisible grid 
for aligning windows and icons and 
to change the window-border width. 

Use this area to select a 
screen saver to display 
when Windows is running 
but not being used. 

Use this area to adjust 
spacing between icons 
and to break long icon 
titles to a second line. 

Use this area to specify 
how fast you want the 
cursor to blink. 

This section describes procedures for using patterns, wallpaper, and screen savers. 
For information about the other desktop options, choose the Help button or press 
Fl while using the Desktop dialog box. 

Displaying Desktop Patterns 
When you first start Windows, the desktop is a solid color. You can replace the 
color with a predesigned desktop pattern or, if you are using a mouse, you can 
create a pattern of your own. 

The background color for the pattern is the same as the Desktop color. The 
foreground color (the dots that make up the pattern) is the same as the color of 
the Window Text screen element. For information about setting these colors, see 
"Customizing Desktop Colors" earlier in this chapter. 

Note If the Desktop and Window Text colors are the same, you will not see a 
pattern on your desktop. 
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~ To choose a pattern 

• Under Pattern in the Desktop dialog box, open the Name list, select a pattern, 
and then choose the OK button. 

If you are using a mouse, you can change an existing desktop pattern or create one 
and save it with a new name. You cannot change a pattern by using the keyboard. 

~ To change or create a pattern 

The results of your 
changes appear here. 

• In the Desktop dialog box, choose the Edit Pattern button. In the Desktop-Edit 
Pattern dialog box, create or edit a pattern, and then choose the OK button. 

For help with the Desktop-Edit Pattern dialog box, choose the Help button or 
press Pi while using the dialog box. 

This box displays the current pattern. Clicking 
the down arrow opens a list of patterns. You 
can type a new name for a pattern you create. 

Clicking in this cell changes 
the selected pattern 

----I-- or creates a new one. 

Choosing these buttons adds 
a new pattern, or changes or 
removes the selected pattern. 

The pattern you define is repeated as many times as necessary to completely fill 
the background. 

If you use only one or two patterns, you can shorten the list of selections by 
removing unneeded patterns. 

Displaying Custom Wallpaper 
Instead of a desktop color or pattern, you can display a wallpaper. You can use 
any bitmap file that has a .BMP extension, even an elaborate one such as a 
scanned color photograph. If you select both a wallpaper and a pattern, the 
wallpaper appears as your desktop background. The pattern appears as the 
background used to highlight icon titles on your desktop. 

You can also use Paintbrush or another drawing application to produce .BMP 
files. 
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~ To choose a bitmap to display as wallpaper 

1. Under Wallpaper in the Desktop dialog box, open the File list, and then select 
a bitmap. Or, in the File box, type the full path for the bitmap if it is not in 
your Windows directory. 

2. Select the Center or Tile option button, and then choose the OK button. 

The Center option positions the bitmap at the center of the desktop. The Tile 
option repeats the bitmap as many times as necessary to cover the desktop. 
This is useful if you are using small bitmaps. 

If the original bitmap is too large to fit on the screen or takes up too much 
memory, Windows does not display it. 

Note Windows uses more memory when displaying wallpaper than when 
displaying a solid color or a pattern on the desktop. If you receive a memory 
error when running an application, you can try changing to a color or pattern, 
or you can select None in the Pattern or Wallpaper box. 

~ To remove a wallpaper from the list 

• Delete the bitmap file from your Windows directory. 

USing a Screen Saver 
If you want, you can select a screen saver, a moving pattern or bitmap, to appear 
on your screen after your computer has not been used for a specified amount of 
time. Screen savers can reduce the wear on your screen and provide some security 
for your system. Windows provides several screen savers. 

~ To choose a screen saver 

1. Under Screen Saver in the Desktop dialog box, open the Name list, and then 
select a screen saver. 

2. To see how the screen saver looks, choose the Test button. To end the test, 
move the mouse or press any key. 

3. In the Delay box, click the up or down arrow to increase or decrease the 
number of minutes of inactivity you want to elapse before the screen saver 
appears. Or type a number larger than zero. 

4. If you want to customize the screen saver, choose the Setup button. (If the 
screen saver cannot be customized, a message notifies you that there are no 
options to set.) 
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5. In the setup dialog box for the screen saver, change any settings you want. 

If you want to specify a password, select the Password Protected check box, 
and then choose the Set Password button. Complete the Change Password 
dialog box, and then choose the OK button twice to return to the Desktop 
dialog box. 

For information about the setup or Change Password dialog box, choose the 
Help button or press Fl while using the dialog box. 

6. Choose the OK button. 

~ To return to Windows when the screen saver is active 

• Move the mouse or press any key. If you have specified a password, a dialog 
box appears, in which you must type the password before you can return to 
Windows. This ensures that unauthorized users do not have access to your 
work. 

Note If an MS-DOS-based application is the active application, the screen saver 
does not appear, even after the specified number of minutes have elapsed. 
Windows screen savers will not appear if Windows is not running. 

Using Fonts 
A font, or typeface, is a collection of characters-letters, numerals, symbols, 
and punctuation marks-that have common characteristics. Fonts have various 
sizes and styles. Font sizes indicate the height of a character and are measured in 
points, a point equaling 1/72 of an inch. Font styles include bold and italic. 

~~~~~~~~~~~~~~~~ 
look you want for a document-professional, highly graphical, or draft quality. 
The font size and style also determine how much text can fit on a page. 

Using Windows Fonts and Printer Fonts 
When you set up Windows on your computer, several kinds of fonts are installed. 
These fonts include: 

• Screen fonts, which are used by Windows to display information such as 
the text that appears in application windows and dialog boxes. Screen fonts 
come in predefined point sizes. Screen fonts also print on some printers (for 
example, dot-matrix printers). 
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• Plotter fonts, which are scalable to any point size and are most often used 
for displaying information on the screen and for plotting graphics with pen 
plotters. Plotter fonts can also be used with some dot-matrix printers; however, 
the print quality may not be as good. 

• True Type fonts, which are scalable to any point size and look the same on the 
screen as they do printed. For information about TrueType fonts, see "Using 
TrueType Fonts" later in this chapter. 

Printers include built-in fonts for printing. These fonts are known as printer 
fonts. The number of printer fonts that a printer supports varies according to the 
capabilities of the printer. Dot-matrix and some laser printers include one or two 
printer fonts; PostScript-compatible printers include several printer fonts. When 
you install a printer, the printer fonts appear in the Font list of the Fonts dialog 
box in applications such as Write. 

USing Cartridge Fonts and Soft Fonts 
You can also use soft fonts and cartridge fonts with your printer. To use soft fonts, 
you need to install them by using the installation program that comes with your 
fonts package. If an installation program was not provided with your fonts 
package and you are using a Hewlett-Packard LaserJet or DeskJet (PCL) printer, 
you can use the Font Installer program provided with Windows. 

To use cartridge fonts, you need to insert one or more font cartridges into the 
cartridge slots on your printer. You might also need to install them, if support 
for the fonts is not built into the printer driver for your printer. If you need to use 
Font Installer, you can do so while setting printing options. For more information 
about setting printing options and using Font Installer, choose the Help button 
or press FI while using the Printer Setup or Font Installer dialog box. For more 
information about printer drivers, see Chapter 8, "Print Manager." 

Viewing Printer, Soft, and Cartridge Fonts on the Screen 
Because various printers and screens display information at different resolutions, 
many printer drivers and cartridge- and soft-font packages include matching 
screen fonts so that the fonts look the same on your screen as they do printed. 
If matching screen fonts are not included with your font cartridge or soft-font 
package, check with your printer or font manufacturer to determine whether they 
are available. 

If you use a cartridge, soft, or printer font to format text, and no matching screen 
font is available, one of the screen, plotter, or TrueType fonts supplied with 
Windows is used to display text on the screen. Though the font on the screen 
may not look exactly like the printed font, the substitute font creates line lengths 
and page breaks on the screen similar to those in the printed document. 
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Using TrueType Fonts 
If you use True Type fonts in your documents, Windows and all Windows-based 
applications display the fonts on the screen exactly as they appear when printed
there is no need to install matching screen fonts. In addition, when you use 
TrueType fonts, your documents become more portable: The fonts look the 
same printed on different printers, as long as you use the same application and 
print at the same resolution. 

Note If you print at a different resolution or print a document from an older 
application, line and page breaks might change. 

Several TrueType fonts are installed automatically when you set up Windows. 
They are immediately available to your printer and to the applications (such as 
Write and Paintbrush) included with Windows. In these applications, TrueType 
fonts appear with a TT symbol next to them in the Font list in the Fonts dialog 
box. If you purchase additional TrueType fonts, you can add them to Windows 
and your Windows-based applications by using the Fonts option in Control Panel. 

Adding and Removing Fonts 
When you install a printer driver, any screen fonts matching the printer fonts that 
your printer supports are also installed. If you are using cartridge or soft fonts, 
your font manufacturer usually supplies a program for installing screen fonts. 
(The program that installs the cartridge or soft fonts may install the screen fonts 
automatically.) If no program is provided for installing screen fonts, you can use 
the Fonts option in Control Panel to install them. You can also use the Fonts 
option in Control Panel to set True Type font options. 

If you find that you use only True Type fonts in your documents, you can use the 
Fonts option to prevent all other fonts-screen, plotter, and printer fonts-from 
appearing in the font lists of your Windows-based applications. 
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~ To add a font and set TrueType options 

1. In the Control Panel window, choose the Fonts icon. The Fonts dialog box 
appears. 

The kind of font (for example,TrueType 
or plotter) is displayed in parentheses. 

Screen fonts are designated by the 
screen resolution (for example, VGA res). 

This box displays a list of installed fonts. 

BbCcXxYyZz 123 

This is a scalable TlUeType lont which can be 
displayed on the screen and printed on your printer. 

Size 01 Font on Disk: 69 KB 

2. Choose the Add button. 

I-----+_ This box shows 
a sample of the 
selected font. 

3. Open the Drives list, and then select the drive that contains the fonts you want 
to add. Then select the directory where the fonts are located. 

4. From the List Of Fonts box, select the fonts you want to add. You can extend 
the selection to add several fonts at once. Or, to add every font in the list, 
choose the Select All button. 

5. If you have limited disk space, you can clear the Copy Fonts To Windows 
Directory check box. You can then use the fonts directly from the directory in 
which they are located, without copying them to your Windows directory. For 
example, this is useful if you are using a CD-ROM that contains hundreds of 
TrueType fonts. 
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If the fonts are located on a network or on a removable disk drive, it is 
recommended that you select the Copy Fonts To Windows Directory check 
box. This ensures that the fonts will always be available, even if the source 
drive is removed or the fonts are removed from the network. 

6. Choose the OK button. Then choose the Close button, unless you want to set 
TrueType options. 

7. To set TrueType options, choose the TrueType button in the Fonts dialog box. 

8. To turn off TrueType fonts, clear the Enable TrueType Fonts check box. Or, to 
use TrueType fonts exclusively, select the Show Only TrueType Fonts In 
Applications check box. Then choose the OK button. 

9. Any change you make to the Enable TrueType Fonts option does not take 
effect until you restart Windows. To restart, choose the Restart Now button. 

Note Selecting the Show Only TrueType Fonts In Applications check box does 
not turn off non-True Type fonts. It only prevents them from appearing in the fonts 
lists of your Windows-based applications. You can still use these applications to 
view and print documents that contain other fonts. Some applications do not 
support the listing of TrueType fonts exclusively. If you select the Show Only 
True Type Fonts In Applications check box and no TrueType fonts appear in your 
application, do not use this option. 

If you are no longer using a font, you can remove it. Removing fonts frees 
memory for use by your applications. 

Caution The MS ® Sans Serif font set is used for most Windows dialog boxes. Do 
not remove this font; if you do, the text in dialog boxes will be difficult to read. 

~ To remove a font 

1. From the Installed Fonts list, select the font you want to remove, and then 
choose the Remove button. 

2. If you want to delete the font files from your disk in addition to removing the 
fonts from memory, select the Delete Font File From Disk check box. Then 
choose the Yes button. Or, if you are removing several fonts at once, choose 
the Yes To All button. 



Chapter 12 Customizing Windows 177 

Caution If you chose not to copy the fonts to your Windows directory (if you 
cleared the Copy Fonts To Windows Directory check box in the Add Fonts dialog 
box), do not select the Delete Font File From Disk check box. If you do, you may 
delete the fonts from their source disk, making them unavailable to anyone else. 

Using Sound 
Control Panel provides several options to control how sound works in Windows. 
By using these options, you can perform tasks such as assigning different sounds 
to system and application events. If you are using a sound device that has Musical 
Instrument Digital Interface (MIDI) capabilities, you can specify MIDI settings 
for your device. If you are not using such a device, the MIDI Mapper icon does 
not appear in the Control Panel window. 

To use sound in Windows, you should have a sound card installed that conforms 
to the Multimedia Personal Computer (MPC) specifications. To use MIDI sound 
capabilities, your sound card should include a built-in MIDI synthesizer, or you 
should have a synthesizer connected to the MIDI output port of your sound card. 
You also need to install the sound drivers that control your sound card and your 
MIDI devices. For information about installing and configuring drivers for your 
sound devices, see Chapter 13, "Configuring Hardware." 

Assigning Sounds to Events 
By using the Sound option in Control Panel, you can assign waveform sounds 
(stored in files that have the .WAV extension) to different application and system 
events. For example, you can select a sound to play whenever you start Windows. 
Other sounds playas specified by the application you are using. For example, 
some applications play the sound assigned to the Exclamation or Asterisk event 
whenever a warning message is displayed. 

If you do not have a sound card that supports the waveform sound format, or if the 
sound driver is not configured properly, Windows uses only a warning beep when 
it encounters an error or when you attempt to do something your computer does 
not recognize. 
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~ To assign sounds to events 

Clicking this check 
box turns all sounds 
on or off, except for 

Windows Exit and 
Windows Start. 

• In the Control Panel window, choose the Sound icon. In the Sound dialog box, 
select which sounds you want to use for which events, and then choose the OK 
button. 

For help with the Sound dialog box, choose the Help button or press Fl while 
using the dialog box. 

Enable System Sounds 

You select an event that you want to assign a sound to. 

You select a sound file in this list. 
If you don't want to assign a sound 
to the selected event, select None. 

Choosing this 
button or 
double-clicking 
the filename 
plays the sound. 

Changing MIDI Settings 
If you are using a sound device, such as a synthesizer, that has Musical Instrument 
Digital Interface (MIDI) capabilities, you can specify MIDI settings for your 
device. 

Windows supports two standards for playing MIDI information that is generated 
by an application or stored in a MIDI file. These standards, the General MIDI 
guidelines and the Microsoft authoring guidelines for MIDI files, both include 
certain instrument patch settings and key assignments, as defined by the General 
MIDI specifications. However, they differ in the channel settings they require. 

When you set up Windows, the Setup program installs MIDI setups that support 
both standards for playing MIDI information on common combinations of sound 
cards and synthesizers. These setups include key maps, patch maps, and channel 
settings that ensure that MIDI information plays accurately on your synthesizer. 
You can use the MIDI Mapper option in Control Panel to select a different MIDI 
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setup, create a new setup, or edit key assignments, patch maps, or channel 
mappings for an existing setup. This section describes how to select a MIDI setup. 
For information about how to edit or create a MIDI setup, see Help for Control 
Panel. 

Caution To use MIDI Mapper, you should have a basic understanding of MIDI 
concepts and terminology. It is recommended that you not use MIDI Mapper to 
edit or create MIDI setups unless you are experienced with MIDI and understand 
the results of the changes you make. 

Selecting a MIDI Setup 
If you are using an application, such as Media Player, that uses MIDI setups to 
play MIDI files, you need to select the MIDI setup for the synthesizer that will be 
playing the file. 

~ To select a MIDI setup 

• In the Control Panel window, choose the MIDI Mapper icon. In the MIDI 
Mapper dialog box, select the name of the setup you want to use, and then 
choose the Close button. 

For help with the MIDI Mapper dialog box, choose the Help button or press FI 
while using the dialog box. 

Description: 

Make sure the Setups option button is selected. 

This box displays the current MIDI 
setup. Clicking the down arrow 
opens a list of setups to choose from. 
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The following table lists the MIDI setups provided with Windows and describes 
the setups you should use with your synthesizer and MIDI output port. 

Use 

Ad Lib 

Ad Lib General 

LAPC1 

MT32 

Proteus/1 

Proteus General 

Extended MIDI 

General MIDI 

For 

The Ad Lib or Ad Lib-compatible synthesizer included on your 
sound card. This setup uses channels 12-16 (base-level channels). 

Same as for Ad Lib; however, this setup uses all 16 channels. 

The Roland synthesizer included on your LAPC1 sound card. 
This setup uses all available LAPC1 channels. 

Same as for LAPC1; however, this setup uses all available MT32 
channels. 

The E-mu Systems Proteus/1 synthesizer connected to the 
Sound Blaster MIDI output port. This setup uses channels 
1-10 (extended-level channels). 

Same as for Proteus/I; however, this setup uses all 16 channels. 

Any General MIDI synthesizer, such as the Roland Sound Canvas 
(SC-55), connected to the Sound Blaster MIDI output port. This 
setup uses channels 1-10 (extended-level channels). Use this 
setup to play MIDI files authored according to Microsoft 
guidelines. 

Same as for Extended MIDI; however, this setup uses all 16 
channels. Use this setup to play MIDI files authored according 
to General MIDI guidelines. 

If you plan to play MIDI files authored according to General MIDI guidelines, use 
a "general" setup for your synthesizer. If you plan to play MIDI files authored 
according to Microsoft guidelines, use the other setup. 

If you are using a synthesizer that is connected to a MIDI output port other than 
Sound Blaster or a Sound Blaster-compatible port, you need to edit the setup to 
change the port assignments. If you are using a synthesizer that is not included in 
the list, you may need to create a MIDI setup for it. For information about editing 
or creating MIDI setups, see Help for Control Panel. 

Setting Network Options 
If you installed a network when setting up Windows, the Control Panel window 
includes a Network icon. You can choose this icon to view information about 
your network or to specify settings available for your particular network. 
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When you choose the Network icon, a dialog box specific to your network 
appears. The following are some of the tasks you might be able to perform by 
using this dialog box: 

• Signing on and off the network 

• Changing user ID and password 

• Sending messages to other network users 

• Restoring network connections when you start Windows 

For information about the tasks you can perform by using your network, see your 
network documentation and Help (if available) in the dialog box. 

Changing the Code Page 
In Windows, the Codepage setting determines the character set (the characters for 
the language you are using on your system) to use for your keyboard layout, for 
filenames that include extended characters, and for MS-DOS-based applications 
running in a window. When Windows is first set up on your system, Setup detects 
the code page used by MS-DOS and sets up Windows to use the same one. If you 
subsequently change your MS-DOS code page, you need to update the Codepage 
setting in Windows to match it. 

You update the Codepage setting by using the Windows Setup program. 

~ To change to another code page 

1. Quit Windows. 

2. Change to your Windows directory, type setup at the command prompt, and 
then press ENTER. 

3. In the System Information screen, select the Codepage setting (use the UP 

ARROW or DOWN ARROW key), and then press ENTER. A list of the available 
code pages appears. 

4. Select the code page you want to use, and then press ENTER. 

5. When the System Information screen appears, press ENTER again. Setup asks 
you to confirm that you want to change code pages. Press F3 to verify the 
change. 

6. Setup prompts you for the disk containing the new code-page file. 

If you are changing to a code page that you have used before, Setup asks you 
whether you want to use a new code-page driver or the one that is currently on 
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your computer. If you have an updated driver, press ESC; otherwise, press 
ENTER. Insert the disk or type the drive and directory where the driver file is 
located, and then press ENTER. 

Mter Setup copies the file, you return to the command prompt. The new code 
page takes effect the next time you start Windows. 

More Ways to Customize Windows 
You can also use Control Panel and Windows Setup when you need to perform 
the following tasks: 

• Setting up a network for use with Windows 

• Customizing the mouse and other pointing devices 

• Adjusting the keyboard speed 

• Setting the system date and time 

• Specifying international settings 

• Creating and editing MIDI setups 

• Adding and removing Windows components 

Help for Windows Setup provides information about adding and removing 
Windows components and setting up a network for use with Windows. Help for 
Control Panel describes all other tasks in detail. Choose the Help button or press 
FI while working in the dialog box for each Control Panel or Setup option. 
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CHAPTER 13 

Configuring Hardware 

When you set up Windows, the Setup program installs the appropriate drivers for 
your hardware, based on your system configuration. A driver is a program that 
enables a specific piece of hardware (or device) to communicate with Windows. If 
you change your system configuration by adding a new device, you need to add a 
driver for it. 

Generally, your device or hardware package includes a disk containing the 
appropriate Windows device driver. Or Windows may include the driver you 
need. 

Although the device may be installed in or connected to your computer, Windows 
does not recognize a device until you install and configure the device driver. 

This chapter describes how to install and change device drivers for your 
multimedia devices, display adapter, keyboard, and mouse. It also describes 
how to configure communications ports. 

The Windows Driver Library 
If you do not have a driver or if you want an updated driver for your device, 
contact your device manufacturer or check the Windows Driver Library (WDL), 
which contains device drivers made available after Windows was released. 
Device drivers are added to the WDL as they become available. If you have 
a modem, you can download WDL device drivers from network services, 
including CompuServe, GEnie, Microsoft OnLine, various user-group bulletin
board services (BBSs on the Association of PC User Groups, or APCUG, 
network), and the electronic downloading service maintained by Microsoft 
(206-936-6735). If you do not have a modem and are located in the United 
States, you can obtain disks by calling Microsoft Customer Support Services 
at 1-800-426-9400. 
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Methods for Installing Device Drivers 
You can install device drivers after you have set up Windows, either by 
running the Setup program or by using Control Panel options. The method you 
use depends on the type of hardware you are adding or changing. For example, 
you can add a sound driver to your system by using Control Panel. If you want 
to change the resolution of your screen, you run Setup. 

To install and configure a printer, you can use either the Printers option in Control 
Panel or the Printer Setup command in Print Manager. For instructions on how to 
install and configure a printer, see Chapter 8, "Print Manager." 

Note Depending on the type of driver that you install or the settings that you 
change, you need to restart Windows or your computer in order for the new 
driver or changed settings to take effect. 

Installing a Third·Party Device Driver 
Windows provides drivers for common display adapters, mice, keyboards, and 
sound cards. If Windows does not supply a driver for your device, or if you are 
updating to a newer version of the driver, you may need to install a driver 
provided by your device manufacturer (third-party driver). 

The driver disks that you receive from your device manufacturer should include 
an OEMSETUP.INF file. This file supplies Windows with setup information that 
specifies the driver files on the disk and any additional files (such as font files) the 
driver requires. 

If your driver disks include an OEMSETUP.lNF file, you can use Setup or 
Control Panel to install the driver. If the driver disks do not include this file, you 
need to follow the instructions supplied by your device manufacturer to install the 
driver. 
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Installing and Configuring Multimedia Drivers 
You can use the Drivers option in Control Panel to install, configure, and remove 
device drivers that support multimedia devices, such as sound cards, synthesizers, 
audio compact-disc players, and videodisc players. 

Note To install an updated version of a multimedia driver, you must first remove 
the old driver from your system. 

.. To install a multimedia device driver 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Drivers icon. The Drivers dialog box 
appears. 

Timer 
[MCI) MIDI Sequencer 
[MCI) Sound 

This box displays a list -++--
of multimedia drivers 

already installed in 
your computer. 

3. Choose the Add button. 

4. In the list, select the driver you want to install, and then choose the OK button. 
(If your device is not listed, select Unlisted Or Updated Driver.) 

5. Insert the requested disk in drive A, and then choose the OK button. 

Or type the drive letter and directory name (for example, d:\drivers) where the 
driver is located, and then choose the OK button. 

(You can also use the Browse button to locate and select the drive and 
directory where the driver is located. When you are finished using the Browse 
dialog box, choose the OK button.) 

If you selected Unlisted Or Updated Driver, another dialog box appears, listing 
the drivers on the disk. Select the driver you want to install, and then choose 
the OK button. 
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6. When you install a multimedia driver, Windows installs other related 
multimedia drivers at the same time. If the drivers require additional settings, 
a setup dialog box appears for each driver. Select the settings required by the 
driver, and then choose the OK button. 

Note Make sure that the settings you specify do not conflict with the settings 
used by other devices installed in your system, such as a mouse or network 
adapter. See the documentation for your devices, including your multimedia 
device, for information about their settings. 

7. New or changed multimedia-driver settings do not take effect until you restart 
Windows. To restart, choose the Restart Now button. 

If you are no longer using a device, you can remove its driver. 

Caution The multimedia device drivers that are automatically installed during 
Setup are required by your system (these are the drivers displayed when you first 
open the Drivers dialog box). If you remove one of these drivers, your system 
may not work properly. 

~ To remove a multimedia driver 

1. In the Installed Drivers list, select the driver, and then choose the Remove 
button. 

2. To completely remove the driver from memory, you need to restart Windows. 
To restart, choose the Restart Now button. 

Removing a multimedia driver from the Installed Drivers list does not delete the 
driver file from your hard disk. If you need to use the same multimedia device 
later, you can add its driver again. 

Changing Your Mouse, Keyboard, or Display Driver 
You might want to add a mouse to your system, upgrade your display adapter 
to use a higher resolution, or install a new keyboard driver. You can do so by 
running Setup from within Windows. 

Note If a driver is in use (for example, your display driver), and you want to 
update it to a newer version of the same driver, you need to quit Windows and 
then run Setup from MS-DOS. For more information, see the following section, 
"Updating a Driver Currently in Use." 
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~ To change your mouse, keyboard, or display driver from within Windows 

1. Be sure your hardware is set up to match the setting to which you are 
changing. Check the documentation for your device. 

2. In the Main group, choose the Windows Setup icon. The Windows Setup 
window appears, listing your current hardware settings. 

Qptions .!::!.elp 

Display: 
Keyboard: 
Mouse: 
Network: 

VGA 
Enhanced 101 or 102 key US and Non US 
Microsoft. or IBM PS/2 
No Network Installed 

3. From the Options menu, choose Change System Settings. 

4. Open the list for the device that you want to change, select the driver you 
want, and then choose the OK button. 

If your hardware is not listed or if you are updating a driver that appears on the 
list (rather than installing a new one), scroll to the bottom of the list, and then 
select Other. Remember that a driver you are updating must not currently be in 
use by Windows. 

If you are installing a new driver or updating to a newer version, Setup 
requests that you insert in drive A a Windows disk or the disk that comes 
with your new mouse, display adapter, or keyboard. Insert the disk, or type the 
drive letter and directory where the device driver is located, and then choose 
the OK button. 

If you selected Other, Setup displays a list of drivers on the disk. Select the 
appropriate device driver, and then choose the OK button. You may be 
prompted for additional disks if more than one disk was provided by the 
hardware manufacturer. You might also be prompted for specific Windows 
disks. Setup then copies the appropriate files to your Windows SYSTEM 
subdirectory and displays the updated list of your hardware. 

5. Choose the OK button. A dialog box appears that contains a Restart Windows 
button and may contain a Reboot button. 

6. If no Reboot button appears, choose the Restart Windows button. 

If the Reboot button appears, make sure there are no disks in any drive, and 
then choose the Reboot button. Your system restarts. Then restart Windows. 

Note If the driver you install for your keyboard, display adapter, or mouse 
prevents Windows from running correctly, you need to run Setup from MS-DOS 
to install the correct driver. For more information, see the following section, 
"Updating a Driver Currently in Use." 
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Updating a Driver Currently in Use 
To update a driver that is being used by Windows, you must quit Windows and 
then run Setup from MS-DOS. 

Note Setup will not run from MS-DOS Prompt within Windows. 

~ To install an updated mouse, keyboard, or display driver 

1. Quit Windows. 

2. Change to your Windows directory, type setup at the command prompt, and 
then press ENTER. The System Information screen appears. 

3. Select the setting for the driver you want to update (use the UP ARROW or 
DOWN ARROW key), and then press ENTER. A screen listing the available 
drivers appears. 

4. Scroll to the bottom of the list (use the UP ARROW or DOWN ARROW key), 
select Other, and then press ENTER. 

S. Insert the disk containing the updated driver, or type the path of the driver file, 
and then press ENTER. You return to the command prompt. The new driver is 
used the next time you start Windows. 

Configuring Communications Ports 
You can specify the communications settings for each serial port on your system 
by using the Ports option in Control Panel. You use serial ports to connect serial 
pointing devices, modems, scanners, or other serial devices to your computer. 
Most computers include at least two serial ports: COMI and COM2. Some 
devices, such as serial-port adapters, modems, and fax cards, can use COM3 
and COM4. The settings you specify determine how information is transferred 
between your computer and the device. 

The communications settings you can specify include standard settings (such as 
those for baud rate, parity, and flow control) and advanced settings (such as those 
for the base port address and interrupt request line). If you plan to use serial ports 
COMI and COM2 only, you may only need to change the standard settings. If 
you want to use COM3 and COM4, you may also need to change the advanced 
settings. 



Chapter 13 Configuring Hardware 189 

Note Most communications applications that you use to exchange information 
between computers (such as Terminal, which is included with Windows) require 
that you specify standard port settings within the application. These settings 
override the settings you specify by using the Ports option in Control Panel. 

~ To specify standard communications settings 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Ports icon. 

3. In the Ports dialog box, double-click the icon for the port whose 
communications settings you want to specify. Or press TAB to select it, 
and then press ALT+S to choose the Settings button. The Settings dialog 
box appears. 

!lata Bits: 

f.arity: I~No=n=e ~= ,_, 
~:: ~:::rol: :~:o=n =, X=o':::' ~II=I 1!l1II",1 

4. Open the list for each option, set the option to match the device connected to 
the port, and then choose the OK button. 

For a description of the options, choose the Help button or press Fi while using 
the Settings dialog box. For information about the correct settings to use, see 
the documentation supplied with the device. 

5. In the Ports dialog box, choose the Close button. 

Setting Advanced Options 
The Ports option in Control Panel provides advanced options for specifying 
the base port address and the interrupt request line (IRQ) for each serial port. 
Windows often can detect the addresses and IRQs the ports are using. However, 
if you install additional serial ports, or if a device connected to a serial port does 
not use the values that Windows detects, you can change the settings so that 
they match those required by your device. 

The table on the following page lists common port-address and IRQ settings. See 
the documentation that came with your device for information about the IRQ and 
base port address that your device uses. If you are not sure which settings to use, 
select Default. 
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~ To specify advanced port settings for a serial port 

1. In the Settings dialog box, choose the Advanced button. 

2. Open the Base I/O Port Address and the Interrupt Request Line (IRQ) 
lists, and then select an address and IRQ value. Or type values in the boxes. 
(The IRQ value must be between 2 and 15.) Then choose the OK button. 

3. Any changes you make do not take effect until you restart Windows. To 
restart, choose the Restart Now button. 

The following table lists common port-address and IRQ settings you can use if 
Windows does not provide settings. 

Port Address IRQ 

COMl 03F8 4 

COM2 02F8 3 

COM3 03E8 4 

COM4 02E8 3 

Note If you want to use serial ports 1 and 3 or 2 and 4 simultaneously and your 
computer cannot simultaneously access ports that use the same interrupt, you 
need to specify a unique IRQ number for each serial port. First, identify which 
interrupts are not being used by other cards or boards installed in your computer. 
After you have determined this, you may need to adjust your communications 
card in order to use the interrupts. For more information, see the documentation 
supplied with your communications card. 



CHAPTER 14 

Managing Memory 
and Performance 

This chapter describes ways you can manage memory and configure settings to 
improve system speed while leaving enough memory for your applications. 
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When you assess the performance of Windows, take into account how much 
memory your system has and how much disk space is available. Also consider 
how many applications you run at one time and whether you use any memory
resident programs (also called terminate-and-stay-resident, or TSRs). Typically, 
optimizing your system involves improving one or more aspects of system 
performance but sacrificing something else. For example, you might optimize 
your system so that more applications can run faster at one time, but you may 
have less disk space available as a result. 

Identifying Your System Memory Configuration 
Memory is found on your computer's main system board or on add-in memory 
boards. Before information on a disk is processed by your computer or displayed 
on the screen, it is first placed in memory. The following table describes memory 
types and terminology used throughout this chapter. 

Type of memory 

Conventional memory 

Extended memory 

Description 

Up to the first 640K of memory on a computer. All 
personal computers have conventional memory. 
MS-DOS uses this memory to run applications. 

Memory beyond 1 MB on 80286, 80386, and 80486 
computers. Extended memory requires an extended
memory manager, such as HIMEM.syS, to prevent 
applications from using the same area of extended 
memory at the same time. Extended memory is 
required for Windows. 
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Type of memory 

Expanded memory 

Virtual memory 

Upper memory area 

High memory area 

Description 

Memory in addition to conventional memory that some 
MS-DOS-based applications can use. Expanded memory is 
installed on an expanded-memory board and comes with an 
expanded-memory manager. Because an expanded-memory 
manager gives access to only a limited amount of expanded 
memory at a time, using expanded memory is slower than 
using extended memory. Windows and Windows-based 
applications do not use expanded memory; however, 
Windows running in 386 enhanced mode can simulate 
expanded memory for MS-DOS-based applications that 
require it. For more information, see "Using Memory 
Managers" later in this chapter. 

Space on your hard disk that Windows running in 386 
enhanced mode uses as if it were memory, by temporarily 
moving information from memory to a file (called a swap 
file). This makes the memory available for other 
applications. The benefit of using virtual memory is that 
you can run more applications at one time than your 
system's physical memory (found on your system boards 
and any add-in boards) would usually allow. The 
drawbacks are the disk space required for the virtual
memory swap file, and the slower performance when 
swapping is required. 

The 384K of memory above the 640K of conventional 
memory in your system, usually reserved for system 
hardware, such as your display adapter. Unused parts of 
the upper memory area are called upper memory blocks 
(UMBs) and can be used by Windows running in 386 
enhanced mode. 

The first 64K of extended memory. This area is used 
by some applications and by Windows. If you are using 
MS-DOS version 5.0 or later, you can run MS-DOS in the 
high memory area, leaving more conventional memory 
available for applications. For more information, see your 
MS-DOS documentation. 

It's important to know how much and what type of memory your computer has. 
On most computers, when you turn on the power, the screen displays a count of 
how much memory there is. However, this won't show you what type of memory 
it is. If you have MS-DOS version 4.0 or later, you can find out about your 
memory configuration by using the MS-DOS mem command. 

~ To find out about your system's memory configuration 

1. Quit Windows. 

2. At the command prompt, type mem and then press ENTER. 
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Managing Memory 
Properly configuring your system memory is one of the most important things you 
can do to improve performance. The following sections describe ways you can 
free memory for your applications and configure memory so that it is used 
efficiently. 

Streamlining Your CONFIG.SYS and AUTOEXEC.BAT Files 
Your CONFIG.SYS and AUTOEXEC.BAT files, located in the root directory of 
your startup drive, may contain commands that load device drivers and other 
programs when you start your computer. You can make more memory available 
by removing unnecessary commands from these files. Be sure to leave intact any 
command lines that start or enable a network. 

Note During Express Setup, the Setup program adds the appropriate memory 
managers to your AUTOEXEC.BAT and CONFIG.syS files. For information 
about these memory managers and how to change command-line options, see 
"Command Reference" later in this chapter. 

When you modify the CONFIG.SYS or AUTOEXEC.BAT file, use the following 
guidelines: 

• First, always make a system disk that you can use to start your computer. 
Include a backup copy of both your CONFIG.SYS and AUTOEXEC.BAT 
files and any other startup files your system requires, such as disk-partitioning 
software. For more information about system disks, see Help for File Manager. 

• Use a text editor that can save files in ASCII (text-only) format, such as 
Notepad, to open and edit the CONFIG.SYS and AUTOEXEC.BAT files. 

• If you want to remove a command line, add the rem command (for "remark") 
at the beginning of the line to disable it. This makes it easy to add the 
command again if you decide you want to put it back in the file. 

For example, to disable the following CONFIG.SYS command line: 

device=c: \device\mouse.sys 

type rem in front of it, as follows: 

rem device=c: \device\mouse.sys 
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Note If you use the rem command to disable command lines in your 
CONFIG.SYS file, and you are using a version of MS-DOS earlier than 5.0, 
you'll see a message, such as "Unrecognized command in CONFIG.SYS," 
when you start your computer. Once you are sure that your computer works 
properly with the command lines disabled, you might want to delete those 
lines to avoid the message. 

• If you are not sure about whether you need a particular command line, do not 
remove it. 

The changes you make do not take effect until you restart your computer. If your 
system does not start properly after you've modified your CONFIG.SYS or 
AUTOEXEC.BAT file, insert in drive A the system disk you created, and start 
your computer again. If you know which command line(s) are causing the 
problem, edit the appropriate file (CONFIG.SYS or AUTOEXEC.BAT) on your 
hard disk, and then restart your computer. Or, to start over, copy the backup 
version of the file( s) from the system disk to the root directory of your hard disk. 

~ To streamline the CONFIG.SYS file 

• Disable command lines for any unnecessary device drivers. Your 
CONFIG.SYS file should define only device drivers that you absolutely 
need. (Device drivers are defined by using the device command.) 

Note Do not disable the HIMEM.SYS command line. When you install 
Windows, the Setup program adds this command line to your CONFIG.SYS 
file if your system needs this device driver. 

• Make sure the buffers setting is from 10 to 20. 

The buffers command line sets the number of disk buffers that MS-DOS 
allocates in memory when your computer starts. These buffers enable 
MS-DOS to improve disk-access time in certain cases. The larger the 
number you specify for buffers, the more conventional memory is used. 

Note Setting buffers to a value higher than 20 might improve disk-access 
time in some cases. However, doing so might also require more memory. If 
you are using MS-DOS version 5.0 or later, you can set buffers=30 without 
using more memory. 

• If your CONFIG.syS file contains a shell command line that specifies your 
environment space, try specifying a smaller environment. The smaller the 
environment, the fewer environment variables you can define with the set 
command in MS-DOS; however, a large environment could take up more 
memory. Environment space should always be at least 1024 bytes. 
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~ To streamline the AUTOEXEC.BAT file 

• Disable command lines that start pop-up programs or other memory-resident 
software. Instead of starting memory-resident programs (TSRs) from the 
AUTOEXEC.BAT file, you can start them from within Windows. For more 
information about running memory-resident programs, see the following 
section. 

• If you have a RAM drive, you might want to set your TEMP environment 
variable to the RAM drive. This can speed up applications that store temporary 
files in the directory specified by the TEMP variable. For example, if your 
RAM drive has the drive letter E, you could place the following lines in the 
AUTOEXEC.BAT file: 

mkdir e:\temp 
set temp=e:\temp 

The first command creates the directory TEMP on the RAM drive. The second 
command sets the TEMP variable to that directory. 

Conserving Memory When Starting Memory-Resident Programs 
If you want a memory-resident program (TSR) to be available to all applications 
that you run with Windows, you must start it before starting Windows. However, 
this takes memory away from other MS-DOS-based applications. 

There are two ways to conserve memory when starting memory-resident 
programs: 

• If a particular MS-DOS-based application needs a memory-resident program, 
you can start both the program and the application from the same batch file in 
Windows. This gives the application access to the program and does not take 
memory away from other applications. For more information about creating 
and using batch files, see your MS-DOS documentation. 

• If only Windows-based applications use the memory-resident program, you 
can create a batch file called WINSTART.BAT in the Windows directory 
and then run the memory-resident program from there. Each time you start 
Windows in 386 enhanced mode, WINSTART.BAT runs. 

When you start a program from WINSTART.BAT, that program is only 
available to Windows-based applications. This prevents the program from 
taking memory away from MS-DOS-based applications. 

Some memory-resident programs do not work when started from 
WINSTART.BAT. For information, see the documentation that came with 
the program. 
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Changing Virtual Memory Settings 
When Windows is running in 386 enhanced mode, it frees memory and speeds up 
performance by swapping information from memory to a swap file on your hard 
disk (virtual memory). 

The Setup program creates a swap file based on the type and amount of available 
space on your hard disk. The Setup program creates a permanent swap file if it 
can-a permanent swap file is contiguous and thus improves the speed of 
Windows. Otherwise, Windows creates a temporary swap file (named 
WIN386.SWP) whenever you start Windows in 386 enhanced mode. This 
file can grow and shrink in size and is deleted when you quit Windows. 

A permanent swap file consists of two files-SPART.PAR is a read-only file 
in your Windows directory, and 386SPART.PAR is a hidden file in the root 
directory of the drive specified for the swap file. 

You can determine whether you are using virtual memory, and see the size and 
type of the swap file, by using Control Panel. (The Windows version 3.1 swap-file 
functionality replaces the Windows version 3.0 Swapfile application.) 

Generally, you should keep the default swap-file settings. However, there may be 
times when you want to change the settings. For example, if you work with an 
application that requires a large amount of memory, you might want to create a 
larger swap file. 

Note If you are connected to a network, storing your swap file on your local disk, 
as opposed to on a network disk, provides better performance and reliability. 

~ To display or change information about your system's virtual memory 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the 386 Enhanced icon. 

3. Choose the Virtual Memory button. The Virtual Memory dialog box appears, 
which displays the current swap-file settings. 

Size: 
Type: Temporary (using htS-DOS) 



Chapter 14 Managing Memory and Performance 197 

4. To change the drive location, size, and type of the swap file, choose the 
Change button. The dialog box expands, enabling you to change the settings. 

If your hard-disk controller is compatible with the 32-bit disk-access 
feature, the Use 32-Bit Disk Access check box appears in the dialog box. 
This feature provides increased performance on all disk activities and 
increased performance when you are using MS-DOS Prompt and running 
MS-DOS-based applications. Using 32-bit disk access may be unreliable on 
some battery-powered portable computers when the computer's power-saving 
features are enabled. To turn this feature on, select the check box. 

For help with the Virtual Memory dialog box, choose the Help button or press 
Fl while using the dialog box. 

Note If Windows is running in 386 enhanced mode, you can conserve disk space 
by preventing Windows from swapping any information to the disk. Do not 
prevent swapping unless disk space is at a premium, because swapping increases 
the number of applications you can run at one time. To prevent swapping, select 
None in the Type box in the expanded Virtual Memory dialog box. 

Working with Application Swap Files (Standard Mode) 
When you start an MS-DOS-based application in standard mode, Windows 
creates a temporary application swap file for that application. (It does not use 
application swap files in 386 enhanced mode.) When you switch from the 
application, Windows moves some or all of the application from memory to the 
application swap file. This makes the memory available to other applications. 
When you quit the application, the application swap file is deleted. 

The location Windows uses to store application swap files can affect the time it 
takes to switch to and from MS-DOS-based applications. 

Application swap files are hidden files with names that start with the characters 
-WOA. These files are placed in the directory specified by the swap disk setting 
in the [Non WindowsApp] section of your SYSTEM.lNI file. If the swapdisk 
setting is not specified, the files are placed in the directory specified by the 
TEMP environment variable in your AUTOEXEC.BAT file. If there is no TEMP 
environment variable specified, swap files are placed in the root directory of the 
first hard disk (or first floppy disk drive, if you start your system from a floppy 
disk). 
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Basic Recommendations 
• Usually, it is not a good idea to set swapdisk to a RAM drive. If the swapdisk 

setting or the TEMP environment variable specifies a RAM drive, when 
Windows tries to swap application information from memory to disk, it swaps 
it to another area of memory instead. This is useful only if you have much 
more memory than you require for running applications. 

• Set the swapdisk setting to a hard disk with at least 512K of free disk space. If 
you have more than one hard disk, set swapdisk to the disk with the most free 
space. 

The more disk space Windows can use for application swap files, the more 
MS-DOS-based applications you can run at one time. 

• If you have more than one hard disk and the disks differ in speed, set the 
swap disk setting to the fastest disk (provided it has enough free space). 

~ To change the location that Windows uses for application swap files 

1. Open your SYSTEM.INI file (located in your Windows directory) by using a 
text editor such as Notepad. Be sure not to use an application such as Write to 
edit this file. Such applications can add characters that prevent MS-DOS from 
correctly processing the file. 

2. Find or add the [Non WindowsApp] section of the file. If you're using 
Notepad, you can find this section quickly by choosing Find from the Search 
menu, typing [NonWindowsApp], and then choosing the Find Next button. 

3. Add or change the swapdisk setting. Set swap disk to the directory and drive 
you want. 

For example, if you want application swap files to be created in the 
TEMPFILE directory on drive D, type the following: 

swapdisk=d: \tempfile 

4. Save your SYSTEM.INI file. 

5. Quit and restart Windows to have the change take effect. 

For more information about SYSTEM.INI settings, use Write to open the 
SYSINI.WRI online document located in the Windows directory. 
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Other Methods for Improving Performance 
There are factors other than memory to consider when optimizing your system. 
This section describes the following ways to speed up your system: 

• Improving the efficiency of your hard disk 

• Using the SMARTDrive disk-caching program 

• Changing multitasking settings for Windows 

This section also describes ways you can find out how your system resources are 
being used and ways you can free those resources to improve the performance of 
your system. 

Improving the Efficiency of Your Hard Disk 
Your system's speed can be greatly affected by the amount of free disk space and 
how efficiently the information on your disk is structured. You can perform the 
following tasks to improve the efficiency of your hard disk: 

• Delete files you don't need. (This section describes how you can find out how 
much free disk space you have and which files you can delete.) 

• Use the MS-DOS chkdsk command to recover lost disk space. For 
information about chkdsk, see your MS-DOS documentation. 

• Run a disk-compaction program. Over time, the information on your disk can 
become fragmented (instead of being stored in a single location, files are split 
into fragments and stored in different locations on the disk). This makes it 
time-consuming to read the files from the disk. Running a disk-compaction 
program regroups fragmented files and can significantly reduce the time it 
takes for Windows and applications to start. 

Before running a disk-compaction program, you should quit Windows, delete 
any unnecessary files, run the chkdsk command, and make sure you are not 
running any programs that use the hard disk. 

Generally, it's a good idea to keep at least 1 MB of free space on your hard disk. 
Windows and applications use free disk space to temporarily store information 
and to save documents and other files. Use the procedure on the following page to 
determine how much disk space is available on your system. 
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~ To check the amount of free disk space when Windows is running 

1. In the Main group, choose the File Manager icon. 

2. Choose the drive icon for the drive you want to check. 

The status bar at the bottom of the File Manager window indicates how much 
disk space is currently available on that disk drive. (If the status bar does not 
appear, you can display it by choosing Status Bar from the Options menu.) 

Often, there is less free disk space when you are running Windows than when you 
are not. This is because Windows uses swap files that take up some disk space. To 
determine how much disk space Windows is using, compare the amount of free 
disk space when it is running to the amount of free disk space when it is not 
running. 

~ To check the amount of free disk space when Windows is not running 

1. Quit Windows. 

2. At the command prompt, type dir and then press ENTER. 

MS-DOS displays information about the files in the current directory. The last 
line of information shows how many bytes of disk space are free on that drive. 

If you need more disk space, you may be able to delete some unnecessary files 
from your hard disk. 

Deleting Unnecessary Files 
If your disk is becoming full, you can delete files you don't need or don't use. 
Depending on how you use Windows, you might also be able to delete certain 
Windows files. It is particularly important to delete unnecessary files before you 
run a disk-compaction program. There are three categories of files you may want 
to delete: 

• Windows files (installed by the Setup program) that you do not need or plan to 
use. For details, see the following procedure. 

• Application files, documents, or programs that you no longer need or use. 

• Temporary files (files that have a .TMP extension) that are left on your hard 
disk when your computer fails unexpectedly. 

~ To delete unnecessary Windows files 

1. If you plan to delete Windows wallpaper or screen-saver files, first use the 
Desktop option in Control Panel to change these settings to "None." 

2. While running Windows, quit all applications except Program Manager. 
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3. In the Main group, choose the Windows Setup icon. 

4. From the Options menu, choose Add/Remove Windows Components. 

5. Choose the Files button for the Windows component that contains the files you 
want to delete. 

6. Follow the instructions on the screen to remove files from your hard disk. 

Note If you use this method (choosing the Windows Setup icon), Setup will not 
delete files that are necessary to run Windows. Therefore, it is recommended that 
you use this method rather than File Manager or MS-DOS Prompt to delete 
Windows files. 

~ To delete other unnecessary files 

1. Quit Windows. 

2. Delete any files that remain in your TEMP directory, the directory that 
applications use to store temporary files. If you don't know which directory is 
set as your TEMP directory, look in your AUTOEXEC.BAT file for the set 
temp= command. 

3. Delete any files that start with the characters ~WOA. These files are 
application swap files that were created in standard mode. Usually, Windows 
deletes application swap files when you quit the associated applications; 
however, these files might remain on your hard disk if Windows stops running 
unexpectedly . You can safely delete application swap files if Windows is not 
running. 

4. Delete any file named WIN386.SWP. This file is a temporary swap file created 
in 386 enhanced mode. Usually, Windows deletes it when you quit Windows. 
However, a temporary swap file might be left on your hard disk if your 
computer stops running unexpectedly. You can safely delete WIN386.SWP 
if Windows is not running. (Do not delete swap files named 386SP ART.P AR 
or SPART.PAR.) 

5. If you want, delete any other unwanted files or documents. 

USing SMARTDrive 
SMARTDrive is a disk-caching program provided with Windows. SMARTDrive 
saves information read from your hard disk in a disk cache in your computer's 
extended memory. When an application tries to read that information from the 
hard disk, SMARTDrive supplies the information directly from memory instead. 
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SMARTDrive also temporarily stores information to be written to disk in the disk 
cache. SMARTDrive later writes this information to the hard disk, when system 
resources are in less demand. 

Caution If you turn off your computer before the information in the disk cache 
is written to your hard disk, the information could be lost. To prevent this, type 
smartdrv Ie at the command prompt to write any cached information to the hard 
disk. For more information, see "Command Reference" later in this chapter. 

Windows runs much faster when using a disk cache. The Setup program adds the 
smartdrv command to your AUTOEXEC.BAT file. It is recommended that you 
use SMARTDrive if your system has a hard disk and at least 2 MB of memory. 
The way you set up SMARTDrive depends on the applications you run and 
your system memory configuration, so there is no single "best setting" for 
SMARTDrive. By default, the size of the SMARTDrive disk cache is based on 
how much memory your system has. In most cases, this provides the best system 
performance; however, you can change the cache size and other SMARTDrive 
settings if needed. For more information, see "Command Reference" later in this 
chapter. 

Setting Multitasking Options 
When Windows is running in 386 enhanced mode, you may need to specify how 
applications share resources. You can do this by using Control Panel. 

You use the Scheduling options in the 386 Enhanced dialog box to determine 
how Windows performs when running more than one application. These options 
are described in the Help for the 386 Enhanced dialog box. For information 
about running more than one MS-DOS-based application, see Chapter 11, 
"MS-DOS Applications." 
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Command Reference 
This section describes the command-line options for the memory managers and 
disk-caching program provided with Windows. 

Using Memory Managers 
Windows provides the following memory managers that provide access to a 
particular type of memory. 

Memory manager 

HIMEM 

RAMDrive 

EMM386 

Description 

A program that coordinates the use of your system's extended 
memory so that no two applications use the same memory at 
the same time. 

A memory-resident program that enables you to use part of 
your system memory as if it were a hard disk drive. This 
memory area is called a RAM drive because it exists in 
random access memory (RAM). 

A program Windows uses to emulate expanded memory when 
Windows is running in standard mode. If you use applications 
that require expanded memory and you don't have any 
expanded memory installed on your computer, you can use 
EMM386 to emulate expanded memory. (Windows running in 
386 enhanced mode can emulate expanded memory and does 
not require EMM386.) 

When used with MS-DOS version 5.0 or later, EMM386 can 
also provide access to upper memory blocks (UMBs) between 
640K and 1MB. For more information, see your MS-DOS 
documentation. 

You install these memory managers by adding a command line to your 
CONFIG.SYS file. The following sections describe the command-line options 
you can set for each of the memory managers provided with Windows. 

Using the HIMEM Command Line 
The HIMEM command line has the following form: 

device=[ drive: ] [path ]himem.sys [/hmamin=m] [/numhandles=n] [/int1S=xxxx] 
[/shadowram:onloff] [lmachine:name] [/a20control:onloff] [/cpuclock:onloff] 
[/eisa] 

An explanation of each part of the command line follows. In most cases you 
won't need to specify command-line options-the default values are designed 
to work with most hardware. 
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Use 

device= 

[drive:] [path ]himem.sys 

Ihmamin=m 

Inumhandles=n 

lintlS=xxxx 

To 

Install a device driver-in this case, HIMEM. You must 
include this part of the command line. 

Specify the location of the HIMEM program file. For 
example, if HIMEM.SYS is in the WINDOWS directory 
on drive C, type c:\windows\himem.sys.1f the file is in 
the root directory of your startup drive, you don't need 
to include a path. However, you must always include the 
filename (HIMEM.SYS). 

Specify how many kilobytes of memory an application 
requires for HIMEM to give that application use of the 
high memory area (HMA). Only one application can use 
the HMA at a time. HIMEM allocates the HMA to the 
first application that meets the memory-use requirements 
set by this option. You can specify a value from 0 to 63. 

The Ihmamin option is not required; the default value is 
zero. Omitting this option (or setting it to zero) specifies 
that HIMEM allocate the HMA to the first application 
that requests it, regardless of how much of the HMA the 
application is going to use. 

Set Ihmamin to the amount of memory required by the 
application that uses the most HMA memory. 

The Ihmamin option has no effect when Windows is 
running in 386 enhanced mode. 

Specify the maximum number of extended-memory 
block (EMB) handles that can be used simultaneously. 
You can specify a value from 1 to 128; the default value 
is 32. Each additional handle requires an additional 6 
bytes of memory. 

The Inumhandles option has no effect when Windows 
is running in 386 enhanced mode. 

Allocate the amount of extended memory (in kilobytes) 
to be reserved for the Interrupt 15h interface. Some older 
applications use this interface to allocate extended 
memory rather than using the XMS (extended-memory 
specification) method provided by HIMEM. If you use 
these applications, you can ensure enough memory is 
available to them by setting xxxx to 64K larger than the 
amount required by the application. 

You can specify a value from 64 to 65535; however, you 
cannot specify more memory than your system has 
available. If you specify a value less than 64, the value 
becomes O. The default value is O. 
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/machine:name 
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To 

Specify whether to disable shadow RAM. Some 
computers make ROM (read-only memory) code run 
faster by "shadowing" it in RAM-that is, by copying 
the ROM code into faster RAM memory at startup. 
However, this uses some extended memory. Usually, on 
computers that use shadow RAM and have less than 2 
MB of RAM, HIMEM attempts to disable shadow RAM 
to recover additional extended memory for Windows to 
use (the default value of this setting is oft). HIMEM can 
disable shadow RAM only on certain types of systems. 
When HIMEM disables shadow RAM, the ROM code 
runs in the slower ROM instead of RAM; therefore, your 
computer might run slightly slower. 

To leave the ROM code running from RAM, even on 
systems with less than 2 MB of memory, include the 
value /shadowram:on. To have HIMEM disable 
shadow RAM, include the value /shadowram:off. 

Specify what type of computer you are using. Usually, 
HIMEM can detect your system type successfully; 
however, there are a few computers that HIMEM cannot 
detect. On such systems, HIMEM uses the default 
system type (IBM AT or compatible). You might need 
to include the /machine option if your computer is a 
type that HIMEM cannot detect and if HIMEM does 
not work properly on your system by using the default 
system type. 

Currently, systems that require this option include Acer 
1100, Wyse, and IBM 7552. 

The value for name can be any of the codes or their 
equivalent numbers listed in the following table. 

Code 

at 

ps2 

ptlcascade 

hpvectra 

att6300plus 

acerllOO 

toshiba 

wyse 

Number 

2 

3 

4 

5 

6 

7 

8 

Computer type 

IBM AT or 100% 
compatible 

IBM PS/2 

Phoenix Cascade 
BIOS 

HP Vectra (A & At) 

AT&T 6300 Plus 

Acer 1100 

Toshiba 1600 & 
1200XE 

Wyse 12.5 Mhz 286 
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Use 

/a20control:onloff 

/cpuclock:onloff 

/eisa 

To 

Code Number Computer type 

tulip 9 Tulip SX 

zenith 10 Zenith ZBIOS 

atl 11 IBM PC/AT 

at2 12 IBM PC/AT 
(alternative delay) 

css 12 CSS Labs 

at3 13 IBM PC/AT 
(alternative delay) 

philips 13 Philips 

fasthp 14 HP Vectra 

ibm7552 15 IBM 7552 Industrial 
Computer 

bullmicral 16 Bull Micral 60 

Specify whether HIMEM is to take control of the A20 
line even if A20 was on when HIMEM was loaded. The 
A20 handler gives your computer access to the HMA. If 
you specify /a20control:off, HIMEM takes control of 
the A20 line only if A20 was off when HIMEM was 
loaded. The default setting is /a20control:on. 

Specify whether HIMEM is to affect the clock speed of 
your computer. If your computer's clock speed changes 
when you install HIMEM, specifying /cpuclock:on may 
correct the problem; however, enabling this option slows 
down HIMEM. The default setting is /cpuclock:off. 

Enable HIMEM to use all the Extended Industry 
Standard Architecture (EISA) memory installed in the 
computer. This option has no effect on non-EISA 
computers. 

Using the RAMDrive Command Line 
The RAMDrive command line has the following form: 

device=[ drive:] [path ]ramdrive.sys [DiskSize [SectorSize [NumEntries]]] [leila] 

An explanation of each part of the command line follows. When you set up a 
RAM drive, it is assigned the next available drive letter. 
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device= 

[drive:] [path ]ramdrive.sys 

DiskSize 

SectorSize 

NumEntries 

Ie 
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To 

Install a device driver-in this case, RAMDrive. You 
must include this part of the command line. 

Specify the path of the RAMDrive program file. For 
example, if RAMDRIVE.SYS is in the WINDOWS 
directory on drive C, type c:\windows\ramdrive.sys. 
If the file is in the root directory of your startup drive, 
you don't need to include a path. However, you must 
always include the filename (RAMDRIVE.SYS). 

Specify how many kilobytes of memory you want to 
use for the RAM drive. For example, to create a 640K 
RAM drive, specify 640. If you don't specify an 
amount, RAMDrive will create a 64K RAM drive. 
You can specify a value from 4 to 32767. However, 
you cannot specify more memory than your system 
has available. 

Specify the sector size in bytes. The size can be 128, 
256, or 512 bytes. (If you include a SectorSize value, 
you must also include a value for DiskSize.) 

Generally, you should use the default sector size of 
512 bytes. 

Limit the number of files and directories you can 
create in the RAM drive root directory. The limit can 
be from 2 to 1024 entries; the limit you specify is 
rounded up to the nearest sector size boundary. If you 
do not specify a limit, you can create up to 64 entries 
in the RAM drive root directory. (If you include a 
value for NumEntries, you must also include values 
for DiskSize and SectorSize.) 

If there is not enough memory to create the RAM 
drive as specified, RAMDrive will try to create it with 
a limit of 16 directory entries. This may result in a 
RAM drive with a limit different from the one you 
specified. 

Create the RAM drive in extended memory. 

For RAMDrive to use extended memory, your system 
must be configured so that it provides extended 
memory. Also, the command line for the extended
memory manager (such as HIMEM.syS) must appear 
in your CONFIG.SYS file before the RAMDrive 
command line. In general, it is best to create a RAM 
drive in extended memory if your system has 
extended memory. 
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Use 

/a 

To 

Create the RAM drive in expanded memory. 

For RAMDrive to use expanded memory, your 
system must be configured so that it provides 
expanded memory. Also, the command line for the 
expanded-memory manager (such as EMM386, 
386MAX, CEMM, or QEMM) must appear in your 
CONFIG.SYS file before the RAMDrive command 
line. 

Although specifying a memory type is optional, it is highly recommended. If you 
omit both the la and the Ie options, RAMDrive uses your system's conventional 
memory. It is not a good idea to use conventional memory for a RAM drive, 
because doing so affects the performance of Windows. 

Using the EMM386 Command Line 
The EMM386 command line has the following form in the CONFIG.syS file: 

device=[ drive: ] [path ]emm386.exe [onloff1auto] [lnohigh] [memory] 
[MemoryOptions] 

An explanation of each part of the command line follows. 

Use 

device: 

[drive:] [path ]emm386.exe 

[ onlofl1auto ] 

/oohigb 

To 

Install a device driver-in this case, EMM386. You 
must include this part of the command line. 

Specify the location of the EMM386 program file. 
For example, if EMM386.EXE is in the WINDOWS 
directory on drive C, type c:\wiodows\emm386.exe. If 
the file is in the root directory of your startup drive, 
you don't need to include a path. However, you must 
always include the filename (EMM386.EXE). 

Activate EMM386 if set to 00, suspend EMM386 if 
set to off, or place EMM386 in auto mode if set to 
auto. Auto mode enables expanded-memory support 
only when a program calls for it. The default value is 
00. Use the emm386 command at the command 
prompt to change this value after EMM386 has 
started. 

Specify that no part of EMM386 is loaded into upper 
memory blocks (UMBs). By default, a portion of 
EMM386 is loaded into UMBs. If UMB space is at a 
premium, use this option to save approximately 3K of 
UMBspace. 
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Use 

memory 

MemoryOptions 

To 

Specify how many kilobytes of memory you want 
EMM386 to use. For example, to give EMM386 640K 
of memory, specify 640. You can specify a value from 
64 to 32768. (EMM386 rounds the value down to the 
nearest multiple of 16.) However, you cannot specify 
more extended memory than your system has 
available. 

This value is optional; if you don't specify an amount, 
EMM386 uses 256K of memory. 

Fine-tune the way EMM386 uses memory. 

You can use the EMM386 memory options to control 
the location of the EMS page frame, determine how 
EMM386 uses certain addresses, and so on. For more 
information, see the following table. 

Under most circumstances, you don't need to specify memory options on the 
EMM386 command line, because EMM386 usually runs properly by using the 
default values. 

However, in some cases, you may want to control how EMM386 uses memory
for example, where EMM386 puts the EMS page frame, or which addresses it can 
use for EMS pages. EMM386 provides several command-line options that you 
can use to fine-tune the way it uses memory. You can use as many of these 
options as you want, in any order, but they should follow the EMM386 path 
and memory amount (if any). 

An explanation of each EMM386 memory option follows. 

Use 

w=onlw=off 

frame=address 

To 

Enable or disable support for the Weitek Coprocessor. 
To enable support, include the value w=on in the 
EMM386 command line. To disable support, include 
the value w=offinstead. By default, Weitek 
Coprocessor support is disabled. 

Specify the base address of the 64K EMS page frame. 
You can specify values in the ranges 8000h through 
9000h and COOOh through EOOOh, in increments of 
400h. 

Usually, you do not need to specify a base address; by 
default, EMM386 uses a contiguous 64K region of 
memory, and it does not place the page frame below 
COOO:OOOO. However, sometimes it is not possible to 
identify adapter memory absolutely. If a conflict 
occurs, you may need to ensure that EMM386 places 
the page frame at a particular location. 
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Use 

mx 

/pmmmm 

pn = address 

To 

You can also use the frame option to specify a more specific base 
address. For example, to place the page frame at C800:0000, type 
frame=C800 on the EMM386 command line. 

If you use the frame option, you cannot use the m option or the /p 
option. 

Specify the address of the page frame. You can specify a value 
from 1 through 14. The following list shows each value and its 
associated base address in hexadecimal: 

1 => COOOh 8 => DCOOh 

2 => C400h 9 => EOOOh 

3 => C800h 10 => 8000h 

4 => CCOOh 11 => 8400h 

5 => DOOOh 12 => 8800h 

6 => D400h 13 => 8COOh 

7 => D800h 14 => 9000h 

Values ranging from 10 through 14 should be used only on 
computers with 5I2K of memory. If you use the m option, you 
cannot use the frame option or the /p option. 

Specify the address of the page frame. Valid values for mmmm are 
in the ranges 8000h through 9000h and COOOh through EOOOh, in 
increments of 400h. 

If you use the /p option, you cannot use the frame option or the m 
option. 

Define the segment address of a specific page. 

The p option has the form pn=address, in which n is the number 
of the page you are specifying and address is the segment address. 
For example, to place page 4 at the address CCOO, type p4=CCOO 
on the EMM386 command line. 

Valid values for n are in the range 0 through 255. Valid values 
for address are in the ranges 8000h through 9COOh and COOOh 
through ECOOh, in increments of 400h. The addresses for pages 0 
through 3 must be contiguous to maintain compatibility with 
version 3.2 of the LIM EMS. 

If you use the frame, m, or /p option, you cannot use the p option 
to specify addresses for pages 0 through 3. 
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x=mmmm-nnnn 

i=mmmm-nnnn 

b=address 

L=minXMS 

a=altregs 

h=handles 

d=nnn 
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To 

Prevent EMM386 from using a particular range of addresses for 
an EMS page. To specify the range, include this option on the 
command line, followed by the range of addresses you want to 
exclude. Valid values for mmmm and nnnn are in the range AOOOh 
through FFFFh, and are rounded down to the nearest 4K 
boundary. For example, to prevent EMM386 from using segments 
AOOO:OOOO through BOOO:OOOO, type the value x=AOOO·BOOO on 
the EMM386 command line. 

The x option takes precedence over the i option if the two ranges 
overlap. 

Specify a range of segment addresses to be used (included) for an 
EMS page or for RAM. Valid values for mmmm and nnnn range 
from AOOOh through FFFFh, and are rounded down to the nearest 
4K boundary. 

The x option takes precedence over the i option if the two ranges 
overlap. 

Specify the lowest address available for EMS "banking" 
(swapping of 16K pages). Valid values are in the range 1000h 
through 4000h. By default, 4000:0000 is the lowest address. 
To specify a different low address, include this option on the 
EMM386 command line, followed by the address you want. For 
example, to make 3000:0000 the lowest address, include the value 
b=3000. 

Ensure that the specified amount of extended memory will still 
be available after EMM386 is loaded. Specify the amount of 
memory in kilobytes. For example, to ensure that 640K of 
extended memory will be available after loading EMM386, 
type the value L=640 on the EMM386 command line. 

Specify how many fast alternate register sets you want to allocate 
to EMM386. For example, to allocate 16 register sets to EMM386, 
type the value a=16 on the command line. You can specify a 
number from 0 to 254; the default setting is 7 sets. Every alternate 
register set adds about 200 bytes to the size in memory of 
EMM386.EXE. 

Specify how many handles EMM386 can use. For example, to let 
EMM386 use 127 handles, type the value h=127 on the EMM386 
command line. You can specify from 1 to 255 handles; the default 
setting is 64. 

Specify how many kilobytes of memory should be reserved for 
buffered direct memory access (DMA). This value should 
reflect the largest DMA transfer that will occur while you use 
EMM386.EXE, not counting floppy disk DMA. You can specify 
from 16 to 256 kilobytes; the default setting is 16. 
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Use 

ram 

noems 

To 

Provide access to both expanded memory and the 
upper memory area. This option is valid only if you 
are running MS-DOS version 5.0 or later. 

Provide access to the upper memory area, but prevent 
access to expanded memory that conforms to the LIM 
specification version 3.2. This option is valid only if 
you are running MS-DOS version 5.0 or later. 

Excluding Shared Memory Used by a Network Adapter 
If you use EMM386.EXE and you have a network adapter installed that uses 
RAM, you should exclude the memory addresses that the network adapter uses, 
so that Windows won't use the same area of memory. 

For example, if your network adapter uses memory in the address range D800h to 
D8FFh, you would exclude this range from Windows by specifying the following: 

device=e: \ windows\emm386.exe x=d800·d8ff 

For information about which address space your network adapter uses, see the 
documentation for the adapter. 

Using the SMARTDrive Command Line 
If for some reason Setup did not install SMARTDrive on your system, or if you 
removed SMARTDrive, you can install it by adding the smartdrv command to 
your AUTOEXEC.BAT file. For information about how to modify this file, see 
"Streamlining Your CONFIG.SYS and AUTOEXEC.BAT Files" earlier in this 
chapter. 

The SMARTDrive command line has the following form: 

[drive: ] [path ]smartdrv.exe [[ drive[ +1-]]. .. ] [le:ElementSize] [InitCacheSize 
[WinCacheSize]] [/b:BufferSize] [Ie] [lr] [/1] [lq] [Is] [/?] 

An explanation of each part of the command line follows. 

Use 

[drive:] [path] smartdrv .exe 

To 

Specify the location of the SMARTDrive program 
file. For example, if SMARTDRV.EXE is in the 
WINDOWS directory on drive C, type 
c:\windows\smartdrv.exe. If the file is in the 
root directory of your startup drive, you don't need 
to include a path. However, you must always include 
the filename (SMARTDRV.EXE). 



Use 

drive 

+1-

le:ElementSize 

InitCacheSize 

WinCacheSize 
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To 

Specify the letter of the disk drive for which you 
want to control caching. If you don't specify a drive 
letter, floppy disk drives are read-cached but not 
write-cached, hard disk drives are read- and write
cached, and CD-ROM and network drives are 
ignored. 

Enable (+) or disable (-) caching. Use the plus ( +) 
and minus (-) signs to override the default settings. If 
you specify a drive letter without a plus or minus 
sign, read-caching is enabled and write-caching is 
disabled. If you specify a drive letter followed by a 
plus sign (+), read- and write-caching are enabled. If 
you specify a drive letter followed by a minus sign 
(-), read- and write-caching are disabled. 

You can specify multiple disk drives. 

Specify in bytes the amount of the cache that 
SMARTDrive moves at a time. Valid values are 
1024,2048,4096, and 8192. The default value is 
8192. 

Specify in kilobytes the size of the cache when 
SMARTDrive starts (before Windows is running). 
The size of the disk cache affects how efficiently 
SMARTDrive runs. In general, the larger the 
cache, the less often SMARTDrive needs to read 
information from the disk, which speeds up system 
performance. If you do not specify an InitCacheSize 
value, SMARTDrive sets the value according to 
how much memory your system has (see the table 
following this list). 

Limit to what amount (in kilobytes) Windows can 
reduce the cache size. Windows reduces the size 
of the cache to recover memory for its own use. 
Windows and SMARTDrive then cooperate to 
provide optimum use of your system memory. When 
you quit Windows, it restores the cache to its normal 
size. The default value depends on how much 
available memory your system has (see the table 
following this list). If you specify a value for 
InitCacheSize that is smaller than the value specified 
for WinCacheSize, InitCacheSize is set to the same 
size as WinCacheSize. 
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Use 

(b:BufierSize 

Ie 

Ir 

II 

Iq 

Is 

/? 

To 

Specify the size of the read-ahead buffer. A read
ahead buffer contains additional information that 
SMARTDrive reads when an application reads 
information from the hard disk. For example, if an 
application reads 512K of information from a file, 
SMARTDrive then reads the amount of information 
specified by BufierSize and saves it in memory. The 
next time the application needs to read information 
from that file, it can read it from memory instead. 
The default size of the read-ahead buffer is 16K. Its 
value can be any multiple of the ElementSize value. 

Write all cached information from memory to the 
hard disk. SMARTDrive writes information from 
memory to the hard disk at times when other disk 
activity has slowed. You might use this option if you 
are going to turn off your computer and want to make 
sure all cached information has been written to the 
hard disk. 

Clear the contents of the existing cache and restart 
SMARTDrive. 

Prevent SMARTDrive from loading into upper 
memory blocks (UMBs), even if there are UMBs 
available. You can use this option if you are using 
MS-DOS version 5.0 or later and UMBs are enabled. 

Prevent the display of SMARTDrive information on 
your screen. 

Display additional information about the status of 
SMARTDrive. 

Display Help about the SMARTDrive command and 
options. 

The following table shows the default values for InitCacheSize and 
WinCacheSize, depending on the amount of available extended memory 
your computer has. 

Extended memory InitCaeheSize WinCaeheSize 

Up to 1MB All extended memory Zero (no caching) 

Upt02MB 1MB 256K 

Upt04MB 1MB 512K 

Upt06 MB 2MB 1MB 

6 MB or more 2MB 2MB 
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Caution Check that SMARTDrive has completed all write-caching before you 
tum off your computer. To make sure this has happened, type smartdrv Ic at the 
command prompt. After all disk activity has stopped, you can safely tum off your 
computer. 

Using Double Buffering 
If you have a SCSI (Small Computer System Interface) hard disk, you may need 
to use the double-buffering feature of SMARTDrive. Double buffering provides 
compatibility for hard-disk controllers that cannot work with virtual memory. If 
necessary, Setup places a smartdrv command line in the CONFIG.SYS file in 
addition to the one in the AUTOEXEC.BAT file. The command line in the 
CONFIG.SYS file is required for you to use the double-buffering feature of 
SMARTDrive. The command line in the CONFIG.SYS file has the following 
form: 

device=c: \windows\smartdrv .exe Idouble _buffer 

Most hard-disk controllers do not need to use double buffering. Therefore, Setup 
does not add the command to the CONFIG.SYS file in most cases. When Setup is 
unable to determine whether double buffering is required, it adds the command 
line to the CONFIG.SYS file. 

If your computer does not require double buffering, you can remove the command 
line from the CONFIG.SYS file. 

~ To determine whether you can remove the SMARTDrive command line from 
CONFIG.SYS 

1. Make sure that the SMARTDrive driver has been loaded using the 
CONFIG.SYS command line and that double buffering is enabled. 

2. In the Main group, choose the MS-DOS Prompt icon. 

3. At the command prompt, type smartdrv and then press ENTER. SMARTDrive 
displays information about your system. 

4. Look at the column labeled "Buffering." If every line in this column reads 
"no," you can remove the device=c:\windows\smartdrv.exe Idouble_buffer 
command line from your CONFIG.SYS file. 
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APPENDIX A 

Keyboard Shortcuts 

This appendix lists keyboard techniques you can use in Windows. 

Use the keyboard shortcuts described in "Basic Windows Tasks" to do common 
Windows tasks, such as choosing commands on menus and moving around in 
dialog boxes and lists. You can use these basic techniques throughout Windows 
and in Windows-based applications. 

To work with specific applications and accessories included with Windows, use 
the keyboard shortcuts described in the other sections of this appendix. 

Basic Windows Tasks 

Using Help 
To Press 

Start Help Fl 

Move among the jumps in a topic TAB or SHlFT+TAB 

Display all the jumps in a topic or CfRL+TAB 

cancel the selection of a jump 

Copy a Help screen or annotation onto ALT +PRINT SCREEN 

the Clipboard 

Quit Help ALT+F4 
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Switching Between Applications 

Using Menus 

To switch 

Between applications 

To the next application 

To the previous application 

To Task List 

An MS-DOS-based application 
from a full screen to a window 
and back 

To 

Activate the menu bar 

Select a menu 

Choose a menu command 

Do this 

Press and hold down ALT or SHlFT+ALT, and 
repeatedly press TAB. 

Press ALT+ESC. 

Press SHIFT +ALT +ESC. 

Press CTRL+ESC. 

Press ALT +ENTER. 

Press 

ALT or FlO 

ALT + the underlined character in the menu name 

An arrow key, ENTER 

Or the underlined character in a command name 

Note Although you can choose any menu command by using this method, many 
commands have faster keyboard equivalents, which are usually shown next to the 
command on the menu. 

Open the Control menu for an 
application window 

Open the Control menu for a 
document window or a group 
window 

ALT+SPACEBAR 

ALT+HYPHEN 



Using Dialog Boxes 
To 

Move between items 

Carry out a command 

Choose a selected item 

Open or close a selected list 

Move around and select items in a 
list 

Cancel the dialog box 

Moving Around 
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Do this 

See "Moving Around" later in this appendix. 

Press ENTER. 

Press SPACEBAR. 

Press ALT +DOWN ARROW. 

See "Moving Around" and "Selecting Items" later in 
this appendix. 

Press ESC or ALT+F4. (Confirmation dialog boxes 
cannot be canceled by using these keys.) 

To move Press 

Between menu commands, An arrow key 
characters in a text box, or items 
in a list 

To the next or previous dialog TAB or SHIFT + TAB 

box item 

To a dialog box item ALT + the character underlined in the item name 

Right or left one word in a text CTRL + an arrow key 
box 

To the beginning or end of a line, HOME or END 

list, or screen 

Up or down one screen PAGE UP or PAGE DOWN 

Selecting Items 
In a Document Window 
To select Press 

One line of text up or down SHIFT+UP ARROW or SHIFT+DOWN ARROW 

Text to the beginning or end of a SHIFT +CTRLtHOME or SHIFT +CTRL+END 

document 
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Editing Text 

In a Document Window, Text Box, or List 
To select Press 

Text to the beginning or end of a line SHIff +HOME or SHIff +END 

The next or previous word SHIFf+CfRL+RIGHT ARROW or SHlFf+CTRL+LEFf 
ARROW 

One letter at a time to left or right SHlFf+LEFf ARROW or SHIFf+RIGHT ARROW 

In a Dialog Box 
To Press 

Select nonconsecutive items in a list SHIff +FS, use the arrow keys to move to each item 
you want to select, press SPACEBAR to select each 
item, and press SHIff +FS again 
when done. 

Select a list item or check box SPACEBAR 

Select all items in a list (where CfRL+SLASH (I) 
applicable) 

Cancel all selections in a list except CTRL+BACKSLASH 0) 
the current one 

In a Text Box or Window 
To 

Delete the character to the left or 
right or delete selected text 

Press 

BACKSPACE or DEL 

Copy selected text onto the Clipboard CfRL+C or CTRL+INS 

Move selected text onto the CTRL+X or SHIff +DEL 
Clipboard 

Paste text from the Clipboard CTRL+ v or SHIff +INS 

Undo the last editing action CfRL+zor ALT+BACKSPACE 



Copying onto the Clipboard 
To 

Copy an image of the entire screen onto 
the Clipboard. (This also works for an 
MS-DOS-based application running in 
text mode.) 

Copy an image of the active window onto the 
Clipboard 

Copy or move selected text onto and from the 
Clipboard 
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Do this 

Press PRINT SCREEN. 

Press ALT+PRINTSCREEN. 

See "Editing Text" earlier in this 
appendix. 

Quitting an Application and Closing a Window 
To 

Quit an application (or, in Program Manager, 
quit Windows) 

Close the active document window or group 
window 

Program Manager 
To 

Move between groups 

Move between items in a group window 

Start the selected application or restore the 
selected group icon 

Tile the group windows 

Cascade the group windows 

Close an active group window 

Press 

ALT+F4 

CTRL+F4 

Press 

CTRL+F60rCTRL+TAB 

An arrow key 

ENTER 

SHIFT+F4 

SHIFT+F5 

CTRL+F4 
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File Manager 
To 

Move among the left and right sides of 
the directory window and the drive bar 

Change the drive displayed in the 
directory window 

Move among and select directories or 
files 

Display or hide a selected directory's 
subdirectories, start a selected 
application, or open a selected file 

Open a new window displaying only 
the contents of the selected directory 

Select the next file or directory whose 
name begins with a certain character 

Move the selected file or directory 

Copy the selected file or directory 

Update the information displayed 

Display the properties of the selected 
file or directory 

Print Manager 

Do this 

Press TAB or F6. 

Press CfRL + the letter representing the drive. 

See "Moving Around" and "Selecting Items" 
earlier in this appendix. 

Press ENTER. 

Press SHIFT +ENTER. 

Press the first character of the file or 
directory name. 

Press F7. 

Press F8. 

Press F5. 

Press ALT +ENTER. 

To Press 

Move between queues and between UP ARROW or DOWN ARROW 

documents in each queue 

Move the selected document up or down CfRL+UP ARROW or CfRL+DOWN ARROW 

in a queue 

Update the information displayed F5 
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Control Panel 
You can use the keyboard shortcuts described in "Basic Windows Tasks" earlier 
in this appendix to move among icons in Control Panel, select icons, and work 
with the dialog boxes displayed when you choose an icon. 

Clipboard Viewer 

PIF Editor 

To 

Clear the Clipboard contents 

Copy or move items onto and from 
the Clipboard 

Do this 

Press DEL. 

See "Copying onto the Clipboard" and 
"Editing Text" earlier in this appendix. 

You can use the keyboard shortcuts described in "Basic Windows Tasks" earlier 
in this appendix to work with the PIF Editor dialog boxes. 

Accessories 

Calculator 

Calendar 

In addition to the keyboard shortcuts described in "Basic Windows Tasks" 
earlier in this appendix, you can use techniques unique to Calculator. For more 
information, see Help for Calculator. 

Use the following keys in Calendar. 

Month View Keys 
Use the following keys in the Month view. 

To Press 

Move to the previous week UP ARROW 

Move to the next week DOWN ARROW 

Move to the previous month PAGE UP 

Move to the next month PAGE DOWN 

Move between a date and the scratch pad TAB 

Change to the Day view ENTER 
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Cardfile 

Notepad 

Day View Keys 
Use the following keys in the Day view. 

To 

Move to the previous time 

Move to the next time 

Move to the previous screen 

Move to the next screen 

Move to the starting time 

Move to 12 entries after the starting time 

Move between the appointment area and the 
scratch pad 

Move the selection onto the Clipboard 

Copy the selection onto the Clipboard 

Paste the Clipboard contents into the 
appointment area or scratch pad 

Move to the previous day 

Move to the next day 

To 

Scroll forward or backward one card (or one 
page of index lines in List view) 

Scroll forward or backward one card in List 
view 

Display the first or last card 

Display the first card whose name begins with 
a particular character 

Press 

UPARROW 

DOWN ARROW or ENTER 

PAGE UP 

PAGE DOWN 

CfRL+HOME 

CfRL+END 

TAB 

SHIFf+DEL 

CfRL+INS 

SHIFf+INS 

CfRL+PAGE UP 

CfRL+PAGE DOWN 

Press 

PAGE DOWN or PAGE UP 

DOWN ARROW or UP ARROW 

CfRL+HOME or CfRL+END 

SHIff +CfRL + the character 

You can use the keyboard shortcuts described in "Basic Windows Tasks" earlier 
in this appendix to work with Notepad. 
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Object Packager 
To Press 

Move between the Content and TAB 

Appearance windows 

Paintbrush 
To move Press 

The cursor An arrow key 

Among the Toolbox, Linesize box, TAB or SHIFf+TAB 

Palette, and drawing area 

To scroll Press 

To the left or right side of the SHIFf +HOME or SHIFf +END 

drawing area 

To the top or bottom of the HOME or END 

drawing area 

Left or right one screen SHIFf +PAGE UP or SHIFf +PAGE DOWN 

Up or down one screen PAGE UP or PAGE DOWN 

Left or right one space SHIFf +LEFf ARROW 

or SHIFf +RIGHT ARROW 

Up or down one line SHIFf +UP ARROW or SHIFf +DOWN ARROW 

To simulate Press 

Clicking the left mouse button INS 

Clicking the right mouse button DEL 

Double-clicking the left mouse button F9+INS 

Dragging the cursor INS + an arrow key 

To undo Do this 

Part of what you have drawn since Press BACKSPACE, and then use 
selecting a tool INS + the arrow keys. 

Everything you have drawn since Press CfRL+ z. 
selecting a tool 
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Sound Recorder and Media Player 

Write 

You can use the same keyboard shortcuts for both Sound Recorder and Media 
Player. 

To 

Move around and select items in 
the window 

Move backward or forward when 
the scroll bar is selected 

Move backward or forward 1 
second when the scroll bar is 
selected 

Do this 

See "Moving Around" and "Selecting Items" earlier 
in this appendix. 

Press LEFT ARROW or RIGHT ARROW. 

Press PAGE UP or PAGE DOWN. 

Move to the beginning or end of Press HOME or END. 

the sound when the scroll bar is 
selected 

In the following table, 5 refers to the 5 key on the numeric keypad only, and will 
only work as described with the NUM LOCK key turned off. 

To move to the 

Next or previous sentence 

Next or previous paragraph 

Next or previous page (if the 
document has been paginated) 

To 

Select text 

Copy or move text onto and from 
the Clipboard 

Undo the last typing or editing 
action 

Insert a manual page break 

Select a picture or object when 
the cursor is above the upper-left 
comer of the picture or object 

Press 

S+LEFT ARROW or S+RIGHT ARROW 

S+DOWN ARROW or S+UP ARROW 

S+PAGE DOWN or S+PAGE UP 

Do this 

See "Selecting Items" earlier in this appendix. 

See "Copying onto the Clipboard" and "Editing Text" 
earlier in this appendix. 

Press CfRL+Z or ALT+BACKSPACE. 

Press CfRL+ENTER. 

Press DOWN ARROW. 



To 

Move the Size Picture cursor or 
move a selected picture after 
choosing Move Picture from the 
Edit menu 
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Do this 

Press an arrow key. 

Insert an invisible hyphen Press CfRL+SHlFT+HYPHEN. 

(only to be used when a word 
is wrapped) 

Switch between the document and Press ALT +F6. 

the Find or Replace dialog box, or 
between the Header and Footer 
window and the Page Header or 
Page Footer dialog box 





APPENDIX B 

Windows and Networks 

Using Windows with Networks 
The Microsoft Windows operating system provides many features that make it 
easier to work with a network's resources. Before you use these features, you 
should be aware of some basic guidelines for using networks. This appendix 
outlines Windows network features and lists guidelines for using networks. 

For information about setting up Windows from a network, see Chapter 1, 
"Setting Up Windows." 

Windows Network Features 
The following list describes what you can do with Windows and networks and 
where to find information about the Windows network features. 

You can do the following: 

• Connect your system to a particular network directory. On some networks, 
you can browse through a list of directories to find the one you want. For 
information, see Chapter 7, "File Manager." 

• Set up a network for use with Windows and set options that are specific to 
your network. For information, see Help for Windows Setup. 

• Set up network printer connections. On some networks, you can browse 
through a list of printers to find the one you want. For information, see 
Chapter 8, "Print Manager." 
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• Take advantage of special features offered by Print Manager when you use a 
network printer. For information, see Chapter 8, "Print Manager." 
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Guidelines for Using Networks 
You can avoid many problems when using Windows with a network by following 
these guidelines: 

• Read the NETWORKS.WRI online document that is included with this 
version of Windows to make sure your network software is compatible with 
Windows. This document contains information about running Windows with 
your specific network. 

• Always start the network before you start Windows. 

You can connect to network directories and printers after you start Windows, 
but the network software must be running on your computer before you start 
Windows. If you try to start your network after you have started Windows, 
your system may not run correctly. 

• Some networks fail if you log in or log out at the MS-DOS prompt while 
running Windows. Some networks support logging in or out by using the 
Network option in Control Panel. If your network does not support this 
feature, log in before you start Windows. 

• If you are using a shared copy of Windows or a shared copy of another 
application, use the same letter to designate the network directory on your 
system every time you connect to that directory. 

For example, if you use the drive letter W when you connect to the network 
directory to set up a shared copy of Windows, Windows records W as the path 
it should use in the future to look for the shared Windows files. If the next time 
you connect to the same network directory you use a letter other than W, you 
will not be able to start Windows correctly. 

If you do need to specify a different drive letter when you connect to a 
network directory in order to use a shared application, be sure to change 
the path that Windows uses to find the application. 

• Every time you connect to a network printer, use the same port for that 
particular printer. 

Control Panel retains the printer settings for a particular port. If you change the 
port you are using for a printer, the settings for the new port may not be correct 
for that printer. 

If you do need to change the port your printer is connected to, be sure to use 
Control Panel to change the printer settings. 
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APPENDIX C 

Troubleshooting 

This appendix is designed to help if you encounter problems when using the 
Microsoft Windows operating system. Each section suggests steps you can take 
to solve the most common problems. 

This appendix has the following sections: 

• Setting Up Windows 

• Using a Mouse 

• Running Applications 

• Linking and Embedding Objects 

• Printing 

• Managing Memory 

• Using Serial Communications 

• Using Terminal 

• Using Windows with a Network 

• Using Two Versions of Windows 

• Additional Troubleshooting Techniques 

Setting Up Windows 
The following sections describe solutions to problems you might have when 
setting up Windows. 

Your system locks up during the MS-DOS part of Setup. 
The first part of the Setup program runs with MS-DOS. (Later, Setup switches to 
Windows mode.) If the Setup program stops while still using MS-DOS, it may be 
because Setup was unable to correctly detect your hardware. To solve this 
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problem, type setup Ii to run Setup again. This causes Setup to skip hardware 
detection and run Custom Setup, in which you specify your system settings. In the 
System Information screen, select descriptions that match the hardware on your 
system. 

Setup stops when switching from MS-DOS to Windows. 
The first part of the Setup program runs with MS-DOS. If Setup stops when 
switching from MS-DOS to Windows, it may be due to one of the following 
reasons: 

• When you started Setup, your system had an application in memory sending 
output directly to your screen. An example is a network message service that 
notifies you when printing is complete. Be sure to close any such applications 
before starting Setup. 

• Setup was unable to correctly detect your hardware or software. You need to 
quit Setup and run it again, choosing the Custom Setup option. If possible, 
Setup indicates which hardware or software is causing the problem. Make sure 
the descriptions of hardware and software in the System Information screen 
match what you have on your system. If not, correct the settings. 

• You are running the wrong version of MS-DOS. Windows version 3.1 requires 
MS-DOS version 3.1 or later. To find out which version you are running, type 
ver at the command prompt. If necessary, install a newer version of MS-DOS, 
restart your computer, and then run Windows Setup again. 

• Your system has a memory-resident program (also known as a terminate-and
stay-resident program, or TSR) that is incompatible with Setup. Setup detects 
and notifies you about using certain programs. Read the online document 
SETUP.TXT for information about using specific programs with Setup or 
Windows. 

SETUP.TXT is a text-only file located on a Windows Setup disk. Programs are 
listed alphabetically in the file. To look at the file, use a text editor you have 
on your system, or use the following procedure. 

~ To view the SETUP.TXT file 

1. Type the following at the command prompt: 

more < setup.txt 

The file is displayed, one screen at a time. 

2. To see the next screen, press the SPACEBAR. 

3. To quit viewing the file, press CTRL+C. 
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You might need to remove from your CONFIG.SYS and AUTOEXEC.BAT files 
any command lines that specify memory-resident programs and then restart your 
computer. For more information, see "Additional Troubleshooting Techniques" 
later in this appendix. 

The Setup program keeps prompting you for the same disk. 
When you run the Setup program, you are prompted to insert disks one by one. If 
Setup doesn't recognize that you have inserted the disk you are being prompted 
for, it might be for one of the following reasons: 

• A disk-caching program (such as SMARTDrive) is caching the floppy disk. 
To correct the problem, use a text editor to open the CONFIG.SYS or 
AUTOEXEC.BAT file, and then disable or remove the command line that 
specifies the disk-caching program. 

For this change to take effect, you must restart your computer (remove the 
Setup disk from the floppy disk drive first). Then run Setup again. 

• The system did not recognize that you changed the floppy disk. To correct 
the problem, add a drivparm command to your CONFIG.SYS file, and then 
restart your computer. For example, if you are setting up Windows from a 
5.25-inch, 1.2-MB floppy disk drive labeled A, you would add the following 
line to the CONFIG.SYS file: 

drivparm = Id:O If:l 

For this change to take effect, you must restart your computer (remove the 
Setup disk from the disk drive first). See your MS-DOS documentation for 
more information about the drivparm command. 

You have special hardware to set up with Windows. 
To use your hardware with Windows, you install a device driver. A device driver 
is a program that instructs Windows how to communicate with your hardware. 
Windows includes drivers for most popular types of display adapters, printers, 
and other devices. 

Windows drivers for your hardware may be available from the following sources: 

• Microsoft provides the Windows Driver Library (WDL), which contains 
device drivers made available after this version of Windows was released. 
If you have a modem, you can download the WDL from network services, 
including CompuServe, GEnie, Microsoft Online, various user-group 
bulletin-board services (BBSs on the Association of PC User Groups, or 
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APCUG, network), and the electronic downloading service maintained by 
Microsoft (phone 206-936-6735). Users who do not have a modem and are 
located in the United States may obtain disks by contacting Microsoft 
Customer Support Services at 1-800-426-9400. 

• If the WDL does not include a driver for your hardware, contact your hardware 
manufacturer to find out whether a device driver is available that is compatible 
with Windows version 3.1. 

Note Color graphics adapter (CGA) display drivers are no longer included with 
Windows. You can, however, obtain a CGA display driver from the WDL, as 
previously described in this section. CGA monitors are not fully supported in 
Windows 3.1 and higher. An enhanced graphics adapter (EGA) or better is 
recommended. 

You receive a message about memory-resident programs. 
The Windows Setup program detects and warns you about some memory
resident (TSR) programs that might not be compatible with Windows. For 
information about setting up and using specific memory-resident programs, see 
the SETUP.TXT online document. SETUP.TXT is a text-only file located on a 
Windows Setup disk. The programs are listed alphabetically in the file. To look at 
the file, use a text editor you have on your system, or use the procedure described 
in the section "Setup Stops When Switching from MS-DOS to Windows" earlier 
in this appendix. 

Windows won't start after a successful Setup. 
If you completed Setup but cannot start Windows, one of the following might be 
the cause: 

• The wrong hardware is specified for your system. This might occur because 
you ran Express Setup and Setup was unable to correctly detect your 
hardware; or because during Custom Setup, you specified the wrong hardware 
settings. In the Windows directory, type setup at the command prompt. Make 
sure the hardware information is correct in the System Information Screen. 
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• Your system may be running memory-resident (TSR) programs that are 
incompatible with Windows. Setup detects and warns you about most of these 
programs; however, your system may have a program that Setup cannot detect. 

For more information about troubleshooting problems with memory-resident 
programs, see "Streamline the CONFIG.SYS and AUTOEXEC.BAT Files" 
later in this appendix. 

If Windows still won't start, run Setup again from the Windows disks, using the 
following guidelines: 

• Type setup Ii, which causes Setup to skip hardware detection. This also runs 
Custom Setup, in which you specify your system settings. In the System 
Information screen, be sure to choose descriptions that match the hardware 
on your system. Then restart your system, and type win to start Windows. 

• Type win Is (for standard mode) or win 13 (for 386 enhanced mode). If you 
can start Windows in standard mode, see the next section. 

Windows runs in standard mode but not in 386 enhanced mode. 
If you have an 80386 or 80486 computer and Windows can run only in standard 
mode, you may be able to correct the problem in one of the following ways: 

• Make sure that your computer has at least an 80386 processor and enough 
memory to run in 386 enhanced mode. You should have at least 200K of free 
conventional memory, 1024K (1 MB) of free extended memory, and at least 2 
MB of free disk space. 

If your system meets these requirements, try to start Windows in 386 enhanced 
mode by typing win 13 at the command prompt. Although you can force 
Windows into 386 enhanced mode if it has less than 1024K of extended 
memory, it is not recommended, because Windows may run very slowly. 

• Use the EMMExclude option when you start Windows, by typing win Id:x at 
the command prompt. This excludes the adapter area from areas that Windows 
searches for unused address space. Typically, this is the area AOOO-FFFF. The 
search can cause conflicts with adapters that use this area. 

If using this command successfully starts Windows in 386 enhanced mode, 
you might want to add the EMMExciude command to your SYSTEM.INI file, 
as described in the procedure following this list. 

• Use the VirtualHDirq option when you start Windows, by typing win Id:v at 
the command prompt. This gives your hard disk-rather than Windows 386 
enhanced mode-control over how hard-disk interrupts are processed. 
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If using this command successfully starts Windows in 386 enhanced mode, 
you might want to add the VirtualHDirq=False command to your 
SYSTEM.lNI file, as described in the following procedure. 

~ To add an EMMExclude or VirtualHDirq command to SYSTEM.INI 

1. Using a text editor, open the SYSTEM.lNI file, which is located in your 
Windows directory. 

2. Find the [386Enh] section of the file, and type one of the following lines: 

EMMExclude=AOOO-FFFF 

VirtualHDirq=F ALSE 

3. Save your changes to the SYSTEM.lNI file. 

4. At the command prompt, type win to start Windows. 

Note When you add the EMMExclude command to your SYSTEM.lNI file, you 
are probably excluding more address space than is necessary. To find out a more 
precise amount of address space to exclude, you can use the Microsoft 
Diagnostics (MSD) program. To start MSD, type msd at the command prompt. 
From the first screen, choose Memory . You should exclude any address space 
identified as "RAM" or "ROM." You might also be able to exclude address space 
identified as "Possibly Available." 

You need to copy Windows files directly to your computer. 
The files on the Windows Setup disks are compressed and are not usable until 
expanded. Usually, Setup and Control Panel expand the compressed files as they 
are copied to your hard disk. In some cases, you may need to copy files directly 
from a Windows Setup disk without using Setup or Control Panel. 

The EXPAND.EXE file is copied to your Windows directory during the setup 
process. 

~ To copy Windows files to your system and expand them 

1. Insert in drive A (or another floppy disk drive) the disk containing the file you 
want to expand. 

2. Type the following command at the command prompt, and then press ENTER: 

expand x:\filenamel y:\windirectory\filename2 

where x is the floppy disk you are copying from, filename1 is the name of 
the compressed file you want to copy, y is the hard disk you are copying to, 
windirectory is the name of your Windows directory, and filename2 is the file 
you want to appear on your hard disk. The compressed file is expanded as it is 
copied to your hard disk. 
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When files are compressed, their extensions are renamed to end with an 
underscore. System files (.SYS) have the extension .SY _ as compressed files. 
For example, MOUSE.SYS is named MOUSE.SY _, and HIMEM.SYS is named 
HIMEM.SY _. When you use the Setup program to install these files, they are 
expanded and renamed with .SYS extensions. 

If you use the expand command to copy .SY _ files to your hard disk, you must 
change their filename extensions to .SYS. You can use the MS-DOS rename 
command, or you can rename each file as you copy it from the Windows Setup 
disk by using the expand command. For more information about the expand 
command, see your MS-DOS documentation. 

Using a Mouse 
The following sections describe solutions to problems you might have when 
using a mouse with Windows. If you cannot use your mouse and need to use 
your keyboard with Windows, see Chapter 4, "Windows Basics." 

The mouse won't work with Windows. 
If your mouse is not working with Windows, it could be for one of the following 
reasons: 

• If you are using a serial mouse, make sure you are using either the COM1 or 
COM2 serial port. You cannot use serial port COM3 or COM4 with a mouse 
in Windows. Examine your hardware to see which port the mouse cable is 
attached to. Then make sure Windows is set up correctly by using the Ports 
option in Control Panel. 

• Determine which hardware interrupt (IRQ) the mouse port is set to use and 
whether there is another device set to use the same IRQ. If there is an IRQ 
conflict with the serial or bus port that the mouse is connected to, the mouse 
won't work. For information about changing IRQ settings and determining 
which IRQs the mouse port and other hardware are using, see your mouse 
and hardware documentation. 

The mouse pointer won't move. 
If your mouse pointer won't move, it could be for one of the following reasons: 

• If the mouse pointer appears on your screen but won't move, choose the 
Windows Setup icon in the Main group to display a list of settings. Make 
sure the mouse you are using is listed here. For information about keyboard 
techniques you can use in Windows, see Appendix A, "Keyboard Shortcuts." 
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• If you are certain you are using the appropriate mouse driver and the mouse 
pointer still won't move, see whether there is an interrupt (IRQ) conflict 
between the mouse port and another device. For information about 
determining which IRQ your mouse or other hardware is using, see the 
documentation supplied with your hardware. 

The mouse pointer jumps around on the Windows screen. 
If the mouse pointer jumps around rather than moving smoothly, you might have 
one of the following problems: 

• There might be a system-hardware interrupt (IRQ) conflict. You need to set up 
the mouse so that it isn't using an IRQ that is being used by another device. 
For information about changing mouse IRQ settings, see the documentation 
supplied with your mouse. 

• Your mouse needs to be cleaned. For instructions, see the documentation 
supplied with your mouse. 

The mouse won't work with an MS·DOS application running in a 
window. 

If your mouse works with an MS-DOS-based application running in a full screen 
but not with an MS-DOS-based application running in a window, you could have 
one of the following problems: 

• To use a mouse with an MS-DOS-based application running in a window, you 
must set up the mouse driver before starting Windows. For a Microsoft mouse, 
you need to use either the MOUSE.SYS or MOUSE.COM driver. You set up 
MOUSE.SYS in the CONFIG.SYS file, or you set up MOUSE.COM in the 
AUTOEXEC.BAT file. For example, to specify the MOUSE.SYS device 
driver located in the WINDOWS directory on drive C, add the following 
command line to your CONFIG.SYS file: 

device = c:\windows\mouse.sys 

The MS-DOS mouse driver you are using might not support the use of a 
mouse pointer for an MS-DOS-based application running in a window. The 
MS-DOS mouse drivers MOUSE.SYS and MOUSE.COM do support this. 

If you are copying these files from the Windows disks, you need to use the 
expand command. For more information, see "You Need to Copy Windows 
Files Directly to Your Computer" earlier in this appendix. 

• You might be using a display driver that does not support the use of a mouse 
pointer for an MS-DOS-based application running in a window. 
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If you are using a 16-color, 800x600-resolution display adapter with a display 
driver that was provided with a Windows version earlier than 3.1, you need to 
update the driver. Display drivers provided with the Windows version 3.0 
Supplemental Driver Library should be updated as well. You need to use the 
standard Super VGA display driver provided with Windows version 3.1. You 
can install this driver, even after Windows is installed, by using the Setup 
program. 

If you are using a display driver that was provided with your display 
adapter, you might need to update the driver to one designed to work with 
MS-DOS-based applications running in a window. Contact your display
adapter manufacturer for an updated display driver. For more information 
about using specific display adapters, view the README.WRI online 
document by using Write (in the Accessories group). 

• If you are using an IBM mouse with the IBM mouse driver version 1.0, you 
need to replace this driver. Version 1.0 of this driver was not designed to 
support MS-DOS-based applications running in a window. Contact your 
dealer for an updated version of the mouse driver. 

Running Applications 
Applications usually run without problems. However, you might occasionally 
receive an error message when starting or running an application, or a key or 
function might not work properly. The following recommendations cover the 
most common problems. 

You press a key, and the unexpected happens. 
If a key combination doesn't work, it is usually because Windows or another 
running application is using the key combination for another purpose. 

The following are some common problems and solutions: 

• You use a key combination that should perform a function in an application, 
but it instead performs a Windows function (for example, you unexpectedly 
switch to another application). 

You are probably using a Windows shortcut key. You assign a Windows 
shortcut key to an application by using the Properties command on the 
File menu in Program Manager or by specifying a key combination in the 
application's program information file (PIF). Use the Properties command 
or check the application's PIF to find out whether you have assigned a 
Windows shortcut key to your application. For more information, see 
Chapter 5, "Application Basics," and Help for PIF Editor. 
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• You press a Windows shortcut-key combination, such as ALT+TAB, but the 
Windows function is not performed. 

The key combination probably is reserved for an MS-DOS-based application 
and no longer performs the Windows function. Check the PIF of the 
foreground application to determine whether a Windows key combination 
is reserved for that application. 

• If Windows is running in 386 enhanced mode and you hear a beep whenever 
you press a key while using a particular application, Windows might have 
suspended that application. This might happen, for example, if you try to run 
the application in a window but it cannot run in a window. If that is the case, 
press ALT +ENTER to return the application to a full screen. If the application 
does not respond to ALT +ENTER, you might be able to press CTRL+ALT +DEL 

to quit the application without having to restart Windows or your computer. 

• If Windows is running in 386 enhanced mode and you have chosen the 
Select or Mark command from the Control menu (the application's title bar 
will contain the word "Select" or "Mark"), Windows is waiting for you to 
select information to copy onto the Clipboard. To cancel the command, press 
the ESC key. To copy selected information onto the Clipboard, choose the 
Copy command from the application's Edit menu, or click using the right 
mouse button. 

• If Windows is running in 386 enhanced mode and you have chosen the Scroll 
command from the Control menu (the application'S title bar will contain the 
word "Scroll"), Windows is waiting for you to use the arrow keys to scroll 
through the information in the application's window. To cancel the Scroll 
command, press the ESC key. 

• If you are using a language that has accented characters, you might not be 
able to use those characters when naming files. Before MS-DOS reads a 
filename, it shifts all the letters in the filename to uppercase. Some accented 
characters do not have valid uppercase characters. 

Your application stops responding to the system. 
If an application stops responding to the system, use the following checklist: 

• You can press CTRL+ALT +DEL to quit an application that has stopped 
responding to the system. Windows displays a message confirming your 
action. To continue, follow the instructions in the message. 

When you are using MS-DOS (not MS-DOS Prompt within Windows) 
and you press CTRL+ALT+DEL, your computer restarts. When you press 
CTRL+ALT +DEL while using Windows, you can quit the application that has 
stopped responding without having to restart your computer or Windows. 

• You are running an earlier version of a Windows application that is 
incompatible with Windows version 3.0 or later. Contact the manufacturer 
for an updated version of the application. 
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Your application runs too slowly. 
If your application runs too slowly, try one of the following solutions: 

• Your system might be low on memory. If your hard-disk light blinks 
frequently, Windows is swapping information to disk to make room in 
memory for other information or is rereading information from the disk 
into memory. For information about making more memory available, see 
Chapter 14, "Managing Memory and Performance." 

• You might need to set up a permanent swap file. If Windows is running 
in 386 enhanced mode and you run more than one application at a time or 
applications that use very large files, you should set up a permanent swap 
file. Do this by choosing the 386 Enhanced icon in Control Panel and then 
choosing the Virtual Memory button. For more information, press the Fl key 
while using the dialog box, or see Chapter 14, "Managing Memory and 
Performance. " 

Your Super VGA screen contents are not restored correctly. 
If you use a Super VGA and the screen contents aren't restored correctly when 
you switch between Windows and an MS-DOS-based application, you probably 
need to update your display driver. The Super VGA display driver provided with 
Windows version 3.1 supports most 16-color, 800x600-resolution display 
adapters. If it doesn't work correctly, contact the display-adapter manufacturer to 
find out whether there is a Windows version 3.1 display driver available for your 
display adapter. 

You cannot take a snapshot of the screen. 
If you cannot take a "snapshot" of an application screen, one of the following 
might be the cause: 

• If Windows is running in standard mode and you are trying to take a snapshot 
of an MS-DOS-based application, open the application's program information 
file (PIF) by using PIF Editor, and see whether the No Screen Exchange check 
box is selected in the application's PIF. This option prevents you from copying 
information onto the Clipboard by using PRINT SCREEN or the ALT +PRINT 

SCREEN key combination. This option might be set to give the application 
enough memory to run. Try clearing this check box. 

• If you are trying to take a snapshot of an MS-DOS-based application by 
using the PRINT SCREEN or ALT+PRINT SCREEN key combination (usually 
Windows shortcut keys), these combinations might be reserved for the active 
application. Try clearing the corresponding Reserve Shortcut Key check boxes 
in the active application's PIF. 
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• If Windows is running in standard mode, the wrong Video Mode option button 
might be selected in the application's PIF. Try selecting a higher-resolution 
video mode. 

• If Windows is running in 386 enhanced mode, more memory might be 
required. Quit some applications to free memory. For more information, 
see "Managing Memory" later in this appendix. 

You cannot paste information into an MS-OOS-based application. 
If you cannot paste information from the Clipboard into an MS-DOS-based 
application, one of the following could be the cause: 

• The information might not be in text format. Windows cannot paste graphics 
into an MS-DOS-based application. Try saving the information you want to 
paste as a separate file and then opening the file by using the application. 

• An MS-DOS-based application might not be able to accommodate the fastest 
pasting method. If Windows is running in 386 enhanced mode, the Allow Fast 
Paste check box in the application's PIF is usually selected because most 
applications can accommodate the fastest pasting method. However, if the 
application cannot use the fastest method, it might not respond when you try to 
paste into it. Try clearing the Allow Fast Paste check box in the application's 
PIF . You must restart the application for the changes to a PIF to take effect. 

You cannot change the font size for an MS-OOS-based 
application. 

If you cannot change the font size for an MS-DOS-based application running 
in a window, one of the following could be the cause: 

• The application is probably running in graphics mode. You can change 
font sizes only when the application is running in text mode. With some 
MS-DOS-based applications, you can choose which mode the application 
runs in. To find out whether your application can run in text mode, see the 
documentation included with the application. 

• You might be using a display driver that doesn't provide the capability of 
changing fonts for an MS-DOS-based application running in a window. 
If you are using a 16-color, 800x600-resolution video graphics adapter (Super 
VGA), make sure you are using the Super VGA display driver provided with 
Windows version 3.1. This driver supports most Super VGA display adapters. 
If this driver doesn't work, contact the display-adapter manufacturer to find 
out whether a Windows version 3.1 display driver is available. 
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• If you are using a display driver that doesn't provide the capability of 
changing fonts for an MS-DOS-based application running in a window, 
try including the following line in the [Non WindowsApp] section of the 
SYSTEM.lNI file: 

FontChangeEnable=l 

For more information about modifying the SYSTEM.lNI file, view the 
SYSINI.WRI online document by using Write (in the Accessories group). 

Note This setting does not work for all display drivers. In some cases, specifying 
this setting causes the mouse pointer to be displayed incorrectly. 

Your system stops responding or quits unexpectedly. 
If Windows or your computer stops responding, an application or Windows closes 
unexpectedly, or your computer restarts unexpectedly, one of the following might 
be the cause: 

• You are running an earlier version of a Windows-based application that is 
incompatible with Windows version 3.0 or later. Contact the manufacturer for 
an updated version of the application. 

• You are using hardware that is incompatible with Windows. Sometimes 
you can resolve hardware incompatibility by adjusting settings in your 
SYSTEM.lNI file. For more information about SYSTEM.lNI, use Write to 
view the SYSINI.WRI online document. 

You receive a message that the registration database is 
corrupted. 

If you have problems such as the following, your registration database may be 
corrupted: 

• You try to open or print a file that is associated with an application and you 
receive a message that the association information is incomplete. 

• While working with linked or embedded objects, you receive a message that 
the server is not registering properly. 

• In File Manager, you choose the Associate command and there are no entries 
in the list of files in the Associate dialog box. 

If your registration database is corrupted, you must delete the registration 
database and then recreate it. 



246 Microsoft Windows User's Guide 

~ To restore your registration database 

1. Quit Windows. 

2. Delete the REG.DAT file (located in your Windows directory). 

3. Restart Windows. 

4. Start Registration Info Editor by opening File Manager and then choosing the 
REGEDIT.EXE file (located in your Windows directory). 

5. From the File menu, choose Merge Registration File. The Merge Registration 
dialog box appears. 

6. In the File Name List, select the SETUP.REG file, and then choose the OK 
button. (The SETUP. REG file is located in the Windows SYSTEM 
subdirectory. ) 

7. Search for * .REG files on drive C by using the Search command on the File 
menu in File Manager. 

8. Double-click each .REG file (or select it, and then press ENTER). 

9. Repeat steps 6 through 8 for each drive on your system. 

Note You may need to contact your software manufacturer if problems still 
persist when running a Windows-based application. 

Linking and Embedding Objects 
The following sections describe solutions to problems you might encounter when 
linking and embedding objects by using Windows-based applications that support 
object linking and embedding. 

You receive a message that the server is unavailable. 
The application used to create the object (sometimes referred to as a server 
application) must be available when you try to create, edit, play, or update an 
object in a destination document. A server application cannot respond if it is 
performing an action such as printing or making calculations, if the cursor is in 
a field waiting for information, or if a dialog box is open. 

Use the following guidelines to solve the problem: 

• Wait a short while to determine whether the server is going to become 
available to respond to your request. If it becomes available, the message 
closes and your request is processed. 
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If the server application does not become available, you may be able to 
choose the Cancel button in the dialog box to cancel the request. If you do 
not want to or cannot cancel the request, determine which server application is 
unavailable. Then switch to the server application, and complete or cancel the 
action that is causing the application to be unavailable. 

• Your registration database may be corrupted. For information about restoring 
your registration database, see "You Receive a Message That the Registration 
Database is Corrupted" earlier in this appendix. 

You choose an object type from the Insert Object dialog box, but 
the application doesn't open. 

If you choose an object type from the Insert Object dialog box and the application 
doesn't open, it means Windows cannot find the application. 

Use the following checklist to solve the problem: 

• Make sure the application that creates this object type has not been deleted 
from the computer. For example, Paintbrush (PBRUSH.EXE) needs to be on 
your computer before you can open a Paintbrush Picture object type. 

• If the application has been moved from the location specified in the 
registration database, make sure the directory containing the application 
is included in the path in your AUTOEXEC.BAT file. 

• Try reinstalling the application. 

You get different results each time you use the Paste command. 
When you use the Paste command, the contents of the Clipboard are either 
inserted or embedded into the document. The result is determined by the type 
of application you used to create the information on the Clipboard. 

If you used a server application-one that can supply objects for object linking 
and embedding-the information may be embedded when you choose the Paste 
command. When the information is embedded, you can activate the information 
or edit it from within the document. 

If the application used to create the information on the Clipboard does not 
support object linking and embedding, the information is simply inserted when 
you choose the Paste command and cannot be edited or activated from within the 
document. 
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A linked sound object updates automatically even though it is set 
to update manually. 

When you create a link, you are inserting into the destination document a 
reference to the source document that contains the linked object. When the 
object is placed in the destination document, you see either the same information 
that is in the source document or a representation of that data, such as an icon. 
When an object is represented by an icon, as it always is for a sound object, you 
always get the latest information when you choose the object. 

The Picture option in the Content window of Object Packager is 
unavailable. 

The Picture option in the Content window displays a snapshot view of the 
object. Picture View is available only when the object was created with a server 
application and when the Clipboard is used to transfer the object into Object 
Packager. 

If you use the Import command on the File menu to load a document into Object 
Packager, or you copy onto the Clipboard information created by using an 
application that is not a server, the Picture option is not available. 

A linked object is not updating. 
Under certain circumstances, a linked object must be manually updated in the 
source document before the linked object in the destination document is 
updated, regardless of whether it is an automatic or manual link. This is true for 
links to documents that contain text, spreadsheets, and pictures because these 
linked objects are represented in the destination document by images that 
reproduce the information in the source file. This is not true for links to sound 
and animation files because these types of links are represented by icons and 
not by the contents of the linked document. 

For example, suppose you have a destination document open that contains a link 
to a Paintbrush document, and you have the source document open in Paintbrush. 
When you make changes to the source document in Paintbrush, the visual 
presentation of the Paintbrush object in the destination document is not updated 
with the changes you are making. You must save the document in Paintbrush and 
then update the linked object in the destination document to see the updated 
object. 
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~ To update a link 

1. Select the linked object in the destination document. 

2. From the Edit menu, choose Links. 

3. Choose the Update Now button. 

4. Choose the OK button. 

The Paste command in Cardfile is not available, yet there is 
information on the Clipboard. 

You must first choose the Picture command from the Edit menu before you can 
use the Paste, Paste Link, and Paste Special commands in Cardfile. 

A check mark appears next to the Picture command when it is in effect. 

The Paste Link command appears dimmed, yet there is 
information on the Clipboard. 

Printing 

If the Paste Link command appears dimmed in your application and you know 
there is information on the Clipboard, one of the following may be the cause: 

• You can only create a link to information in a saved file, so the Paste Link 
command is available in the destination document's application only when 
you copy information from a saved file onto the Clipboard. 

Save the file before copying information onto the Clipboard. Then you have 
the choice of using the Paste command to embed the information or the Paste 
Link command to create a link to it. 

• If you have chosen the Paste Special command in a destination document 
and are selecting from a list of file formats, the Paste Link command will be 
available only when the format you have selected is supported by the 
application used to create the destination document. 

The following sections describe common printer problems and offer suggestions 
for correcting the problems. When there are suggested steps to follow, you should 
try to print after you complete one of the steps. If you can print from Windows, 
you've solved the problem. If not, try the next step. 
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Your printer does not print. 
When a printer cannot print, the cause is often mechanical. For example, the 
printer could be offline, turned off, or disconnected. Use the following checklist: 

• Is the printer plugged in, turned on, and online? 

• Do you have the correct cable for your printer, and is it properly connected? 
For example, if you are using a Hewlett-Packard plotter, you need to use a 
Hewlett-Packard plotter cable. If you suspect the cable is the problem, you 
may want to borrow a cable that is working with another computer and printer. 

• Does the currently selected printer in the application you are printing from 
match the printer you are printing to? 

• Are the printing options set correctly, and have you chosen the correct port for 
the selected printer? For more information, see Chapter 8, "Print Manager." 

• When you are using a serial printer and you choose the Ports icon in Control 
Panel, does the information in the Settings dialog box match those required by 
your printer? For more information, see Chapter 13, "Configuring Hardware." 

• Do you need to change the ribbon, install a print wheel or cartridge, or add 
paper? Choose the Print Manager icon in the Main group. Depending on the 
printer you are using and the commands you have chosen from the Options 
menu, a message might appear that describes the problem. 

• If you are printing to a network printer, have you connected to the network 
printer? 

• Can you print from Notepad and Write? If so, the problem is likely with the 
application you are using. Consult the application's documentation or contact 
the software manufacturer. 

• If you are using a switchbox to switch between different printers, try clearing 
the Fast Printing Direct To Port check box in the Connect dialog box. (Choose 
the Printer icon in Control Panel, and then choose the Connect button.) If this 
doesn't work, try printing directly to the printer without using the switchbox. 

If you still cannot print, try copying a small text file from MS-DOS directly to the 
port your printer is connected to. For printers that accept ASCII codes (such as 
dot-matrix printers) and PCL printers (Hewlett-Packard DeskJet, LaserJet, or 
compatible printers), you could type the following at the command prompt, 
specifying the directory where your Windows files are located, and the port 
you are using: 

copy c:\windows\setup.txt Ipt1: 

The output from the copy command (in this example, the contents of your 
SETUP. TXT file) is sent to the printer that is using LPTl instead of to the screen. 
If the file doesn't print, the problem is not with Windows. For more information, 
see the documentation supplied with your printer. 
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For PostScript printers, try copying the file TESTPS.TXT to the port you are 
using. This file was copied to your hard disk when you installed the PostScript 
printer driver. For example, if your Windows system files are stored in a directory 
named C:\WINDOWS\SYSTEM (the default directory name), you would type the 
following: 

copy c:\windows\system\testps.txt coml 

This command line prints a list of communications settings. Make sure your 
settings match the list. 

You can print from MS-DOS but not from Windows. 
If you can print from MS-DOS but not from Windows, there may not be enough 
space for Windows to store temporary files. (Windows creates temporary files 
when printing, even if you are not using Print Manager.) 

~ To see how much space exists for temporary files 

1. At the command prompt, type set to see what directory the TEMP 
environment variable is set to use. 

2. If there is a TEMP variable listed, make sure the specified directory exists. If 
it doesn't exist, you need to create it or reset the value of TEMP to specify 
an existing directory. If there is no TEMP variable listed, define one. For 
example, to set the TEMP variable to use a directory named TMP located 
on drive C, add the following line to your AUTOEXEC.BAT file: 

set temp=c:\tmp 

You need to restart your computer after making changes to the 
AUTOEXEC.BAT file. Windows uses the root directory of your 
startup drive to store temporary files if no other location is defined. 

3. Change to the directory specified by the TEMP variable. 

4. Type dir to see how much space is available. Windows needs at least 2 MB 
of free disk space in which to store temporary files. 

5. If you had to change any of these settings, try printing again. 

If you still cannot print, step through the following checklist: 

• Check the printer cable. Windows-based applications require that all pin 
connectors are functioning, whereas some MS-DOS-based applications 
do not. Try using a cable that you know is functioning. 

• If you are using a serial printer, make sure you do not have an interrupt (IRQ) 
conflict. A mouse might be on the same IRQ as the serial port being used for 
printing. 
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• Make sure you are not using a serial port to connect to a network printer. 
Windows supports network-printer connections on parallel (LPT) ports only. 

• If you are using a printer that isn't listed during Windows Setup (or in the 
Printers dialog box in Print Manager or Control Panel) and are trying to 
emulate a standard printer, make sure you have chosen the correct printer 
to emulate. See your printer documentation. 

• Try printing without using Print Manager. To turn off (deactivate) Print 
Manager, choose the Printers icon in Control Panel, and then clear the Use 
Print Manager check box. 

• If you are printing to LPT1, try printing to the LPT1.DOS file instead. 
To specify the LPT1.DOS file, choose the Printers icon in Control Panel. 
When the Printers dialog box appears, choose the Connect button. Choose 
LPT1.DOS from the Ports list. If LPT1.DOS does not appear in the list, you 
need to add it to the list of ports in the [ports] section of the WIN.INI file. 
For more information, view the WININI.WRI online document by using Write 
(in the Accessories group). 

The page prints but is formatted incorrectly. 
If the pages of a document are formatted incorrectly, the margins are incorrect, the 
document contains extra lines, or the document is paginated incorrectly, use this 
checklist: 

• If you haven't already read the PRINTERS.WRI online document provided 
with Windows, you should determine whether it contains information specific 
to your printer. You can view this file by using Write (in the Accessories 
group). 

• Make sure your printer is capable of printing the formats you specified in your 
application. Pay special attention to your printer's capabilities when selecting 
fonts and point sizes. For more information about the font you specified in 
Windows, start Write, and then choose Fonts from the Character menu. The 
Font dialog box appears, providing information about the fonts that are 
available with Windows. 

• Make sure you specified the correct settings when you configured your 
printer. When configuring a printer, you can control settings such as margin 
size, number of lines per printed page, paper orientation, and number of dots 
per inch. Choose the Printers icon in Control Panel. In the Printers dialog box, 
select the printer you are using, and then choose the Setup button. 

• If your printer has hardware switches that set page length or line length, 
make sure you've chosen the correct settings. (For information, see your 
printer documentation.) For example, on a Hewlett-Packard LaserJet printer, 
you would set the number of lines per printed page to a maximum of 66. 
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• If your printer has a hardware switch that inserts an automatic linefeed at 
each carriage return, it should be set for carriage returns only. For more 
information, see your printer documentation. 

• Determine whether the formatting problems are consistent by printing the 
same file twice. If the two printouts look different, you may be having 
problems sending printing information through the port. 

Your printer output is garbled. 
If you can print your document, but it is unreadable or contains extra characters, 
use this checklist: 

• Make sure the correct printer is selected as the default printer. For more 
information, see Chapter 8, "Print Manager." 

• If your printer accepts font cartridges, make sure you select the correct 
cartridge when you set the printing options. If the wrong font cartridge is 
selected, the printer may insert stray characters at the beginning of lines. 
For more information, see Chapter 12, "Customizing Windows." 

• If you have a serial printer, make sure the settings for the printer port match 
those required by your printer. Choose the Ports icon in Control Panel, and 
then choose the Settings button. Lowering the baud rate might solve the 
problem. 

• You may be using a printer that isn't listed during Windows Setup (or in the 
Printers dialog box in Print Manager or Control Panel). If so, you are probably 
trying to use your printer to emulate a standard printer. Few printers are 100-
percent accurate when emulating industry-standard printers. Often, fonts are 
not printed accurately. Try emulating a different type of printer. You could 
also contact the printer manufacturer to find out whether a Windows printer 
driver is available for your printer. 

• The printer buffer may be retaining garbled information. Try turning the 
printer off, waiting a few seconds, and then turning it on again. 

• The printer cable may be faulty. Verify that you have the correct cable and 
that it is functioning. 

As a last resort, try installing the Windows Genericffext Only printer-driver file 
to see how it works with your printer. You could also contact your printer 
manufacturer or dealer to determine whether there is a problem with your printer. 
For information about installing printer drivers, see Chapter 8, "Print Manager." 
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The last page of a document is left in the printer. 
Some MS-DOS-based applications leave the last page of a document in the 
printer instead of ejecting it when printing is completed. When this happens, 
the next document to be printed starts printing on the last page of the previous 
document. 

If your printer has a form-feed or continue button, you can press the button to get 
the last page out of the printer. 

If you are printing multiple documents, using separator pages can also solve this 
problem. If the last page of a document is still in the printer, it is ejected when the 
separator page that precedes the next document is fed in. 

The fonts on your screen and the fonts that print are different. 
A font set is a group of letters, numbers, symbols, and punctuation marks having 
the same design. Screen fonts display information in windows and dialog boxes. 
Printer fonts are part of the printer driver or are in the form of cartridge fonts and 
soft fonts. Many printer drivers, cartridge fonts, and soft fonts have matching 
screen fonts so that the fonts on your screen look the same as those that print. 
If matching fonts are not available, Windows uses a font that looks the most like 
the printer font being used. Sometimes there isn't a font that looks the same. 

If you use True Type fonts, Windows and Windows-based applications use the 
same fonts, and fonts appear the same on the screen as they do when printed. 
TrueType fonts are installed when you set up Windows. 

.. To find out whether TrueType fonts are available 

1. In the Control Panel window, choose the Fonts icon. 

2. Choose the TrueType button. 

3. Note whether the Enable True Type Fonts check box is selected. If it is, 
TrueType fonts are available and can be used in your documents. 

To view available fonts, choose the Write icon in the Accessories group, and 
then choose the Fonts command from the Character menu. The Font dialog box 
appears, displaying samples of various fonts. The TrueType fonts have a 
TrueType icon next to them, and printer fonts have a printer icon. Plotter and 
screen fonts have no icon next to them. 

You cannot print TrueType fonts on your laser printer. 
When you are using a laser printer, TrueType fonts are listed in your application 
as a selectable font only if you are using a Windows version 3.1 printer driver. 
Windows version 3.1 printer drivers provide the necessary information for 
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printing TrueType fonts. If you cannot print TrueType fonts, the printer driver 
you are using may not be the correct version. Contact your printer manufacturer 
to find out whether a Windows version 3.1 printer driver is available for your 
printer or whether one of the printer drivers supplied with Windows can work 
with your printer. 

Your laser printer does not print your cartridge or soft fonts. 
If you install a font cartridge or soft fonts for your laser printer, but the printer 
doesn't print these fonts, use this checklist: 

• Make sure the printing-option settings for your printer are correct and that you 
have selected the correct cartridge from the Cartridges list in the Setup dialog 
box. To select a cartridge, choose the Printers icon in Control Panel, and then 
choose the Setup button. 

• If you are using a font cartridge, turn off the printer and make sure the 
cartridge is all the way in its slot. You may need to press firmly on the 
cartridge until it pops into the slot. 

• If you are using soft fonts, make sure they are properly installed. (For 
information, see the installation kit provided with your soft fonts.) 

• If your soft fonts are installed as permanent, perhaps the printer was turned 
off or reset. Try sending the soft fonts to the printer again. 

• You may be using too many soft fonts. Printer drivers can support a limited 
number of soft fonts. Generally, PostScript printer drivers have a limit of about 
170 soft fonts. PCL printer drivers generally have a limit of 250 soft fonts. 

The number of soft fonts you can use is also limited by the maximum size of 
the WIN.INI file. The WIN.INI file can be no larger than 64K. If the file is 
full, you cannot specify any additional soft fonts. One way to minimize the 
size of the WIN.INI file is to move the soft-font files closer to the root of the 
directory structure and then specify these shorter paths in the WIN .INI file. 

You can also try installing fewer fonts or installing them as temporary fonts, if 
appropriate. For more information, see your printer documentation or contact 
your printer manufacturer. 

• If you have changed port connections since you installed soft fonts, you need 
to reinstall the soft fonts for the new port. If you are using the Hewlett-Packard 
LaserJet and DeskJet family of printers, choose the Printers icon in Control 
Panel, and then choose the Setup button in the Printers dialog box. Then use 
the Fonts button in the Print Setup dialog box to copy soft fonts from one port 
to another. 
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The printer loses text. 
• If you are using a parallel printer and an LPT port, and the printer loses text, 

the cable could be faulty. Try using a new cable of the same type. 

If you have a serial printer and it prints the document but loses blocks of text, you 
might have a flow-control (also called handshake) problem with your serial port. 

To check for a flow-control problem: 

• Try lowering the baud rate. 

• Make sure all communications settings (baud rate, data bits, parity, stop 
bits, and flow control) are set the same in Windows, in MS-DOS, and on the 
printer. The most common values for these settings are 9600 baud, 8 data bits, 
no parity, 1 stop bit, and Xon/Xoff flow control. 

You can change these settings in Windows by choosing the Ports icon in 
Control Panel and then choosing the Settings button. You can also change 
these settings in MS-DOS by using the mode command. For information 
about mode command-line options, see your MS-DOS documentation. For 
information about settings on the printer, see your printer documentation. 

If the printer is still losing text, make sure all the manual switches on your printer 
are set as described in your printer documentation. If you are using a network 
printer, make sure you are using network software that works with Windows. 
For more information, see the NETWORKS.WRI online document provided with 
Windows. You can view this file by using Write (in the Accessories group). 

Only part of a page prints. 
If your printer prints only part of your document, use the following checklist: 

• The most common cause of this problem is insufficient memory in the printer. 
It is recommended that you add more memory to the printer. If you are 
printing graphics, try using a lower print resolution. You can try printing a 
page of text to confirm that you are running out of memory because you are 
printing graphics. 

• Make sure the paper size you chose when configuring the printer matches 
the paper size loaded in the printer. 

• Make sure you have selected the appropriate memory setting in the printer
driver dialog box. Make sure you haven't specified more memory than your 
printer actually has. 

To view this dialog box, choose the Printer Setup command from the Options 
menu in Print Manager. 
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Paintbrush graphics are too small when printed. 
If you are using Paintbrush and the printed image is much smaller than you 
expected, use the following checklist: 

• From the File menu in Paintbrush, choose Print. Make sure the Use Printer 
Resolution check box is cleared in the Print dialog box. Also, check the 
scaling factor. If a small scaling factor is specified, the printer output is small. 

• From the View menu, choose View Picture to see how the image appears on 
the page. You may need to adjust the position. 

Your PostScript printer runs out of memory. 
Occasionally when you try to print a file, you might see a message indicating 
that the printer is out of memory. 

If you are using a PostScript printer, and the document you are trying to print 
includes soft fonts, try using TrueType or printer fonts instead. (For more 
information, see Chapter 12, "Customizing Windows.") 

You can also try changing some of the options in the Advanced Options 
dialog box. 

~ To change a PostScript printer's options 

1. In the Main group, choose the Print Manager icon. 

2. From the Options menu, choose Printer Setup. 

3. From the list of installed printers, select the printer you are using. 

4. Choose the Setup button. 

S. Choose the Options button. 

6. Choose the Advanced button. 

7. In the Send To Printer As list, make sure Adobe Type 1 is selected. This 
option causes the driver to use outline fonts for large point sizes and 
bitmaps for small point sizes. 

8. Make sure the Clear Memory Per Page check box is selected. This option 
causes the driver to clear the printer's memory after printing each page. 

9. Make sure the Use Substitution Table check box is selected. This option 
causes the driver to use a built-in printer font already in the printer's 
memory instead of using a new font. Make sure you select a printer font 
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to use in place of the TrueType fonts in your document. To do this, choose 
the Edit Substitution Table button, and then supply the necessary information 
in the Substitution dialog box. 

If you need help working with the Advanced Options or the Substitution dialog 
box, choose the Help button or press PI while using the dialog box. 

If a problem still exists after completing this procedure, consider adding more 
memory to your printer. If your printer still runs out of memory when printing, 
there is a problem with the driver or printer. For more information, contact your 
printer manufacturer. 

You receive a message that the printer is not responding. 
When printing files, you may receive the following message from Print Manager: 
"The printer on LPT1 is not responding. Check the printer or increase the 
Transmission Retry value in the Printer Connect dialog box, and then resume 
the print queue." 

Check whether there is a problem with the printer, such as jammed paper, and 
make sure the printer is online. 

You might also receive this message if you are using PostScript printer 
cartridges; it is most common when printing graphics with these cartridges. 
When the printing process takes too long, it appears to Windows that a printer is 
not responding. If you receive this message, go through the following procedure 
to increase the value (in seconds) of the Transmission Retry setting. 

~ To change the Transmission Retry setting 

1. In the Main group, choose the Print Manager icon. 

2. From the Options menu, choose Printer Setup. 

3. Select the printer you are using. 

4. Choose the Connect button. 

5. In the Transmission Retry box, type a larger value (start by doubling the 
current value). 

Managing Memory 
The following sections describe solutions to problems you might encounter when 
managing memory in Windows. For more information about managing memory, 
see Chapter 14, "Managing Memory and Performance." 
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You receive an out-of-memory message. 
If you receive an out-of-memory message when you try to start an application, 
you can free memory in a number of ways, including the following: 

• Free some memory before starting Windows. You may be able to do this 
by modifying your CONFIG.SYS and AUTOEXEC.BAT files to eliminate 
any memory-resident software that isn't needed by all applications. For 
information about how to do this, see Chapter 14, "Managing Memory 
and Performance." 

• Close any applications you aren't using. 

• Run MS-DOS-based applications in a full screen instead of a window 
(possible in 386 enhanced mode only). If an MS-DOS-based application is 
running in a window, you can switch it to a full screen by pressing ALT+ENTER 

while it is the active application. 

• Reduce Windows-based applications to icons. Many applications use less 
memory when minimized than when running in a window. To reduce an 
application to an icon, click the Minimize button in the upper-right corner of 
the window. Or bring the application to the foreground, press ALT+SPACEBAR 

to open the Control menu, and then choose Minimize. 

• Clear or save the Clipboard contents. For information about using the 
Clipboard, see Chapter 5, "Application Basics." 

• If you are using a desktop wallpaper, set the wallpaper to None or use a pattern 
(a pattern uses less memory than wallpaper). For more information, see 
Chapter 12, "Customizing Windows." 

• If you are trying to run an MS-DOS-based application, change its PIF options. 
Descriptions of PIF Editor options follow this section. For more information 
about PIF options, see Help for PIF Editor. 

• If you are trying to run more than one MS-DOS-based application at a time 
(in 386 enhanced mode), use PIF Editor to change the multitasking options, 
Background Priority and Foreground Priority. For more information about 
these options, see Chapter 11, "MS-DOS Applications." 

• If Windows is running in 386 enhanced mode, set the PIF for each 
MS-DOS-based application so that the application does not run when 
it is in the background. When the Execution Background setting is not 
selected, the MS-DOS-based application does not run when it is in the 
background. This may temporarily free memory. 

• Make sure Windows has enough available hard-disk space to create 
and use swap files. For information about how Windows uses swap files, 
see Chapter 14, "Managing Memory and Performance." 
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• If possible, set up a permanent swap file. If Windows is running in 386 
enhanced mode, you can do this by choosing the 386 Enhanced icon in 
Control Panel and then choosing the Virtual Memory option button. For 
help with this dialog box, press PI while using it, or see Chapter 14, 
"Managing Memory and Performance." 

Freeing Memory by Using PIF Editor: Standard Mode 
If Windows is running in standard mode and you receive an out-of-memory 
message when trying to run an MS-DOS-based application, first try the 
techniques listed in the preceding section. If you still get an out-of-memory 
message, consider changing the following PIF options. Choose the PIF Editor 
icon in the Main group to open PIF Editor. (If you upgraded from Windows 
version 3.0, PIF Editor remains in the Accessories group.) 

Option 

Video Mode 

Memory Requirements 

XMSMemory 

No Screen Exchange 

Prevent Program Switch 

Suggested change 

Under Video Mode, select the Text option button to 
reduce the amount of memory Windows sets aside to 
display the application. This makes more memory 
available to the application. However, if you change 
modes while using the application, you might not be able 
to switch from the application. 

If Windows displays an out-of-memory message when 
you try to start the application, reduce the amount 
specified in the Memory Requirements: KB Required 
box. 

If the application starts but subsequently displays an 
out-of-memory message, you might need to free more 
memory before starting Windows. For information, see 
Chapter 14, "Managing Memory and Performance." 

If the application does not need extended memory, 
make sure that XMS Memory: KB Required and XMS 
Memory: KB Limit are set to O. This prevents the 
application from taking up memory that another 
application could use. 

Select this check box to prevent Windows from 
allocating memory when you copy information onto 
the Clipboard by using PRINT SCREEN or AL T + PRINT 
SCREEN. This makes more memory available to the 
application. However, you cannot take a "snapshot" 
of the MS-DOS-based application screen. 

Select this option to make more memory available to the 
application. Windows makes more memory available by 
preventing you from switching from the application. 
When this option is selected, you have to quit the 
application to return to Windows. 
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Freeing Memory by Using PIF Editor: 386 Enhanced Mode 
When Windows is running in 386 enhanced mode, Windows-based applications 
and MS-DOS-based applications share memory resources. The more memory that 
is allocated to one application, the less memory there is available to others. If you 
receive an out-of-memory message when trying to start an application, first try the 
techniques described earlier in the "You Receive an Out-of-Memory Message" 
section. 

If you still receive an out-of-memory message, try changing the PIF for the 
MS-DOS-based application. You can free memory for an application by changing 
the following PIF settings. Choose the PIF Editor icon in the Main group to open 
PIF Editor. (If you upgraded from Windows version 3.0, PIF Editor remains in the 
Accessories group.) 

Option 

Video Memory 

Memory Requirements 

Display Usage 

Execution 

Suggested change 

Under Video Memory, select the Text option button if 
you plan to use only text mode while running the 
application. Text mode requires less memory than 
graphics mode. Clear the Retain Video Memory check box 
in the Advanced Options dialog box to free memory. 

If Windows displays an out-of-memory message when you 
try to start the application, reduce the amount specified in 
the KB Required box. 

If the application starts but subsequently displays an out
of-memory message, increase the amount specified in the 
KB Required and KB Desired boxes. (An application 
might also run out of memory if it doesn't have enough 
extended or expanded memory. If you suspect this is the 
case, try increasing the amounts in the XMS Memory and 
EMS Memory boxes.) 

Select the Full Screen instead of the Windowed option 
button. Running an application in a window requires more 
memory. 

Select the Exclusive check box to suspend other 
applications while this application is in the foreground. 
This might make more memory available to the 
application, but it prevents other applications from running 
in the background. 
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If you still receive an out-of-memory message after changing the application's 
PIF, try changing the PIFs for other applications you plan to run at the same time. 
You can free additional memory for an MS-DOS-based application by changing 
the following PIF settings for other applications. 

Option 

Memory Requirements 

Display Usage 

Execution 

Lock Application Memory 

Suggested change 

Reduce the amount specified in each application's KB 
Desired box. (Do not reduce it so much that the 
applications cannot run effectively.) 

Select each application's Full Screen option button. 

Clear other applications' Background check boxes to 
prevent them from running in the background. This 
makes more memory available to the application you 
want to run but prevents the other applications from 
running at the same time. 

You might want to do this to prevent particular 
applications from running in the background. If you 
want to prevent all applications from running in the 
background, it is easier to select the foreground 
application's Exclusive check box. 

Clear each application's Lock check boxes (Lock 
Application Memory, XMS Memory: Locked, and 
EMS Memory: Locked) to free memory. This might 
make more memory available to the application you 
want to run but also might slow down the applications 
for which you clear the Lock check boxes. 

For more information about freeing memory, see Chapter 14, "Managing Memory 
and Performance." 

Using Serial Communications 
With Windows, you can have serial communications on serial ports COMl 
through COM4. The following sections describe solutions to problems you 
might have when using serial communications. 

You cannot access a serial port. 
If Terminal or another Windows-based communications application cannot access 
a modem or other device connected to a serial port, use the following checklist to 
determine the problem. 

• Determine whether another application is preventing access to the port even 
though it is not actively using it. If so, close the application so that other 
applications can gain access to the serial port. 
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• Make sure Windows is using correct base port address and hardware interrupt 
(IRQ) settings for the serial port you are trying to use. For instructions on how 
to specify these settings, see Chapter 13, "Configuring Hardware." 

The computer locks up when you try to access a serial port. 
When a serial device attempts to use a hardware interrupt (IRQ) or memory 
address that is being used by another device, your computer can lock up. If you 
encounter this problem, determine whether one of the following is the cause: 

• Serial ports COMI and COM3 are often set to use IRQ4, and serial ports 
COM2 and COM4 are often set to use IRQ3. If you are using these ports 
and your computer locks up, try including the following setting in the 
[386Enh] section of the SYSTEM.lNI file: 

COMlrqSharing=true 

Note This setting works only for some systems. Many serial-communications 
adapters do not allow these ports to be used simultaneously, regardless of the 
setting in the SYSTEM.lNI file. 

• Some 85I4/A display adapters and some network adapters conflict because 
they use the common address for serial port COM4 (2E8). If you are using 
either of these two devices, determine whether they are conflicting with your 
serial port. 

For information about which IRQ your device uses and how to change IRQ 
settings, see the documentation supplied with the device. For more information 
about specifying IRQ and address settings for your serial devices and ports in 
Windows, see Chapter 13, "Configuring Hardware." 

Errors occur during high-speed communications. 
The fastest communications speed possible in Windows is dependent on many 
factors, including your serial device, computer speed, communications software, 
and other programs (or applications) running on your system. If you have 
problems during communications transmissions at high speeds (9600 baud 
and higher), use the following checklist: 

• Close or adjust the background-execution priority for any MS-DOS-based 
applications running in the background. Such an application could prevent 
the active communications application from receiving information fast 
enough. For information about adjusting settings for MS-DOS-based 
applications, see Chapter 11, "MS-DOS Applications." 
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• Make sure the computer is running at its fastest possible speed. Some 
computers may run at slower speeds to prolong battery life. See the 
documentation supplied with your computer. 

• Use a serial port that contains a 16550A Universal Asynchronous Receiver 
Transmitter chip (UART). Windows uses the buffering capabilities of such 
ports so that Windows-based communications applications can achieve high 
speeds even on slow computers. For more information, see your serial-port 
documentation. 

Note Using the buffering capabilities of Windows causes problems with 
some versions of the UART. In this case, you need to disable the buffer of 
the UART by using the comxfifo setting in the SYSTEM.lNI file. For more 
information about this setting, view the SYSINI.WRI online document by 
using Write (in the Accessories group). 

Errors occur when you use MS-DOS communications 
applications. 

If you are running an MS-DOS-based application that uses the XonlXoff protocol 
for serial-port communications, you might lose characters or receive protection 
violations when other running applications are slowing down the system. If this 
happens, include the following setting in your SYSTEM.lNI file: 

COMxProtocol = XOFF 

where x is the number of the COM port. For information about this setting and 
how to change it, view the SYSINI.WRI online document by using Write (in the 
Accessories group). 

Using Terminal 
If you have trouble using Terminal and a modem to connect to a remote 
computer, a number of factors could be the cause. The following sections 
describe solutions for a few common problems. 

The modem does not dial the number. 
Your hardware may be connected improperly, or the incorrect COM port is 
specified. Use this checklist: 

• Make sure the correct cables are attached to the modem and phone jack, 
and between the two computers. 
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• Make sure the proper COM port is specified in the Communications dialog 
box. Choose the Communications command from the Settings menu in 
Terminal to see how the Connector option is set. 

You cannot establish a connection. 
If the modem dials and you get an answer, but no connection is established, 
you might not have the correct settings for the remote computer. Communicating 
systems must use the same baud rate, although some modems can drop back to 
the rate of the remote modem and notify Terminal of the change. (For information 
about this feature, see your hardware documentation.) If you want to transfer data, 
both systems must also use the same settings for data bits, parity type (none, odd, 
even, mark, and space), stop bits, and flow control. 

If you do not know what settings the remote system is using, refer to its 
documentation by calling the remote system's information number (not the 
data-transmission number). Request the information, and then set Terminal to 
match the remote-system settings by using the Communications command on 
the Settings menu. 

You cannot send or receive a text file. 
Communicating systems must use the same flow-control (or handshake) method. 

To determine whether the systems use the same handshake method, you need to 
know the following information: 

• What software-handshake method, if any, the remote system uses. 

The standard method is Xon/Xoff. However, another method may be used. 

• Whether the remote system is using the hardware-handshake method. 

If it is, choose the Communications command from the Settings menu in 
Terminal, and then select the Hardware option button. 

Using Windows with a Network 
The following sections provide solutions for problems you might encounter when 
running Windows with a network. Be sure to also read the NETWORKS.WRI 
online document; you can do so by using Write (in the Accessories group). 
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You cannot connect to a network drive. 
• If you cannot connect to a network drive or network printer from Windows, 

try making the network connection before starting Windows. If you cannot, 
it is probably not a Windows problem. 

• If you cannot connect to a network, make sure you are using the correct 
network drivers. You can find out what network driver you are using by 
choosing the Windows Setup icon in the Main group. 

You have trouble when running a shared copy of Windows. 
• If you receive a message about sharing violations while running a shared 

copy of Windows or a shared copy of another application, make sure the 
application's file attributes are set to read-only. You can view or change a 
file's attributes by using the Properties command on the File menu in File 
Manager. 

• If you have trouble running a shared copy of Windows, make sure your 
personal Windows directory and the shared Windows directory are both 
specified in your path. Your personal Windows directory must be specified 
first. 

• Make sure you are using the same letter to designate the network drive every 
time you connect to that drive. For example, if you use the drive letter W 
when you connect to the network drive to set up a shared copy of Windows, 
Windows records W as the path it should use in the future to look for the 
shared Windows files. If the next time you connect to the same network drive 
you use a letter other than W, you will not be able to start Windows correctly. 

If you do need to specify a different drive letter when you connect to a 
network drive in order to use a shared application, be sure to change the 
path that Windows uses to find the application. 

You have trouble with network software when running Windows. 
• If you cannot run Windows or other applications while your network 

software is loaded into the high memory area (HMA), the first 64K of 
extended memory, try disabling the network software's HMA options. 
For more information, see the documentation provided with the network 
software. 

• If you cannot run Windows while your network software is loaded into the 
upper memory area between 640K and 1 MB, try loading the network software 
into conventional memory. Some network software does not work when 
loaded into the upper memory area. 
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• If your system locks up when you receive a network pop-up message, 
you might need to either disable such messages or run a Windows-based 
application that properly displays them. For example, WinPopup, supplied 
with Windows, is such an application. 

Using Two Versions of Windows 
The following list describes solutions for problems you might encounter when 
you have two versions of Windows installed on your computer: 

• Make sure the PATH setting in your AUTOEXEC.BAT file specifies the 
directory that contains the version of Windows that you are currently using. 
Remove the directory of the older version from the PATH setting before you 
install the newer version. You can check the dates of files by using the All File 
Details command on the View menu in File Manager. 

• When you want to run an application, print a file, install a printer, or install 
a driver, make sure the current directory is the directory that contains the 
version of Windows that you are currently using. Windows searches the 
current directory for the application's files before searching other directories 
specified by the PATH setting. 

• Always use the device drivers for the version of Windows that you are 
currently using. 

• If you want to use applications that are set up in the same directory as the 
earlier version of Windows (not a subdirectory of it), you probably need to 
set up those applications in the directory where the later version of Windows 
is located. In some cases, you can simply copy the files to the new directory; 
in other cases, you must set up the application again. 

• If you set up an application in Windows version 3.0, and you want to run the 
application in Windows version 3.1, you need to set up the application again 
from version 3.1. 

Additional Troubleshooting Techniques 
If you still have difficulties with Windows, you should read the following 
guidelines for additional troubleshooting techniques. 

Read the Windows text files. 
During Windows Setup, several online documents are copied to your hard 
disk and are placed in the directory where you set up your Windows files. 
The filenames end with the .TXT and .WRI extensions. The files contain 
information that was received too late to be printed in this book. They also 
contain information about the initialization files SYSTEM.INI and WIN.INI. 
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~ To open and read the README.WRI document 

• In the Main group, choose the Read Me icon. 

Write starts and opens the README.WRI document, which contains information 
about locating and opening other Windows online documents. For information 
about using Write, press the FI key, or choose Contents from the Help menu in 
Write. 

If you chose not to install the initialization files when you set up Windows, you 
can run the Setup program again to install them now. For more information about 
using Setup, see Chapter 1, "Setting Up Windows." 

Know your system. 
When troubleshooting your computer system, it is helpful to note anything unique 
about your system-for example: 

• The contents of your CONFIG.SYS and AUTOEXEC.BAT files. (For more 
information about the role these files play in troubleshooting, see the following 
section, "Streamline the CONFIG.SYS and AUTOEXEC.BAT Files.") 

• The drive and directory where Windows is installed. 

• The type (brand and processor) of computer you are using (for example, 
COMPAQ 386). 

• The version and type of BIOS (basic input/output system) in your computer. 

• The amount of RAM (random access memory) your computer has. 

• The size of your hard disk. 

• The type of display adapter you are using (for example, EGA or VGA). 

• The type of mouse you are using (brand, model, and whether it is a serial or 
bus type). 

• The type and layout of the keyboard you have (for example, enhanced). 

• If you are running Windows on a network; and if so, the name and version 
number of the network software you are using. 

• The printer and printer port you are using. 

• The amount of memory your printer has. 

• The names and version numbers of applications you are running with 
Windows. 

It may also be helpful if you know the type of hard-disk controller in your 
computer. 
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Microsoft Diagnostics 
If you are uncertain about your computer configuration, you can use the Microsoft 
Diagnostics (MSD) program to find out. This program, provided with Windows, 
provides information about your system memory and the device drivers installed 
on your system. During the setup process, this file is placed in your Windows 
directory. 

~ To start Microsoft Diagnostics 

• Type the following at the command prompt, and then press ENTER: 

msd 

Then follow the instructions on the screen. 

Note If Windows was not successfully set up on your hard disk, you can run 
MSD from the Windows Setup disks. 

Streamline the CONFIG.SYS and AUTOEXEC.BAT files. 
If you want to troubleshoot a problem yourself, it's best to start with a 
"minimum" Windows configuration. This means that as a test, you should 
try removing unused applications, memory-resident programs (TSRs), and 
unnecessary device drivers from your CONFIG.SYS and AUTOEXEC.BAT files. 
You can use a text editor, such as Notepad (in the Accessories group), to open 
and edit these files. When just a few applications are running with Windows, it's 
easier to isolate your problem. 

Before you make any changes, create a system disk that includes a backup 
copy of both the CONFIG.SYS file and the AUTOEXEC.BAT file. You can 
restore these files when you are finished with the troubleshooting tests. You 
also can use this disk to start your system, if necessary. 

You can make a system disk by starting File Manager (in the Main group), and 
then choosing Make System Disk from the Disk menu. Then copy your current 
CONFIG.SYS and AUTOEXEC.BAT files to the disk. These files are usually 
located in the root directory of your first hard disk drive, which is usually drive C. 
If you start your system by using a floppy disk, these files are located in the root 
directory of that disk. 

When removing command lines from your CONFIG.SYS and AUTOEXEC.BAT 
files, make one change at a time. After making one change, test it. This will help 
you isolate the problem. As a general rule, if you don't know what a particular 
command line does in the CONFIG.SYS or AUTOEXEC.BAT file, do not 
remove it. If you are using disk-partitioning software, such as DMDRVR.BIN, 
do not remove the command lines that specify it. 
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The following are examples of CONFIG.SYS and AUTOEXEC.BAT files at a 
minimum configuration. 

A streamlined CONFIG.SYS file: 

fi 1 es=30 
buffers=20 
device=c:\windows\himem.sys 

The files command sets the number of files MS-DOS can access at one time. 
The buffers command allocates memory for buffers when your system starts. The 
device command in this example sets up the HIMEM.SYS device driver. 

A streamlined AUTOEXEC.BAT file: 

prompt $p$g 
path c:\;c:\windows;c:\msdos 
set temp=c:\windows\temp 

The prompt command determines the appearance of the command prompt. The 
path command specifies the search path for MS-DOS and Windows. (Some 
versions of MS-DOS might name this directory something other than \MSDOS.) 
The set temp command specifies the directory where temporary files are stored. 
You may need to create the specified directory if it does not exist. The directory 
for temporary swap files should be a location that has at least 2 MB of available 
disk space. For more information about temporary swap files, see Chapter 14, 
"Managing Memory and Performance." 
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32-bit disk access 197 
386 enhanced mode 

About command, checking Windows mode 61 
Control menu, opening 61 
copying a window (window snapshot) 95 
improvements, described 19 
memory required for running Windows 12 
MS-DOS Prompt, running in a window 83 
MS-DOS-based applications 

accessing printer ports 128 
copying and pasting information 160-161 
exclusive use of resources 161-162 
font size, changing 160 
running in a window 157-158 
running in the background 162 
Settings command options 158-160 
switching between a window and a full screen 158 

network drives, disconnecting from 114 
running two or more applications 84 
Scheduling options 202 
starting Windows in 13 
system requirements for using xvi 
troubleshooting 

386 enhanced mode not available 237-238 
application stops responding 242 
memory, freeing by using PIF Editor 261-262 

virtual-memory settings, changing 196-197 
WINSTART.BAT batch file 195 

386 symbol in margin, meaning of xviii 
386MAX line, modified by Setup 11 
386SPART.PAR file 196 

A 
About command 

checking Windows mode 61 
Help menu 101 

Accented characters, trouble using in filenames 242 
Accessories 

Calculator 129-130 
Calendar 131 
Cardfile 131-132 
Character Map 133 
Clock 133 
Media Player 134 
Notepad 135 
Paintbrush 135-136 
Recorder 137 

Accessories (continued) 
Sound Recorder 137 
Terminal 138 
Write 138 

Accessories group, described 74 
Active window, defined 85 
Ad Lib MIDI setups 180 
Adding applications 

creating program items 
by using File Manager 78 
by using Program Manager 75-78 
by using Setup 79 

setting up applications 79,153-154 
using program information files (PIFs) 

default PIF 156 
manufacturer-supplied PIFs 155 
modifying PIFs 155 
multiple PIFs per application 156 

Adding directories 114 
Addingfonts 174-176 
Adding groups 75 
Adding program items 75-79 
Addresses, filing in Cardfile 131-132 
Advanced settings for serial ports 189 
All File Details command, File Manager 108 
ALT +PRINT SCREEN key combination 

copying a window (window snapshot) 95 
troubleshooting 243 

Always On Top command 
Control menu 62 
Help menu 101 

Animation 
files, playing 134 
linked objects, updating 149 

Application swap files 197-198 
Application windows 

arranging 87 
closing 67 
Control menu, opening 60 
described 53-54 
document window, described 53-54 
illustrated 50 

Applications 
See also MS-DOS-based applications 
About command 101 
background, running in 162 
Clipboard, transferring information 94-97 
exclusive use of resources 161-162 
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Applications (continued) 
icons for 

described 55 
illustrated 50 

program items for, creating 
by using File Manager 78 
by using Program Manager 75-78 
by using Setup 79 

quitting 
MS-DOS-based applications 89 
Windows-based applications 88 

reducing to icons when starting 77,83 
running simultaneously 84 
setting up 79,153-154 
settings, changing 

by using PIF Editor 155-156,161-162 
by using the Settings command 158-160 

starting 
by using MS-DOS Prompt 83, 157 
by using the Run command 82-83 
from a directory window 82 
from a group 81 
from the StartUp group 81 
"out-of-memory" message 259 

switching between 85,220 
troubleshooting 

application quits unexpectedly 245 
application stops responding 242 
capturing a screen image (snapshot) 243 
font size, changing 244 
key or key combination doesn't work 241-242 
pasting into MS-DOS-based applications 244 
slow-running application 243 
Super VGA display driver 243 

types of, described 
MS-DOS-based applications 73 
older Windows-based applications 73 
Windows-based applications 73 

Applications group, described 74 
Arrange Icons command, Task List 87 
Arranging application windows or icons 87 
ASCII files, creating or editing 135 
Audio compact-disc players 

playing by using Media Player 134 
setting up device drivers for 185-186 

AUTOEXEC.BAT file 
changes Setup makes 11 
editing to free memory 193-195 
memory-resident programs, running 162 
MOUSE.COM mouse driver, setting up 240 
rem command, using to disable command lines 193-194 
SMARTDrive command line 212-215 
system disk, creating 269 
TEMP environment variable 195 

AUTOEXEC.BAT file (continued) 
testing 269 

B 

two versions of Windows, using 267 
win command 12 

Background 
of the desktop 

displaying patterns 169-170 
displaying wallpaper 170-171 

running applications in 162 
Background option 

PIF Editor 162 
Settings command 159 

Base port address, specifying 189-190 
.BAT filename extension 82 
Batch files 

creating or editing 135 
starting applications from File Manager 82 
WINSTART.BAT file 195 

Baud rate 
changing 189 
common setting 256 
lowering to fix printing problems 253, 256 
new support for printing at a baud rate of 19200 17 

BBS See Bulletin-board services 
Bitmaps for wallpaper 170-171 
.BMP filename extension 170 
Bold type, usage in this guide xviii 
Branches of the directory tree, viewing 111 
Breaking a link to an object 150 
Broken links, restoring 150 
Browsing 

for network directories 113 
for network printers 125 

buffers command, CONFIG.SYS file 194, 270 
Bulletin-board services for obtaining device drivers 7 
Buttons 

command buttons 68-69 
for sizing windows (illustrated) 51 
Help buttons 103 

By File Type command, File Manager 108 

c 
Calculator 

See also online Help for Calculator 
described 129-130 
keyboard shortcuts 225 

Calendar 
See also online Help for Calendar 
described 131 
keyboard shortcuts 225 



Canceling 
check boxes 72 
commands 72 
links 150 
menus 59 
printing of documents 122 
selections 

in application windows 92 
in dialog boxes 57-58 

Capturing screen images 
copying onto the Clipboard 94-95 
troubleshooting 243 

Cardfile 
See also online Help for Cardfile 
described 131-132 
keyboard shortcuts 226 
trouble with the Paste command 249 

Cartridge fonts 
printing problems 253, 255 
using 173 

Cascade command, Task List 87 
Cascading menu, defined 59 
CD players See Audio compact-disc players 
CGA (color graphics adapter) 236 
Change System Settings command, Windows Setup 187 
Channel maps for MIDI setups, editing 178-179 
Character Map 

See also online Help for Character Map 
described 133 

Character set (code page), changing 181 
Characters used with a font, displaying 133 
Check box, in dialog boxes 72 
Check mark on menus, meaning of 59 
chkdsk command 

recovering lost disk space 199 
restriction on using while Windows is running 84 

Choosing vs. selecting, defined 57 
Clearing check boxes 72 
Clicking with the mouse, described 56 
Clipboard 

See also Clipboard Viewer 
clearing contents 97 
copying information 

from MS-DOS-based applications 160 
from Windows-based applications 94-95 
screen image (screen snapshot) 94 
window contents (window snapshot) 95 

files, retrieving 97 
format of stored information, changing 150-151 
keyboard shortcuts 223 
memory management 259 
pasting information 

into MS-DOS-based applications 161 
into Windows-based applications 96 

Clipboard (continued) 
saving the contents of 97 
troubleshooting 
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Paste command gives varied results 247 
Paste command unavailable 249 
Paste Link command unavailable 249 
pasting into MS-DOS-based applications 244 
Picture option unavailable in Object Packager 248 

viewing the contents of 96 
Clipboard Viewer 

keyboard shortcuts 225 
viewing Clipboard contents 96 

Clock speed of computer 206 
Clock, displaying analog or digital 133 
Close command, on the Control menu 

closing dialog boxes 72 
closing documents or windows 67 
described 61 
quitting Windows-based applications 88 

Closing 
applications 

MS-DOS-based applications 89 
Windows-based applications 88 

dialog boxes 72 
files 61 
Help 104 
menus 59 
windows 67 

.CLP filename extension 97 
Code page (character set), changing 181 
Collapse Branch command, File Manager 112 
Collapsing a directory 112 
Color graphics adapter (CGA) 236 
Color schemes for the desktop 

changing 167 
choosing 165-167 
creating custom colors 168 

.COM filename extension 82 
COM ports See Serial ports 
COMIrqSharing setting, SYSTEM.INI file 263 
Command buttons, in dialog boxes 68-69 
Command line, Windows 13 
Command lines in startup files 

See also AUTOEXEC.BAT file; CONFIG.SYS file 
disabling 193-194 

Command prompt, MS-DOS 83 
Commands 

canceling 72 
choosing from menus 58--59 
command buttons 68-69 
dimmed commands, meaning of 59 
Help for dialog boxes 102 



274 Index 

Communications 
remote (using Terminal) 

described 138 
troubleshooting 264-265 

serial 
changing settings 188-189 
common settings 256 
troubleshooting 262-264 

Compressed files on Setup disks, expanding 238 
COMxProtocol = XOFF setting, SYSTEM.INI file 264 
CONFIG.syS file 

buffers command line 194, 270 
changes Setup makes 11 
device command lines 

disabling 193-194 
EMM386.EXE 208-212 
HlMEM.SYS 203-206 
MOUSE.SYS 240 
RAMDRIVE.SYS 206--208 

double buffering 215 
drivparm command, adding 235 
editing to free memory 193-194 
memory-resident programs, running 162 
rem command, using to disable command lines 193-194 
shell command line 194 
system disk, creating 269 
testing 269 

Configuring 
hardware See Device drivers 
memory See Managing memory and performance 
multimedia device drivers 185-186 
ports 188-189 
printers 126--127 

Connect Network Drive command 112 
Connecting 

to network directories 112-113 
to network printers 124-125 
to remote computers via modem 138 

Contents feature in Help 101 
Context-sensitive Help 20 
Control menu 

commands, described 61-62 
Control-menu box (illustrated) 51 
opening 60-61 

Control Panel 
See also online Help for Control Panel 
color schemes for the desktop 

changing 167 
choosing 165-167 
creating custom colors 168 

desktop settings 
patterns 169-170 
screen savers 171-172 
wallpaper 170--171 

Control Panel (continued) 
device drivers, installing 184 
fonts 

adding 174-176 
described 172-173 
removing 176--177 
TrueType 174-176 
viewing on the screen 173 

keyboard shortcuts 225 
MIDI Mapper 179-180 
multimedia drivers 

installing 185-186 
removing 186 

multitasking options 202 
network options, setting 180--181 
ports, configuring 188-189 
sound options 177-180 
virtual-memory settings, changing 196 

Conventional memory 
avoiding for a RAM drive 208 
described 191 
disk buffers 194 

Conventions, typographic xviii 
Copy command 

File Manager 114 
MS-DOS-based applications 160 
Windows-based applications 94, 95 

Copy Disk command, File Manager 117 
Copying 

See also Object linking and embedding (OLE) 
compressed files on Setup disks 238 
directly to a printer port 250 
directories 114 
files 114 
floppy disks 117 
from MS-DOS--based applications 160 
from Windows-based applications 94-97 
keyboard shortcuts for 223 
linked objects 149 
screen image (screen snapshot) 94 
vs. object linking and embedding 143 
window contents (window snapshot) 95 

Copyright of active application, checking 101 
Correcting typing mistakes 92 
Create Directory command, File Manager 114 
Creating 

directories 114 
groups 75 
program items 

by using File Manager 78 
by using Program Manager 75-78 
by using Setup 79 

Current directory, changing 110 



Cursor 
cursor-movement keys 221 
selection cursor, defined 68 

Custom colors, creating 168 
Custom Setup 4 
Customer Support Services, obtaining device drivers 7 
Customizing Windows 

character set, changing 181 
color schemes 

changing 167 
choosing 165-167 
creating custom colors 168 

fonts 
adding 174-176 
described 172-173 
removing 176-177 
TrueType 174-176 
viewing on the screen 173 

MIDI settings 178-180 
patterns 169-170 
screen savers 171-172 
sound 177-180 
wallpaper 170-171 

Cut command, Windows-based applications 94 
Cutting 

See also Copying; Pasting 
text or graphics from Windows-based applications 94 

D 
Data bits 

changing the setting 189 
common setting 256 

Data transfer 
between applications 

MS-DOS-based applications 160-161 
Windows-based applications 94-95 

between computers, using Terminal 138 
Default color scheme 166 
Default printer, choosing 123 
_DEFAULT.PIFfile 156 
Definitions of terms in online Help, displaying 103 
Delete command 

File Manager 115 
Program Manager 75 

Deleting 
Clipboard contents 97 
commands in startup files 193-195 
directories 115 
documents from the print queue 122 
files 115 
fonts 176-177 

Deleting (continued) 
groups 75 
links 150 

DeskJet printers, Hewlett-Packard 255 
Desktop 

color schemes 
changing 167 
creating custom colors 168 
selecting 165-167 
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copying (capturing the screen image) 94 
defined 50,165 
patterns 169-170 
screen savers 171-172 
wallpaper 170-171 

Destination directory or drive, moving or copying files 114 
Destination document, object linking and embedding 142 
device command lines 

disabling unnecessary device drivers 193-194 
EMM386.EXE 208-212 
HIMEM.SYS 203-206 
mouse driver 240 
RAMDRIVE.SYS 206-208 
SMARTDrive command for double buffering 215 
streamlined CONFIG.syS file 270 

Device drivers 
See also Display drivers; Keyboard drivers; Mouse 

drivers 
bulletin-board services 7 
configuring 184 
defined 183 
downloading from network services 7 
EMM386.EXE 208-212 
HIMEM.SYS 203-206 
Microsoft Diagnostics (MSD) program, using to get 

information about installed device drivers 269 
installing 184 
multimedia drivers 185-186 
preserved when upgrading Windows 6 
purchasing on disks 7 
RAMDRIVE.SYS 206-208 
SMARTDRY.EXE 212-215 
third-party drivers, installing 184 
upgraded by the Setup program 6 
Windows Driver Library (WDL) 7, 183 

devicehigh command, CONFIG.SYS file 6 
Diagnostics See Microsoft Diagnostics (MSD) program 
Dialog boxes 

check boxes 72 
closing 72 
command buttons 68-69 
Control menu, opening 60 
described 67-72 
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Dialog boxes (continued) 
Help, online 102 
keyboard shortcuts 221 
keys for selecting items in 222 
list boxes 

described 70 
drop-down list boxes 70-71 
selecting items in 57-58 

moving 67 
moving within 68 
option buttons 71 
scrolling through information in 66 
selecting options in 68-69 
text boxes 69 

Dimmed command buttons 69 
Dimmed commands 59 
dir command, checking free disk space 200 
Directories 

changing directory levels 111-112 
changing the current directory 110 
copying 114 
creating 114 
deleting 115 
icon representing, illustrated 106 
moving 114 
network directories 

connecting to 112-113 
disconnecting from 114 

renaming 115 
searching for 115 
selecting 109 
start-up directory for applications 77 

Directory tree 
branches, changing the display of 111-112 
current directory, changing 110 
described 106 

Directory windows 
current directory, changing 110 
customizing 107-108 
directory levels, changing 111-112 
drive, changing 110 
icons in, illustrated 106 
opening 107 
selecting files or directories 109-110 
sorting the contents of 108 
split bar 106 
starting applications from 82 
updating 108 

Disabling commands in startup files 193-195 
Disconnect Network Drive command 112 
Disconnecting 

from network directories 114 
from network printers 125 

Disk access, 32-bit 197 

Disk buffers 194 
Disk caching 

described 201-202 
disabling if interfering with Setup 235 
SMARTDrive command line 212-215 

Disk drive 
current drive, changing 110 
icons for 106, 107 

Disk space 
amount of, determining 200 
conserving by preventing swapping 197 
disk caching 201-202 
freeing 

by removing unnecessary files 200-201 
by using the chkdsk command 199 

recommended amount of free space 199 
swap files 

386 enhanced mode 196-197 
described 192 
standard mode 197-198 

Disk-compaction programs 199 
Diskless workstation 8 
Disks 

See also System disk 
copying 117 
formatting 116 
labeling 116 

Display drivers 
CGA, obtaining 236 
EGA, updated by Setup 11 
installing or updating 186-188 
Super VGA 243, 244 

Display options, Settings command (MS-DOS-based 
applications) 159 

Display Usage option, PIP Editor 261, 262 
Document conventions xviii 
Document windows 

closing 67 
Control menu, opening 60 
described 53-54 
keys for selecting items in 221 

Documents 
closing 61 
destination document, object linking and embedding 142 
icon for 

in application windows 55 
in directory windows 106 

opening 89 
opening when starting applications 82-83 
program items for, creating 78 
saving 90 
source document, object linking and embedding 142 
switching between 86 
text, working with 91-93 



DOS prompt See Command prompt; MS-DOS Prompt 
DOSPRMPT.PIF file 84, 157 
Double-buffering feature of SMARTDrive 11, 215 
Double-clicking with the mouse, described 56 
Downloading device drivers 7 
Dragging and dropping file icons 87-88 
Dragging with the mouse, described 56 
Drawings 

creating See online Help for Paintbrush 
embedding in documents 145 
linking to documents 148 

Drive bar in File Manager windows 
changing the current drive 110 
described 107 
illustrated 106 

Drive icons, described 107 
Drive, changing the current drive 110 
Driver Library, Windows (WDL) 7,183 
Drivers See Device drivers 
drivparm command, adding to the CONFIG.SYS file 235 
Drop-down list box, in dialog boxes 70-71 

E 
Edit commands, MS-DOS-based applications 61-62 
Editing 

See also Word processing 
ASCII (text) files 135 
embedded objects 145 
linked objects 148 
sound files 137 
text 

basic techniques 92-93 
keys for editing text 222 

EGASYS device driver, updated by Setup 11 
EISA memory 206 
Electronic downloading service 7 
Ellipsis 

in command buttons 68 
in commands on menus 59 

EMB handles 204 
Embedding 

See also Object linking and embedding (OLE) 
by using Object Packager 151-152 
described 15,142-145 
format of objects, changing 150-151 
Paintbrush drawings 145 

EMM386 memory manager 
command line 208-212 
described 203 
excluding shared memory used by network adapter 212 
memory options 209 
updated by Setup 11 
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EMMExclude option, starting Windows with 237-238 
Enhanced features in Windows version 3.1 15 
Enhanced graphics adapter (EGA) device driver 11 
Enhanced mode See 386 enhanced mode 
Entering text 91 
Environment space, modifying 194 
Environment variables 

effect of environment space on 194 
TEMP, setting to a RAM drive 195 

EPT ports 127 
Erasing See Deleting 
Exclusive option 

PIF Editor 162 
Settings command 159 

.EXE filename extension 82 
Execution option, PIF Editor 261,262 
Exit command 

applications, quitting 88 
MS-DOS Prompt, quitting 84 
printing, canceling 122 
windows, closing 67 

Expand All command, File Manager 111 
Expand Branch command, File Manager 111 
expand command, MS-DOS 238 
Expand One Level command, File Manager 111 
EXP AND.EXE program 238 
Expanded memory 

described 192 
EMM386 memory manager, described 203 

Expanding a directory 111 
Expanding and copying files on Setup disks 238 
Express Setup 3-4 
Extended characters 

character set, changing 181 
displaying by using Character Map 133 

Extended Industry Standard Architecture (EISA) 206 
Extended memory 

described 191 
HIMEM memory manager 203-206 

Extended MIDI setup 180 
Extended-memory block (EMB) handles 204 
Extending selections 93 

F 
Fast application-switching 41 
Fast Printing Direct To Port option, Control Panel 250 
FILE as printer port, printing to a file 123 
File Manager 

See also Directories; Directory windows; Files; online 
Help for File Manager 

changing the current directory 110 
changing the drive 110 



278 Index 

File Manager (continued) 
copying files or directories 114 
copying floppy disks 117 
creating a directory 114 
customizing the File Manager window 107-108 
deleting files or directories 115 
described 16-17, 105-107 
directory levels, changing 111-112 
directory windows 

opening 107 
updating 108 

disk space, checking the amount of 200 
dragging and dropping files 87-88 
drive bar 106, 107 
formatting floppy disks 116 
icons in directory windows 106 
keyboard shortcuts 224 
menu bar 106, 107 
moving files or directories 114 
printing files 116 
renaming files or directories 115 
searching for files or directories 115 
selecting files or directories 109-110 
starting applications 82 
status bar 106, 107 

File transfer, using Terminal 138 
Filename extensions 

.BAT (batch file) 82 

.BMP (bitmap file) 170 

. CLP (Clipboard file) 97 

.COM(programfile) 82 

.EXE (program file) 82 

.INI (initialization file) 115 

.PIF (program information file) 155 

.REG (registration file) 246 

.SYS (system file) 239 

.TMP (temporary file) 200 

.TXT (text file) 267 
using to rename files 115 
using to search for files 115 
using to select files 110 
.w AV (sound file) 177 
.WRI (Write file) 267 

Filenames 
See also Filename extensions 
accented characters, trouble using 242 
changing 115 

Files 
See also Filename extensions 
closing 61 
copying 114 
deleting 115 
dragging and dropping 87-88 

Files (continued) 
fragmented 199 
icons representing, illustrated 106 
moving 114 
opening 89 
opening when starting applications 82-83 
printing See Printing 
renaming 115 
saving 90 
searching for 115 
selecting in directory windows 109-110 
sorting in directory windows 108 

files command, CONFIG.SYS file 270 
Finding information in online Help 101-102 
Floppy disks 

copying 117 
formatting 116 
labeling 116 

Flow control 
changing the setting 189 
common setting 256 
remote communications, troubleshooting 265 
serial port, troubleshooting 256 

FontChangeEnable setting, SYSTEM.INI file 245 
Fonts 

adding 174-176 
cartridge fonts 173 
characters used with, displaying 133 
copying soft fonts from port to port 255 
printer fonts 173 
printing problems 

cartridge fonts 253, 255 
printer capabilities, checking 252 
soft fonts 255 
TrueType fonts 254-255 

removing 176-177 
screen fonts 173 
size, changing 

MS-DOS-based applications 160 
troubleshooting 244 

soft fonts 173 
TrueType 

adding 174-176 
described 15, 174 
using exclusively 176 

Windows fonts 172-173 
Fonts command, on the Control menu 62, 160 
Foreground option, Settings command 159 
Format Disk command, File Manager 116 
Format of objects stored on the Clipboard, changing 150-151 
Formatting disks 116 
Fragmented files 199 
Full Screen option, Settings command 159 



G 
Games group, described 74 
General MIDI setup 180 
Glossary terms in Help, displaying definitions of 103 
Graphics mode vs. text mode 244 
Graphics, printing problems 

insufficient printer memory 256 
Paintbrush graphics 257 

Group icons 
adding a program item to a group 78 
described 55 

Groups 
adding program items to 78 
creating 75 
deleting 75 
group icons, described 55 
predefined, described 74 
preserved when upgrading Windows 6 
size limitation of 75 
starting applications from 81 

Guided tour of Windows operating system 23-44 

H 
Handles, extended-memory block (EMB) 204 
Handshake 

remote communications, troubleshooting 265 
serial port, troubleshooting 256 

Hardware 
configuring See Device drivers 
detection by Setup, skipping 233-234,237 
setting up to use with Windows 235-236 
settings, correcting after running Setup 236 
system requirements xvi 

Hayes modem, using Terminal with 138 
Help, online 

closing 104 
context-sensitive 20 
dialog boxes, getting Help with 102 
finding information 101-102 
glossary definitions, displaying 103 
Help buttons, described 103 
Help menu commands, described 100-101 
keyboard shortcuts 219 
starting 99-100 

Hewlett-Packard 
DeskJet and LaserJet printers 255 
mouse driver, updated by Setup 11 

Hidden files 
defined 115 
icon representing, illustrated 106 

High memory area (HMA) 
described 192 
HIMEM command line 204 

Index 279 

network software, troubleshooting 266 
High-speed communications errors 263-264 
Highlighting text or options See Selecting 
HIMEM memory manager 

command line 11, 203-206 
described 203 

HMA See High memory area 

IBM mouse 241 
Icons 

application icons 
described 55 
illustrated 50 

arranging 87 
changing 80 
choosing 81 
Control menu for, opening 60 
directory-window icons, illustrated 106 
document icons 55 
dragging and dropping files 87-88 
drive icons 106, 107 
flashing to signal a message 88 
group icons 55 
label for, changing 76 
MORICONS.DLL file 80 
moving 65 
PROGMAN.EXE file 80 
program-item icons 55 
reducing windows to 63-64 
restoring to windows 65 
Up icon in directory windows 

illustrated 106 
using to change directories 110 

.INI filename extension 115 
Insert Object command 

troubleshooting 247 
Write 145 

Inserting files See Object linking and embedding (OLE) 
Insertion point 

illustrated 51 
in text boxes 69 

Installing 
device drivers 

methods for installing, described 184 
mouse, keyboard, or display drivers 186-188 
multimedia drivers 185-186 
third-party drivers 184 

fonts 174-176 
printers 126-128 
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Interrupt (IRQ) settings 
specifying 189-190 
troubleshooting 

mouse problems 239, 240 
printing problems 251 
trouble accessing a port 263 

Interrupt 15h interface 204 
Interrupting printing 121-122 
Introduction to the Windows operating system 23-44 
IRQ See Interrupt (IRQ) settings 
Italic type, usage in this guide xviii 

K 
Key assignments for MID I setups, editing 17&-179 
Key combinations 

format in this guide xviii 
troubleshooting 241-242 

Keyboard driver, installing or updating 186-188 
Keyboard layout, changing the character set 181 
Keyboard shortcuts 

L 

Calculator keys 225 
Calendar keys 225 
Cardfile keys 226 
Clipboard Viewer keys 225 
closing windows 223 
Control Panel keys 225 
copying to the Clipboard 223 
cursor-movement keys 221 
dialog-box keys 221 
editing keys 222 
Pile Manager keys 224 
Help keys 219 
Media Player keys 228 
menu keys 220 
Notepad keys 226 
Object Packager keys 227 
Paintbrush keys 227 
PIP Editor keys 225 
Print Manager keys 224 
Program Manager keys 223 
quitting applications 223 
scrolling keys 221 
selection keys 93, 221 
Sound Recorder keys 228 
switching between applications 220 
Write keys 228 

Labeling disks 116 
LAPC1 MIDI setup 180 
Laser printers, troubleshooting 254,255 

LaserJet printers, Hewlett-Packard 255 
LCD color schemes 166 
Linking 

See also Object linking and embedding (OLE) 
by using Object Packager 151-152 
canceling or deleting links 150 
copying linked objects 149 
described 15,142-143,146-148 
editing linked objects 148 
format of objects, changing 150--151 
multiple links to an object, creating 149 
Paintbrush drawings to documents 148 
restoring broken links 150 
updating linked objects 149,24&-249 

Links command, updating linked objects 249 
List box, in dialog boxes 

described 70 
drop-down 70--71 
selecting items in 57-58 

loadhigh command, AUTOEXEC.BAT file 6 
Lock Application Memory option, PIP Editor 262 
LPT ports 127 
LPTl.DOS file 252 

M 
Macros, creating by using Recorder 137 
Main group, described 74 
Make System Disk command, Pile Manager 269 
Managing memory and performance 

disk caching, described 201-202 
disk space, freeing 

removing unnecessary files 200--201 
using the chkdsk command 199 

double buffering, using 215 
memory configuration, identifying 191-192 
memory managers 

described 203 
EMM386 208-212 
HIMEM 203-206 
RAMDrive 206-208 

memory, freeing 
AUTOEXEC.BAT file, streamlining 193, 195 
CONPIG.syS file, streamlining 193-194 
conserving memory when starting programs 195 
swap files, working with 196-198 
virtual-memory settings, changing 196-197 

multitasking options 202 
"out-of-memory" message 259 
speed, increasing 

compacting your hard disk 199 
multitasking options, setting 202 
SMARTDrive, using 201-202,212-215 
TEMP variable, setting to a RAM drive 195 



Managing memory and performance (continued) 
swap files 

386 enhanced mode 196--198 
standard mode 197-198 

Mark command, MS-DOS-based applications 62, 160,242 
Maximize button 

enlarging windows to maximum size 64 
illustrated 51 

Maximize command, on the Control menu 61 
Media Player 

See also online Help in Media Player 
described 134 
keyboard shortcuts 228 

mem command, displaying memory information 192 
Memory 

See also Managing memory and performance; Memory 
managers 

386 enhanced mode, amount required for 12 
available, checking the amount of 101 
configuration, identifying 191-192 
conventional memory, described 191 
expanded memory 

described 192 
EMM386 memory manager 203, 208-212 

extended memory 
described 191 
HIMEM memory manager 203-206 

freeing 
by changing virtual-memory settings 196--197 
by streamlining the AUTOEXEC.BAT file 193, 195 
by streamlining the CONFIG.syS file 193-194 
by using swap files 196--198 
conserving memory when starting programs 195 

high memory area, described 192 
Microsoft Diagnostics (MSD) program, using to get 

information about your system configuration 269 
"out-of-memory" message 259 
printer memory, insufficient 256 
RAM drive 203 
requirements for running Windows xvi 
upper memory area, described 192 
virtual memory, described 192 

Memory managers 
described 191-192,203 
EMM386 208-212 
HIMEM 203-206 
RAMDrive 206--208 

Memory Requirements option, PIF Editor 260, 261, 262 
Memory-resident programs 

See also MS-DOS-based applications 
compatibility with Windows 236 
pop-up programs, running 163 

Memory-resident programs (continued) 
running with other applications 162 
starting from WINSTART.BAT 195 

Menu bar, illustrated 51 
Menus 

cascading menu, defined 59 
check marks, meaning of 59 
closing 59 
commands, choosing 58-59 
Control menu 

commands, described 61-62 
Control-menu box (illustrated) 51 
opening 60 

dimmed items, meaning of 59 
ellipsis, meaning of 59 
illustrated 58 
keyboard shortcuts 220 
menu bar (illustrated) 51 
selecting (opening) 59 
shortcut-key combinations 59 
triangles, meaning of 59 
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Merge Registration File command, File Manager 246 
Messages 

"out of memory" 259 
received from inactive applications 88 
"server unavailable" 246 
"sharing violation" 266 

Microsoft Customer Support Services 7 
Microsoft Diagnostics (MSD) program 

determining address space to exclude 238 
getting information about your system configuration 269 
starting 269 

Microsoft electronic downloading service 7 
Microsoft Windows Tutorial 5,18,45 
MIDI Mapper 179-180 
MIDI settings 

requirements for MID I sound capabilities 177 
changing 178-180 

Minimize button 
illustrated 51 
reducing windows to icons 64 

Minimize command, on the Control menu 61 
Minimize On Use command, File Manager 82 
Minimizing applications, running minimized 77,83 
Minimum Windows configuration 269-270 
Modem 

troubleshooting 264--265 
using Terminal with 138 

Modes 
See also 386 enhanced mode; Standard mode 
checking the current mode 101 

MORICONS.DLL file, selecting icons from 80 
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Mouse 
basic techniques for using 56 
driver 

installing or updating 186-188 
updated by Setup 11 

pointer, illustrated 51 
support for MS-DOS-based applications 19 
troubleshooting 

mouse doesn't work with MS-DOS-based 
applications 240 

mouse doesn't work with Windows 239 
pointer doesn't move 239 
pointer jumps around 240 

MOUSE.COM mouse driver 240 
MOUSE.SYS mouse driver 240 
Mouse Systems mouse 11 
Move command 

File Manager 114 
on the Control menu, described 61 

Moving 
around the screen, keys for 221 
dialog boxes 67 
files or directories 114 
icons 65 
windows 62 

MPC specifications 177 
MSD See Microsoft Diagnostics program 
msd command 269 
MS-DOS, version required for Windows version 3.1 xvi 
MS-DOS-based applications 

See also Troubleshooting 
386 enhanced mode 157-162 
About command, checking Windows mode 157 
background, running in 162 
character set, changing 181 
Control menu, opening 60-61 
copying and pasting information 160-161 
defined 73 
exclusive use of resources 161-162 
font size, changing 160 
improved support for, described 19 
memory management 

conserving memory 195 
"out-of-memory" message 259 

memory-resident programs 
pop-up programs, running 163 
running with other applications 162 

mouse support for 19 
program information files (PIFs) 

created by the Setup program 10 
default PIF 156 
manufacturer-supplied 155 
modifying 155 
multiple versions per application 156 

MS-DOS-based applications (continued) 
quitting 89 
running in 386 enhanced mode 157-162 
running in a window 157-158 
running in the background 162 
setting up 153-154 
settings, changing 158-160 
starting 157 
swap files 197-198 
switching between a window and a full screen 158 
troubleshooting 

capturing a screen image (snapshot) 243 
font size, changing 244 
Mark or Select command, on Control menu 242 
mouse problems 240 
pasting from the Clipboard 244 
reserved key combinations 242 
Scroll command, on Control menu 242 
serial communications 264 

MS-DOS interrupts, printing by using 123 
MS-DOS Prompt 

quitting 84 
restrictions with MS-DOS commands 84 
starting applications 83, 157 

MT32 MIDI setup 180 
Multimedia 

features, described 18 
playing files or devices 134 
removing device drivers 186 
setting up device drivers for 185-186 

Multimedia Personal Computer (MPC) specifications 177 
Multitasking options, 386 enhanced mode 202 
Musical Instrument Digital Interface (MIDI) 

N 

changing MIDI settings 178-180 
MIDI sound capabilities 177 
playing sound files 134 

Name command, File Manager 108 
Network adapter, using with EMM386.EXE 212 
Network Connections command 

File Manager 113 
Print Manager 125 

Network directories 
connecting to 112-113 
disconnecting from 114 
drive letter for connections 232 

Network drives 
connecting to 112-113 
defined 112 
disconnecting from 114 
troubleshooting 266 



Network printers 
connecting to 124-125 
disconnecting from 125 
troubleshooting 

can't connect to a network printer 266 
can't print from Windows 252 
printer doesn't print 250 

Networks 
guidelines for using 232 
port for printing 232 
setting network options 180--181 
setting up Windows from a network 8-9 
troubleshooting 

can't connect to a network drive 266 
high memory area, running network software in 266 
"sharing violation" message 266 
upper memory area, running network software in 266 

Windows network features 231 
NETWORKS.WRI online document xvii, 232 
New command, on File menu 

groups, creating 75 
program items, creating 75-78 

New directories, creating 114 
New features in Windows version 3.1 15-21 
New Window command, File Manager 107 
Next command, on the Control menu 61 
No Screen Exchange option, PIF Editor 260 
Non-Windows applications See MS-DOS-based applications 
Notepad 

o 

See also online Help for Notepad 
described 135 
keyboard shortcuts 226 

Object linking and embedding (OLE) 
applications supporting OLE 141 
canceling or deleting links 150 
copying linked objects 149 
described 15,141-143 
destination document, defined 142 
editing 

embedded objects 145 
linked objects 148 

embedding 
described 143-145 
Paintbrush drawings in documents 145 

format of objects, changing 150 
linking 

described 146--148 
Paintbrush drawings to documents 148 
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Object linking and embedding (OLE) (continued) 
multiple links to an object, creating 149 
Object Packager, using 151-152 
restoring broken links 150 
source document, defined 142 
troubleshooting 

Cardfile 249 
Insert Object dialog box 247 
Object Packager, Picture option unavailable 248 
Paste command gives varied results 247 
Paste Link command is unavailable 249 
registration database 245-246 
server application unavailable 246 
sound object, Manual Update setting 248 
updating linked objects 248-249 

updating linked objects 149 
vs. copying and pasting 143 

Object Packager 
See also online Help for Object Packager 
embedding packages in documents 151-152 
keyboard shortcuts 227 
troubleshooting 248 

OEMSETUP.lNF file 184 
Online documents 

described xvii 
opening and reading 268 

Online Help 
closing 104 
context-sensitive 20 
dialog boxes, getting Help with 102 
finding information 101-102 
glossary definitions, displaying 103 
Help buttons, described 103 
Help menu commands, described 100--101 
keyboard shortcuts 219 
starting 99-100 

Online information services, connecting to 138 
Online Windows Tutorial 

described 5, 18 
running from within Windows 45 

Open command, on the File menu 89 
Opening 

See also Starting 
Control menu 60-61 
documents when starting applications 82-83 
files 89 
menus 59 

Optimizing See Managing memory and performance 
Option buttons, in dialog boxes 71 
"Out-of-memory" message 259 
Overlapping windows, switching between 85,220 
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p 
Packages 

See also Object Packager 
embedding in documents 151-152 

Paintbrush 
See also online Help for Paintbrush 
described 135-136 
editing embedded drawings 145 
editing linked drawings 148 
embedding drawings in documents 145 
keyboard shortcuts 227 
linking drawings to documents 148 
printing problem 257 
window, illustrated 136 

Parallel ports 127 
Parallel printers, troubleshooting 256 
Parity 

changing the setting 189 
common setting 256 

Partial Details command, File Manager 108 
Password for screen saver 172 
Paste command 

MS-DOS-based applications 161 
troubleshooting 247, 249 
Windows-based applications 96 

Paste Link command, troubleshooting 249 
Paste Special command 151 
Pasting information 

into MS-DOS-based applications 161 
into Windows-based applications 96 
troubleshooting 244 
vs. object linking and embedding 143 

Patch maps for MIDI setups, editing 178-179 
PAm setting, AUTOEXEC.BAT file 

minimum search path 270 
modified by Setup 11 
using two versions of Windows 267 

Patterns for the desktop 169-170 
Pausing printers or documents 121-122 
PCL printers, number of soft fonts supported 255 
Performance 

See also Managing memory and performance 
improvements, described 21 

Permanent swap file 196 
Phone numbers See Telephone numbers 
Pictures 

creating See online Help for Paintbrush 
embedding in documents 145 
linking to documents 148 

PIF See Program information files 
.PIF filename extension 155 

PIFEditor 
See also Program information files 
modifying PIFs 155-156 
default PIF 156 
freeing memory by using 260-262 
keyboard shortcuts 225 

Plasma Power Saver color scheme 166 
Playing animation files 134 
Playing back macros 137 
Playing sound files 

by using Media Player 134 
by using Sound Recorder 137 

Plotter fonts 173 
Pointer (mouse) 

illustrated 51 
troubleshooting 239,240 

Pointing with the mouse, described 56 
Pop-up programs, running 163 
Ports 

configuring 188-189 
copying soft fonts from port to port 255 
described 127 
enhancements for serial ports 21 
FILE, specifying as printer port 123 
LPTl.DOS file 252 
network printing 232 
physical vs. virtual, defined 4 
setting up printers 127 
troubleshooting 

changing settings 256 
flow-control problem 256 
inaccessible port 262 
interrupt (IRQ) conflict 251,263 
port settings conflict with printer 250 
XonlXoff protocol 264 

PostScript printers 
changing setup options 257 
memory 257 
number of soft fonts supported 255 
setting up 126-127 
TESTPS.TXT file 251 
Transmission Retry setting 258 

Prevent Program Switch option, PIF Editor 260 
Print command, File Manager 116 
Print file, defined 119 
Print Manager 

See also online Help for Print Manager 
canceling the printing of documents 122 
default printer, choosing 123 
described 17,119 
dragging file icons to print files 116 
FILE option, printing to a file 123 



Print Manager (continued) 
keyboard shortcuts 224 
MS-DOS interrupts, printing with 123-124 
network printers 

connecting to 124-125 
defined 120 
disconnecting from 125 

pausing and resuming printing 121-122 
quitting 122 
removing printers 128 
setting up printers 126-128 
Transmission Retry setting 258 

PRINT SCREEN key 
capturing a window image 95 
capturing the screen image 94 
troubleshooting 243 

Print servers See Network printers 
Printer driver, defined 119 
Printer Setup command, Print Manager 

choosing the default printer 123 
removing a printer 128 
setting up a printer 126-127 

Printers 
connecting to network printers 124-125 
default printer, choosing 123 
disconnecting from network printers 125 
fonts 173 
installing and configuring 126-127 
network printer, defined 120 
pausing 121-122 
PostScript 

changing setup options 257 
memory 257 
number of soft fonts supported 255 
setting up 126-127 
TESTPS.TXT file 251 

print queue 120-121 
printer driver, defined 119 
PRINTERS.WRI online document xvii, 126 
removing installed printers 128 
resetting 122 
setting up 126-128 
Transmission Retry setting 258 
troubleshooting See Printing 
Windows Driver Library (WDL) 127 

PRINTERS.WRI online document xvii, 126 
Printing 

canceling printing 122 
copying files directly to a port 250 
deleting documents from the print queue 122 
dragging and dropping files 87,116 

Printing (continued) 
File Manager, using to print files 116 
FILE option, printing to a file 123 
fonts 

printerfonts 173 
screen fonts 173 
TrueType fonts 174 
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MS-DOS interrupts, using 123-124 
pausing printers or documents 121-122 
print queue 120-121 
speed, new features that increase 17 
troubleshooting 

can't connect to a network printer 266 
can't print from Windows 251 
cartridge or soft fonts don't print 255 
format of printed page is incorrect 252 
page only prints partially 256 
Paintbrush graphics are too small when printed 257 
printer doesn't print 250, 258 
printer fonts differ from screen fonts 254 
printer loses text 256 
printer output is garbled 253 
printer runs out of memory 257 
TrueType fonts don't print 254-255 

Priority options, Settings command (MS-DOS-based 
applications) 159 

PROGMAN.EXE file, selecting icons from 80 
Program Group Properties dialog box 75 
Program information files (PIFs) 

created by the Setup program 10, 154 
default PIF 156 
described 153 
exclusive use of resources 161-162 
manufacturer-supplied PIFs 155 
modifying 155 
multiple PIFs per application 156 
running applications in the background 162 

Program Item Properties dialog box 76 
Program items 

creating for applications 
by using File Manager 78 
by using Program Manager 75-78 
by using Setup 79 

creating for documents 
by using File Manager 78 
by using Program Manager 78 

icons, changing 80 
label, changing 76 
maximum number per group 75 
working (start-up) directories for 77 
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Program Manager 
See also online Help for Program Manager 
groups 

creating 75 
deleting 75 
preserved when Windows is upgraded 6 

keyboard shortcuts 223 
program items, creating 75-78 
returning to 81 
shortcut-key combinations, reserving 77 
starting applications 

from a group 81 
when you start Windows 81 

Program-item icons 
changing 80 
described 55 

Programs 
See also Applications; MS-DOS-based applications; 

Program items 
filename extensions for program files 82 

prompt command, AUTOEXEC.BAT file 270 
Properties command, Program Manager 76 
Proteus MIDI setups 180 

Q 
Queue, print 120-121 
Quick format, defined 116 
Quitting 

R 

applications 
keyboard shortcuts 223 
MS-DOS-based applications 89 
Windows-based applications 88 

Help 104 
Print Manager 122 
Windows operating system 44 

RAM See Random-access memory 
RAM drive 

avoiding conventional memory 208 
creating in extended memory 207 
setting the TEMP variable to 195 
size of 207 
using for swap files 198 

RAMDrive program 
command line 206-208 
described 203 
updated by Setup 11 

Random-access memory (RAM), excluding address 
space identified as 238 

Read-only memory (ROM), excluding address space 
identified as 238 

README.WRI online document xvii, 268 
Rearranging application windows or icons 87 
Recorder 

See also online Help for Recorder 
described 137 

Recording sound files 137 
Refresh command, File Manager 108 
.REG filename extension 246 
REG.DAT file 246 
REGEDIT.EXE file 246 
Registration database, restoring 245-246 
Registration Info Editor 246 
rem command, using to disable commands in startup 

files 193-194 
Remote communications See Terminal 
Removing 

Clipboard contents 97 
commands in startup files 193-194 
directories 115 
documents from the print queue 122 
files 115 
fonts 176-177 
groups 75 
links 150 
multimedia device drivers 186 
printers 128 

Rename command, File Manager 115 
Renaming files or directories 115 
Replacing text, basic techniques 93 
Requirements, hardware and software xvi 
Reserve Shortcut Key option, PIF Editor 243 
Restore button 

illustrated 51 
restoring windows to previous size 65 

Restore command, on the Control menu 61 
Restoring broken links 150 
Reverse video with LCD monitors 166, 167 
ROM See Read-only memory 
Run command, using to start applications 82-83 
Run Minimized option for applications 77,83 

s 
Save As command, on the File menu 90 
Save command, on the File menu 90 
Save Settings On Exit command, File Manager 108 
Saving Clipboard contents 97 
Saving files 90 
Scheduling options, 386 enhanced mode 202 
Screen colors, changing 167 



Screen fonts 172-174 
Screen images, capturing 

copying onto the Clipboard 94-95 
troubleshooting 243 

Screen savers 
described 20 
using 171-172 

Scroll bars 
how to use 66 
illustrated 51 

Scroll command, MS-DOS-based applications 62,242 
Scrolling keys 221 
SCSI hard disk 215 
Search command, File Manager 115 
Search feature in online Help 102 
Search Results window in File Manager 115 
Searching 

for files or directories 115 
for information in Help 101-102 

Select command, MS-DOS-based applications 242 
Select Files command, File Manager 110 
Selecting 

check boxes 72 
current directory 110 
directories in directory windows 109 
files in directory windows 109-110 
list items 57-58 
menu items 58--59 
menus 59 
option buttons 71 
text 

basic techniques 92-93 
extending selections 93 
in dialog boxes 69 
keyboard methods 93, 221 

vs. choosing, defined 57 
Selection cursor, defined 68 
Serial mouse, troubleshooting 239 
Serial ports 

See also Serial printers 
assigning to a printer 127 
configuring 188--189 
enhancements, described 21 
serial mouse, using with 239 
troubleshooting 

errors during high-speed communications 263-264 
trouble accessing a port 262-263 

Serial printers, troubleshooting 
flow-control problem 256 
interrupt interrupt (IRQ) conflict 251 
port settings conflict with printer 250 
printer output is garbled 253 

"Server unavailable" message 246 
set command 194, 270 
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Set Up Applications command, Setup program 79, 154 
Setting up applications 

See also Setup program 
by using File Manager 78 
by using Program Manager 75-78 
by using Setup 79, 153-154 

Setting up printers 126--128 
Setting up Windows 

copying and expanding files on Setup disks 238 
Custom Setup 4-5 
Express Setup 3-4 
network setup 8--9 
running Setup 5 
troubleshooting 

incompatible memory-resident programs 236 
setting up special hardware 235-236 
Setup repeatedly prompts for the same disk 235 
Setup stops before it is complete 233-234 
Windows won't start 236 

upgrading from Windows version 3.0 6--7 
Settings command, MS-DOS-based applications 158-160 
setup command 5 
setup la command 10 
setup Ii command 234, 237 
setup In command 9 
Setup disks, copying and expanding files 238 
Setup program 

applications, setting up 79, 153-154 
AUTOEXEC.BAT file, changes Setup makes 11 
character set, changing 181 
CONFIG.SYS file, changes Setup makes 11 
Custom Setup 4-5 
deleting unnecessary Windows files 200--201 
device drivers 

adding or updating 186--188 
installing 184 

Express Setup 3-4 
network setup 8--9 
program items, creating for applications 79 
results of upgrading from Windows version 3.0 6,10--11 
running 5 
summary of results 10 
troubleshooting 

incompatible memory-resident programs 236 
setting up special hardware 235-236 
Setup repeatedly prompts for the same disk 235 
Setup stops before it is complete 233-234 

SETUP.REG file 246 
SETUP.TXT online document xvii,234 
Shared copy of Windows 

setting up 8 
trouble using 266 

Sharing resources, multitasking options for 202 
"Sharing violation" message 266 
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shell command, CONFIG.SYS file 194 
Shortcut-key combinations 

See also Keyboard shortcuts 
for commands on menus 59 
reserving for an application 77 
troubleshooting 241-242 

Size command, on the Control menu 61 
Size of windows, changing 63-65 
Small computer system interface (SCSI) hard disk 215 
SMARTDrive program 

command line, AUTOEXEC.BAT file 212-215 
disabling if interfering with Setup 235 
disk caching, described 201-202 
double buffering 11, 215 

Snapshot of the screen 
copying onto the Clipboard 94-95 
troubleshooting 243 

Soft fonts 
printing problems 255 
using 173 

Software requirements xvi 
Sort By Date command, File Manager 108 
Sort By Name command, File Manager 108 
Sort By Size command, File Manager 108 
Sort By Type command, File Manager 108 
Sorting contents of directory windows 108 
Sound 

assigning to system events 177-178 
multimedia features, described 18 

Sound Blaster port 180 
Sound cards 

MIDI sound capabilities 177 
setting up device drivers for 185-186 
specifications 177 

Sound files 
assigning to system events 177-178 
playing 

by using Media Player 134 
by using Sound Recorder 137 

recording or editing 137 
.w A V filename extension 177 

Sound objects, linked 149,248 
Sound Recorder 

See also online Help for Sound Recorder 
described 137 
keyboard shortcuts 228 

Source directory or file, moving or copying files 114 
Source document, object linking and embedding 142 
SPART.PAR file 196 
Speed of computer system, increasing 

See also Managing memory and performance 
by compacting your hard disk 199 

Speed of computer system, increasing (continued) 
by setting multitasking options 202 
by setting TEMP to a RAM drive 195 
by using SMARTDrive 201-202,212-215 

Speed of printing, new features that increase 17 
Split bar in directory windows 106 
Standard mode 

freeing memory by using PIF Editor 260 
memory required for running Windows 12 
starting Windows in 13 
swap files 197-198 
system requirements for using xvi 

Starting 
applications 

by using MS-DOS Prompt 83,157 
by using the Run command 82-83 
from a directory window 82 
from a group 81 
from the StartUp group 81 
MS-DOS-based applications 157 
"out-of-memory" message 259 

Help 99-100 
memory-resident programs 162, 195 
Windows 

386 enhanced mode 12 
from the AUTOEXEC.BAT file 12 
network, starting before Windows 232 
sample command lines 13 
specifying an application or MS-DOS command 13 
standard mode 12 
troubleshooting 236-237 
without command-line options 12 

Windows Tutorial from within Windows 45 
Startup disk 

creating when troubleshooting 269 
formatting 116 

Startup files 
See also AUTOEXEC.BAT file; CONFIG.syS file 
streamlining 193-195 
testing 269 

StartUp group 
described 74 
starting applications 81 

Status bar, File Manager 106, 107 
Status messages See Messages 
Stop bits 

changing the setting 189 
common setting 256 

Subdirectories, displaying 111 
Super VGA display driver 243, 244 
Support Services, Customer 7 



Swap files 
386 enhanced mode 196-197 
standard mode 197-198 
troubleshooting application problems 

"out-of-memory" message 259 
slow-running application 243 

Swap disk setting, SYSTEM.lNI file 197 
Swapfile program, Windows version 3.0 196 
Switch To command, on the Control menu 

described 61 
opening Task List 86 

Switchbox, printing problems when using 250 
Switching 

between a window and a full screen 158, 220 
between applications 85,220 
between documents 86 
fast application-switching, described 41 
to and from pop-up programs 163 
to Program Manager 81 

Synthesizers 
device drivers, setting up 185-186 
MIDI setups for 179-180 

.SYS filename extension 239 
SYSINI. WRI online document xvii 
System disk 

creating before modifying startup files 193 
creating when troubleshooting 269 
formatting 116 

System files 
icon representing, illustrated 106 
renaming 115 

System performance 
See also Managing memory and performance 
improvements, described 21 

System requirements, hardware and software xvi 
System settings 

changing 186-188 
preserved when upgrading Windows 6 

SYSTEM.lNI file 

T 

COMIrqSharing setting 263 
COMxProtocol = XOFF setting 264 
documentation for xvii 
EMMExclude setting 237-238 
FontChangeEnable setting 245 
swapdisk setting 197 
DART buffer setting 264 
VirtualHDirq setting 238 

Task List 
arranging icons 87 
arranging windows 87 

Task List (continued) 
opening 86 
switching between applications 85-86 

Index 289 

Tasking options, Settings command (MS-DOS-based 
applications) 159 

Telephone numbers 
filing in Cardfile 131-132 
Microsoft Customer Support Services 7 
Microsoft electronic downloading service 7 

TEMP directory, created by Setup 11 
TEMP environment variable 

printing problems 251 
set by the Setup program 11 
setting to a RAM drive 195 

Temporary files, removing 200 
Terminal 

See also online Help for Terminal 
described 138 
troubleshooting 264--265 

Terminate option, Settings command (MS-DOS-based 
applications) 160 

Testing ADTOEXEC.BAT and CONFIG.SYS files 269 
TESTPS.TXT file 251 
Text 

copying 
from MS-DOS-based applications 160 
from Windows-based applications 94--97 

deleting 93 
editing 92-93, 222 
entering (typing) 91 
moving within 91 
pasting 

into MS-DOS-based applications 161 
into Windows-based applications 96 

replacing 93 
selecting 

basic techniques 92-93 
canceling selections 92 
extending selections 93 
in dialog boxes 69 
keyboard methods 93, 221 

Text box, in dialog boxes 69 
Text editor (Notepad) 135 
Text files (Windows online documents) 

described xvii 
opening and reading 268 

Text mode vs. graphics mode 244 
Third-party device drivers, installing 184 
Tile command, Task List 87 
Time, analog or digital clock 133 
Title bar 

flashing to signal a message 88 
illustrated 51 
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.TMP filename extension 200 
Toolbox in Paintbrush 136 
Tour of Windows operating system 23-44 
Transferring information 

between computers, using Terminal 138 
between MS-DOS-based applications 160-161 
between Windows-based applications 94-97 

Transmission Retry setting, Print Manager 258 
Triangle on menus, meaning of 59 
Troubleshooting 

application problems 
application quits unexpectedly 245 
application stops responding 242 
capturing a screen image (snapshot) 243 
font size, changing 244 
key or key combination doesn't work 241-242 
pasting into MS-DOS-based applications 244 
slow-running application 243 
Super VGA display driver 243 

AUTOEXEC.BAT file, testing 269 
computer restarts or stops unexpectedly 245 
CONFIG.SYS file, testing 269 
copying and expanding files on Setup disks 238 
memory management 258-262 
Microsoft Diagnostics (MSD) program, using 269 
mouse problems 

mouse doesn't work with MS-DOS-based 
applications 240 

mouse doesn't work with Windows 239 
pointer doesn't move 239 
pointer jumps around 240 

networks 
can't connect to a network drive 266 
guidelines for using 232 
high memory area, running network software in 266 
"sharing violation" message 266 
upper memory area, running network software in 266 

object linking and embedding 
Cardfile 249 
Insert Object dialog box 247 
Object Packager, Picture option unavailable 248 
Paste command gives varied results 247 
Paste Link command unavailable 249 
server application unavailable 246 
sound object, Manual Update setting 248 
updating linked objects 248-249 

printing problems 
can't connect to a network printer 266 
can't print from Windows 251 
cartridge or soft fonts don't print 255 
fonts on screen differ from printed fonts 254 

Troubleshooting (continued) 
printing problems (continued) 

format of printed page is incorrect 252 
page only prints partially 256 
Paintbrush graphics are too small when printed 257 
printer doesn't print 250, 258 
printer loses text 256 
printer output is garbled 253 
printer runs out of memory 257 
TrueType fonts don't print 254-255 

registration database 245-246 
serial communications 

errors during high-speed communications 263-264 
MS-DOS-based applications 264 
trouble accessing a port 262-263 

setting up Windows 
incompatible memory-resident programs 236 
setting up special hardware 235-236 
Setup repeatedly prompts for the same disk 235 
Setup stops before it is complete 233-234 

starting Windows 
386 enhanced mode not available 237-238 
Windows won't start 236-237 

system disk, creating 269 
system stops responding 245 
Terminal 264-265 
testing your Windows configuration 269 
two versions of Windows, using 267 

TrueType fonts 
adding 174-176 
described 15,174 
printing problems 254-255 
removing 176-177 
using exclusively 176 

Tutorial for Windows 
described 5, 18 
running from within Windows 45 

. TXT filename extension 267 
Typographic conventions xviii 

u 
UART (Universal Asynchronous Receiver Transmitter) 

chip 264 . 
UMBs See Upper memory blocks 
Underlined terms in online Help 103 
Undo command, on application Edit menus 93 
Undoing changes in text 93 
Up icon in directory windows 106,110 
Update command, Paintbrush 145 
Updating directory windows 108 



Updating linked objects 149, 248-249 
Upgrading from Windows version 3.0 6-7 
Upper memory area 

described 192 
network software, troubleshooting 266 
providing access to 203, 212 
settings preserved when upgrading Windows 6 

Upper memory blocks (UMBs) 
defined 192 

v 

preventing EMM386 from loading into 208 
preventing SMARTDrive from loading into 214 

Version of active application, checking 101 
Video Memory option, PIP Editor 261 
Video Mode option, PIP Editor 244, 260 
Videodisc players 

playing by using Media Player 134 
setting up device drivers for 185-186 

Virtual memory 
changing swap-file settings 196-197 
described 192 

VirtualHDirq option, starting Windows with 237-238 

w 
Wallpaper 

displaying 170--171 
memory management 259 

.WAV filename extension 177 
WDL (Windows Driver Library) 7, 183 
Wildcards 

renaming files or directories 115 
searching for files or directories 115 
selecting a group of files 110 

win command 12 
win /3 command 13 
win /d:v command 237 
win /d:x command 237 
win /s command 13 
WIN.INIfile 

documentation for xvii 
LPTl.DOS port 252 
size limitation 255 

WIN386.SWP file 196, 201 
Window 

application windows 
arranging 87 
described 53-54 
illustrated 50 

borders 51,52 

Window (continued) 
closing 67 
dialog boxes 67-72 
document window, described 53-54 
elements of 

described 51-52 
illustrated 51 

moving 62 

Index 291 

opening See Opening files; Starting applications 
scrolling through information in 66 
size, changing 

by dragging a border or corner 63-65 
by enlarging to maximum size 64 
by reducing to an icon 63-64 
by restoring to previous size 65 

snapshot 
copying onto the Clipboard 95 
troubleshooting 243 

switching between a window and a full screen 220 
title bar (illustrated) 51 

Window option, Settings command 159 
Window title, changing 76 
Windows command line 13 
Windows Driver Library (WDL) 7,183 
Windows operating system 

configuration, minimum 269 
guided tour 23-44 
mode, determining 101 
new features 15-21 
problems See Troubleshooting 
quitting 44 
requirements, hardware and software xvi 
setting up 

Custom Setup 4--5 
Express Setup 3-4 
network setup 8-9 
running Setup 5 
troubleshooting 233-239 

starting 
from the AUTOEXEC.BAT file 12 
mode, specifying 12 
network, starting before Windows 232 
sample command lines 13 
specifying an application or MS-DOS command 13 
troubleshooting 236-237 
without command-line options 12 

upgrading from Windows version 3.0 6-7 
Windows text files (online documents) 

described xvii 
opening and reading 268 

Windows Tutorial 
described 5,18 
running from within Windows 45 
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Windows version 3.0, upgrading from 6-7 
Windows version 3.1, using two versions of Windows 267 
Windows-based applications See Applications 
WININI. WRI online document xvii 
WINSTART.BAT batch file 195 
Word processing with Write 138 
Working directory for an application 77 
Workstation, diskless 8 
.WRI filename extension 267 
Write 

x 

See also online Help in Write 
described 138 
editing embedded objects 145 
editing linked objects 148 
embedding objects in documents 145 
keyboard shortcuts 228 
linking objects to documents 148 

XMS Memory option, PIP Editor 260 





For product support, contact the manufacturer of your PC. 
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